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CHAPTER 1 TO 18 BOOK BACK & PUBLIC ONE MARK QUESTION WITH ANSWERS 
(CHAPTER-1) (Multimedia) 

1. What is multimedia? 

a) a type of computer hardware  b) a type of computer software  

c) a type of computer network d) the use of multiple forms of media to communicate information 

2. ---------has five major components like text, image, sound, video and animation. 

a) Multimedia  b) Master page  c) Master page  d) Multi-word 

3. What is a raster image? 

a) a type of image made up of image made up of pixels  

b) a type of image made up of image made up of geometric shapes 

c) a type of image made up of image made up of text 

d) a type of image made up of image made up of sound waves 

4. What is vector image? 

a) a type of image made up of image made up of pixels 

b) a type of image made up of image made up of geometric shapes 

c) a type of image made up of image made up of text 

d) a type of image made up of image made up of sound waves 

5. Which of the following is raster image file format? 

a) JPEG   b) EPS   c) CDR   d) SVG 

6. Which of the following is vector image file format? 

a) PSD   b) JPEG   c) EPS   d) BMP 

7. RTF (Rich Text Format) file format was introduced by--- (J-2023, J-2024)  

a) TCS   b) Microsoft  c) Apple Inc  d) IBM 

8. The expansion of  JPEG is ------- (M-2022) 

a) Joint photographic experts group      b) Joint Photo Experts Group 

c) Joint Photon Experts Group    d) Joint Photographic Express Group 

9. AIFF file format was developed by – (M-2024) 

a) TCS   b) Microsoft  c) Apple Inc  d) IBM 

10. Which of the following is an audio file format? 

a) MP3   b) AVI   c) MPEG  d) PNG 

1. Write the expansion of MIDI : (M-2020) 

  a) Musical Information Digital Interpreter  b) Musical Instrument Digital Information 

  c) Musical Intelligent Digital Interface   d) Musical Instrument Digital Identifier  

2. The live telecasting of real time program through Internet is known as ____ (M-2023) 

           a) Web casting      b) web hosting   c) data manipulation    d) none  

3. The least frame rate of at least ______ frames in Multimedia Animation. (S-2020) 

a) 10    b) 12    c) 15    d) 16 

4. Which is not an image format? (S-2020) 

a) AIFF    b) GIF    c) TIFF    d) JPEG 

5. ---- refers to any types of applications that involves more than one type of media such as text, graphics, videos, 

animation and sound. (J-2022) 

a) An executable file b) DTP    c) Multimedia  d) Hyper text 

 
(CHAPTER-2) (An Introduction to Adobe Page maker) 
1. DTP stands for ____________     

a) Desktop Publishing   b) Desktop Publication  c) Doctor to Patient  d) Desktop Printer 

2. ____________ is a DTP software. 

         a) Lotus 1-2-3   b) PageMaker   c) Maya    d) Flash 

3. Which menu contains the new option? 

           a) File menu   b) Edit menu   c) Layout menu  d) Type menu 

4. In PageMaker Window, the area outside of the dark border is referred to as – (M-2023) 

          a) Page    b) Pasteboard   c) blackboard   d) dashboard 

5. Shortcut to close a document in PageMaker is ___________ (J-2023) 

           a) Ctrl + A     b) Ctrl + B    c) Ctrl + C    d) Ctrl + W 

6. A __________ tool is used for magnifying the particular portion of the area. (M-2023) 

            a) Text tool    b) Line tool    c) Zoom tool    d) Hand tool 

7. _________ Tool is used for drawing boxes. 

           a) Line    b) Ellipse  c) Rectangle   d) Text 

8. Place option is present in _____________ menu. (M-2024) 

           a) File    b) Edit    c) Layout   d) Window 
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9. To select an entire document using the keyboard, press _____  (S-2020) 

             a) Ctrl + A    b) Ctrl + B   c) Ctrl + C   d) Ctrl + D 

10. Character formatting consists of which of the following text properties? (M-2022) 

             a) Bold    b) Italic    c) Underline   d) All of these 

11. Which tool lets you edit text? (J-2024) 

            a) Text tool    b) Type tool   c) Crop tool   d) Hand tool 

12. Shortcut to print a document in Page maker is ______ (J-2022) 

            a) Ctrl + A    b) Ctrl + P   c) Ctrl + C   d) Ctrl + V 

1. Which is the Keyboard shortcut to open a new page maker file? (M-2020) 

       a)  Ctrl+O    b) Ctrl+M  c) Ctrl+N  d) Ctrl+X 

2. Shortcut to fetch a pointer Tool in PageMaker: (S-2020) 

a) F2    b) F5    c) F7    d) F9 

3. _______ Command is used to show the ruler in PageMaker. (S-2020) 

a) View → Ruler   b) Show → Ruler c) View → Show Rulers   d) None 

 
(CHAPTER-3) (Introduction to Database Management System) 
1. Which language is used to request information from a Database? 

a) Relational    b) Structural   c) Query    d) Compiler 

2. The ---------- diagram gives a logical structure of the database graphically? (M-2022) 

            a) Entity-Relationship    b) Entity    c) Architectural    d) Database 

3. An entity set that does not have enough attributes to form primary key is known as --- (J-2023) 

a) Strong entity set     b) Weak entity set    c) Identity set   d) Owner set 

4. ---------- Command is used to delete a database. 

          a) Delete database database_name    b) Delete database_name 

          c) drop database database_name      d) drop database_name  

5. MYSQL belongs to which category of DBMS? (M-2023) 

            a) Object Oriented   b) Hierarchical   c) Relational    d) Network 

6. MySQL is freely available and is open source. 

            a) True     b) False 

7. ---------- represents a “tuple” in a relational database? 

           a) Table    b) Row    c) Column    d) Object 

8. Communication is established with MySQL using 

            a) SQL     b) Network calls   c) Java    d) API’s 

9. Which is the MySQL instance responsible for data processing? 

           a) MySQL Client     b) MySQL Server  c) SQL    d) Server  

10. The structure representing the organizational view of entire database is known as -----in MySQL database. 

            a) Schema       b) View    c) Instance     d) Table 

1. SQL can be expanded as---  (J-2022)(M-2022) 

a) Script Query Language     b) Special Query Language 

c) Server Query Language    d) Structured Query Language 

2. The horizontal entity in a Table is known as ----- (M-2020) 

 a) Key   b) Record  c) Table   d) Column 

3. Which one of the following is not a DDL command? (M-2020) 

       a) INSERT   b) CREATE  c) ALTER  d) DROP 

4. ________ uniquely identifies the row in Database table. (S-2020) 

a) Foreign key   b) Super key  c) Primary key   d) Composite key 

5. DBMS stands for -------- (J-2022) 

a) Database model system    b) Database management system 

c) Database management software   d) Data management system. 

6. Identify the data query language command used to retrieve the data from the database. (M-2024) 

a) Delete   b) Insert   c) Select   d) Update 

  

(CHAPTER-4) (PHP: Hypertext Pre-Processor) 
1. The expansion of PHP is ------- 

          a) PHP: Hypertext Preprocessor            b) Personal Hypertext Preprocessor 

     c) Pretext Homepage        d) Pre-processor Home Page 

2. What is the extension of PHP file? (M-2022) 

          a) .html     b) .xml     c) .php     d) .ph 

3. A PHP script should start with ___ and end with --------  

          a) <?php     b) < php   c) <php? >    d) <:? 

4. How many data types does PHP support? 

a) 18   b) 28   c) 8   d) 38 
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5. Every variable name in PHP must begin with a --------symbol. 

a) #    b) , /   c) $   d) < 

6. --- in PHP are case-sensitive. 

a) variable names     b) keywords   

c) variable name with keywords   d None of the above 

7. The assignment operator is ---- 

a) =    b) = =   c) = = =   d)! = 

8. ---operators perform an action to compare two values. 

a) Arithmetic   b) Comparison  c) Increment  d) logical 

9. Which operator is called “identical”? 

a) =    b) = =    c) = = =   d) < > 

10. --- is a data type which contains decimal numbers (J-2024) 

a) Integer   b) Float   c) Boolean  d) NULL 

1. A PHP script should start with ___ (J-2023) 

a) <?php     b) < php   c) <php? >    d) <:? 

2. Recent statistics of server side scripting language usage depict that 78.9% of Website are developed by ---- 

Scripting language. (M-2023) 

a) PHP   b) Microsoft ASP  c) CSS   d) JSP 

3. PHP  is a -------- Programming language (M-2022) 

a) Object Side  b) Client side  c) File side  d) Server side  

4. We can use ___ to comment a single line? i) /?  ii) //  iii) #  iv) /* */  (M-2020)  

        a) Only (ii)     b) (i), (iii) and (iv)   c) (ii), (iii) and (iv) d) Both (ii) and (iv) 

5. Which of the following PHP statements will output ‘Hello world’ on the screen? (J-2022) 
a) echo(“Hello world”);  b) print(“Hello world”);  c) printf(“Hello world”);  d) sprintf(“Hello world”); 

6. Which statement is used to show the output of a string or other data in the screen in PHP? (M-2024) 

a) for    b) switch  c) while    d) echo 

(CHAPTER-5)  (Functions and Arrays IN PHP) 
1. A --- is a block of code that performs a specific task 

a) Parameter    b) function  c) class   d) label 

2. Pre-defined functions are also called ----------. 

a) User-defined  b) Recursive  c)Build-in  d) Lamda 

3. Which one of the following is the right way of defining a function in PHP? 

a) function functionname() {//code to be executed} b) function () {}  

      c) def myFunction ():     d) None of the above 

4. A user-defined function in PHP starts with the keyboard ----. (M-2024) 

a) function   b) def   c) defined  d) funct 

5. Which of the following is a correct way to call a function in PHP? 

a) functionName();  b) call function name; c) executefn();  d) runfn(); 

6. What is an array in PHP? 
a) An array is a special data type                 b) It can hold many values under a single variable name  

c) An array element can be any type of data   d) All the above 

7. How many types of arrays are there in PHP? (J-2022, J-2023, J-2024) 

a) 2    b) 3   c) 4   d) 5   

8. What is the index of the first element in an indexed array in PHP? 

a) 0    b) 1   c) 2   d) 3 

9. What is the index of the third element in an indexed array in PHP with 5 elements? 

a) 2    b) 3   c) 4   d) 5 

10. How do you create an indexed array in PHP? 
a) By enclosing a comma-separated list of values in square brackets  b) By using the array () function 

c) By enclosing a comma-separated list of values in curly braces   d) Both A and B 

11. How do you access the elements of an indexed array in PHP? 

a) By using the array index in square brackets  b) By using the array key in square brackets 

c) By using the array index in curly braces  d) By using the array key in curly braces. 

1. Associative arrays are a --- pair data Structure. (M-2023) 

             a) Single value          b) Key value  c) Double       d) String value 

2. -------  stores more than one value of same data type  in single array value. (M-2022) 

             a) Array   b) Function  c) Indexed   d) Multidimensional 

3. The loop exclusively used for array is ----- (M-2022) 

a) for   b) while   c) for each  d) Do while 

4. How many functions are there in PHP? (M-2020) 

 a) 5    b) 4   c) 3   d) 2 

5. PHP - numerically indexed array begin with Position ________  (S-2020) 

a) –1    b) 1    c) 0    d) 2 
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 (CHAPTER-6) (Conditional Statements IN PHP) 
1. Which of the following is NOT a type of conditional statement in PHP? 

a) if    b) if..else  c) if..elseif..else  d) while 

2. What type of statement is the if..else statement? (J-2024) 

a) Conditional statement b) Looping   c) Input   d) Output 

3. What is the simplest conditional statement in PHP? 

a) if-else   b) if   c) Switch  d) if—elseif--else 

4. How does the if statement work in PHP? 

a) A block of code is executed if a certain condition is true.  

b) A block of code is executed if a certain condition is false 

c) A block of code is executed if a multiple condition is true  

d) A block of code is executed if a multiple condition is false 

5. What happens if the conditions is an “if” statement is false? 

a) The code inside the curly braces is executed   

b) The code inside the curly braces is skipped 

c) The program terminates     

d) none of the above  

6. What is the syntax for an if-else statement in PHP? 

a) If (condition) { // True-block;}    

b) if(condition) {// True-block; } else {// False-block;} 

c) if-else (condition) {// True-block; } else {// False-block;}  

d) if-else (condition) {// True-block; } else {// False-block;} 

7. Which of the following is used to specify multiple conditions in an if ---else if –else statement? 

a) AND    b) OR   c) case   d) elseif 

8. Which of the following is used to specify multiple conditions in a switch statement? 

a) AND    b) OR   c) case   d) if 

9. What happens if none of the case values match the expression in a switch statement? 

a) The default case block is executed    b) The program terminates 

c) The nearest case block is executed   d) The first case block is executed. 

10. Which of the following is used to terminate the switch statement? (M-2024) 

a) return   b) continue   c) goto   d) break 

1. Statement which is used to make choice between two options any only option is to be performed is written as (M-2022)  

a) Then else statement  b) if    c) else one  d) if else statement 

 

 (CHAPTER-7) (Loops IN PHP) 
1. Which of the following is NOT a type of loop statement in PHP? 

a) for   b) if..else  c) while   d) do-while 

2. What type of loop is “for loop” in PHP? 

a) Entry-Check  b) Exit-Check  c) Counter  d) Iteration loop 

3. What is the syntax for for-loop in PHP? 

a) for(initialization; condition; increment) {//code}   

b) foreach(initialization; condition; decrement) {//code} 

c) while(condition)      

d) do {…}while(condition) 

4. What are the three parts of the for loop syntax in PHP? 

a) initialization, condition, increment   b) initialization, code block, condition 

c) code block, condition, increment   d) condition, initialization, code block 

5. When the ‘initialization’ part of a for loop executed? 

a) Before each iteration    b) After each iteration 

c) Only once at the at the beginning of the loop  d) Only once at the end of the loop 

6. What is the purpose of the ‘increment’ part of a for loop? (J-2024) 

a) To initialize variables    b) To update variables   

c) To check the condition    d) To execute the code block 

7. What type of is “while loop” in PHP? 

a) Entry-Check   b) Exit-Check  c) Counter loop  d) Iteration loop 

8. What type of is “do..while loop” in PHP? 

a) Entry-Check   b) Exit-Check  c) Counter loop  d) Iteration loop 

9. Which looping structure should be used to iterate over elements of an array in PHP?  

a) for loop   b) while loop  c) do..while  d) foreach loop 

10. What is the output of the following code? 

$array = array(1,2,3,4,5); foreach ($array as $value) { echo $value} 

a) 12345                              b) 54321                                 c) 11111                             d) None of the above 
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1. ---loops exclusively used for array? (J-2023) 

a)  For loop    b) While loop   c) Do while loop   d) For each loop   

2. Loops that iterate for fixed number of times is called--- (M-2023) 

           a) Unbounded   b) Bounded   c) While   d) For  

3. --- check the condition at the end. (S-2020) 

a) for   b) Do-while  c) for each  d) while 

4. The ----loop construct over the array. (J-2022) 

a) for   b) for each  c) while   d) Do-while 
5. What is the output of the following code? for($i=0;$i>=1;$i- -) { echo $i.”<br>”;} (M-2024 mere attempt) 

a) 5432   b) 12345   c) 1234   d) 54321 

 
(CHAPTER-8)(Forms and Files) 
1. What are HTML forms used for? 

a) To collect input from users    b) To create server –side programming language 

b) To create a database    d) to send email 

2. Which of the following is NOT a form control available in HTML forms? 

a) Text inputs  b) Buttons  c) Checkboxes  d) Cropping Tool 

3. Which tag is used to create an HTML form? 

a) Form   b) input   c) text area  d) select 

4.  What form control allows the user to select multiple values? 

a) Text inputs  b) buttons  c) checkboxes  d) radio buttons 

5. What form control allows the user to select only one value at a time? 

a) Text inputs  b) buttons  c) checkboxes  d) Radio buttons 

6. What is the purpose of validation in PHP? 

a) To check the input data submitted by the user from the client machine. 

b) To display data to users  c) To store data on the server    d) to send data to the client   

7. How many types of validation are available in PHP? (J-2024) 

a) One   b) Two   c) Three   d) Four 

8. Which PHP function can be used to open a file? 

a) fopen ()   b) fread ()  c) fclose ()  d) fwrite ()  

9. What PHP function can be used to read a file? 

a) fopen ()   b) fread ()  c) fclose ()  d) fwrite () 

10. What PHP  function can be used to close a file? 

a) fopen ()   b) fread ()  c) fclose ()  d) fwrite () 

1. Which attribute of form tag to helps in client side validation (J-2023) 

(a) Submit   b) Check  c) Validate   d) Required 

2. In which input field only one option can be selected? (M-2023) 

            a) Text box    b) Check box  c) radio button   d) Drop Down  

3. ------- is a request for data or information from a database table or combination of tables. (M-2020) 

a) Code   b) Query  c) form   d) Report      

4. In PHP ________ variables called the data and prepares the response accordingly (S-2020) 

a) Method    b) $_GET, $_POST c) fread( ), fwrite( )  d) All the above 

5. ---- method stores in the input data in the request body of the client HTML. (J-2022) 

a) POST   b) GET   c) FORM  d) HTML 

 
 (CHAPTER-9) (Connecting PHP and MYSQL) 
1. Which is the correct function to execute the SQL queries in PHP? 

               a) mysqli_query(“Connection Object”,”SQL Query”) b) query(“Connection Object”,”SQL Query”) 

                c) mysql_query(“Connection Object”,”SQL Query”)  d) mysql_query(“SQL Query”) 

2. Which is the correct function Closing Connection in PHP? (M-2024) 

             a) mysqli_close(“Connection Object”);  b) close(“Connection Object”);  . 

             c) mysql_close(“Connection Object”);   d) mysqli_close(“Database Object”); 

3. Which is the correct function to establish Connection in PHP? 

         a) mysqli_connect(“ServerName“,”UserName”,”Password”,”DB Name”);  

               b) connect(“Server Name “,”User Name”,”Password”,”DB Name”); 

               c) mysql_connect(“Server Name “,”User Name”,”Password”,”DB Name”); 

               d) mysqli_connect (“Database Object”); 

4. Which is the not a correct MySQL Function in PHP? 

             a) Mysqli_connect() Function             b) Mysqli_close() Function 

             c) mysqli_select_data() Function      d) mysqli_affected_rows() Function 

5. How many parameter are required for MYSQLi connect function in PHP? (J-2023) 

             a) 2      b) 3       c) 4       d) 5 
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6. How many parameter are required for MYSQLi query function in PHP? 

             a) 2       b) 3       c) 4       d) 5 

7.  How many parameter are required for MYSQLi Close function in PHP? 

             a) 1       b) 2       c) 3       d) 5 

8.  Which version of PHP supports MySQLi functions? (S-2020) 

               a) Version 2.0    b) Version 3.0    c) Version 4.0    d) Version 5.0  

 
(CHAPTER-10)  (Introduction to Computer Networks) 
1. A set of computers connecting together is called as ------ (J-2023, J-2024)  

            a) Network      b) Server    c) Hub      d) Node 

2. Many discussions in an online forum leads to personal attacks and is called— 

a) Hackers   b) Virus   c) Online war  d) Flame war 

3. Wi-Fi is short name for--- (M-2020) 

      a) Wireless Fidelity     b) Wired fidelity  c) Wired fibre optic      d) Wireless fibre optic 

4. Which among them was challenging  to the business people on computer networking   

a) Hacking     b) Viruses    c) Both a & b    d) none  

5. Which one of the following is not  the social media 

            a) Gmail     b) Facebook    c) twitter     d) Linked in 

6. In mobile network, land areas for  network coverage was distributed as (M-2024) 

            a) Firmware     b) cells    c) Range   d) Service 

7. Which one of the following are harmful to computer? 

             a) Bloggers     b) Browser    c) Hackers    d) twitter 

1. In which one of the following periods, the speed capacity supported towards gigabit on computer network? (M-2023)   

     a) SABRE       b) SAGE   c) NEW FIBRE OPTICS d) ARCNET 

2. Which of the following will be an easy way to use internet and the public telecommunication system to securely 

share business’s information with suppliers, partners and customers? (M-2022) 

a) Arpanet   b) Extranet  c) Arcnet  d) Intranet 

3. Computer which connected to a network is called--- (M-2020) 

a) Device   b) node   c) system  d) cable 

 

(CHAPTER-11)  (Network Examples and Protocols) 
1. Which one of the following system to securely share business’s information with suppliers, vendors, partners and customers. 

             a) Extranet    b) Intranet    c) arpanet   d) arcnet 

2. Match the following and choose the correct answer 
            i. HTTP -The core protocol of the World Wide Web.  ii. FTP- enables a client to send and receive complete files from a server. 

            iii. SMTP - Provide e-mail services.                          iv. DNS- Refer to other host computers by using names rather than numbers. 

       a) i, ii, iii, iv     b) ii, iii, iv, i      c) iii, iv, i, ii      d) iv, iii, ii, i 

3. Communication over ---is be made up of voice, data, images and text messages. 

            a) Social media   b) mobile network  c) whatsapp   d) software 

4. Wi-Fi stands for…. 

a) Wireless Fidelity  b) Wired fidelity  c) Wired optic fibre d) Wireless optic fibre 

5. A TCP/IP network with access restricted to members of an organization 

            a) LAN      b) MAN    c) WAN    d) Intranet 

6. RFID stands for -------------- 

             a) Radio Free identification            b) real Frequency identity  

             c) Radio Frequency indicators        d) Radio Frequency Identification 

7. It guarantees the sending of data is  successful and which checks error on operation at OSI layer is---- 

            a) Application    b) Network   c) Transport     d) Physical  

8. Which one of the following will secure data on transmissions------- 

            a) HTTPS       b) HTTP     c) FTP      d) SMTP 

9. ----------- provides e-mail service. (J-2024) 

           a) DNS        b) TCP     c) FTP      d) SMTP 

10. ------------- refer to other host computers by using names rather than numbers. (J-2023) 

             a) DNS       b) TCP      c) FTP      d) SMTP 

1.  Which one of the following is a technology to locate objects using radio signals? (M-2023) 

a) WiFi   b) URL   c) RFID   d) HTTP  

2. What is the expansion of TCP— (M-2020) 
a) Television Control Protocol b) Television Control Program c) Transmission Control Program d) Transmission Control Protocol 

3. There are ________ number of layers in OSI. (S-2020) 

a) 5     b) 6    c) 8    d) 7 
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(CHAPTER-12)   (Domain Name System (DNS)) 
1. Which of the following is used to maintain all the directory of domain names? 

               a) Domain name system   b) Domain name space  c) Name space    d) IP address 

2. Which of the following notation is used to denote IPv4 addresses? (M-2020) 

            a) Binary    b) Dotted-decimal   c) Hexadecimal    d) a and b 

3. How many bits are used in the IPv6 addresses? (J-2023, M-2024) 

            a) 32     b) 64     c) 128     d) 16 

4. Expansion of URL is 

            a) Uniform Resource Location     b) Universal Resource Location 

             c) Uniform Resource Locator       d) Universal Resource Locator 

5. How many types are available in URL? (J-2024) 

            a) 2        b) 3        c) 4       d) 5 

6. Maximum characters used in the label of a node? (J-2022, M-2023) 

            a) 255      b) 128       c) 63       d) 32 

7. In domain name, sequence of labels are separated by---- (M-2020) 

            a) semicolon (;)      b) .(dot)      c) colon (:)     d) NULL 

8. Which of the following initiates the mapping of domain name to IP address? 

           a) Zone    b) Domain     c) Resolver    d) Name servers 

9. Which is the contiguous area up to which the server has access? 

          a) Zone      b) Domain     c) Resolver    d) Name servers 

10. Root Name servers are maintained by, (M-2024) 

a) IANA   b) ICANN  c) WHOIS  d) DNS 

1.  Which is the Non-profitable organization? (S-2020) 

a) .edu    b) .gov    c) .org    d) .com 

 
(CHAPTER-13) (Network Cabling) 
1. ARPANET stands for  

             a) American Research Project Agency Network  b) Advanced Research Project Area Network 

             c) Advanced Research Project Agency Network d) American Research Programs and Network 

2. WWW was invented by--- (M-2020, M-2022, J-2023) 

            a) Tim Berners Lee    b) Charles Babbage   c) Blaise Pascal    d) John Napier 

3. Which cable is used in cable TV? 

             a) UTP cable       b) Fibre optics        c) Coaxial cable   d) USB cable 

4. Expansion of UTP is 

            a) Uninterrupted Twisted Pair     b) Uninterrupted Twisted Protocol 

            c) Unshielded Twisted Pair        d) Universal Twisted Protocol 

5. Which medium is used in the optical fibre cables to transmit data? 

           a) Microwave   b) infrared     c) light    d) sound 

6. Which of the following is a small peripheral device with a sim slot to connect the computers to Internet?  (J-2022)  

a) USB     b) Dongles    c) Memory card    d) Mobiles 

7. Which connector is used in the Ethernet cables? (S-2020, J-2024) 

a) RJ11     b) RJ21    c) RJ61    d) RJ45 

8. Which of the following connector is called as champ connector? (M-2024) 

             a) RJ11      b) RJ21      c) RJ61      d) RJ45 

9. How many pins are used in RJ45 cables?   

a) 8      b) 6      c) 50       d) 25 

10.  Which wiring standard is used for connecting two computers directly? 

               a) straight Through wiring   b) Cross Over wiring   c) Rollover wiring   d) none 

1. The cables that are placed in deep underground to avoid any damage to the cables (M-2023) 

a) Fiber optics  b) Coaxial  c) USB cables  d) Twisted pair cables 

(CHAPTER-14) (Open Source Concepts) 
1. If the source code of a software is freely accessible by the public, then it is known as –    

            a) Freeware      b) Firmware     c) Open source     d) Public source 

2. Which of the following is a software program that replicates the functioning of a computer network?    

        a) Network software    b) Network simulation c) Network testing       d) Network calculator 

3. Which of the following can document every incident that happened in the simulation and are used for examination? 

            a) Net Exam    b) Network hardware    c) Trace file      d) Net document 

4. Which is an example of network simulator? (M-2023) 

      a) Simulator     b) TCL     c) Ns2     d) C++ 

5. Choose the Correct Pair from the   following to build NS2 

           a) UNIX & TCL      b) UNIX & a. C++    c) C++ & OTcl            d) C++ & NS2 
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6. Which of the following is not a network simulation software?  

           a) Ns2      b) OPNET    c) SSFNet     d) C++ 

7. Which of the following is a open source network monitoring software? 

            a) C++     b) OPNET    c) Open NMS     d) OMNet++ 

8. Open NMS was released in   … (J-2024) 

      a) 1999     b) 2000     c) 2003      d) 2004 

 
(CHAPTER-15) (E-Commerce) 
1. A company involved in E-Business if  ------ 

            a) it has many branches across the world   b) it conduct business electronically over the Internet 

            c) it sells commodities to a foreign country   d) it has many employees 

2. Which of the following is not a tangible good? (J-2024) 

             a) Mobile Phone       b) Mobile Apps     

c) Medicine                    d) Flower bouquet 

3. SME stands for----- (J-2022, M-2024) 

             a) Small and medium sized enterprises   b) Simple and medium enterprises 

             c) Sound messaging enterprises                 d) Short messaging enterprises 

4. The dotcom phenomenon deals with ________  (S-2020, M-2023) 
               a) Textile industries                     b) Mobile phone companies  

c) Internet based companies       d) All the above 

5. Which of the following is not correctly  matched (J-2023) 

                a) The First Wave of Electronic  Commerce: 1985 -1990   b) The Second Wave of Electronic  Commerce: 2004 – 2009 

                c) The Third Wave of Electronic  Commerce: 2010 – Present d) Dotcom burst: 2000 – 2002 

6.  Assertion (A): The websites of first wave dotcom companies were only in    English   (M-2022) 

             Reason (R): The dotcom companies of first wave are mostly American companies.   

                a) Both (A) and (R) are correct and  (R) is the correct explanation of (A) 

                b) Both (A) and (R) are correct, but (R) is not the correct explanation of (A) 

                c) (A) is true and (R) is false        d) (A) is false and (R) is true 

7. Off-shoring means 

             a) Work outsourced to a branch of it sown company b) Work outsourced to new employees.   

       c) Work outsourced to a third party locally   

            d) Work outsourced to a third party outside its own country 

8. G2G systems are classified into 

            a) Internal facing and external facing    b) Internet facing and Extranet facing 

             c) Internal flag and external flag            d) Internet flag and Extranet flag 

9. ____ host the e-books on their websites. 

         a) Bulk-buying sites                b) Community sites  

      c) Digital publishing sites      d) Licensing site 

10.   Which of the following is  a characteristics of E-Commerce 
             a) Products cannot be inspected physically before purchase b) Goods are delivered instantly  

       c) Resource focus supply side     d) Scope of business is global 

(CHAPTER-16)  (Electronic Payment Systems) 
1. Based on the monetary value e - payment system can be classified into (J-2022) 

              a) Mirco and Macro                     b) Micro and Nano    

  c) Maximum and Minimum        d) Maximum and Macro 

2. ---refers to a payment made from one bank account to another bank account using electronic methods. 

a) Electronic payment     b) Direct payment   

c) Indirect payment     d) none of the above 

3. Assertion (A): Micro electronic payment systems support higher value payments. 

            Reason (R): Expensive cryptographic operations are included in macro payments 

            a) Both (A) and (R) are correct and(R) is the correct explanation of (A) 

            b) Both (A) and (R) are correct, but (R) is not the correct explanation of (A) 

            c) (A) is true and (R) is false      d) (A) is false and (R) is true 

4. Which of the following is correctly matched (M-2024) 

             a) Credit Cards - pay before            b) Debit Cards - pay now 

             c) Stored Value Card - pay later      d) Smart card – pay anytime 

5. ECS stands for---- (J-2023) 

            a) Electronic Clearing Services     b) Electronic Cloning Services 

            c) Electronic Clearing Station        d) Electronic Cloning Station 

6. Which of the following is  online payment system for small payments 

            a) Card based payment     b) Micro electronic payment 

      c) Macro electronic payment    d) Credit card payment 
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7. Which of the following is true about Virtual payment address (VPA) 

           a) Customers can use their e-mail id as VPA   b) VPA does not includes numbers 

           c) VPA is a unique ID         d) Multiple bank accounts cannot have single VPA. 

8. Pick the odd one in the credit card transaction--- (M-2022) 

          a) Card holder       b) merchant     

     c) Marketing manager      d) acquirer 

9. Which of the following is true about  debit card 
           i. debit cards cannot be used in ATMs   ii. debit cards cannot be used in online transactions 

             iii. debit cards do not need bank account  iv. debit cards and credit cards are identical in physical properties 

            a) i, ii, iii           b) ii, iii, iv        

c) iii alone          d) iv alone 

10. Match the following 

       List A   List B                A1 A2 A3 A4 

      A1) First Digit  B1) Account number  a) B4 B3 B2 B1 

     A2) 9th to 15th Digit  B2) MII Code   b) B2 B1 B3 B4 

     A3) First 6 Digits    B3) BIN Code   c) B2 B3 B4 B1 

     A4) Last Digit              B4) Check digit   d) B2 B4 B3 B1  

(CHAPTER-17) (E-Commerce Security Systems) 
1. In E-Commerce, when a stolen credit card is used to make a purchase it is  termed as -- 

            a) Friendly fraud    b) Clean fraud   c) Triangulation fraud    d) Cyber squatting 

2. Which of the following is not a security element involved in E-Commerce? (M-2024) 

            a) Authenticity   b) Confidentiality  c) Phishing   d) Privacy 

3. Asymmetric encryption use – keys for encryption and decryption. 

a) Same   b) Different   c) Positive  d) Negative 

4. The security authentication technology includes 

             i) Digital Signatures       ii) Digital Currency iii) Digital Image  iv) Digital Certificates 

       a) i, & iv      b) ii & iii    c) i, ii & iii   d) all the above 

5. PGP stands for  ----- (M-2023)  

a) Pretty Good Privacy         b) Pretty Good Person 

           c) Private Good Privacy       d) Private Good Person 

6. _____ protocol is used for securing credit cards transactions via the Internet 

         a) Secure Electronic Transaction (SET)    b) Credit Card Verification 

         c) Symmetric Key Encryption                        d) Public Key Encryption 

7. Secure Electronic Transaction (SET) was developed in ----- (J-2022, J-2023) 

           a) 1999    b) 1996    c) 1969    d) 1997 

8. The websites secured by Secure Socket Layer protocols can be identified using---- (M-2022) 

           a) html://    b) http://   c) htmls://   d) https:// 

9. ---- is the process of converting plain text into meaningless cipher text.  (J-2024) 

a) Encryption  b) Decryption  c) Digital certificate d) Digital signature 

10. Which of the following is true about Ransom ware ------ 

            a) Ransomware is not a subset of malware  b) Ransomware deletes the file instantly 

            c) Typopiracy is a form of ransomware            d) Hackers demand ransom from the victim 

1. Expansion of SET : (S-2020) 

a) Secure Enabled Transaction    b) Secure Electronic Transaction 

c) Secure Exchange Transaction   d) Secure Electric Transaction 
(CHAPTER-18) (Electronic Data Interchange- EDI) 

1. EDI stands for ---- 

            a) Electronic Details Information      b) Electronic Data Information 

            c) Electronic Data Interchange          d) Electronic Details Interchange 

2. Which of the following is an internationally recognized standard format for EDI? 

            a) TSLFACT    b) SETFACT     c) FTPFACT     d) EDIFACT 

3. Which is the first industry-specific EDI standard? 

           a) TDCC     b) VISA    c) Master     d) ANSI 

4. Which of the following is a type of EDI? 

            a) Direct ED     b) Indirect EDI   c) Collective EDI   d) Unique EDI 

5. Who is called as the father of EDI? (J-2024) 

           a) Charles Babbage   b) Ed Guilbert    c) Pascal    d) None  

1. The versions of EDIFACT are also called as (M-2022) 

           a) Message types   b) Subsets     c) Directories    d) Folders 

2. UNSM stands for ---- (J-2022) 

a) United Nations Standard Message   b) Universal natural standard message 

c) Universal notation simple message   d) United nation service message 
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CHAPTER 1 TO 18 ONE MARK BOOK INSIDE QUESTION & ANSWERS                         
(CHAPTER-1) (Multimedia) 
1. ----- is the first popular format for high resolution images.  

A) GIF   B) TIFF   C) DIB   D) TGA 

2. ---- involves moving an object on a screen that has a constant background.  

A) Animation   B) Frame  ` C) Path animation D) Image animation 

3. ....... is the basic component of multimedia 

 A) Video    B) Audio   C) Text    D) Graphics 

4. How many major components are there is multimedia?  

A) 4    B) 3    C) 5    D) 2  

5. Which of the following is not a major component of multimedia?  

A. Text   B. Pagemaker   C. Video   D. Animation  

6. Which of the following is not a dynamic element of multimedia?  

A. Video    B. Animation   C. Audio   D. Text  

7. Which of the following is a static element?  

A. Graphics   B. Video   C. Animation   D. Audio  

8. How many types of elements are there in multimedia?  

A. 3    B. 4    C. 2    D. 5  

9. The most common ways of communicating information to other person is  

A. Audio    B. Text    C. Graphics   D. Images  

10. How many types of text used in multimedia?  

A. 4    B. 3    C. 2    D. 5   

11. Which of the following type of text not used in multimedia?  

A. Static Text   B. Hyper Text   C. Multi Text   D. Interactive Text   

12. Which of the following text will give information or support an image or a video?  

A. Static    B. Hyper   C. Multi   D. Information   

13. Which text defines the paths the user need to follow for the text access in non-sequential ways?  

A. Static    B. Multi   C. Hyper   D. None of these 

14. Which of the following acts as an vital component in multimedia?  

A. Text    B. Image   C. Video   D. Audio   

15. How many ways the images are generated by the computer?  

A. 4    B. 5    C. 3    D. 2  

16. Which of the following is a type of image not generated by computer?  

A. Bitmap    B. Raster   C. Hyper   D. Vector  

17. The common form of storing images in a computer is  

A. Raster    B. Bitmap   C. Vector   D. a or b  

18. The image formed by pixel is  

A. Bitmap    B. Vector   C. GIF    D. JPG  

19. How many colours are there is each pixel?  

A. 1    B. 2    C. 256    D. more  

20. Which of the following is used to determine the number of colors in images?  

A. Bits    B. Bytes   C. Megabytes   D. Gigabytes  

21. Which types of image is used to create line, rectangle?  

A. Raster    B. Vector   C. Bitmap   D. GIF  

22. Which types of images is useful for storing large number of images and speeding transmission for network application?  

A. Raster    B. Bitmap   C. Animated GIF  D. Vector   

23. Which of the following is not a compression format image?  

A. GIF    B. MPEG   C. TIFF   D. JPEG   

24. Which of the following is the process displaying still images in continuous movement?  

A. Images    B. Graphics   C. Animation   D. Video   

25. The least frame rate that gives the impression of animation smoothness is  

A. 16    B. 25    C. 9    D. 20  

26. The least frame rate that gives the impression of animation in natural is  

A. 16    B. 25    C. 20    D. 21  

27. How many types of animation are there?  

A. 1    B. 2    C. 3    D. 5  

28. Which of the following is not a types of animation?  

A. Vector    B. Path    C. Frame   D. All of these  

29. Which tools are very powerful and effective?  

A. Animation   B. Image   C. Text    D. None  

30. Which type of animation involves moving an object on a screen that has a constant background?  

A. Frame    B. Static   C. Dynamic   D. Path  
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31. In which type of animation there is no change in the background?  

A. Frame    B. Path    C. Dynamic   D. Vector  

32. In which type of animations, multiple objects are allowed to travel simultaneously?  

A. Vector    B. Raster   C. Frame   D. Path  

33. In which type of animation, the background changes according to the object?  

A. Frame    B. Vector   C. Raster   D. Path  

 
(CHAPTER-2) (An Introduction to Adobe Page maker) 
1. --- tool is used to draw a circle  

a) Rectangle   b) Ellipse tool  c) Rectangle frame d) Polygon tool 

2. ---is the keyboard shortcut key for getting character specification  

a) Ctrl+L   b) Ctrl+P  c) Ctrl+T  d) Ctrl+C  

3. The insert pages option is available on clicking the –menu.  

a) Layout→Insert pages b) Element→Insert c) Type→Insert  d) Utilities→Insert 

4. A—dialogue box appears when double click the line tool from the page maker tool box  

a) Rounded corners  b) Custom stroke c) Polygon  d) Goto page            

5. The shortcut key used to create a new document in Adobe PageMaker is  

A. Ctrl + D    B. Ctrl + O   C. Ctrl + N   D. Alt + N   

6. The default name of the new document is  

A. Untitled -1   B. document -1   C. Page - 1   D. Untitled page -1  

7. Which of the following is used to temporarily hold elements while designing document in adobe PageMaker?  

A. Clibboard   B. Clipboard   C. Paste book   D. Pastboard  

8. The default top and bottom margin is  

A. 0.25”    B. 0.75”   C. 0.50”   D. 1”   

9. The default page orientation is  

A. Tall    B. Wide    C. Landscape   D. Letter  

10. 29. The default page dimension is  

A. 8.5” x 10”   B. 8.5 x 11”   C. 11 x 8.5”   D. 8.5 x 11.5”  

11. The topmost part of the window is ---- 

A. Tool bar    B. Tool box   C. Menu bar   D. Tittle bar  

12. Which of the following is not a control button in a Title bar?  

A. Open    B. Close   C. Minimize   D. Maximize   

13. Which of the following is not a menu in the menu bar?  

A. Layout    B. Type    C. Margin   D. Element  

14. Tool tip will appear on the 

A. Menu bar   B. Tool bar   C. Tittle bar   D. All of these  

15. How many tools are there is Tool box? 

A. 9    B. 11    C. 10    D. 14  

16. Which menu is used show or Hide tool box in Page Maker? 

A. Tools   B. Window   C. Edit    D. View  

17. The shortcut key is used select printer tool in the PageMaker tool box is… 

A. F5   B.F8    C. F9    D. Shift + F9  

18. Which of the following tool is used to train imported graphics objects? 

A. Pointer tool  B. Hand tool   C. Cropping tool  D. None  

19. How many scroll bars are there is PageMaker Window? 

A. 2    B. 3    C. 4    D. Only 1  

20. How many ruler bars are there in PageMaker Window?  

A. 4    B. 3    C. 2    D. Only 1   

21. Which of the following appears along the top and left sides of the document window?  

A. Scroll bars   B. Status bar   C. Ruler bars   D. Tool box   

22. Which menu is used show Rulers?  

A. File    B. Edit    C. Type    D. View  

23. The key is used to insert a blank line in a document is  

A. Shift key    B. Alt key   C. Enter key   D. Esc key  

24. The flashing vertical bar called  

A. Cursor    B. Insertion point  C. Marker  D. Pointer   

25. Text can be selected using  

A. Only mouse   B. Only keyboard  C. Mouse or keyboard  D. Tools  

26. The key used to select the text is  

A. Shift    B. Alt    C. Ctrl    D. Esc  

27. Which of the following key combination to select text to the end of the current line?  

A. Ctrl + End   B. Shift + Ctrl + End  C. Alt + End   D. Shift + End 
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28. Which key is used to delete the character towards left of the insertion point?  

A. Delete    B. Backspace   C. Shift + Delete   D. Alt + Delete  

29. Under which menu clear command appears.  

A. File    B. View    C. Edit    D. Window A 

30. The shortcut key used to reverse the action of the last command.  

A. Ctrl + U    B. Ctrl + N   C. Ctrl + D   D. Ctrl + Z  

31. A text block contains  

A. typed text   B. pasted text   C. imported text   D. all of these  

32. How many handles are seen while resizing the text block?  

A. 4    B. 3    C. 2    D. 1  

 
(CHAPTER-3) (Introduction to Database Management System) 
1. Which one of the following is not a DDL command?  

       a) INSERT   b) CREATE  c) ALTER  d) DROP 

2. Any database whose logical organisation is based on relational data model is known as---database.  

a) Relational  b) Network   c) Object-Oriented d) Hierarchical 

3. In ER-model which of the following represents separate notations for data?  

a) Entities   b) attributes  c) relationships  d) all the above 

4. The Query result are listed are ascending or descending order using the command… 

a) CREATE   b) WHERE  C) ORDER BY  d) GROUP BY 

5. A key with more than one attribute to identify rows originally in a table is called------ 

a) Candidate key  b) Foreign key  c) Primary key  d) Composite key 

6. In which one of the following command is not present in TCL –  

a) ROLL BACK  b) REVOKE  c) SAVE POINT  d) COMMIT  

7. Which of the following is system software for creating and managing databases? 

a) Database   b) DBMS  c) SQL   d) MYSQL 

8. DBMS stands for------ 

a) Database Management System    b) Data Based Managers System  

c) Database Managers Society     d) Data Base Management Society 

9. Which of the following notation is used to weak relationship in ER diagrams? 

a) Simple rectangular box     b) Double rectangular boxes  

c) Rhombus       d) Rhombus with in rhombus 

10. Which of the following the DBMS provides to the users?  

A. create data   B. retrieve data   C. update data   D. all of these  

11. Grouping only related data together and storing them under one group name called  

A. tuple    B. table    C. list    D. database  

12. Which of the following is not a type of dbms?  

A. DBMS    B. RDBMS   C. ODBMS   D. EDBMS  

13. How many basic concepts all DBMS adheres?  

A. 2    B. 3    C. 4    D. 6  

14. Which of the following is the DBMSs mechanism used for data sharing?  

A. ACID    B. Concurrency control  C. Locking   D. Consistency  

15. The famous Hierarchical database model was  

A. IBM    B. INS    C. IMS    D. MIS 

16. Which of the following is not a database model?  

A. Hierarchical   B. Relational   C. Network   D. Consistency   

17. IMS expansion is  

A. Information Memory System    B. Information Management System  

C. Information Model System    D. Information Management Solution  

18. IBM’s first DBMS is  

A. IMS    B. RDBMS   C. ODBMS   D. none of these  

19. Which of the following database model has information in parent/child relationship?  

A. Network    B. Object   C. Hierarchical    D. Relational  

20. The first developed network data model is  

A. IMS    B. IDS    C. DB2    D. Oracle  

21. IDS expansion is  

A. Integrated Data Store     B. Integrated Data Source  

C. Integrated Data System     D. Integrated Digital Source  

22. Which of the following model is defined with terminologies?  

A. Hierarchical   B. Relational   C. Network   D. Object  

23. Which of the following model is similar to Hierarchical model?  

A. Relational   B. ER    C. Object oriented  D. None of these 
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24. Which database components not identified by Network model?  

A. Network Schema   B. Subschema   C. Instance   D. Language 

25. How many terminology are there to define relational model?  

A. 2    B. 3    C. 4    D. 6  

26. In Relational model, which terminology specifies the table structure including name and type of each column?  

A. Network schema   B. Schema   C. Sub Schema   D. Instance   

27. Which model incorporates the OOP’s concept?  

A. Relational   B. Network   C. Object oriented  D. ER   

28. Which model serves as the base of relational model?  

A. Hierarchical   B. Network   C. ER    D. Object oriented  

29. Which model efficiently manages large number of different data types?  

A. Object oriented   B. Hierarchical   C. Relational   D. Network and ER  

30. Which one of the following is not a modern database systems?  

A. SQL    B. MySQL   C. Oracle   D. Ms-Access   

31. Which of the following is not a RDBMS Jargons?  

A. Key    B. List    C. Tuple   D. Schema  

32. Which of the following is a basis for SQL?  

A. DBMS    B. ODBMS   C. Network model   D. RDBMS  

33. Which of the following relational database supports different operating system platforms?  

A. Oracle    B. DB2    C. MySQL   D. Ms-Access  

34. Which of the following is the simple representation of relations?  

A. Key    B. tuple    C. Schema   D. Table  

35. Each column is a table is known as  

A. Tuple    B. Attribute   C. Key    D. Schema  

 

(CHAPTER-4) (PHP : Hypertext Pre-Processor) 
1. Who introduced the concept of Internet and world wide web?  

A. Bill gates    B. Tim Berners Lee  C. Jame Gonsling  D. Dennis Ritchie  

2. Which is one of the most widely used and recognizable technologies in use on the internet?  

A. MySQL    B. SQL    C. PHP    D. HTML  

3. Which of the following is a fundamental part of any dynamic webpage?  

A. SQL    B. HTML   C. Pagemaker   D. PHP  

4. Which one of the following is the important server side web and general purpose scripting language?  

A. Javascript   B. PHP    C. VB script   D. SQL  

5. PHP invented by  

A. Tim Berner’s Lee   B. Dennis Ritchie  C. Rasmus Lerdorf  D. Ken Thomson  

6. PHP invented in the year  

A. 1991    B. 1992    C. 1993    D. 1994  

7. CSS expansion is  

A. Cascading Style Sheets     B. Cascading Side Sheets  

C. Consolidated Style Sheets     D. Compiled Style Sheets   

8. Which of the following is a server side scripting language?  

A. CSS    B. Java script   C. PHP    D. Python  

9. Which of the following is a client side scripting language?  

A. PHP    B. CSS    C. ASP    D. JSP   

10. JSP stands for  

A. Java Script Page      B. Java Server Page  

C. Java Sheet Page      D. Java Server Processor   

11. CGI stands for  

A. Common Gateway Interface    B. Consistency Gateway Interface  

C. Common Gateway Information    D. Common Gateway Intelligent   

12. In Microsoft IIS, IIS stands for  

A. Internet Information Server    B. Information Internet Server  

C. Internet Information System    D. Internet Information Script  

13. The current version of php is  

A. 3.7    B. 7.3    C. 8.7    D. 7.4   

14. Which of the following is a high performance hardware machine it could run more than one application 

concurrently?  

A. Client    B. Server   C. CGI    D. JSP  

15. Which is a hardware machine which connected with server in the network?  

A. IIS    B. Apache Tomcat  C. Client   D. None of these   

16. How many classifications are there in client-server Architecture?  

A. 2    B. 4    C. 5    D. 3   
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17. How many classifications are there in web scripting language?  

A. 2    B. 3    C. 4    D. many  

18. How many percentage of websites are running under the open source web servers? 

A. 100%    B. 110%   C. 120%   D. 130%   

19. Which of the following is not a open source web servers?  

A. Apache Tomcat   B. Microsoft IIS   C. Nginx   D. all of these   

20. The process of web development includes  

A. Web content generation  B. Web page designing  C. Web site security  D. all of these  

21. How many types of PHP Syntax are available?  

A. 2    B. 4    C. 3    D. 6  

22. Which of the following is not a type of PHP Syntax?  

A. Default Syntax   B. Short open tags  C. HTML script embed tags D. Script open Tags  

23. The short open Tags begins with  

A. <?...?>    B. <?php?>   C. ?<...<?   D. <!...!>  

24. The variable in PHP beging with  

A. @    B. =    C. !    D. $ .  

25. The PHP statement always ends with  

A. :     B. ;    C. ,    D. .  

26. How many data types supported by PHP scripting language?  

A. 11    B. 12    C. 10    D. 13  

27. Which of the following datatype enclosed with in single or double quotes?  

A. Resource    B. String   C. Boolean   D. NULL  

28. Non decimal numbers are called  

A. Float    B. NULL   C. Array   D. Integer  

29. Which of the following must be installed on your computer so as to run PHP script?   

      a) Adobe     b) windows    c) Apache    d) IIS 

30. Which statement will output $x on the screen? 

           a) echo “\$x”;     b) echo “$$x”;   c) echo “/$x”;   d) echo “$x; 

31.  Which of the below symbols is a newline character?   

       a) \r      b) \n      c) /n     d) /r 

 
(CHAPTER-5)  (Functions and Arrays IN PHP) 
1. A function uses----- statement to return a value. 

a) return   b) break   c) Indexed ` d) Multi 

2. A user defined function begins with the keyword. 

a) def   b) function  c) array   d) string 

3. As compared to associate arrays vector arrays are much  

A. Faster    B. Slower   C. Stable   D. None   

4. What functions count elements in an array?  

A. Count    B. Sizeof   C. Array_count   D. Count_array  

5. How many built in functions are there in PHP?  

A. 300    B. 500    C. > 700   D. < 100  

6. A block of segment in a program is known as ___  

A. Parameter   B. Function   C. Argument   D. Loop  

7. How many types of functions are there in PHP?  

A. 1    B. 2    C. 4    D. 3  

8. Which of the following is not a type of function?  

A. User defined    B. Default    C. Pre defined    D. Parameterized  

9. UDF stands for  

A. User defined function     B. User deleted function  

C. Utility defining function     D. User datatype function  

10. In PHP, how many important steps the programmer has to create a user defined function?  

A. 3    B. 4    C. 2    D. 1  

11. A user defined function declaration begins with the keyword?  

A. User    B. Defined   C. Function   D. System  

12. The parameter is also called as  

A. Arguments   B. Functions   C. Operators   D. Variable  

13. The function parameters are enclosed in  

A. { }    B. [ ]    C. < >    D. ( )   

14. All the function arguments are separated using  

A. ,     B. ;    C. :    D. .  

15. A function block is enclosed with in  

A. ( )    B. { }    C. [ ]    D. < >  
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16. How many array concepts in PHP?  

A. 2    B. 4    C. 3    D. 1  

17. Which of the following is not array type?  

A. Single dimensional  B. Indexed array   C. Associative array  D. Multidimensional  

18. Arrays with numeric index for the available values can be accessed using  

A. Functions   B. Parameters   C. Keys    D. Arguments  

19. Which types of array is a key value pair data structure?  

A. Indexed array   B. Associative array  C. Multidimensional  D. All of these  

20. A _______ is a type of subroutine or procedure in a program.  

A. Function    B. Array   C. Objects   D. Parameters  

21. A concept that stores more than one variable of same data type in a single variable is called  

A. Function    B. Array   C. Objects   D. Parameters  

22. In Parameterized, the parameters are like----- 

          a) Variables     b) Constants  c) String   d) Null value 

23. In PHP arrays of ---- types 

           a) 1     b) 2    c) 3    d) 4  

24.  Arrays more than ----levels deep are hard to manage. 

           a) 1    b) 2   c) 3   d) Multiple 

 

(CHAPTER-6) (Conditional Statements IN PHP) 
1. Statement which is used to make choice between two options any only option is to be performed is written as……  

a) Then else statement  b) if    c) else one  d) if else statement 

2. The ----statement is also known as if..else ladder  

a) if    b) if..elseif..else  c) if..else  d) switch 

3. ---statement can check for multiple value at a time. 

a) Switch   b) if    c) if..else  d) all the above 

4. If the condition is false in if..else statement -----statement will be executed  

a) if    b) else   c) switch  d) both a and b 

 

(CHAPTER-7) (Loops IN PHP) 
1. Which loop is mainly used for arrays?  

a)  for   b) foreach  c) while   d) do-while 

2. ---loop run the statement inside of the loop block at the first time execution?  

a) while   b) for    c) Switch  d) do-while 

3. Most complicated looping structure is                                                         

a) While    b) Do while   c) For    d) None 

4. How many times the following loop will execute? for($x=2; $x<=10; $x+=2) 

        a) 2    b)  5    c) 10    d) 20 

5. Which of the following loop construct provides an easy way to iterate over   arrays? 

a) do    b) do...while   c) for    d) for each 

6. How many parameters are used in for loop?  

A. 3    B. 4    C. 2    D. 5  

7. Which of the following is not a parameter used in for loop?  

A. Init counter   B. Time counter   C. Test counter   D. Increment counter  

8. Which loop will issue an error when the variable used for iteration?  

A. For    B. For each   C. While   D. Do while  

9. Which of the following the loop iteration depends on each key value pair in the array?  

A. For each    B. For    C. While   D. Do while   

10. Which loop run the statement inside of the loop block at the first time execution?  

A. For    B. While   C. For each   D. Do while  

11. _______ are useful for writing iteration logics.  

A. Looping structures  B. Functions   C. Class   D. Objects  

12. __________ loop works only on arrays and objects.  

A. Do while    B. For each   C. While   D. For   

13. PHP ________ loops execute a block of code while the specified condition is true.  

A. Do while    B. For each   C. While   D. For  

14. _________ loops execute a block of code a specified number of times.  

A. Do while    B. For each   C. While   D. For  

15. The loop exclusively used for arrays is ---  

a) While     b) Do While     c) For    d) for each 

16. Which loop evaluates condition expression as Boolean, if it is true, it executes statements and when it is false it will terminate? 

            a) For loop     b) For each loop   c) While loop   d) All of them 
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17. for ($ x=0;$ x<5;x++) echo “Hi” The above loop executes how many no of times? 

a) 5   b) 4   c) 3   d) 2 

18. PHP supports which types of looping techniques; 

            a) for loop    b) while loop   c) for each loop   d) all the above 

 
(CHAPTER-8)(Forms and Files) 
1. Which attribute of form tag to helps in client side validation? 

(a) Submit   b) Check  c) Validate   d) Required 

2. In which input field only one option can be selected? 

            a) Text box    b) Check box  c) radio button   d) Drop Down  

3. ------- is a request for data or information from a database table or combination of tables.  

a) Code   b) Query  c) form   d) Report       

4. In which input field more than one value o can be selected? 

            a) Text box    b) Check box  c) radio button   d) Drop Down  

5. How the data can be sent from client to server via HTML?  

A. file handling   B. form validation  C. form controls  D. protocols  

6. Which of the following is not a HTML control types?  

A. Radio box   B. file    C. Check box    D. Buttons  

7. Buttons contain  

A. Submit    B. Reset   C. Cancel   D. all of these  

8. Which form control have the feature to select machine at a time?  

A. Buttons    B. Radio button   C. File select   D. Check box   

9. Which form control have the feature to select machine at a time?  

A. file open    B. file read   C. file select   D. form  

10. Which of the following method control the entire form controls in the HTML document?  

A. Post    B. GET    C. a or b   D. Button  

11. Which of the following are most important concepts that the PHP web development processes?  

A. forms    B. files    C. controls   D. a and b  

12. PHP file is mentioned in the form tag under the attribute  

A. action    B. method   C. form    D. none of these  

13. How many PHP variables are there to collect the data from the server and prepares the response accordingly?  

A. 3    B. 2    C. 4    D. 1  

14. Which of the following variables collects the data and prepares the response accordingly?  

A. $-Post    B. @-Post   C. $-Get   D. a and b  

15. How many types of validation available in PHP?  

A. 2    B. 3    C. 4    D. only one    

16. Server side validation are by the programming  

A. PHP    B. ASP    C. JSP    D. all of these   

17. Which of the following is not a back-end application  

A. HTML    B. CGI    C. PHP    D. ASP  

18. Which attribute used for validation in HTML? 

A. validate    B. valid    C. required   D. action  

19. Which of the following function helps to open a file in the server PHP?  

A. fopen ()    B. fileopen ()   C. open ()   D. openf ()  

20. How many parameters are there in fopen () function?  

A. 1    B. 3    C. 4    D. 2  

21. How many modes in which files can be opened using fopen () function?  

A. 3    B. 4    C. 2    D. 6  

22. Which function is used to close an opened file?  

A. close ()    B. fclose ()   C. fileclose ()   D. closefile () 

23. Which of the following is the best feature to select one file from the local machine to server machine?  

A. form handling   B. file handling   C. file upload   D. form control  

24. Which of the following is not a programming language?  

A. ASP    B. JSP    C. PHP    D. AJAX  

25. PHP and HTML are to collect data from users.  

A. form controls   B. form variables  C. file handling   D. file objects   

26. All form input values are synchronized and sent to the server through and method  

A. text, get    B. post, object   C. post, get   D. none of these  

27. The input data sent to the server with POST method via URL address is known as  

A. quary string   B. open string   C. read string   D. close string  

28. All input data are visible by user after they clicks the button.  

A. ratio    B. check   C. submit   D. cancel  
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29. -----is an important activity of all web application development process.  

A. form controls   B. file objects   C. file handling   D. none of these  

30. The function reads from an openfile.  

A. fopen ()    B. fclose ()   C. fwrite ()   D. fread ()   

31. AJAX expend  

A. Asychronous Javascript And XML   B. Assume Javascript And XTML  

C. Attribute Javascript And XTML    D. None of these ANSWER: A 

32. When you use the $_GET variable to collect data, the data is visible to-------- 

              a) none     b) only you   c) everyone    d) selected few 

33. ---- method stores the input data in the request body of the clients HTTP request. 

             a) POST     b) GET    c) form     d) HTML 

34. In HTML form <input type=”text”>   is used to ------ 

           a) process text    b) input text   c) Validate text     d) Output text 

35. Which attribute of form tag helps in client side validation? 

a) Submit    b) Check  c) Validate    d) Required 

36. The no. of  parameters used by fclose( ) function 

           a) 1    b) 2    c) 3    d) 4 

37. PHP is a ______ Programming language. 

            a) Client side    b) Server side    c) Object side   d) file side 

38.  Identify which is not a server side application language  

          a) PHP   b) HTML  c) ASP    d) JSP 

39. What does fopen() function do in  PHP? 

          a) It used to open files in PHP         b) It used to open Remote Server. 

          c) It used to open folders in PHP     d) It used to open Remote Computer 

40. How PHP files can be accessed?   

a) Through Web Browser      b) Through HTML files 

c) Through Web Server      d) All of Above 

(CHAPTER-9) (Connecting PHP and MYSQL) 
1. Which is the not a correct MYSQLI function in PHP? 

a) Mysqli_connect()  b)Mysqli_close()  c) Mysqli_Select_data() d) Mysqli_affect 

2. Which of the following is important to all computer and internet related applications?  

A. function    B. information   C. data    D. procedure  

3. Which operation cannot be performed which connecting database with programming language?  

A. CONNECT   B. INSERT   C. DELETE   D. UPDATE  

4. Which of the following is the extension in PHP scripting language which gives access to the MySQL database?  

A. MySQL    B. MySQLi   C. iMySQL   D. MySQiL  

5. The function used to co0nnect MySQL database to databse server machine via PHP scripting language using?  

A. mysqli_connect()   B. mysql_connect()  C. connect_mysql()  D. mysqli_link()  

6. Which of the following is not a parameter used in mysqli_connect() function?  

A. Database Server name     B. Database link  

C. Database name      D. Database username Password  
7. The function helps to execute the SQL query statements in PHP scripting language is  

A. mysql_query()   B. mysqli_query()  C. query_mysql()  D. query  

8. The function used to close an existing opened database connection is  

A. close()    B. fclose()   C. mysqli_close()  D. mysql_close()  

9. Which of the following is not a web frame work?  

A. cakePHP  B. PRADO     C. HipHop’s HPHP’c  D. Zend  

10. The combination of _______ and __________ has become very popular server side web scripting language in Internet.  

A. PHP,MySQL   B. C++, Java   C. PHP,C++   D. HTML,Java  

11. Mysqli_connect() required __________ parameters connect to database server.  

A. 1    B. 2    C. 3    D. 4  

12. The function used to check whether the database is connected or not is ________  

A. error()    B. die()    C. connect error()  D. error_die()  

13. The alternative version of PHP in facebook is  

       A. PRADO    B. cake PHP   C. codeIgniter   D. HipHop’s HPHP’c   

14. The ___________ helps to convert PHP code into C++  

A. HipHop’s HPHP’c  B. cake PHP   C. codeIgniter   D. HipHop’s HPHP’c  

15. Choose the correct statement from the following  

(i) PHP is not a community support scripting language.  

(ii) 100% of website has been built by PHP and MySQL.  

(iii) PHP can embed easily with HTML and client side Scripting language.  

(iv) PHP not supports software frame works.  

A. (i) is correct   B. (ii) is correct   C. (iii) is correct   D. (iv) is correct  
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(CHAPTER-10)  (Introduction to Computer Networks) 
1. Computer which connected to a network is called---  

a) Device   b) node   c) system  d) cable 

2. Which innovation made the people to use internet?  

a) Social web  b) Mobile tech  c) Mobile app  d) Both a and b 

3. Banking services can be accessed at any time through the internet  

a) e-banking   b) e-shopping  c) e-learning  d) e-governing 

4. ---is based on internet computing, to share resources, software and information 

a) Cloud storage  b) Cloud computing c) Spyware  d) Malware 

5. Networks of network is called  

A. Nodes    B. Internet   C. Social media  D. Web server  

6. Which of the following is the most common resource shared everywhere at present? 

A. Internet    B. Nodes   C. Network   D. Server  

7. In computer networking exchanges the data with each other through  

A. wired    B. wireless   C. A or B   D. node  

8. Computer which is connected to network called as  

A. Internet    B. nodes   C. WWW   D. server  

9. In networking, nodes are identified by its  

A. Http address   B. IP address   C. TCP address   D. node address  

10. SAGE expansion is  

A. Semi- Automatic Ground Environment   B. Semi- Automatic General Environment C. Semi – 

Application Ground Engine     D. System – Application Ground  

11. ARPANET were connected between how many nodes?  

A. 3    B. 4    C. 2    D. 8 

12. Who laid the foundation of the modern-day internet?  

A. Lawrence Roberts   B. Paul Baran   C. Vint cerf   D. J.C. RLicklider  

13. ARCNET was created by  

A. Norman Abramson  B. Robert met calfe  C. John murphy  D. David Boggs  

14. Which network was used first to share the storage device in 1976?  

A. Packet switching   B. Telephone switch  C. Internet   D. Token-passing  

15. ARCNET was created in the year  

A. 1975    B. 1976    C. 1974    D. 1973  

16. New fibre optic cables Introduced in the year  

A. 1976    B. 1995    C. 1973    D. 1972  

17. INTERNET stands for  

A. INTERnational Network     B. INTER connected NETwork  

C. Interesting Notions Transmitted Electronically Round Newly Engineered Technology  

D. All the above  

18. Which of the following provides all the information and services to us?  

A. Internet    B. Switch   C. Wifi    D. Network  

19. Which Innovations have been charged the people life style to use internet?  

A. mobile technology   B. social web   C. network   D. both a and b  

20. In Internet, people everywhere can express and publish their ideas and opinions via  

A. mobile    B. blogs   C. search engine   D. Google  

21. Which of the following network powering algorithms will become most intelligent?  

A. Artificial    B. Packet-switching  C. Telephone-switch  D. Token-passing  

22. How many ways the networks at home were connected?  

A. 1    B. 2    C. 3    D. 4  

23. Which network is connecting devices without labels? 

A. Wired    B. Telephone   C. Wireless   D. Packet-switch   

24. Which of the following is not a social network media?  

A. Google    B. WhatsApp   C. Facebook   D. blogs  

25. US military radar system used  

A. SABRE    B. WIFI    C. SAGE   D. ARCNET  

26. In which year WAN was introduced for time sharing?  

A. 1965    B. 1966    C. 1967    D. 1976  

27. Computer network devices that  originates route and terminate the  data were  called as— 

     a) Hub    b) Resource  c) Node    d) Cable 

28. -------------use less power  comparing with single transmitter or satellite with cell towers closer 

a) Mobile devices    b) Transistors   c) WIFI    d) Communication 

29.  People now a days getting relaxed  via 

          a) Business     b) Corporate company  c) Newspapers    d) Social media 
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30.  Face book was created at  ------------year  

 a) 2002     b) 2004    c) 2013     d) 2010 

31.  Which innovation made the people to use Internet? 

            a) Social web    b) Mobile technology  c) Mobile App   d) Both a & b 

32. ---------- help to predict, manage, and protect the computer network at problems. 

          a) Artificial intelligence      b) Broadband provider  

          c) Cloud computing      d) Transceivers 

 

(CHAPTER-11)  (Network Examples and Protocols) 
1. Which one of the following is a technology to locate objects using radio signals?  

a) WiFi   b) URL   c) RFID   d) HTTP  

2. Which protocol will deliver packets from the source host to the destination host?  

A. IP    B. TCP    C. FTP    D. ARP  

3. IP connection less datagram service was in the transmission control program was introduced by  

A. Vint Cerf    B. Bob Kahn in   C. Dennis Retich   D. both a and b  

4. IP connection less datagram service was introduced in the year  

A. 1975    B. 1973    C. 1974    D. 1972  

5. Which of the following are the network security protocols?  

A. HTTP, TCP/IP   B. HTTP/ SFTP, SSL  C. ICMP, SNMP   D. All of these  

6. Which of the following is a network management protocol?  

A. HTTP    B. SFTP   C. SSL    D. ICMP   

7. Which of the following is a worldwide system of computer networks?  

A. Internet    B. Intranet   C. Extranet   D. Protocol  

8. Which of the following is a private network that uses Internet technology to share only business information?  

A. Internet    B. Extranet   C. Intranet   D. Arpanet  

9. In which type, TCP/IP network with access restricted to members of an organisation?  

A. Internet    B. Extranet   C. Intranet   D. None of these  

10. Online education / training is an application of  

A. Arpanet    B. Internet   C. Intranet   D. Extranet  

11. Corporate telephone directories is an application of  

A. Intranet    B. Internet   C. Extranet   D. Arpanet  

12. A mobile network is made up of a large number of signal areas called  

A. protocols    B. transceivers   C. cells    D. Base station  

13. Communication order mobile network is to made up of  

A. voice    B. data    C. images   D. All of these 

14. First generation mobile system launched in the year  

A. 1980    B. 1981    C. 1979    D. 1982  

15. Second to third generation Bridge is a  

A. GPRS launch   B. GSM launch   C. NMT launch   D. UK 3G launch  

16. NMT launch is on which generation  

A. 2G    B. 3G    C. 4G    D. 1G   

17. GSM launch in the year  

A. 1981    B. 1991    C. 2000    D. 2007  

18. NMT stands for  

A. National Mobile Telephone     B. Nordic Mobile Telecommunication  

C. Nordic Mobile Telephone     D. Nordic Mobile Technology   

19. 2G launched in the year  

A. 1981    B. 1990    C. 1994    D. 1991  

20. 900 MHz and 1800 MHz frequency bands used in  

A. 1G    B. 3G    C. 2G    D. 4G    

21. GSM mobile systems grown digital transmission using  

A. NMT    B. CDMA   C. GPRS   D. SIM   

22. SIM stands for  

A. System Identity Mobile     B. Subscriber Identity Module  

C. Subscriber Identity Mobile     D. Subscriber Information Mobile  

23. Which of the following is not a multimedia service?  

A. voice    B. data    C. video   D. GPRS  

24. In 3D network, data transmission used a  

A. GPRS    B. CDMA   C. EDGE   D. WCDMA   

25. Which of the following was based on an adhoc networking model?  

A. 1G    B. 2G    C. 3G    D. 4G   

26. What waves used by RFID to capture information stored on a tag attached to an object?  

A. micro    B. radio   C. light    D. digital  
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27. How many types of RFID tags are there?  

A. 2    B. 3    C. 1    D. 4  

 

(CHAPTER-12)   (DNS - Domain Name System) 
1. Pick the odd one out from the following. 

         a) node    b) label     c) domain    d) server 

2. How many parts there in URL?  

a) 2    b) 4   c) 8   d) 9 

3. Which one of the following is Social Media?  

a) Whatsapp   b) Facebook  c) Instagram  d) All of the above 

4. In earlier, websites were accessed through their  

A. Name server   B. Label   C. IP address   D. Resolver  

5. Which of the following layer the DNS belongs?  

A. Application   B. Physical   C. Network   D. Transport  

6. DNS provides the domain name to IP address mapping through  

A. Zone    B. Resolvers   C. Webservers   D. Name servers  

7. Who was known as ‘God of the Internet’?  

A. Paul V Mockapertris  B. Jon Postel   C. James Gosling  D. Vint cerf  

8. Who invented Domain Name System?  

A. Paul V Mockapertris  B. Vint Cerf   C. Jon Postel   D. a and c   

9. Which of the following is simply the logical address in the network layer?  

A. Web address   B. Network address  C. IP address   D. TCP address  

10. How many IP addressing methods are there?  

A. 2    B. 3    C. 4    D. 6  

11. Which of the following address is 32 bit unique address?  

A. IPv6    B. IPv4    C. IPv3    D. IPv2  

12. How many bit unique address is a IPv4 address?  

A. 8    B. 16    C. 32    D. 128   

13. How many are there to represent the IP address?  

A. 4    B. 3    C. 1    D. 2  

14. Which of the following is the address of a document on the internet? 

A. TCP    B. IP    C. HTTP   D. URL   

15. How many parts are there in URL?  

A. 2    B. 3    C. 4    D. 6   

16. Which of the following is not a part of URL?  

A. IP address   B. Folder name   C. Protocol   D. file name 

17. Which URL is the complete address of the document on the Internet?  

A. Path URL   B. Relative URL   C. Address URL  D. Absolute URL  

18. How many parts are very important in absolute URL?  

A. 2    B. 3    C. 4    D. 6   

19. Which of the following is the partial address of a document on the internet?  

A. Absolute URL   B. Relative URL  C. Address URL   D. None of these  

20. Which type of URL is used when the file is on the same server related to original document?  

A. Absolute URL   B. Web URL   C. Relative URL  D. Name space URL  

21. How many important components in DNS?  

A. 2    B. 3    C. 4    D. 6   

22.  Which of the following is not a component of DNS?  

A. URL    B. Namespace   C. Name server   D. Zone  

23. How many ways the name space can be organized?  

A. 3    B. 4    C. 2    D. many  

24. Which name space do not have any specific structure?  

A. Flat    B. Hierarchical   C. Network  D. Object  

25. How many parts are there in hierarchical name space?  

A. 2    B. 3    C. 4    D. many   

26. In hierarchical name space, the maximum levels of the tree is  

A. 64    B. 32    C. 128    D. 256    

27. In hierarchical name space, the root elements of the tree always represent the string  

A. 0    B. 1    C. -1    D. NULL  

28. In Hierarchical name space, in a tree the children of the root element is called  

A. label    B. domain name   C. string   D. node  

29. The generic domain name for information service providers is  

A. .org    B. into    C. net    D. com  
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30. Which of the following are the programs that run on a physical system and store all the zone data?  

A. Name space   B. Web server   C. Name server   D. Zone   

31. The main part of the DNS is  

A. name space   B. label    C. domain name   D. Name server  

32. Which component of DNS translates the domain names to IP addresses?  

A. Namespace   B. Name server   C. Zone    D. Resolver   

33. Which component of DNS contains domain names and their corresponding IP address?  

A. Name server   B. Name space   C. Zone    D. Resolver  

34. Which of the following initiates the mapping of domain name to IP address?  

          a) Zone      b) Domain    c) Resolver    d) Name servers 

 

(CHAPTER-13) (Network Cabling) 
1. The cables that are placed in deep underground to avoid any damage to the cables ---- 

a) Fiber optics  b) Coaxial  c) USB cables  d) Twisted pair cables 

2. Expansion of USB is  

a) Universal Serial Bus    b) Unified Serial Bus 

c) Unitied Serial Bus     d) Uniform Serial Bus 

3. Which one is used to connect the television sets to home antennas?  

a) Coaxial   b) Twisted pair  c) Fiber optics  d) USB 

4. How many types of cables available in networking?  

A. 6    B. 16    C. 28    D. many  

5. Which cable used to connect television sets to home antennas?  

A. Co-axial cable   B. Fiber optic cable  C. Twisted pair cable  D. USB cable  

6. Which cable is used to transfer the information in 10mbps?  

A. Fibre Optic   B. Twisted pair   C. Co-axial   D. USB  

7. Which cable is divided thinnet and thicknet cables?  

A. Twisted pair   B. Co-axial   C. Fibre optic   D. USB 

8. Which type of cable with two or more insulated wires twisted together?  

A. Co-axial    B. Twisted pair   C. USB    D. Fibre optic   

9. 10BASE-TX is an example of  

A. USB    B. Co-axial   C. Fibre optic   D. none of these  

10. How many wires are there in twisted pair cable?  

A. 10    B. 9    C. 8    D. 4   

11. How many types of twisted pair cable?  

A. 3    B. 4    C. 2    D. 6  

12. STP stands for  

A. Shielded Twisted Pair     B. System Twisted Pair  

C. Service Twisted Pair     D. Shielded Transmission Pair  

13. How many types of fiber optic cables?  

A. 3    B. 2    C. 4    D. 8 

14. Which cable is used in internet instead of coaxial cable?  

A. fiber optic   B. USB    C. STP    D. UTP  

15. Which of the following is a network that extends to very large distance to connect to computers?  

A. WAN    B. MAN   C. PAN    D. LAN  

16. How many types of fiber optic cables available?  

A. 4    B. 3    C. 2    D. 5  

17. Which of the following is not a type of fiber optic cable?  

A. 100 Base Bx   B. 100 Base Tx   C. 100 Base Sx   D. a and c  

18. Which of the following fiber optic multimode cable is used for short distance transmission?  

A. 100 Base Bx   B. 100 Base Tx   C. 100 Base T   D. 100 Base Sx  

19. Which of the following fiber optic single mode cable is used for long distance transmission?  

A. 100 Base Bx   B. 100 Base Tx   C. 100 Base T   D. 100 Base Sx  

20. Which cable is used to connect keyboard and mouse?  

A. fiber optic   B. co-axial   C. USB    D. UTP   

21. The network devices used to connect the Internet through the USB called  

A. Modem    B. Setup box   C. HDMI   D. Dongle  

22. The data transfer rate of USB 3.0 is  

A. 4.85 Gbps   B. 480 Mbps   C. 48.5 Gbps   D. 64.80 Mbps  

23. How many bit(s) data sent through serial port?  

A. 4    B. 8    C. 1    D. 16   

24. How many bit(s) data sent through parallel port?  

A. 4    B. 8    C. 1    D. 16  
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25. Which of following is a types of serial cable? 

A. RJ45    B. RJ230   C. RJ232   D. 100 Base RS  

26. Which of the following cable is also called null modem cable?  

A. RJ232    B. RJ45    C. RJ11    D. RS232  

27. Which of the following cable is an example of null modem cables?  

A. Cross over Ethernet  B. Patch   C. UTP    D. Co-axial  

28. Which cable is used for inter connecting two computers without modem?  

A. RJ45    B. Cross over   C. RS235   D. b or c  

29. Which of the following is not a wireless media?  

A. Infrared    B. USB    C. Blue tooth   D. Wifi  

30. Which of the following is the basic component of the LAN?  

A. Ethernet cable   B. USB    C. Modem   D. Dongle  

31. Which of the following is most popular Ethernet cable used? 

A. RS232    B. RJ11    C. RJ45   D. Cat 7  

32. How many wires care inside the patch cable?  

A. 2    B. 4    C. 6    D. 8  

33. How many main components are used in the Ethernet cabling?  

A. 2    B. 3    C. 4    D. 8  

34. How many pins are there in RJ45 connector?  

A. 4    B. 16    C. 32    D. 8  

35. How many wiring schemes available to terminate the twisted pair cable on each end?  

A. 2    B. 3    C. 8    D. 4  

 
(CHAPTER-14) (Open Source Concepts) 
1. Which of the following software has been developed by a variety of programmers?  

A. Proprietary   B. free    C. open source   D. none of these  

2. Which one help to prompt the use of open source software in India?  
A. FRCFUSS    B. C-DAC   C. Open Source Foundation  D. FSS foundation  

3. The free software concept developed by  

A. Richard Stallman  B. Tim Berners lee  C. Charles Babbage  D. Blaire Pascal  

4. The users can download at no cost, but whose source code cannot be changed is refers to  

A. Proprietary software  B. Free ware   C. Shareware   D. Firmware  

5. Which of the following is not a open source application software?  

A. NS2    B. MySQL   C. PHP    D. Windows  

6. Which of the following software that replicates the functioning of a computer network?  

A. PHP    B. Open NMS   C. Network Simulator  D. Audacity  

7. Which of the following is a method where by a software program models the activities of a network? 

A. Network software   B. Network simulation  C. Network management  D. Network monitoring   

8. Which files can document every incident that happened in the simulation?  

A. Data    B. Text    C. Network   D. Trace  

9. NS2 is the abbreviation of  

A. Network System Version 2     B. Network Software Version 2  

C. Network Simulator Version 2    D. Network Solutions Version 2  

10. Which of the following was considered explicitly the event driven open-source simulator in computer?  

A. NS2    B. Open NMS   C. C++    D. OTCL  

11. Which of the following is used to create and run NS2?  

A. OTCL and PHP   B. NS2 and C++   C. OTCL and Windows  D. OTCL and NS2  

12. Which of the following is a free and open source initiative grade network monitoring platform?  

A. Open NMS   B. Open NS2   C. OTCL   D. FCAPS  

13. Which one comprises a discovery engine to routinely configure and manage network device without operator intervention?  

A. NS2    B. OTCL   C. Open NMS  D. JMX  

14. Which of the following is written in Java and is issued under the GNU?  

A. OTCL    B. Open NMS   C. NS2    D. DNS  

15. Which of the following is the world’s first software for network monitor with open source options?  

A. NS2    B. OTCL   C. DNS    D. Open NMS  

16. How many types of in open NMS?  

A. 2    B. 3    C. 4    D. 1   

17. Open NMS was released by  

A. Steve Giles   B. Brain Weaver   C. Luke Rind fuss D. all of them  

18. Open NMS was released in the year  

A. 1989    B. 1999    C. 2000    D. 2003  

19. Which year open NMS group was created  

A. 1999    B. 2003    C. 2004    D. 2005   
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20. Which of the following won lot of awards for best of open source software?  

A. NS2    B. Open NMS   C. VCC    D. PHP   

21. How many main functional areas in open NMS?  

A. 3    B. 4    C. 2    D. 1  

22. Which of the following is a general public license?  

A. OTCL    B. NS2    C. GNU   D. CUI  

23. Which software notifications help the user for fixed errors?  

A. NS2    B. C++    C. Network Monitoring  D. GNU  

24. NRC FOSS stand for _____.  

A. National Resource Centre for Free and Open Source Software  

B. Network Resource Centre for Free and Open Source Software  

C. Network Resource Centre for Free and Open Source Systems    D. None of these  

25. BOSS stands for _____.  

      A. Bharat operating system solutions    B. Bharat open source system  

      C. Bharat open source solutions    D. Bharat operating system software  

26. FCAPS stands for _____.  

A. Fault, Configuration, Accounting, Performance, Security  

B. Fault, Configuration, Accounting, Performance, Systems  

C. Fault, Configuration, Accounting, Performance, Security    D. None of these  

27. Fill in the blanks: NS2 comprises of----key languages?  

a) 13     b) 3     c) 2      d) 4 

28. Open NMS Group was created by………………. 

           a) Balog      b) Matt Brozowski  c) David Hustace   d) All of them 

 

(CHAPTER-15) (E-Commerce) 
1. Which of the following company coined the term E-Business?  

A. Google    B. Microsoft   C. IBM    D. Yahoo  

2. In which year, IBM coined the term E-Business?  

A. 1994    B. 1993    C. 1995    D. 1996   

3. Which of the following is a subset of E-Business?  

A. Internet    B. E-Commerce   C. Intranet   D. Extranet  

4. Which of the following is commercial transaction through Internet?  

A. E-Commerce   B. E-Business   C. E-government   D. Extranet  

5. Which of the following entirely depends on the Internet?  

A. E-Commerce   B. E-governance   C. E-Learning   D. E-Business  

6. In e-commerce, what is ‘e’ denotes?  

A. electric    B. extranet   C. electronic   D. expansion   

7. Which year the internet opened to the public?  

A. 1989    B. 1990    C. 1991    D. 1994  

8. In which way, the goods, information or services are delivered in Internet through  

A. tangible    B. electronic form  C. network   D. a or b  

9. Who proposed a technique that enables online transaction processing between in consumers and business?  

A. Michael Aldrich   B. Vint cerf   C. Joe Mc Cambley  D. Phil Branden berger  

10. How many distinct waves the economists described in the industrial revolution?  

A. 2    B. 3    C. 4    D. 6  

11. The first wave of Electronic Commerce is  

A. 1990-1995   B. 1995-2003   C. 2004-2009   D. 2010-till   

12. Which wave is considered as the global wave?  

A. First    B. Second   C. Third   D. Forth   

13. Which wave is the rebirth of E-Commerce after the dotcom burst? 

A. forth    B. third   C. second    D. first  

14. Which type of e-commerce companies nourished during the second wave?  

A. B2C    B. B2B    C. B2G    D. C2C   

15. The Period in which the second wave of Electronic commerce is  

A. 1995-2003   B. 2004-2009   C. 2010-2015   D. 2016-till date  

16. Which wave is brought on by the mobile technology?  

A. first    B. second   C. third   D. none of these  

17. The future internet include(s)  

A. Artificial Intelligence     B. Semantic web  

C. Generic Database      D. All of these  

18. How many E-Commerce business models are there? 

A. 4    B. 5    C. 9    D. 8  
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19. Out-sourcing are generally associated with the E-Commerce  

A. B2C    B. B2B    C. B2G    D. G2G  

20. Off-storing are generally associated with the E-Commerce  

A. B2C    B. B2G    C. G2G    D. B2B  

21. If a company’s work is hired to another company, it would be termed as  

A. out sourcing   B. off shoring   C. e-companies   D. call centres  

22. If the work is out sourced to a company, which is outside of its won country, is termed as  

A. out sourcing   B. off shoring   C. off sharing   D. a or b 
23. Which E-commerce category the commercial transactions take place between business firms and their consumers?  

A. C2B    B. B2B    C. B2C    D. a or b  

24. Which E-commerce category works as ‘retail store’ over internet?  

A. B2C    B. C2B    C. B2B    D. C2C  

25. Which E-commerce model is also called as reverse action model?  

A. B2C    B. C2B    C. B2G    D. G2B  

26. Which E-commerce category provides opportunity for trading of products of services among consumers who 

are connected through the internet? 

A. B2C    B. C2G    C. C2B    D. C2C  

27. People paying for renewal of license online fall under the E-commerce category  

A. G2B    B. C2C    C. C2G    D. G2C   

28. Which E-commerce is a part of e-governance?  

A. C2G    B. B2G    C. G2B    D. B2G  

29. Which E-commerce is very similar to C2G?  

A. G2C    B. C2G    C. B2G    D. G2B  

30. How many types of classifications are there in G2G systems?  

A. 3    B. 2    C. 4    D. 9  

31. Which sites collect a number of users together all of who want to buy similar items?  
A. Bulk-buying   B. Banner advertisement  C. Digital publishing  D. Licensing  

32. Which of the following sites allow other websites to make use of their own software?  

A. Name-your-price   B. Bulk-Buying   C. Licensing   D. Digital publishing  

 
(CHAPTER-16)  (Electronic Payment Systems) 
1. The traditional and most likely used payment instrument that consumer use is ----- 

A. Payment Instrument  B. crypto currency  C. Physical money  D. all of these  

2. Electronic payment system is also called  

A. liquidation   B. clearing system  C. clearing service  D. all of these  

3. How many payment systems are there in throughout the world?  

A. <750    B. >750    C. 750    D. 200  

4. How many types of electronic payment systems are generally classified?  

A. 2    B. 3    C. 4    D. 6  

5. Which of the following is an on-line payment system designed for payments of small amounts?  

A. Macro    B. Mini    C. Micro   D. UPI  

6. Which of the following electronic payment systems use expensive public key cryptography?  

A. Micro    B. Mini    C. Macro   D. Nano  

7. Which payment systems supports payments of higher value? 

A. Micro    B. Mini    C. Macro   D. Nano  

8. Which of the following is not a macro electronic payment system?  
A. Mobile banking   B. Watch a movie online  C. Internet banking  D. Credit card  

9. Which of the following is not a card based payment system?  

A. Credit card   B. Debit card   C. Gift card   D. IMPS  

10. Which of the following card normally used for retail transactions?  

A. Debit    B. Gift    C. Credit   D. IMPS  

11. The modern credit card concept was born in  

A. Germany    B. Canada   C. USA    D. France  

12. How many digit unique identification number in the credit card?  

A. 8    B. 16    C. 4    D. 3  

13. The first digit of the credit card is  

A. MII    B. BIN    C. IIN    D. UIN  

14. The first 6 digit in the credit card together called  

A. MII    B. BIN    C. IIN    D. b or c  

15. EMV stands for  

A. Europay, Master Card, Visa    B. Electronic, Machine, Visa  

C. Electronic, Magnetic, Visa     D. Europay, Magnetic, Visa  
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16. Which of the following card is Indian domestic open loop card?  

A. Master    B. Visa    C. Rupay   D. Debit  

17. In which Rupay card was launched?  

A. 2009    B. 2012    C. 2014    D. 2005   

18. How many digit code is CVV?  

A. 2    B. 4    C. 3    D. 16  

19. Which is used in contact less transactions in credit card? 

A. CVC1    B. CVC3   C. CVV0   D. CVC2  
20. Which of the following card where the transaction amount is directly deducted from the card holders back account?  

A. Debit    B. Credit   C. Stored value   D. Smart card  

21. Which of the following card is act a substitute for cash?  

A. credit    B. stored value   C. smart card   D. debit  

22. How many ways are there for processing debit card transactions?  

A. 2    B. 3    C. 4    D. 5  

23. Which card will be issued to the customer without having bank account?  

A. Debit    B. Credit   C. Stored value   D. smart  

24. How many types of stored value cards are there?  

A. 2    B. 3    C. 4    D. 8  

25. Which of the following is also called as prepaid debit cards?  

A. Closed loop stored value card    B. Smart card  

C. Open loop stored value card    D. Credit card  

26. How many classification are there in smart cards?  

A. 4    B. 3    C. 2    D. 6  

27. NEFT Stands for  

A. Non Electronic Fund Transfer    B. National Electronic Fund Transfer  

C. National Electrical Fund Transfer    D. National Electricity Fund Transfer  

28. Which payments are also called as push payments that are initiated by the payer?  

A. RTGS    B. IMPS   C. NEFT   D. ECS  

29. Which of the following is a currency that flows in the form of data?  

A. E-Wallet    B. E-pay   C. E-cash   D. E-crypto  
30. Which of the following is a unique virtual asset designed to work as a medium of exchange using cryptographic algorithm?  

A. E-Wallet    B. Cryptograph   C. Crypto currency  D. VR   

31. The state of ownership of a crypto currency is related to individual system blocks called  

A. algorithms   B. forks    C. e-cash   D. Portfolios  

32.  Which of the following is not a function of crypto currency?  

A. Mining    B. ECS    C. Block chain   D. Directed acyclic graph  

33. Which of the following is not a category of micropayment? 

              a) Buying a movie ticket      b) Subscription to e journals 

              c) Buying a laptop               d) Paying for smartphone app 

(CHAPTER-17) (E-Commerce Security Systems) 
1. Which has become the critical factor and core issue in any emerging E-Business?  

A. Protocols    B. Network   C. Security   D. Transactions  

2. Which of the following has turned to be the best medium for the spread of viruses?  

A. Resources   B. Internet   C. E-Business   D. E-Commerce  

3. Interception and stealing of online documents is called  

A. Tampering   B. Frauds   C. DDos   D. Information leakage  

4. Which E-Commerce threat in which a target is contacted by telephone by some ones who is contacted by 

telephone by some ones who pretend himself a genuine authority?  

A. Phishing    B. Hacking   C. Cracking   D. Tampering   

5. Destroying the authenticity and integrity of the data is called  

A. Leakage    B. Phising   C. Typo piracy   D. Tampering  

6. When customer demands false reclaim or refund is called  

A. Friendly fraud   B. Clean fraud   C. Triangulation fraud  D. E-fraud  

7. Which type of fraud is take online shops offering cheapest price and collect credit card data?  

A. Friendly fraud   B. Triangulation fraud  C. Clean fraud   D. Hacking  

8. Which of the following is used by an attacker will extract the credit card information and sell it on black markets?  

A. Malware    B. Cross site scripting  C. SQL injection   D. All of these  

9. Which one will be conducted from numerous unidentified computers using botnet?  

A. DDos    B. Phising   C. Leakage   D. Virus  

10. Which attacks is also called network flooding?  

A. Phishing    B. Virus   C. Typopiracy   D. DDos  

11. The illegal practice of registering an internet is called  

A. Phishing    B. Cyber squatting  C. Tampering   D. Hacking  
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12. Which of the following refers to unauthorized intrusion into a computer or a network?  

A. Phishing   B. Cracking   C. Hacking   D. Tampering  

13. Find the odd man out  

A. DDos    B. Cyber Squatting  C. Typopiracy   D. Privacy  

14. Which of the following is a security element involved in E-Commerce?  

A. Cyber Squatting   B. Integrity   C. DDos   D. Tampering  

16. Which of the following is a type malware that usually encrypt all the files in a target’s computer?  

A. Malicious code   B. Hacking   C. Cracking   D. Ransomware  

17. Which of the following is not a security technologies E-Commerce transaction?  

A. Decryption Technology     B. Encryption Technology  

C. Authentication Technology     D. Authentication Protocols  

18. How many encryption technologies are widely used in E-Commerce transactions?  

A. 2    B. 3    C. 4    D. 5  

19. Which of the following is a symmetric key data encryption method?  

A. DES    B. RSA    C. FIPS    D. ECC  

20. DES introduced in the year  

A. 1996    B. 1976    C. 1986    D. 2006  

21. Triple-DES also known as  

A. TDES    B. 3DES   C. DESede   D. All of these  

22. The main role of security certification is to ensure  

A. Authentication   B. Integrity   C. Non-repudiation  D. All of these   

23. Security certification is achieved through  

(i) Digital signatures  (ii) Encryption Technologies  (iii) Digital certificates  

A. i and ii    B. ii and iii   C. i and iii   D. i, ii and iii   

24. Which of the following is not an algorithm used in symmetric key encryption? 

A. DES    B. RSA    C. AES    D. RC4  

25. Which of the following is not an algorithm used in Asymmetric key encryption?  

A. RSA    B. ECC    C. DSA    D. AES   

26. Which of the following is an electronic document used to prove the ownership of a public key?  

A. Digital signature   B. Digital key   C. Digital certificate  D. Digital Encryption  

27. Which of the following is not included in digital certificate?  

       A. Sender’s identity   B. Digital signature  C. Public key   D. Private key  

28. Which of the following works on the concept of ‘web of trust’?  

A. X.509    B. PGP    C. RSA    D. ECC  

29. Which of the following is an authorized certifying authorities?  

A. NIC    B. TCS    C. E-mudhra   D. All of these  

30. Which of the following is a mechanism that is used to verify that a particular digital document is authentic?  

(i) Digital certification  (ii) Digital signature  (iii) Encryption technology  

A. i only    B. ii only   C. iii only   D. i and ii  

31. DSS stands for  

A. Digital Signature System     B. Digital Signature Service  

C. Digital Signature Standard    D. Digital Signature Solution  

32. PKCS stands for  

A. Public Key Cryptography Standards   B. Private Key Cryptography Standards  

C. Public Key Cryptography System    D. Private Key Cryptography System  

33. Digital signatures use a standard worldwide accepted format called  

A. DES    B. PKI    C. RSA    D. ECC   

34.  PKI stands for  

A. Public Key Interface     B. Public Key Information  

C. Private Key Infrastructure     D. Public Key Infrastructure  

35. Asymmetric encryption is also  called as 

          a) Secure Electronic Transaction    b) Certification Authority  

c) RSA algorithm     d) Payment Information 

36. 3-D Secure, a protocol was developed by  

a) Visa        b) Master    

c) Rupay        d) Paytm 

 
(CHAPTER-18) (Electronic Data Interchange- EDI) 

1. The versions of EDIFACT are also called as  

           a) Message types   b) Subsets     c) Directories    d) Folders 

2. Which of the following is the exchange of business documents between one trade partner and another 

electronically?  

A. EFT    B. RTGS   C. EDI    D. IMPS  
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3. Which of the following is not an internationally accepted EDI standard?  

A. EDIFACT   B. EFT    C. XML   D. ANSI ASC X12   

4. EDI is  

A. Paperless Trade   B. Paperless Payment  C. Paperless File   D. Paperless Transfer  

5. EFT is  
A. Paperless Trade   B. Paperless Payment  C. Find Transfer with paper  D. Paperless file 

6. Earlier, EDI documents transferred by using  

A. Radio teletype   B. Telex message  C. Telephone   D. All of these  

7. The committee formed to develop EDI standard formats is  

A. TLS    B. TCDC   C. TDCC   D. EDIFACT  

8. The first EDI standard were released by  

A. EDIFACT   B. RSA    C. XML   D. TDCC  

9. The first EDI standard were released in the year  

A. 1975    B. 1974    C. 1973    D. 1985  

10. The TDCC is renamed as  

A. ANSIX12   B. EDIFACT   C. EDIA   D. TLS   

11. Which of the following is the most widely used EDI?  

A. EDUSAT   B. EDIFACT   C. TDCC   D. EDIA   

12. Which of the following is created by UN to assist with the global reach of technology in E-commerce?  

A. TDCC    B. EDIA   C. EDIFACT   D. GTDI  

13. The TDCC renamed in the year  

A. 1976    B. 1978    C. 1980    D. 1960   

14. The first EDI messages was sent in  

A. 1975    B. 1985    C. 1995    D. 1965  

15. Which of the following is called point to point EDI?  

A. Direct EDI   B. Web EDI   C. Mobile EDI   D. EDI via VAN  

15. Which type of EDI suits to larger businesses?  

A. EDI via VAN   B. Web EDI   C. Mobile EDI   D. Direct EDI  

16. In type EDI via VAN, VAN stands for  

A. Value associate network     B. Value added network  

C. Value address network     D. Value added node  

17. In which type where EDI documents transferred with the support of third party network providers?  

A. Web EDI    B. Mobile EDI   C. EDI via VAN  D. Direct EDI  

18. Which of the following acts as an intermediary between trading partners?  

A. VAN    B. EDI    C. EFT    D. EDIFACT  

19. The exchange of EDI based documents through internet or intranet is called as 

A. EDI via VPN / FTP  B. EDI via SFTD  C. EDI via FTPS   D. None  

20. Which of the following EDI type is easy and convenient for small and medium organizations?  

A. Direct EDI   B. Web EDI   C. Mobile EDI   D. EDI via VAN  

21. Which EDI type considerably increase the speed of EDI transactions?  

A. Web EDI    B. Direct EDI   C. Mobile EDI   D. EDI via FTP  

22. How many layers in EDI architecture?  

A. 7    B. 6    C. 5    D. 4  

23. Which of the following is not a layer in EDI architecture?  

A. Semantic    B. Application   C. Transport   D. Physical   

24. How many major components in EDI?  

A. 4    B. 3    C. 2    D. 7  

25. Which of the following is not a component of EDI?  

A. Standard document format     B. Translator and Mapper  

C. Network data transfer     D. Communication software of network. 

26. In which year the first industry specific EDI standard?  

A. 1980    B. 1975    C. 1965    D. 1976  

27. A wide range of EDI standard developed by ANSI ASC is called  

A. TDCC    B. ANSI X13   C. ANSI X15   D. ANSI X12  

28. European region developed an integrated EDI standard known as  

A. TDCC    B. EDIA   C. GTDI   D. GEDI  

29. GTDI stands for  

A. Guideline Trade data interchange    B. Global trade data interchange  

C. Global trade data information    D. Guideline trade data interleave  

30. The most widely used EDI message standards are  

A. EDIFACT   B. GTDI   C. ANSI X12   D. None  

31. In EDIFACT hierarchical structure the top level is referred as  

A. Interchange   B. Messages   C. Data    D. Information  
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32. In EDIFACT hierarchical structure the low level contain  

A. Interchange   B. Information   C. Messages   D. Standards  

33. The lower levels hierarchical structure of EDIFACT contains  

A. Messages    B. Segments   C. Composites   D. All of these  

34. Segment table tags contains  
A. Tagnames    B. Requirements designator  C. Reputation field   D. All of these   

35. In EDI interchange, interchange is also called as  

A. Label    B. Envelope   C. Information   D. Message  

36. The basic standardization concept of EDIFACT is  

A. UNSM    B. UNB    C. UN2    D. UNT  

37. How many character alphanumeric code is EDIFACT segment?  

A. 2    B. 3    C. 4    D. 6  

38. The father of EDI is  

A. Ed Guilbert   B. David Cehumn  C. Vint Cerf   D. Tim Berners Lee  

39. A type of tele printer is  

A. VAN    B. FAX    C. Telex   D. Typewriter  

40. EDIA stands for ______  

A. Electronic data interchange association   B. Electronic data information associative  

C. Envelope data informative association   D. None  

41. UNSM message being with _____ and ends with _______  

A. ESI / EDI   B. UNH / UNT   C. GTDI / EDI   D. EDIFACT, UNT  

42. UNSM stands for? 

          a) Universal Natural Standard message   b) Universal Notations for Simple message 

          c) United Nations Standard message   d) United Nations Service message 

43. EDI interchanges starts with ____ and ends with ____  

          a) UNA, UNZ      b) UNB, UNZ       c) UNA, UNT     d) UNB, UNT 

44. EDIFACT  stands for  

          a) EDI for Admissible Commercial Transport   b) EDI for Advisory Committee and Transport 

          c) EDI for Administration, Commerce and Transport d) EDI for Admissible Commerce and Trade 

45. Number of characters in an single  EDIFACT messages 

          a) 5        b) 6        c) 4        d) 3       
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ABBREVIATIONS                      
1. TIFF   - Tagged Image File Format 

2. JPEG   - Joint Photographic Experts Group 

3. MIDI   - Musical Instrument Digital Identifier 

4. RTF   - Rich Text Format 

5. BMP   - Bitmap 

6. GIF   - Graphics Interchange Format 

7. TGA   - Tagra 

8. PNG   - Portable Network Graphics 

9. WAV   - Waveform Audio File Format 

10. MP3   - MPEG Layer-3 Format 

11. AIFF  - Audio Interchange File Format 

12. WMA  - Windows Media Audio 

13. RA   - Real Audio Format 

14. AVI   - Audio Video Interleave 

15. MPEG  - Moving Pictures Experts Group 

16. ISO   - International Standard Organization 

17. EDUSAT  - Education Satellite 

18. DIB   - Device Independent Bitmap 

19. DRM  - Digital Right Management 

20. DBMS  - Database Management System. 

21. RDBMS  - Relation Database Management System 

22. ODBMS  - Objective Database Management System 

23. ACID  - Atomicity, Consistency, Isolation, and Durability 

24. IMS   - Information Management System 

25. IDS   - Integrated Data Store 

26. OOPS  - Object Oriented Programming  

27. SQL   -  Structure Query Language. 

28. ER   - Entity Relationship. 

29. DBA  - Database Administration. 

30. ANSI  - American National Standards Institute. 

31. ISO   - International Organization For Standardization. 

32. DDL   - Data Definition Language. 

33. DML  - Data Manipulation Language. 

34. DQL   - Data Query Language. 

35. TCL   - Transaction Control Language. 

36. DCL   - Data Control Language. 

37. ASP   - Active Server Page 

38. JSP   - Java Server page. 

39. CSS   - Cascading Style Sheets 

40. PHP   - Hypertext Pre-processor 

41. CGI   - Common Gateway Interface 

42. SAGE  - Semi- Automatic Ground Environment 

43. SABRE  - Semi Automatic Business Research Environment 

44. NPL   - National Physical Laboratory 

45. WAN  - Wide Are Network 

46. DDOS  - Distributed Denial-of- Service attacks 

47. ARPANET  - Advanced Research Projects Agency Network  

48. ARPA  - Advanced Research Projects Agency 

49. NMT  - Nordic Mobile Telephone Communication 

50. GSM  - Global System For Mobile Communication 

51. SIM   - Subscriber Identity Module 

52. TMDA  - Time Division Multiple Access 

53. CDMA  - Code Division Multiple Access 

54. GPRS  - General Packet Radio Service 

55. EDGE  - Enhanced Data Rates for Global Evolution 

56. LIFI   - Light Fidelity 

57. UMTS  - Universal Mobile Telecommunication System 

58. WCDMA  - Wideband code Division Multiple Access 

59. ATM  - Asynchronous Transfer Mode 

60. MPLS  - Multiprotocol Label Switching 

61. ITU   - International Telecommunication Union 

62. RFID  - Radio Frequency Identification 
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63. FTP   - File Transfer Protocol 

64. HTTP  - Hyper Text Transfer Protocol 

65. IP   - Internet Protocol 

66. SMTP  - Simple Mail Transfer Protocol 

67. ARP   - Address Resolution Protocol 

68. ICMP  - Internet Control Message Protocol 

69. WWW  - World Wide Web 

70. W3C  - World Wide Web Consortium 

71. LAN   - Local Area Network 

72. UTP   - Unshielded Twisted Pair 

73. STP   - Shielded Twisted Pair  

74. NIC   -  Network Interface Card 

75. USB   - Universal Serial Bus  

76. RJ   - Registered Jack 

77. 8P8C  - 8-position, 8-contact 

78. NRCFOSS  - National Resource Centre for Free and Open Source Software 

79. BOSS  - Bharat Operating System Solutions 

80. C-DAC  - Centre for Development of Advanced Computing 

81. GNU  -  General Public License 

82. FCAPS  -  Fault, configuration, accounting, performance, security 

83. NMS  -  Network Management System 

84. B2B   - Business to Business 

85. B2C   - Business to Consumer 

86. B2G   - Business to Government 

87. C2B   - Consumer to Business 

88. C2C   - Consumer to Consumer 

89. C2G   - Consumer to Government 

90. G2B   - Government to Business 

91. G2C   - Government to Consumer 

92. G2G   - Government to Government 

93. SMEs  -  Small Medium-sized Enterprises 

94. SCM  -  Supply Chain Management 

95. UPI   -  Unified Payment Interface 

96. MII   -  Major Industry Identifier 

97. IIN   - Issuer Identifier Number 

98. BIN   - Bank Identification Number 

99. EMV  - Euro pay , MasterCard ,Visa 

100. RFID  - Radio Frequency Identification 

101. CVV  - Card Verification Code 

102. ECS  - Electronic Clearing Services 

103. EFT  - Electronic Fund Transfer 

104. RTGS  - Real Time Gross Settlement System 

105. PoS  - Point of Sale 

106. NEFT  - National Electronic Fund Transfer 

107. RBI  -  Reserve Bank of India 

108. IDRBT  - Institute for Development and Research in Banking Technology 

109. ICO  - Initial Coin Offer 

110. ACH  - Automated Clearing House 

111. NCPI  - National Payment Corporation of India 

112. IMPS  - Immediate Payment Service 

113. VPA  - Virtual Payment Address 

114. BHIM  - Bharat Interface for Money 

115. NPCI  - National Payment Corporation of India 

116. DDoS  - Distributed Denial of Service 

117. DES  - Data Encryption Standard 

118. RSA  - Rives t- Shamir- Adleman 

119. CA   - Certification Authorities 

120. PGP  - Pretty Good Privacy 

121. PKI  - Public Key Infrastructure 

122. SET  -  Secure Electronic Transaction 

123. SSL  -  Secure Sockets Layers 

124. TLS  - Transport Layer Security 

125. MD  - Message Digest 
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126. PIN  - Personal Identification Number 

127. OTP  - One Time Password 

128. FIPS  - Federal Information Processing Standard 

129. PKCS  - Public key cryptography standards 

130. EDI  - Electronic Data Interchange 

131. EFT  - Electronic Transfer 

132. TDCC  - Transportation Data Coordinating Committee 

133. EDIA  - Electronic Data Interchange Association 

134. ANSI  - American National Standards Institute 

135. VAN  - Value Added Network 

136. UNSM  - United Nations Standard Message 

137. GTDI  - Guideline for Trade Data Interchange 

138. UN/ECE  - United –Nations Economic Commission for Europe 

139. UN/EDIFACT -  United Nations / Electronic Data Interchange for 

                                    Administration, Commerce and Transport 

140. ANSIASC  -  American National Standards Institute Accredited Standard Committee 

141. IFSC  - Indian Financial System Code  

142. IMPS  - Immediate Payment Service  

143. MPIN   - Mobile banking Personal Identification number 

 144. COD  - Cash on delivery           

145. CVV2  - Card Verification Value        

                         

 

AUTHORS / ETC 
1. Rich Text format   - Microsoft (1987) 

2. AIFF   - Apple Inc 

3. WMA   - Microsoft 

4. SQL   - ANSI & ISO (1986 & 1987) 

5. PHP   - Rasmus Lerdorf (1994) 

6. Internet   - Vint Cerf (Father of the internet) 

7. TCP/IP   - Vint Cerf 

8. Internet Arch co design - Robert E.kahn & Vint Cerf 

9. DNS   - Jon Postel & Paul V.Mockapetris (God of the internet) 

10. WWW   - Tim Berners Lee 

11. Ethernet   - Bob Metcalf (1973) 

12. Teleshopping   - Michael Aldrich (1979) (Refer book page no 201) 

13. Diners Club Card  - Frank McNamara and Ralph Schneider (1950 Feb) 

14. EDI    - Ed. Guilbert 
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CHAPTER 1 TO 18 LIST OUTS/TYPES/ SUB HEADINGS 
 CHAPTER – 1 ( Multimedia and Desktop Publishing ) 
1.  Multimedia is a Types of media: Text, graphics, images, audio, animation, video. 

2.  Components of Multimedia:  

❖ Text, images, sound, video and animation. 

❖ 1) Dynamic elements: Video, Animation, Audio. 2) Static elements: Text, Graphics 

3.  Text: 1.Static text, 2.Hyber text 

4.  Static Text: Headings or in a line or in a paragraph 

5.  Image:  1) Bitmap or raster images 2) vector images. 

6.  Raster or Bitmap Images: 1) One bit is two colours, 2) Four bits means sixteen colours, 3) Eight bits indicates 256  

7.  Raster Images examples: BMP, GIF, TIFF, JPEG. 

8.  Vector Images examples: AI, EPS, SVG,  CDR 

9.  Animation:   1) Path animation 2) Frame animation. 

10.  Animations dimensional: Two or Three dimensional. 

11.  Sound: Musical Instrument Digital Identifier (MIDI),  Digital Audio 

12.  Video: Analog Video, Digital Video 

13.  Types of analog video: 1) Composite 2) Component Analog Video.   

14.  Examples of analog video: 1) Video tape, 2) Laser disc, 3) Film etc 

15.  Examples of composite analog video: Brightness, color, and synchronization. 

16.  File Formats for Multimedia:  1.Text, 2.Image, 3.Digital Audio, 4.Digital Video 

17.  Types of Text  file Formats: 1.RTF(Rich Text Format)  2.Plain text – TXT 

18.  Types of Image file Formats:  

1.TIFF (Tagged Image File Format)               2.BMP (Bitmap)  

3.DIB (Device   Independent Bitmap)            4.GIF (Graphics Interchange Format) 5.TGA (Tagra) 

6.JPEG (Joint Photographic Experts Group)  7.PNG (Portable Network Graphics) 

19.  Types of Digital Audio file Formats:  

1.WAV (Waveform Audio File Format)  2.OGG  3.MP3 (MPEG Layer-3 Format)  

4.AIFF (Audio Interchange File Format) 5.WMA (Windows Media Audio)  6.RA (Real Audio Format) 

20.  Types of Digital Video File Formats: 

1.AVI (Audio/Video Interleave)  2.WMV (Windows Media Video) 3.FLV (Flash Video)  

4. 3GP                                          5.MPEG (Moving Picture Experts Group) 

21.  Plain text (Text editors): Notepad (Windows), Gedit or nano (Unix, Linux), TextEdit (Mac OS X) and so on 

22.  JPEG Works: 1) Good with photographs, 2) Naturalistic artwork, 3) Similar material, 4) Live drawings  

23.  Common audio file formats are: 1) Wave files (.WAV) 2) MPEG Layer-3 files (.MP3), 3) WMA 4) RA. 

24.  MPEG examples:  
1) MPEG-1, the standard: Video CD and MP3. 2) MPEG-2, the standard: Digital Television set top boxes and DVD  

3) MPEG-4, the standard: Multimedia, Mobile web 4) MPEG-7, the standard: Search of audio and visual content.  

5) MPEG the standard:  Digital video and audio compression. 

25.  Steps in Multimedia Production (or) Process of multimedia:  

1. Conceptual Analysis and Planning, 2. Project design, 3. Pre-production, 4. Budgeting,  

5. Multimedia Production Team 6. Hardware/Software Selection,7. Defining the Content,  

8. Preparing the structure, 9. Production, 10. Testing, 11. Documentation, 12. Delivering the Multimedia Product. 

26.  Multimedia Production Team: 

1. Production Manager, 2. Content Specialist, 3. Script Writer, 4. Text Editor, 5. Multimedia Architect,  

6. Computer Graphic Artist, 7. Audio and Video Specialist, 8. Computer Programmer, 9. Web Master. 

27.  Pre-production :  

1. Budgeting, 2.Multimedia Production Team 3.Hardware/Software Selection, 

4. Defining the Content, 5. Preparing the structure, 6. Production, 7. Testing,  8. Documentation,  

9. Delivering the Multimedia Product 

28.  Budgeting phases: Consultants, hardware, software, travel, communication and publishing 

29.  Hardware/Software Selection: 1) Fastest CPU, RAM, huge monitors, sufficient disc for storing the records. 

30.  Production:  

❖ Text is incorporated using OCR software, Pictures shot by digital camera, Video clips are shot, edited and compressed. 

31.  Testing: Different browsers like Internet Explorer, Chrome, Mozilla and Netscape Navigator. 

32.  Delivering the Multimedia Product:  

1.CD/DVD or in the website. 2.The integration of two mediums CD-ROM/DVD and Internet 

33.  Production Manager: 

1. Expertise in the technology, 2.good at proposal writing, 3.good communication skills  

4. Budget management skills, 5. Experience in human resource management 6.efficient team leader. 

34.  Content Specialist: Projects information, graphics, data or facts presented 
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35.  Multimedia Architect: Graphics, text, audio, music, video, photos and animation by using an authoring software. 

36.  Computer Graphic Artist: Backgrounds, bullets, buttons, pictures editing, 3-D objects, animation, and logos etc 

37.  Audio and Video Specialist:   Recording, editing sound effects and digitizing. 

38.  Social networking sites:Facebook, Whatsapp, Twitter, Instagram etc.. 

39.  Applications of Multimedia:  

❖ Education, 2. Entertainment, 3. Business Systems, 4. Medical Services, 5. Public Places, 6. Multimedia Conferencing. 

40.  Multimedia based teaching and learning system named:MODULO at GMU 

41.  Different ways for teaching and learning: e-learning, distance learning, virtual learning 

42.  Account of multimedia technology applications in libraries: 

1. Multimedia Kiosk,              2. Webcasting and Video Conferencing,  

3. User Orientation Program,  4. In-house Production of Multimedia Resources and E-publishing,  

5. Digital Multimedia Libraries 

43.  Multimedia Kiosk:  

❖ Airports and other public locations, library, Kiosk is usually located near the entrance of the library, used for 

displaying announcements, reading lists, comments and suggestions. 

44.  Multimedia is available in many public places 

❖ Trade shows, libraries, railway stations, museums, malls, airports, banks, hotels and exhibitions 

 CHAPTER – 2 ( An Introduction to Adobe Page maker ) 
1.  Some popular DTP software: Adobe PageMaker, Adobe InDesign, QuarkXPress, etc. 

2.  Opening PageMaker: Start→All Programs → Adobe → PageMaker 7.0 → Adobe PageMaker 7.0. 

3.  The main components of the PageMaker window:Title bar, Menu bar, Toolbar, Ruler, Scroll bars and Text area 

4.  Menu bar: File, Edit, Layout, Type, Element, Utilities, View, Window, Help. 

5.  Show the tool bar:1. Click on Window. 2. Click on Show tools. 

6.  Hide the tool bar:1. Click on Window. 2. Click on Hide tools. 

7.  Toolbox: 

1.Pointer Tool 2.Rotating Tool 3.Line Tool 4.Rectangle Tool 5.Ellipse Tool 6.Polygon Tool 7.Hand Tool, 

 8.Text Tool 9.Cropping Tool 10.Constrained Line Tool,11.Rectangle Frame Tool, 12.Ellipse Frame Tool  

13.Polygon Frame Tool 14.Zoom Tool 

8.  Keyboard shortcuts: 

1) Pointer- F9,                    2) Rotating- Shift + F2,          3) Line - Shift + F3,      4) Rectangle - Shift + F4  

5)Ellipse - Shift + F5         6)Polygon- Shift + F6             7) Hand- Shift + Alt + Drag Left mouse button   

8) Text- Shift + Alt + F1   9) Cropping-Shift + Alt + F2, 10) Constrained Line- Shift + Alt + F3, 

11) Rectangle Frame - Shift + Alt + F4 

9.  Tool Box Usage: 

1) Pointer- select, move, resize, text objects, graphics. 2) Rotating- select, rotate objects.   

3) Line - draw straight lines in any direction,4) Rectangle - draw squares, rectangles   

5) Ellipse -draw circles and ellipses. 6)Polygon- draw polygons 7) Hand- scroll the page   

8) Text- type, select, edit text. 9) Cropping-trim imported graphics,  

10) Constrained Line-draw vertical or horizontal lines, 11) Rectangle Frame - text and graphics. 

10.  Scroll bars:   Vertical and Horizontal scroll bars 

11.  Rulers:  There are two ruler bars. One is at the top and the other is at the left side. 

12.  Show the ruler:1. Click on view. 2. Click on Show rulers. 

13.  Hide the ruler:1. Click on view. 2. Click on Hide rulers. 

14.  Editing Text in the Document: Inserting and deleting words and phrases, correcting errors, and moving and copying text 

15.  Selecting Text:   

❖ Text can be selected using the mouse or the keyboard. 

Selecting Text using the mouse:  

1) A Word- Double-click with I-beam            2) A Paragraph- Triple-click with I-beam 

Selecting Text using the Keyboard:              

1) One character to the left- Shift + ←            2) One character to the right- Shift + →           

3) One line up- Shift + ↑                                  4) One line down- Shift + ↓  

5) To the end of the current line- Shift +End   6) To the beginning of the current line- Shift + Home  

7) Entire Document- Ctrl + A 

16.  Keyboard shortcuts: 

1) Cut- Ctrl + X       2) copy- Ctrl + C      3) paste - Ctrl + V      4) Save - Ctrl + S       5) Close -Ctrl +W 

6) Print – Ctrl + P    7) Undo- Ctrl +Z      8) Redo – Ctrl +Y       9) Open - Ctrl + O  

10) Control palette- Ctrl + ‘                      11) Go to page -Alt + Ctrl + G       

12)Master Page - Ctrl + Alt + P                13) Zoom out – Ctrl + Alt +Spacebar    

14) Zoom in – Ctrl+ Spacebar                   15) Save different location - Shift +Ctrl + S   

16) Character formatting text- Ctrl +T      17) Filling Rectangle with colour – Ctrl +J 

17.  Undo command: Edit>Undo (or) Ctrl + Z 
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18.  Moving the text: Edit > Cut (or) Ctrl + X  // Edit > Paste (or) Ctrl + V 

19.  Copying the Text: Edit > Copy (or) Press Ctrl + C // Edit > Paste (or) Press Ctrl + V 

20.  Saving a Document: File > Save (or) Ctrl + S 

21.  Saving a Document with a new name or in a different location: File > Save As (or) Press Shift + Ctrl + S 

22.  Closing a Document: File > Close (or) Ctrl +W 

23.  Opening a Document: File > Open (or) Ctrl +O 

24.  Print a document: File > Print (or) Ctrl + P 

25.  Converting text in a Text block to a Frame: Choose Element > Frame > Attach Content on the Menu bar 

26.  Separating Text from the Frame:  Choose Element > Frame > Separate Content in the menu bar. 

27.  Moving Around the Document: 

1) One character to the left – Left Arrow 2) One character to the right- Right Arrow 

3) One word to the left- Ctrl + Left Arrow 4) One word to the right- Ctrl + Right Arrow 

5) Up one line- Up Arrow 6) Down one line- Down Arrow 7) To the end of a line- End 

8) To the beginning of a line- Home 9) Up one paragraph -Ctrl + Up Arrow  

10) Down one paragraph- Ctrl + Down Arrow 

28.  To magnify part of a page by dragging: Select the zoom tool.  

To zoom in or out while using another tool: 1.Press Ctrl+Spacebar to zoom in. 2.Press Ctrl+Alt+Spacebar to zoom out.  

29.  Character formatting consists of text properties: Bold, italic, underline, font type, font size, font color, etc. 

30.  Apply character formatting to text: 1. Select the text to be formatted. 2. Choose Type > Character (or) Press Ctrl + T  

31.  Character Formatting using the Control Palette:  

❖ Click on Window > Show Control Palette (or)  2. Press Ctrl + ‘ in the keyboard. 

32.  To modify character attributes using the Character Control Palette: 

❖ 1. Select the text you want to modify. 2. Make the appropriate changes in the Control palette 

33.  Drawing Tools: Line tool, Rectangle tool, Ellipse tool and Polygon tool 

34.  Master Pages: Logos, page numbers, headers, and footers. 

35.  Drawing a Star using Polygon tool: Choose Element > Polygon Settings in the menu bar. 

36.  Filling Shapes with Colors and Patterns:Choose Window > Show colors in the menu bar. (or) Press Ctrl + J 

37.  Going to a specific Page: Layout > Go to Page in the menu bar (or) Press Alt + Ctrl + G 

38.  Inserting Pages: Layout > Insert Pages in the menu bar. 

39.  Removing Pages: Layout > Remove Pages in the menu bar. 

40.  Inserting Page Numbers in Master Pages: Click on Master Page icon. Press Ctrl + Alt + P. 

41.  Hiding Master Items: View > Display Master items (which is usually ticked). 

42.  Showing Master Page Palette: Windows> Show Master Pages in the menu bar. 

 CHAPTER  -  3 (Introduction to Database Management System) 
1.  DBMS: Various actions like storing, retrieving, filtering etc. 

2.  Some of the popular Database Management System: MySQL, Oracle etc. 

3.  DBMS provides users and programmers with a systematic way: Create, retrieve, update and manage data. 

4.  Various access methods in file system: Indexed, random and sequential access. 

5.  The file system had more limitations:Data Duplication, High Maintenance, Security 

6.  The form of DBMS: Relational Database Management System (RDBMS) and Object Database Management System (ODBMS). 

7.  ACID Properties:  Atomicity, Consistency, Isolation and Durability 

8.  DBMS Database Models: 1) Hierarchical , 2) Network, 3) Relational, 4) Object-oriented  

9.  Hierarchical Database Model Advantages: 1.Less redundant data, 2.Efficient search, 3.Data integrity, 4.Security 

10.  Hierarchical Database Model limitations:  Complex to implement and difficulty 

11.  Network model components: 1.Network schema, 2.Sub schema 3.Language 

12.  Network model Advantages: Ability to handle more relationship types, easy data access, data integrity and independence. 

13.  Network model limitations: Difficulty in design and maintenance. 

14.  Few commercial relational models: Oracle and DB2 

15.  Relational model:   

❖ Two terminologies - Instance and Schema,  1)Instance- rows and columns  2)Schema - name and type of each column 

16.  Modern database systems like:  MySQL, oracle and Microsoft Access 

17.  The basic RDBMS concept: 1.Database, 2.Tables, 3.Tuple, 4.Attribute, 5.Schema, 6.Key 

18.  SQL database supporting different platforms: 1.Windows, 2.Linux, 3.MAC Operating Systems. 

19.  The other relational databases available: Oracle, MS SQL Server and MS Access 

20.  The features of RDBMS:  

❖ 1) High Availability  2) High Performance  3) Robust Transactions and support  4) Ease of management  5) Less cost  

21.  1.Table- relations.  2.Column- attributes, 3.Single entry in a table - Row or Record or Tuple. 

4.The horizontal entity in a table- Record or row, 5.Candidate key- Each super key called. 

6.Foreign Key- foreign key is a “copy” of a primary key. 7.Composite key – Compound key. 

22.  The basic concepts of ER model: 1. Entity or Entity type  2. Attributes  3. Relationship 
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23.  Types of Entity: 1. Strong Entity,2. Weak Entity  3. Entity Instance 

24.  Types of attributes:  1. Key, 2. Simple,3. Composite, 4. Single Valued,5. Multi Valued 

25.  Relationship Type:  One-to-One, One-to-Many, Many-to-Many, 

26.  Degree of a relationship: One – Unary, Two – Binary, Three – Ternary 

27.  Cardinality: One-to-one, One-to-many and Many-to-Many 

28.  ER-Diagram: Entities, attributes and relationship 

ER- Modelling Diagram Notations: 

1. Entity – Strong: Simple rectangular box; 2. Entity – Weak: Double rectangular boxes, 

3. Relationships: Rhombus symbol – Strong 4. Between Entities: Rhombus within rhombus – Weak  

5. Attributes: Ellipse Symbol connected to the entity 6. Key Attribute for Entity: Underline the attribute    

    name inside Ellipse 7. Derived Attribute for Entity: Dotted ellipse inside main ellipse  

8. Multivalued Attribute for Entity: Double Ellipse 

29.  MYSQL:  It runs on multiple platforms like Windows, Linux and is scalable, reliable and fast. 

30.  Most popular database databases – Statistics: 

1.MySQL - 44.3%  2.SQL server - 30.8%  3.SQLite - 21.2% 4.PostgreSQL - 21.2%  

5.MongoDB - 16.8%  6.Oracle - 13.2%  7.Redis - 11.2%  8.Cassandra - 2.5%  

31.  Commonly used databases: 1.DB2 2.MySQL 3.Oracle 4.Postgre 5.SQL 6.SQLite 7.SQL Server 8.Sybase  

32.  MySQL – Administration Responsibilities: Configuration, installation, performance, security and data backup. 

33.  DBA’s posses: The skills on database design, database queries, RDMS, SQL and networking. 

34.  The user account is activated with various access rights like: INSERT, SELECT and UPDATE. 

35.  User table has the following fields: Host, Name, Password, select_priv, insert_priv,update_priv. 

36.  List of privileges available in MySQL: 1. Select_priv- select rows from database tables  

2. Insert_priv- insert rows into, 3. Update_priv- update rows of 4. Delete_priv- delete rows of  

5. Create_priv- create new tables in database  6. Alter_priv - make changes to the database structure 

37.  Administrative MySQL Command: 

1. USE Database, 2. SHOW Databases, 3. SHOW Tables, 4. SHOW COLUMNS FROM tablename,  

5. SHOW INDEX FROM tablename, 6.SHOW TABLE STATUS LIKE tablename\G 

38.  Types of software tools: MySQL Workbench and HeidiSQL 

39.  HeidiSQL FEATURES:  Monitoring server host, server connection, Databases, Tables, Views, Triggers and Events. 

40.  Designing Databases: Create Conceptual Design: 1. Create Database: Tables , Queries, Views 

41.  SQL : Few major functions: 

1) Executes queries against a database.  2) Retrieves data from database.  3) Inserts and updates records in a 

database 4) Delete records from database.  5) Creates new databases and new tables in a database.  

42.  Types of SQL Commands: 

1. Data Definition Language (DDL) 2. Data Manipulation Language (DML) 3. Data Query Language (DQL)  

4. Transaction Control Language (TCL) 5. Data Control Language (DCL) 

43.  Data Definition Language (DDL) commands: CREATE, ALTER, DROP,RENAME,TRUNCATE 

44.  Data Manipulation Language (DML) commands: INSERT, UPDATE, and DELETE 

45.  Data Query Language (DQL) commands: SELECT 

46.  Transaction Control Language (TCL) commands: COMMIT, ROLLBACK, SET TRANSACTION,SAVEPOINT 

47.  Data Control Language (DCL) commands: GRANT and REVOKE 

48.  WHERE clause:  

WHERE conditions, operations like =, !=, >, >=, < , <=  

WHERE clause is used in SELECT and UPDATE query  

 CHAPTER – 4 ( php: Hypertext Pre-Processor ) 
1.  Features of PHP: Server-side scripting language, Open-source software, Platform independent, Database support 

2.  List out O.S: Windows, Linux, and mac os 
3.  Examples of web development using PHP:HTML, JAVA SCRIPT, CSS 

4.  Types of PHP tags:  1. PHP Default tags 2. Short open Tags  3. HTML Script embed Tags 

5.  PHP has variables like other programing languages such as: C, C++ and Python etc. 

6.  Basic Rules for Variable Declaration: Variable’s name must start with a  dollar sign ($)  

7.  PHP Data Type: 1. Integer 2. Float 3. String 4. Boolean 5. Array 6. Object 7. Resource 8. NULL 

8.  Comments in PHP: Single-line comment and multi-line comments. 

9.  Echo statement:  
❖ It is used to output a string or other data to the screen. 

The echo statement can be used in several different ways:   

• To output a single string                  • To output multiple strings 

• To output the value of a variable     • To output the result of an expression. 

• To output multiple variables in the same echo statement, you can separate them with a comma. 

• To concatenate (join) multiple strings together, you can use the concatenation operator (.) 
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• To print multiple lines of text, you can use multiple echo statements. 

• To output a string of text that contains a single quote, you can use double quotes to enclose the string. 

10.  Operators in PHP:  

1. Arithmetic operators, 2. Assignment operators, 3. Comparison operators,  

4. Increment/Decrement operators, 5. Logical operators, 6. String operators. 

11.  Arithmetic operators: Addition, subtraction, multiplication and division etc. 

12.  Assignment Operators: x = y, x += y, x -= y, x *= y, x /= y 

13.  Comparison Operators: 1. > - Greater than 2. < - Less than 3) >= Greater than or equal to  4) <= Less than or equal to 5) == Equal 

14.  Increment and Decrement Operators: 

❖ 1) ++$x - Pre-increment 2) $x++ - Post-increment3) --$x - Pre-decrement 4) $x-- - Post-decrement 

15.  Logical Operators: 1) &&- And 2) ||-OR 3) !- Not 

16.  String Operators: 1) Concatenation - . 2) Concatenation assignment: - .= 

17.  WAMP is abbreviation: “Windows, Apache, MySQL, and PHP”. 

 CHAPTER – 5 ( functions and arrays in php) 
1.  Advantages of function: • Code reuse • Testing and debugging • Modularity 

2.  Functions in PHP: Insert, Execute, Delete, Calculate, etc. 

3.  Types of functions in PHP: 1.Built-in Functions 2.User defined Function.  

4.  List the function syntax: Function, Function name, Parameter list 

5.  Array in PHP:1) Indexed, 2) Associative,  3)Multi-Dimensional (Nested array) 

 CHAPTER – 6 ( Conditional Statements In php ) 
1.  Statements: The statements that cause such jumps are called as control statements or control structures. 

2.  List out control structures: Conditional statements and Looping statements. 

3.  List out PHP Conditional Statements: 1) if 2) if...else  3) if...elseif....else , 4) Switch statement 

 CHAPTER – 7 ( Loops in php ) 
1.  List out Loops: 1) for Loop 2) foreach Loop 3) While Loop 4) Do While Loop 

2.  List out Entry & Exit check loop: (For & while – Entry check) (Do-while – Exit check) 

3.  List out for loop basic forms: 1.Initialization 2.Condition 3. Increment/Decrement Ex: for ($i = 1; $i<= 5; $i++) 

4.  List out while and do-while loop structures: • Execution order • Minimum number of iterations 

5.  For each loop: It is used to iterate over elements of an array. It is used to iterate over the keys and values 

 CHAPTER -  8 ( Forms and Files) 
1.  HTML form controls: Textbox, dropdown box and radio button etc., 

2.  Basic HTML Form Controls: Text inputs, Buttons, Checkbox, Radio box, File Select Form Tag. 

3.  Text inputs: Textbox and text area controls 

4.  Buttons may contain: Submit button, Reset button and Cancel Button. 

5.  Checkbox: Selects more than one value 

6.  PHP Basic Form Handling: Post Method, Get Method 

7.  Two PHP variables: $_POST and $_GET 

8.  Basic PHP Form Validation: 1.Client-Side Validation 2. Server Side Validation 

9.  Validation rules: 

1)Name (Text Input) : Must contain letters and white-spaces  

2)Email (Text Input) : Must contain @ and .strings  3)Website (Text Input) : Must contain a valid URL  

4)Radio : Must be selectable minimum one value    5)Check Box : Must be checkable minimum one value  

6)Drop Down menu : Must be selectable minimum one value 

10.  HTML form  (Back-end applications): CGI, ASP Script or PHP script etc 

11.  Files:   PHP Open a File, PHP Read a File, PHP Close a File, PHP Write a File, PHP Appending a File and PHP uploading a File.  

 CHAPTER – 9 ( Connecting PHP and MYSQL ) 
1.  RDBMS Features: MySQL, Oracle, IBM DB2, and Microsoft SQLSERVER etc. 

2.  Databases are connected with Programing language and perform major operations: 

❖ INSERT, SELECT, UPDATE and DELETE using Structured query language (SQL). 

3.  PHP Scripting language many functions are available: 

❖ MySQL Database connectivity and executing SQL queries. 

4.  MySQLi Function in PHP:1) Mysqli_connect(), 2) Mysqli_close(),3) Mysqli_query()Function  

5.  Database Connections:   

❖ Four parameters to connect to database server.  Server name, Username, Password and DB Name. 

6.  Four variables are used to connect to the Database server:  

1.$servername -> Database Server Server IP address 2.$username -> Database Server User Name  

3.$password -> Database Server Password  4.$DB_Name -> Database Name  

7.  List out frame works: 

❖ PRADO, CakePHP, Symfony, CodeIgniter, Laravel, Yii Framework, Phalcon and Zend Framework 
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 CHAPTER – 10 ( Introduction to Computer Networks ) 
1.  Some of the shared resources are:  File server, web camera, speakers, printer, scanner, fax machine etc., 

2.  Accessing services: WWW (World Wide Web), Digital audio, Digital video 

3.  In networking, nodes are identified by its IP addresses  

❖ i.e.,(network address) and can include hosts such as mobile phones , tabs , personal computers, huge 

servers and other networking device 

4.  Evolution of Internet : 

1.Age of commence begins 1995,                              2.Mosaic created 1993,    3.WWW created 1989,  

4.Internet named and goes TCP/IP 1984,                  5.TCP/IP Created 1972,    6.ARPANET 1969,  

7.Hyper tent invented 1965,                                      8.Packet switching invented 1964,  

9.First vast computer network envisioned 1962,      10.Silicon chip 1958,  

11.A mathematical theory of communication 1948, 12.Memex conceived 1945. 

5.  Online service providers: Flipkart, Amazon, snap deal etc to buy products via Internet and have the product at door step 

6.  For example on olden days (Search engine): 

❖ Internet Explorer, Yahoo, bing were powerful search engine.  

❖ Later, Google stepped in with user friendly gmail, youtube, googledrive, google maps, etc 

7.  List out two innovations of internet:  Mobile technology and social web. 

8.  The common uses of computer network: Communication, Resource sharing, Information sharing. 

9.  Communication :  

❖ People can easily communicate at very low cost via mobile, social media, telephone, e-mail, chatting, video 

telephone, video conferencing, SMS, MMS, groupware etc. 

10.  Resource sharing :Simply resource sharing is sharing such as printers, scanner, PDA, fax machine, and modems 

11.  Applications of computer network: 1. Networks in business 2.Networks at homes 3.Mobile Networks 4.Social application. 

12.  Examples of networks in business: 

❖ Company license, renewals, other certificates, bill payments, receipts, invoice, stock maintenance, can be done 

13.  Examples of networks at homes: 

❖ Network at home helps us to perform e-banking, e-learning, e-governance, e-health, telemedicine, call 

centers, video conferencing, digitalization of memories, etc. 

14.  Mobile networks: 

❖ For example mobiles, tablets, pagers, laptops, engaged with mobile broadband just like modems etc. 

15.  Networks at home were connected in two ways:1)Wired network  2) Wireless network  

16.  A Wired network system example: Speakers, CCTV, printers, outdoors, and scanners etc., with cables. 

17.  Wireless network example: Tablets(tab), indoor cameras and E-readers, etc., without cables (WiFi). 

18.  Social Application: Whatsapp, Facebook, Twitter, Blogs, Pinterest, Classmate and so on. 

19.  Social networks share several attributes in common: 

1) Membership 2) Content contribution 3) Frequent return visits 4) Human relationship building.  

20.  Benefits of Social Networks: 

1) Group information sharing over long distances 2) Broadcast announcements 3) Fostering diversity of thought  

 CHAPTER – 11 ( Network Examples and Protocols) 
1.  Network protocols so as to carry out the communication between: 

❖ Routers, servers, computers, laptop, and other authorized networked device 

2.  Types of networking protocols: 

1) Network communication-HTTP and TCP/IP, 2) Network security protocol- HTTP, SFTP,SSL.,  

3) Network management protocol-ICMP and SNMP. 

3.  INTERNET: Global network, public TCP/IP network 

❖ Internet is a network of global connections – comprising private, public, business, academic and government 

networks – linked by guided, wireless and fiber-optic technologies 

4.  INTRANET:  
❖ Intranet is a private network within an enterprise to share company data and computing resources between the employees. 

5.  EXTRANET:  

❖ The public telecommunication system to securely share business information with suppliers, vendors, 

partners, customers, or other business. 

6.  Network Applications:  1) Application of Internet, 2) Application of Intranet, 3) Application of Extranet 

7.  Application of Internet: 

❖ Download programs and files, Social media,E-Mail,E-Banking,Audio and Video Conferencing, 

❖ E-Commerce,File Sharing, E- Governance ,Information browsing, Chatting and etc.  

8.  Application of Intranet:  

❖ Sharing of company policies/rules and regulations , Access employee database, Distribution of circulars/ 

Office Orders ,Access product and customer data Sharing of information of common interest ,Launching of 

personal/ departmental home pages,  Submission of reports, Corporate telephone directories.  
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9.  Application of Extranet: 
❖ Customer communications, Online education/ training ,Account status enquiry ,Inventory enquiry, Online discussion 

,Supply – chain managements ,Order status enquiry ,Warranty registration, Claims ,Distributor promotions  

10.  Communication over mobile network is made up: Voice, data, images and text messages. 

11.  The generation of mobile networks: 

1) First Generation(1G) 1981- NMT launch 2) Second Generation(2G) 1991-GSM Launch  

3) Second to Third Generation Bridge (2.5)2000 – GPRS launch   

4) Third Generation( 3G) 2003- UK 3G launch 5) Fourth Generation (4 G) 2007   

6) Fifth Generation (5G) 2019+  

12.  First Generation (1G) 1981 – NMT launch: 

They had a very low traffic density of one call per radio channel, and a very poor voice quality, and they used 

unsure and unencrypted transmission. 

13.  Second Generation (2G) 1991 – GSM launch: 

1.GSM -Global System for Mobile communication, 2. SIM –Subscriber Identity Module, 

3. TMDA - Time Division Multiple Access, 4.CDMA - Code Division Multiple Access. 

14.  Second to Third Generations Bridge (2.5G) 2000 – GPRS launch: 

1.GPRS -General Packet Radio Service, 2. EDGE-Enhanced Data rates for Global Evolution 

15.  Third Generation(3G)2003 – First UK 3G launch: 

1) MMS: voice, video and data,2) UMTS -Universal Mobile Telecommunication Systems, 

3) WCDMA : Wideband Code Division Multiple Access 4) MPLS:Multiprotocol Label Switching 

16.  Fourth Generation(4G) 2007:  Example: 802.11 WLAN, GPRS and UMTS) 

17.  Fifth Generation (5G) 2019+ 

❖ 5G is the stage succeeds the 4G (LTE/ WiMAx), 3G(umts) and 2G(GSM) syetems. 

❖ 5G targets to perform the high data rate, reduced latency, energy saving, cost reduction, higher system, 

capacity, and massive device connectivity. 

❖ The two phases of 5G, First one will be Release-15 complete by March 2019,Second one Release-16 is 

expected to complete at March2020, 

18.  ADVANTAGES: Benefits of Wi-Fi : 

1) It provides mobility, 2) It provides connection to Internet. 3) Flexibility of LAN.  

4) Ensures connectivity 5) It allows remote places to benefit from connectivity. 6) Low cost, high benefits 

19.  RIFD Two parts: A reader and A tag or A label 

20.  RIFD Tags are installed with: Transmitter and receiver. 

21.  RFID component two parts:  A microchip & antenna 

22.  Two types of RFID tags were:  Active RFID and Passive RFID systems. 

23.  OSI Layers: 1. Physical,2. Data Link,3. Network,4. Transport,5. Session6. Presentation,7. Application 

24.  OSI Layers:  

1. Physical Layer: The electrical and physical specifications for devices.  

2. Data Link Layer: It guarantees that the data transmitted. 

3. Network Layer: Determining the path of the data packets.  

4. Transport Layer: Guarantees the transportation/sending of data successfully.  

5. Session Layer: It controls dialogues between computers. 

6. Presentation Layer: Encryption and decryption protocols occur in this layer such as, Secure Socket Layer. 

7. Application Layer: The user interface platform comprising of software within the system. 

25.  Frequent TCP/IP Protocols: 1) HTTP ,  2) HTTPS , 3) FTP, 

26.  The Different Layers of TCP/IP:  

● Network Access Layer - concerned with building packets.  

● Internet Layer - describes how packets are to be delivered.  

● Transport Layer - ensure the proper transmission of data.  

● Application Layer - application network processes.  

27.  Application Layer processes:  

1) Hypertext Transfer Protocol (HTTP), 2) File Transfer Protocol (FTP), 

3) Simple Mail Transfer Protocol (SMTP), 4) Domain Name System (DNS) 

28.  Other Network Protocols: 

1) Network layer :  IP, ARP, ICMP,IGMP, 2) Transport layer : TCP,UDP 

3) Application Layer : HTTP, FTP, Telenet, SMTP, and DNS. 

 CHAPTER – 12  Domain Name System  (DNS)) 
1.  IP Address: Two addressing methods i.e., IPv4 and IPv6. 

2.  There are two ways to represent the IP address: 1) Binary notation 2) Dotted-decimal notation  

3.  URL is made up:  Four parts–protocols, hostname, folder name and file name 

4.  URL is divided into 2 types   1) Absolute URL  2) Relative URL  

5.  Domain Name System components:  1) Namespace 2) Name server 3) Zone  
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6.  The name space can be organized in two ways  1) Flat name space 2) Hierarchical name space  

7.  Hierarchical name space parts: 

❖ The first part may represent the nature of the organization,  

❖ The second part may represent the name of the organization,  

❖ The third part may represent the department of the organization. 

8.  Basic rules of Domain names: 

❖ Domain name can consist of alphabets (a-z, A-Z) and the digits (0-9)  

❖ Hyphens are allowed, but hyphens can not be used as the first character of a domain name.  

❖ Spaces are not allowed   Special symbols (such as !, $, &, _ and so on) are not permitted.  

❖ The entire domain name may be at most 253 characters long. 􀁺 Domain names are not case-sensitive. 

9.  Generic Domain Names:  

1) Com- Commercial Organisation, 2) Edu- Educational Institutions,  

3) Gov- Government (US)  4) Mil- Military groups, 5) Org- Non profit Organization,  

6) Net- Networking organization, 7) Info- Information service providers 

10.  Country top-level domain names:  

In- india, fr-France, uk-United kingdom, ca- canada,  

au-Australia,lk-Srilanka,bd-Bangladesh,cn-China,pk-Pakistan,jp-Japan,sg-Singapore,us-United States.  

11.  Types of Name Servers :  1. Root Name Server,2. Primary/Master Name Server,  3. Secondary/Slave Name Server 

12.  There are two copies of zone files available:Master file and slave file 

 CHAPTER – 13 ( Network Cabling) 
1.  Types of Network Cables:1. Coaxial, 2. Twisted Pair,3. Fiber Optics, 4. USB, 5. Serial and Parallel, 6.Ethernet Cables 

2.  Coaxial Cables: The cable is classified Thinnet and thicknet cables. 

3.  Twisted Pair Cables types:  Unshielded Twisted Pair (UTP) and Shielded Twisted pair (STP). 

4.  Fiber Optics: (2) Single-mode (Long distance),Multimode (short distance). 

5.  USB cables are used connect: Keyboard, mouse and other peripheral devices. 

6.  Wired media:  

❖ Unshielded Twisted pair, shielded Twisted pair, Co-axial cables and Optical fibre 

Wireless media:  

❖ Infra Red, Bluetooth, WiFi 

7.  Ethernet cabling components: 

❖ 1. Patch Cable (Twisted pair),2. RJ45 Connector, 3. Ethernet Ports,4. Crimping Tool 

8.  Patch Cable (Twisted Pair):  

❖ 8 wires in different colors. Four of them are solid colours, and the others are striped. 

9.  Ethernet cables are normally manufactured in several industrial standards:  Cat 3, Cat 5, Cat 6, Cat 6 and cat 7. 

10.  Ethernet Port: It is found on personal computers, laptops, routers, switches, hubs and modems. 

11.  Devices/Technology Alternative Names 

Ethernet Technology RJ45, 802.3 

RJ45 Connector (male) RJ45 plug, Ethernet connector, 8P8C connector 

RJ45 socket (female) RJ45 jack, Ethernet Port 

RJ45 Cable Ethernet cable 
 

12.  Types of Jacks: 1) Registered Jacks:RJ-11, RJ-45, RJ-21, and RJ-28 

13.  Ethernet Cable Color Coding Techniques:   1.Straight-Through Wiring 2.Cross-over Wiring 3.Roll-over Wiring  

14.  Straight-Through Wiring: 

❖ This is a simple physical connection used in printers, computers and other network interfaces. 

15.  How to determine the type of Ethernet cables?  1) Straight-through, 2) Cross-over, 3)Roll-over 

16.  The parallel cables are used to connect: Printer and other disk drivers.  

17.  Cross over cable example:  1.Two PCs or two network devices. 2.The Null modem Cables. 

 CHAPTER – 14 ( Open Source Concepts ) 
1.  Advantage of the proprietary software: It gives more control, support, training, security and stability 

2.  Need for network open source software: 

❖ We need Network Software to Control, Analyse the Server, System, protocol, Network, Traffic flow and 

reports about ups and downs of network parts. 

3.  Organizations related to Open Source :  

1.Apache Software Foundation, 2) Free Software Foundation, 3) Linux Foundation 4) Open Source Initiative  

4.  Types of open source license:  

1) Apache License 2.0 2) BSD 3-Clause “New” or “Revised” license, 

3) BSD 2-Clause “Simplified” or “FreeBSD” license, 4) GNU General Public License (GPL),  

5.  Benefits Open-Source Software  

1) Communication tools.         2) Distributed revision control systems.  

3) Bug trackers and task lists. 4) Testing and debugging tools. 
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6.  Example of open source Application software  

NS2 , OPEN NMS, Ubuntu , MySQL, PDF Creator, Open Office, 7zip GNUCASH, GIMP, BLENDER, 

AUDACITY, VLC, MOZILA FIREFOX, MAGENTO, ANDROID, PHP 

7.  The different network objects: Routers, nodes, switches, access points, links etc. 

8.  Open NMS : 
Maintained by a community of users ,developers and by the Open NMS Group, it offering services, training and support. 

It gives us:  Event management & Notification, Discovery & Provisioning, service monitoring and Data Collection. 

9.  All features of the FCAPS (Fault, configuration, accounting, performance, security) network management model. 

10.  There are two types of Open NMS: Meridian and Horizon 

11.  Open Source Hardware: 1) Remix, 2) Remake, 3) Remanufacture 4) Redistribute, 5) Resell, 6) Study and Learn 

12.  Open NMS has three main functional areas: 

1. Service monitoring - ICMP, HTTP, DNS, etc  2. Data Gathering - Using SNMP and JMX. 

3. Event management and notifications - Alarm reduction & robust announcement system  

 CHAPTER – 15  ( E-Commerce) 
1.  Internet E-Business is grounded on technologies such: Network Infrastructures (like Internet, Intranet, Extranet), 

2.  Multimedia content & network publishing infrastructures: 

(like HTML, Online Marketing), Messaging & information distribution infrastructures (like EDI, e-mail, http, 

Computerized Inventory Management Systems) 

3.  Other Common business service infrastructures: 
 (like electronic payments gateways, globalized Supply Chain Management (SCM), Online Transaction Processing) 

4.  A company is set to have E-Business if and only if  

1) It has the ability to conduct business electronically over Internet.  

2) It manages payment transaction through Internet.  

3) It has a platform for selling products & services via Internet.  

5.  E-Business:  

1) Network Infrastructure,  2) Multimedia content & publishing’s,  

3) Messaging & Information Distribution ,Common Business Service Infrastructure 

6.  Tangibles products:  Printed books, CD’s and DVD’s, lamp etc. 

7.  Intangible products:  Digital files, downloaded video games, music files are movies which can not be physically touch. 

8.  The Development and Growth of Electronic Commerce: 
❖ The First Wave of Electronic Commerce: 1995 -2003 ,The Second Wave of Electronic Commerce: 2004 – 2009,  

❖ The Third Wave of Electronic Commerce: 2010 – Present, 

9.  The Third Wave of Electronic Commerce: 2010 – Present  

❖ The future Internet which include Artificial Intelligence, Semantic Web, Generic Database etc. 

10.  Classification of E-Commerce Business models: 

1. Business to Business (B2B) 2. Business to Consumer (B2C) 3. Business to Government (B2G)  

4. Consumer to Business (C2B) 5. Consumer to Consumer (C2C) 6. Consumer to Government (C2G)  

7. Government to Business (G2B) 8. Government to Consumer (G2C) 9. Government to Government (G2G 

11.  Traditional commerce: 

1.Buying or selling of products and services physically. 2.Resource focus Supply side. 

3.Business Relationship is Linear. 4.Marketing is one way marketing. 

5.Payment is made by cash, cheque, cards etc. 6.Most goods are delivered instantly. 

12.  E-commerce: 

1.Carries out commercial transactions electronically on the Internet. 2.Scope of business is global. 

3.Resource focus Demand side. 4.Business Relationship is End-to-end. 

5.One-to-one marketing. 6.Payment system is mostly through credit card, debit card or fund transfer. 

7.It takes time to transport goods. 

 CHAPTER – 16 ( Electronic Payment Systems) 
1.  Classification of Electronic Payment systems: 1) Micro electronic 2) Macro electronic 

2.  Examples of micro electronic payment system:  
❖ Subscriptions of online games, read journals, listen to a song or watch a movie online etc.  

3.  Popular macro on-line payment systems:  

1) Card based payment systems  2) Electronic account transfer, 3) Electronic cash payment systems,  

4) Mobile payment systems and internet payment systems  

4.  Card Based Payments Systems:  

1. Credit card based payment systems (pay later),  

2. Debit card based payment systems (pay now), 3. Stored value card based payment systems (pay before) 

5.  Key players in operations of credit card: 1. Bearer, 2. Merchant, 3. Acquirer, 4. Credit Card Network, 5. Issuer, 

6.  Anatomy of a credit card: 

1. Publisher, 2. Credit card number, 3. Name of the cardholder, 4. EMV chip, 5. RFID symbol,  

6. Expiration month and year, 7. Card brand logo, 8. Magnetic stripe, 9. Hologram,10. Signature 11. CVC/CVV 
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7.  Currently there are three ways of processing debit card transactions:  

1. EFTPOS (also known as online debit or PIN debit), 2. Offline debit (also known as signature debit), 

3. Electronic Purse Card System 

8.  Stored value cards: 
1. Closed loop (single purpose)- Ex: Chennai metro rail travel card. 2.Open loop (multipurpose)- Ex: Visa gift cards 

9.  Smart card: Contact smart cards and Contactless smart cards. 

10.  Electronic Account Transfer: ECS (Electronic Clearing Services),  

1.EFT (Electronic funds transfers), 2.Real Time Gross Settlement system (RTGS) etc. 

11.  ECS can be used: Credit and debit purposes i.e. for making bulk payments or bulk collection of amounts. 

12.  Functions of crypto currency: Mining, Block chain, Directed Acyclic Graph, Distributed register (ledger), etc. 

13.  Electronic wallets:  Electronic wallet services that are now widely used. e.g. :PayPal, SBI Buddy 

14.  Real-time gross settlement transactions are:  1) Unconditional , 2) Irrevocable  

15.  Mobile Banking operations can be implemented in the following ways:  

1.Contacting the call center. 2.Automatic IVR telephone service 3.Using a mobile phone via SMS.  

4.WAP technology. 5.Using smartphone applications  

16.  Internet banking: 

❖ Internet banking is a collective term for E-banking, online banking, virtual banking, direct banks, web 

banking and remote banking. 

17.  UPI applications use two types of address - global and local.  

❖ Global address includes bank account numbers and IFSC.  

❖ Local address is a virtual payment address.  

 CHAPTER – 17 (E-Commerce Security Systems) 
1.  E-Commerce security threats can be accidental (caused by a human error) or intentional.  

❖ Foreign or domestic, internal or external, group or individual, business rivals or disgruntled employees, 

terrorists or hackers anyone with the capability, technology, opportunity, and intent to do harm can be a 

potential threat to E-Commerce 

2.  E-Commerce business would face the following specific threats: 

1. Information leakage, 2. Tampering,3. Payment frauds, 4. Malicious code threats, 

5. Distributed Denial of Service (DDoS) Attacks,6. Cyber Squatting, 7. Typopiracy 

3.  Examples of Payment frauds: 

1.Friendly fraud (when customer demands false reclaim or refund),  

2.Clean fraud (when a stolen credit card is used to make a purchase)  

3.Triangulation fraud (fake online shops offering cheapest price and collect credit card data) etc. 

4.  Examples of Typo piracy:  1.www.goggle.com 2.www.faceblook.com 

5.  Dimensions of E-Commerce security: 

1. Authenticity, 2) Availability, 3) Completeness, 4) Confidentiality,5) Effectiveness Integrity, 

6) Non-repudiation, 7) Privacy 8) Reliability 8) Review ability  

6.  Security technologies in E-Commerce transaction: 

1) Encryption technology, 2) Authentication technology, 3) Authentication protocols  

7.  A digital certificate function is similar to the function of identification cards such as: 

❖ Passports and driving licenses. 

8.  The SET purchase involves three major participants: The customer, the seller and the payment gateway 

9.  Authentication protocols:  Secure Electronic Transaction (SET) and Secure Sockets Layer (SSL). 

10.  SET was developed in 1996 by:  

❖ VISA and MasterCard, with the participation of GTE, IBM, Microsoft and Netscape. 

11.  The SSL standard was developed by Netscape in collaboration with: 

❖ MasterCard, Bank of America, MCI and Silicon Graphics. 

12.  3D Secure:This authentication model comprise 3 domains (hence the name 3D) which are:  

1. The Acquirer Domain, 2. The Issuer Domain, 3. The interoperability Domain 

13.  Symmetric key encryption algorithm: DES, AES, RC4 

14.  Asymmetric key encryption algorithm: RSA, ECC, DSA 

15.  Digital certificate (Under govt of india example) NIC, Safescript, TCS, MTNL, e-Mudhra 

 CHAPTER – 18 ( Electronic Data Interchange- EDI) 
1.  EDI:  

❖ It is used to transfer documents such as delivery notes, invoices, purchase orders, advance ship notice, 

functional acknowledgements etc 

2.  There are many internationally accepted EDI standard e.g:  EDIFACT, XML, ANSI ASC X12, etc. 

3.  EDI Types:  1) Direct EDI, 2) EDI via VAN, 3) EDI via FTP/VPN, SFTP, FTPS, 4) Web EDI,5) Mobile EDI  

4.  Advantages of EDI:  

1) Improving service to end users, 2) Increasing productivity, 

3) Minimizing errors, 4) Slashing response times, 5) Automation of operations ,6) Cutting costs,  
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7) Integrating all business and trading partners, 8) Providing information on process status,  

9) Optimizing financial ratios  

5.  EDI Layers:1. Semantic layer , 2. Standard translation layer,3. Transport layer, 4. Physical layer 

6.  EDI Components: 

1. Standard document format, 2. Translator and Mapper 3. Communication software,4. Communication network 

7.  EDI Standards: 

❖ Basic standards, code standards, message standards, document standards, management standards, application 

standards, communication standards and security standards 

8.  The most widely used EDI message standards: United Nations EDIFACT and the ANSI X12. 

9.  UN/EDIFACT Message structure: 

Highest Level, 

❖ Interchange-UNB/UNZ  

❖ Functional Groups-UNG/UNE 

❖ Messages-UNH/UNT 

❖ Segment Groups-Block of related data 

❖ Segments-simple and composite elements 

❖ Composite Elements-Group of related simple elements 

❖ Simple data Elements-Piece of single data 

Lowest Level 

10.  EDIFACT message:  

❖ Service messages -To confirm / reject a message, CONTRL and APERAK messages are sent.  

❖ CONTRL- Syntax Check and Confirmation of Arrival of Message, 

❖ APERAK - Technical error messages and acknowledgment Data exchange  

❖ CREMUL - multiple credit advice, DELFOR- Delivery forecast, IFTMBC - Booking confirmation  
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GLOSSARY: 
CHAPTER-1 

Multimedia ▪ Multimedia allows the users to combine and change data from various sources like image, text, 

graphics, video, audio and video to a single platform 

Raster Image ▪ Raster image is made up of the tiny dots called pixel. 

Vector Image ▪ Vector image is a type of image made up of geometric shapes.  

Animation ▪ Animation is the process of displaying still images quickly so that they give the impression of 

continuous movement.  

▪ In animation the screen object is a vector image.  

Path Animation ▪ Path animation involves moving an object on a screen that has a constant background  

▪ E.g. a cartoon character may move across the screen regardless of any change in the 

background or the character. 

MIDI ▪ Musical Instrument Digital Identifier (MIDI) is a standard communication tool developed for 

computers and electronic instruments. 

CHAPTER-2 

Header ▪ Text that is repeated at the top of each page 

Footer ▪ Text that is repeated at the bottom of each page  

Symbol ▪ A sign or a special character that can be inserted in a PageMaker document 

Margins ▪ The amount of space between the text and the edge of the page on all four sides  

Orientation ▪ The direction (along the height or along the width) in which the page is being printed 

Menu ▪ A list of commands 

Editing ▪ Making changes to the text 

Undo ▪ Reversing the last command 

Redo ▪ Reversing the Undo command 

CHAPTER-3 

Backup ▪ It is a program or process of copying table contents into a file for future reference.  

▪ It’s a challenging task for DBA’s  

Primary Key ▪ This key of relational table identifies each record in the table in a unique way. 

Relationship ▪ There exists a relationship between two tables when the foreign key of one table references 

primary key of other table. 

Cardinality ▪ It is defined as the number of different values in any given table column 

Open Source ▪ Open source – refers to the design that is publicly accessible by people for modification and sharing  

SQL ▪ It (Structured query Language) is a programming language designed mainly for managing data in RDBMS  

Record ▪ Record is referred in a table, which are composed of fields. 

Query ▪ In SQL, all commands are named as query. The query statement is executed against the databases. 

Join ▪ Retrieves data from two or more tables, by referencing columns in the tables that hold identical values. 

CHAPTER-4 

HTML ▪ HTML stands for Hyper Text Mark-up Language.  

▪ This language is designed for creating websites.  

PHP ▪ PHP is server-side scripting language. 

ECHO ▪ Echo statement is used to display output in PHP.  

WAMP ▪ WAMP is abbreviation for “Windows, Apache, MySQL, and PHP”. 

CHAPTER-5 

Function ▪ A function is a block of code that performs a specific task.  

Array ▪ An array is a special data type. It can hold many values under a single variable name.  

▪ An array element can be any type of data. 

CHAPTER-6  
Control 

statements / 

Structures 

▪ The statements that cause a jump of control from one part of a script to another are called 

Control statements or Control Structures.  

Conditional 

statements 

▪ Conditional statements in PHP execute code based on a specific condition. 

 

CHAPTER-7 

Loop ▪ A loop is a control structure that repeatedly executes a block of code until a certain condition is 

met or a specific number of times.  

Block of code / 

Code Block 

▪ A block of code, also known as a  

▪ Code block, is a group of statements to be executed together as a single unit. 

 

CHAPTER -8 

HTML ▪ Hypertext Mark-up Language is the standard mark-up language for creating web pages and 

web applications.  
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FORM Validation ▪ Validation of HTML form data is important to protect your form from hackers and spammers!  

Files handling ▪ File handling is an important part of any web application. You often need to open and process 

a file for different tasks.  

File upload ▪ A PHP script can be used with a HTML form to allow users to upload files to the server. 

CHAPTER-9 

SQL ▪ SQL is a domain-specific language used in programming and designed for managing data held 

in a relational database management system  

Queries ▪ A query is a request for data or information from a database table or combination of tables.  

MySQL ▪ MySQL is an open-source relational database management system 

SERVER ▪ A server is a computer or a device that provides functionality for other programs or devices, called “clients”.  

▪ This architecture is called the client– server model, and a single overall computation is 

distributed across multiple processes or devices.  

Database ▪ A database is an organized collection of data, generally stored and accessed electronically from 

a computer system. 

CHAPTER-10 

e-Governance  ▪ e-Governance is an application of ICT for access the government services, communication transactions, 

of various standards system between government to citizen, government to business. 

e-Banking ▪ It was a safe, fast, easy and efficient electronic service that enables you access to bank account 

and to carry out online banking services, 24 hours a day, and 7 days a week. 

Hackers ▪ Hackers were skilled computer experts, some who with their technical knowledge access our accounts.  

Viruses ▪ Malware treats or computer warms that replicates it By its own is called as virus 

Globalized ▪ Developed to make international influence or operation possible. 

Cloud Storage ▪ Just a storage of data on online, access in different area no geographical limits was in need  
Cloud Computing ▪ It is based on Internet computing, to share resources, software and information. 

e-Readers ▪ E-Readers is similarly called as e-book reader these were designed for the purpose of reading 

via mobile electronics device to read digital e-books and periodically 

Flame wars ▪ Flame wars are nothing that lengthy exchange of angry or abusive messages between users of 

an online forum or other discussion area. 

CHAPTER-11 

Internet ▪ Several networks, small and big all over the world, are connected together to form a Global 

network called the Internet. 

Intranet ▪ It is a website used by organizations to provide a place where employees can access company 

related information.  

Extranet ▪ It is a private network using Internet technology to share part of business information with    

supplier’s partners and customers.  

APRANet  ▪ Advanced Research Projects Agency Network 

TCP/IP ▪ Transmission Control Protocol / Internet Protocol 

Wi-Fi ▪ Wireless Fidelity.  

RFID ▪ Radio Frequency Identification. 

OSI ▪ Open System Interconnection 

HTTP ▪ Hypertext Transfer Protocol  

HTTPS ▪ Hypertext Transfer Protocol Secure  

FTP ▪ File Transfer Protocol  

SMTP ▪ Simple Mail Transfer Protocol  

UDP ▪ User Datagram Protocol 

DNS ▪ Domain Name System 

CHAPTER-12 

DNS ▪ Domain Name System an Internet service that translates domain name into IP address. 

IP address ▪ IP address used to uniquely identify a computer over the network.  
Domain Namespace ▪ A naming system on which domain names are in a hierarchical and logical tree structure.  

Domain Name ▪ Domain Name a symbolic name associated with an IP address  

Name server ▪ Contains the DNS database which consists of domain names and their corresponding IP addresses.  

ICANN ▪ Internet Corporation for Assigned Name and Numbers, Non-profit organization which 

regulates an Internet.  

IANA ▪ Internet Assigned Numbers Authority (IANA) is an affiliated authority of ICANN.  

Zone ▪ A group of contiguous domains and sub domains in the Domain Name Space.  

The resolver ▪ The resolver a program which is responsible for initiating the translation of a domain name 

into an IP address  

TLD ▪ Top Level Domain, domains below the root domain  

IPv4 /IPv6 ▪ Internet Protocol version 4/6 

CHAPTER-13 

www.Padasalai.Net                                                                     www.Trb Tnpsc.Com

Kindly Send Me Your Key Answer to Our email id - Padasalai.net@gmail.com

www.P
ad

as
al

ai
.N

et

www.P
ad

as
al

ai
.N

et

https://www.padasalai.net/
https://www.padasalai.net/


 

45 

PREPARED BY.., B.MOHAMED YOUSUF M.C.A.., B.Ed.., (PG. ASST IN COMPUTER SCIENCE) 

                              [yousufaslan5855@gmail.com] 

ARPANET ▪ Advanced Research Project Agency Network, predecessor to the modern Internet 

WWW ▪ World Wide Web, Definition comes from the World Wide Web Consortium (W3C):  

▪ “The World Wide Web is the universe of network-accessible information, an embodiment of 

human knowledge.” 

10BASE-T / 

100BASE-TX / 

100BASE-FX/ 

100BASE-BX/ 

100BASE-SX 

▪ 10 Mbps / 100 Mbps  

▪ Mbps stands for Mega bits per second  

▪ T stands for Twisted pair  

▪ X stands for number of paired copper wires  

▪ F, B, S – Fibre optic cables  

WAN ▪ Wide Area Network, WAN is the network that spans large geographical area  

USB ▪ Universal Serial Bus, connects all the peripheral devices with the computers 
Null modem cables ▪ A communication method directly connects two computers without modem or any equipment.  

LAN ▪ Local Area Network in which the devices used in home or office interconnected for sharing the 

resources.  

TX / RX ▪ Transmit / Receive signals used in connectors 

Dongles ▪ The dongle is a small peripheral device with a sim slot in it and connects the Internet and acts 

as an Ethernet port to the computer. 

CHAPTER-14 

NS2 ▪ Network Simulation 2 

Open NMS  ▪ First Open Source Network Management Software 

Trace File ▪ A document file, consists of every incident happens in a simulation  

OTCL ▪ Object-oriented Tool Command Language 

FCAPS ▪ Fault, configuration, accounting, performance, security 

GNU ▪ GPLGNU - General Public License 

SSFNet  ▪ Scalable Simulation Framework Net Models  

API ▪ APPLICATION PROGRAM INTERFACE 
SOURCE CODE ▪ Set of Instructions that decide, how the software should work 

BOSS ▪ Bharat Operating System Solutions 

C-DAC ▪ Centre for Development of Advanced Computing  

FOSS ▪ Free Open Source Software 

CHAPTER-15 

Affiliate ▪ Business who promotes the products of another business for a commission.  

Blog ▪ An online platform for writing articles about a topic.  
Brick and mortar ▪ The term that refers to a business that has a physical store; opposite of online store.  

Dotcom ▪ Common name for Internet based companies.  
Mobile commerce ▪ Businesses that are conducted through the Internet using mobile phones or other wireless hand-held devices.  

Nascent stage ▪ Initial stage of growth.  

Off-shoring ▪ Company’s work is given to overseas (another country) company 

Out-sourcing ▪ Hiring third party service providers to handle business on behalf.  

Social media ▪ In terms of E-Commerce, a platform for advertising products to targeted consumers  

▪ E.g. Facebook, twitter. 

Tangible form ▪ Physical goods we receive.  

Teleputer  ▪ Fusion of television, computer and telecom networking technologies. 

Word press  ▪ A free, open source online blogging platform. 

CHAPTER-16 

BIN ▪ Bank Identification Number. The first six-digits of credit card number to uniquely identify 

financial institutions.  
Brick and mortar ▪ The term that refers to a business that has a physical store; opposite of online store.  

(CVC2/CVV2) ▪ Card Verification Code and Card Verification Value: A three digit code printed on the 

cardholder signature panel allows e-payments when the card is not physically accessible.  
Credit card 

network / 

processor 

▪ Company responsible for communicating the transaction between the acquirer and the credit 

card issuer. E.g. MasterCard, Visa, Rupay  

Double spend ▪ A type of fraud where same crypto currency is spent in more than one transactions.  

E-wallets ▪ Electronic purses allow users to make electronic transactions quickly and securely 

Gift cards ▪ A magnetic stripe or chip card that holds the value of money to offer as a gift by a E-business  
Internet banking ▪ Internet banking Is the activity of buying or selling of commodities through online services or over the Internet  

PIN ▪ Personal Identification Number. A static number that is assigned to consumers to secure card based payments.  

Point of sale 

(POS) 

▪ Merchant’s electronic device that enables the e-payments. It reads the card information from 

EMV or magnetic strip. 
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CHAPTER-17 

3-D Secure ▪ An additional security layer for online credit and debit card transactions.  

Cipher text ▪ It is the encrypted data usually the output of an encryption algorithm  

Cracker ▪ A person who breaks computer network’s security maliciously to gain access to critical data. 

Cryptanalysis ▪ Analysing a suspecting document for hidden data or cipher text  

Cyber Squatting ▪ Cyber Squatting Is the illegal practice of registering an Internet domain name that might be 

wanted by another person in an intention to sell it later for a profit  

Decipher ▪ A standard algorithm for decrypting data 

Domain name ▪ The website address of an online store, e.g.www.amazon.com  

Encryption ▪ A method of scrambling data using an algorithm to protect / hide from unauthorized access.  

Friendly Fraud ▪ Friendly Fraud Is an intentional falsely claim of a costumer that they really didn’t buy. 

Hacking ▪ Unauthorized intrusion into a computer or a network. That is to say breaking security to gain 

access to a website illegally and intercept confidential information 

Message digest 

(MD) 

▪ Message digest (MD) Is a representation of data in a form of single string of digits using one- 

way hashing formula 
One-Time 

Password (OTP) 
▪ A dynamic password that is valid for one login session or transaction provides a potential 

security for a e-payment transaction. 

PIN  ▪ A static number that is assigned to consumers to secure card based payments.  

Traffic ▪ An indicator that marks the number of visitors for a particular site. 

CHAPTER-18 

HTML ▪ HTML stands for Hyper Text Mark-up Language. This language is designed for creating websites. 

PHP ▪ PHP is server-side scripting language. 

ECHO ▪ Echo statement is used to display output in PHP. 

WAMP ▪ WAMP is abbreviation for “Windows, Apache, MySQL, and PHP”. 
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CHAPTER 1 TO 18 TWO MARK BOOK BACK & PUBLIC QUESTION WITH ANSWERS 
 CHAPTER – 1 (Multimedia) 
1. Define Multimedia.  (S-2020, M-2023) 

❖ The word multimedia consists of two words “multi” and “media. 
❖ Multimedia is a computer based presentation technique that inter corporates text, images, sound, video and animation. 

2. List out Multimedia Components: 

❖ Multimedia has five major components like 1.text, 2.images, 3..sound, 4.video and 5.animation 

3. Classify the TEXT component in multimedia : 

Types: 1.Static Text      2.Hyper Text 

1.Static Text : 

❖ Static text, the text which will remain static as a heading or in a line, or in a paragraph.   

2.Hypertext : 

❖ A hypertext is a system which consists of nodes, the text and the links between the nodes, which defines the path the 

user need to follow for the text access in non-sequential ways 

4. Classify the IMAGE component in multimedia. 

❖ Images acts as a vital component in multimedia.  

1.Raster or Bitmap Images :  

❖ The common and comprehensive form of storing images in a computer is raster or bitmap image.  

2.Vector Images : 
❖ Drawing elements or objects such as lines, rectangles, circles and so on to create an images are based on Vector images   

5. Define Animation (J-2023) 

❖ Animation is the process displaying still images so quickly so that they give the impression of continuous movement.    

❖ Types:  1. Path Animation 2. Frame Animation   

1. List out video file formats with expansion. (M-2022) 

1) AVI (Audio/Video Interleave)  2) MPEG (Moving Picture Experts Group) 

3) WMV(Windows Media Video) 4) MOV(Quick time format) 4) FLV (Adobe Flash Video Format) 

2. Define – Multimedia production (J-2022) 

❖ Adequate time and efficient planning is required for multimedia production.  

❖ This assures that the project will proceed smoothly and ensures that the information reaches the target audience. 

3. List out audio file formats: (M-2024) 

1) WAV (Waveform Audio File Format) 2) MP3 (MPEG Layer-3 Format) 3) OGG     

4) WMA (Windows Media Audio) 5) RA (Real Audio Format) 6) AIFF (Audio Interchange File Format) 

 CHAPTER – 2 (An Introduction to Adobe Page maker) 
1. What is desktop publishing? (S-2020)                                                                         

❖ Desktop publishing (abbreviated DTP) is the creation of page layouts for documents using DTP software. 

2. Give some examples of DTP software. 

❖ The popular DTP software are ,1.Adobe PageMaker, 2.Adobe In Design, 3.QuarkXPress, etc 

3. Write the steps to open PageMaker. 

❖ We can open Adobe PageMaker using the command sequence , 

❖ Start→ All Programs → Adobe → Page maker 7.0 → Adobe PageMaker 7.0.    

4. How do you create a New document in PageMaker? 

To create a new document, 

❖ 1. Choose File > New in the menu bar. (or) Press Ctrl + N in the   keyboard. 

     Now Document Setup dialog box appears. 

❖ 2. Enter the appropriate settings for your new document in the Document Setup dialog box. 

❖ 3. Click on OK 

5. What is a Pasteboard in PageMaker? (J-2023) 

❖ A document page is displayed within a dark border. 

❖ The area outside of the dark border is referred to as the pasteboard.  

❖ Anything that is placed completely in the pasteboard is not visible when you print the document.  

❖ The use of pasteboard is to temporarily hold elements while designing your document. 

6. Write about the Menu bar of PageMaker. 

❖ Menu bar contains the following menus File, Edit, Layout, Type, Element, Utilities, View, Window, and Help.  

❖ When you click on a menu item, a pull down menu appears.  

❖ There may be sub-menus under certain options in the pull-down menus. 

7. Differentiate Ellipse tool from Ellipse frame tool. 
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8. What is text editing? (M-2020) 

❖ Editing means making changes to the text. 

❖ Editing may be inserting and deleting words and phrases, correcting errors, and moving and copying text to 

different places in the document. 

9. What is threading text blocks? (J-2024) 

❖ A Text block can be connected to other text block so that the text in one text block can flow into another text block. 

❖ Text blocks that are connected in this way are threaded. 
10 How do you insert a page in PageMaker? 

1. Go to the page immediately before the page you want to insert. 

2. Choose Layout > Insert Pages in the menu bar.  

    The Insert Pages dialog box appears. 

3. Type the number of pages you want to insert. 

4. To insert pages after the current page, choose ‘after’ from the pop-up menu. 

5. Click on Insert button 

6. The new pages are inserted in your publication. 

1. What is threading text? (J-2022) 

❖ The process of connecting text among Text blocks is called threading text. 

2. How will you delete text in PageMaker file? (M-2020) 

To delete a character, do the following : 

(i) Position the insertion point to the left of the character to be deleted. 

(ii) Press Delete key on the keyboard. (or) 

(iii) Position the insertion point to the right of the character to be deleted. 

(iv) Press Backspace key on the keyboard. 

3. Write the command and shortcut key to cut and paste a block of a document in Abode PageMaker. (M-2022) 

❖ The selected text can be easily cut and pasted in the required location. 

To cut and paste text: 

1. Select the text to be moved.  2. Choose Edit > Cut in the menu bar. 3. Insertion point is moved to the place where 

    the text is to be pasted.  4. Choose Edit > Paste in the menu bar. 

The following keyboard shortcuts can be used to move text: 1.Ctrl + X → to Cut  2. Ctrl + V → to Paste 

4. What is text blocks? (M-2023) 

❖ A Text block contains text you type, paste or import. 

❖ You can’t see the borders of a text block until you select it with the pointer tool. 

 CHAPTER  -  3 (Introduction to Database Management System) 
1. Define Data Model and list the types of data model used.                            

❖ A data model shows the logical structure of a database, including the relationships and constrains that determine 

how data can be stored and accessed.  

❖ Types of data model: 1)Hierarchical   2)Network  3)Relational  4)Object-oriented      

2. List few disadvantages of file processing system. 

1.Data Duplication: 
❖ Same data is used by multiple resources for processing, thus created multiple copies of same data wasting the spaces. 

2.High Maintenance : 

❖ Access control and verifying data consistency needs high maintenance cost. 

3.Security:  

❖ Less security provided to the data.  

3. Define Single and multivalued attributes.   

Single Valued Attributes Multi Valued Attributes 

❖ A single valued attribute contains only one value for the 

attribute and they don’t have multiple numbers of values.  
❖ A multi valued attribute has more than one value 

for that particular attribute. 

❖ Example : Age ❖ Example : Degree 
 

4. List any two DDL and DML commands with its Syntax.  (M-2024) 

DDL  

Commands 

1.CREATE  Used to create database or tables 

Syntax :  CREATE database data base name; 

2. DROP   Deletes a database or table. 

Syntax :      DROP database data base name; 

DML 

Commands 

1. INSERT   Adds new rows into database table. 

Syntax :              

❖ INSERT INTO table name (column1, column2,   column3) VALUES (value1, value2, value3); 

2. DELETE  Deletes the records from the table. 

Syntax  :              

❖ DELETE from table name WHERE  Column name=”value”; 
 

5. What are the ACID properties?  The acronym stands for Atomicity, Consistency, Isolation and  Durability 

www.Padasalai.Net                                                                     www.Trb Tnpsc.Com

Kindly Send Me Your Key Answer to Our email id - Padasalai.net@gmail.com

www.P
ad

as
al

ai
.N

et

www.P
ad

as
al

ai
.N

et

https://www.padasalai.net/
https://www.padasalai.net/


 

49 
                                             PREPARED BY...,    B.MOHAMED YOUSUF   M.C.A., B.Ed..,    (PG   ASST IN COMPUTER SCIENCE) 

                                             [yousufaslan5855@gmail.com] 

 

6. Which command is used to make permanent changes done by transaction? 

❖ COMMIT;    (or)        1.COMMIT -       Permanent save into database 

7. What is view in SQL? 

❖ View – A set of stored queries. 

❖ A VIEW in SQL is a logical subset of data from one or more tables. 

❖ View is used to restrict data access. 

❖ A view is more than a SQL statement that is stored in the database with an associated name 

❖ View in SQL is a kind of virtual table. 

8. Write the difference between SQL and My SQL. (M-2022) 

SQL My SQL 

❖ SQL is a Structured query language is not a database ❖ MySQL is a database management system. (Software) 

❖ Used to access the database. ❖ Allows managing relational databases. 

❖ It is used in the accessing, updating and 

manipulation of data in the database. 

❖ It is an RDBMS that allows keeping the data that 

exists in a database organized. 
 

9. What is Relationship and List its types. (J-2022) 

❖ In Entity Relationship Model, relationship exists between two entities.  

❖ 1.One-to-One relationship 2.One-to-Many relationship 3.Many-to-Many relationship 
10 State few advantages of Relational databases. (M-2023) 

❖ 1) High Availability, 2) High Performance, 3) Robust Transactions and support 

❖ 4) Ease of management,  5) Less cost      

1. What is primary key? (M-2023) 

❖ This key of relational table identifies each record in the table in a unique way 

2. Write a short note on cardinality in Data Base Management System. (M-2024) 

❖ It is defined as the number of different values in any given table column. 

❖ It is defined as the number of items that must be included in a relationship. 

Example :   

❖ Number of entities in one set mapped with the number of entities of another set via the relationship.  

❖ Three classifications in Cardinality are one-to-one, one-to-many and Many-to-Many 

 
 CHAPTER – 4 (PHP : Hypertext Pre-Processor ) 
1. What is PHP? 

❖ PHP stands for PHP: Hypertext pre-processor. 

❖ PHP is a server –side scripting language, which means that the code is executed on the server rather than in the 

user’s browser. 

❖ It is widely used for web development. 

2. What is a dynamic web page? 

❖ A dynamic webpage is a page whose content can change each time it is viewed. 

❖ It is particularly well-suited for creating database-driven websites, because it can be used to interact with databases 

in a very efficient way. 

3. What are the different types of comments in PHP? Give an example. 

❖ There are two types of comments in PHP. 

1.Single line comment: 

❖ To add a single line comment to our code, we precede the comment with # or // 

Example: # This is a comment // This is also comment 

2.Multiline comment: 

❖ To add multiple lines comment, we enclose the comment in /*…*/ 

Example:  /* This an examples of a multi-line comment */ 

4. List any four operators in PHP. 

❖ The types of operators in PHP are 1.Arithmetic 2.Assignment 3.Comparision 4.Logical 

5.Increment/decrement 6.String operators 

5. What is ‘Echo’ statement used for? Give an example. (J-2024) 

❖ The echo statement is used to output a string or other data to the screen. 

❖ It is a simple and efficient way to display information to the user. 

Example:    echo “Hello, world!”; 

1. Write short note on PHP (S-2020) 

❖ PHP (Hypertext Pre-processor) is a one of the important server side Web and general purpose scripting language 

invented by Rasmus Lerdorf in 1994. 

❖ It is very simple and lightweight open source server side scripting language. 
❖ It can easily embed with HTML and other client side scripting languages like CSS (Cascading Style Sheets) and Java script. 
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2. How many types of Syntax are available in PHP (S-2020) 

❖ Three types of PHP Syntax are available.  

❖ 1. Default Syntax. 2. Short Open Tags. 3. HTML Script embed Tags. 

3. Is PHP a case sensitive language? (M-2022) 

(i) Yes, PHP is a case sensitive language both upper and lower case are treated differently. 

(ii) Example: $x and $X are different variable names. 

4. How to declare variables in PHP? (J-2022)(M-2023) 

❖ Variable name must always begin with a $ symbol. 

EX: $name = “Balu”; $age = 30; $is_admin = true; $prices = array(10, 20, 30); 

5. Define client server architecture (J-2023) 

❖ A server is a computer or a device that provides functionality for the other programs or devices called clients.  

❖ This architecture is called the client server model, and a single over all computation is distribution across multiple 

processes or devices. 

 CHAPTER – 5 (Functions and Arrays IN PHP ) 

1. What is function? 

❖ A function is a collection of code that performs a specific task. 

❖ A functions are an important feature of PHP, and are used to reuse code. 

❖ A function is a block of code that performs a specific task. 

2. What are the different types of functions in PHP? 

❖ In PHP, there are several types of functions that we can use. 

❖ 1.Build-in functions 2.User-defined functions 

3. Write short notes on build-in functions in PHP. 

❖ There are functions that are pre-defined in the PHP language and can be used to perform a variety of tasks, such as 

calculating the length of a string or sorting an array. 

4. What is an array in PHP and what are its main types? 

❖ An array is a special data type. 

❖ It can hold many values under a single variable name. 

❖ An array element can be any type of data. 

❖ Types: 1.Indexed array 2.Associative array 3.Multi-dimensional array. 

5. How do you create an indexed array in PHP? 

❖ by en closing a comma-separated list of values in square brackets (or) 

❖ by using the array () function. 

1. Write a note on Parameterized functions in PHP. (M-2022) 

(i) PHP Parameterized functions are the functions with parameters or arguments. 

(ii) Required information can be shared between function declaration and function calling part inside the program. 

2. Define – Associative array (J-2022) 

❖ An associative array is a data structure that stores a collection of key-value pairs.  

❖ The keys are used to identify the values, and the values can be of any data type.  

❖ The keys in an associative array are often called “labels” because they label or identify the corresponding values. 

3. How to you call a function in PHP? (M-2024) 

❖ Calling a function is another name for executing the function.  

❖ A function is called simply by using the function name, along with an argument list, as a statement.  

Syntax{ 

 functionName( );  

(or)  

functionName(argument list); 

 CHAPTER – 6 (Conditional Statements IN PHP) 
1. What are the different types of conditional statements in PHP? 

❖ There are several types of conditional statements in PHP. 

❖ They are,1) if Statement 2) if...else Statement 3) if...else if....else  4) switch statement. 

2. Write the syntax for an if statement in PHP. 

if (condition)  

{ 

    // code to be executed if condition is true;  

} 

3. What is the purpose of if…else statement? 

❖ The if.. else statement is a conditional statement in PHP. 

❖ It executes one block of code if a condition is true and another block of code if the condition is false. 
❖ If the condition is true then the True-block is executed and if the condition is False then the False-Block is executed. 
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4. Write the syntax for an if … else statement in PHP. (J-2022, J-2023, J-2024) 

if (condition) 

{ 

     // True-block; 

} 

else 

{ 

      // False-block;    

} 

5. What is the role of the break statement in a switch statement?  

❖ The if ... else statement is a conditional statement in PHP.  

❖ It executes one block of code if a condition is true and another block of code if the condition is false. 

1. Write short notes on if-else Statement in PHP. (S-2020) 

❖ The if ... else statement is a conditional statement in PHP.  

❖ It executes one block of code if a condition is true and another block of code if the condition is false. 

 CHAPTER – 7 (Loops IN PHP) 
1. What is the purpose of a loop in PHP? 

❖ A loop is a control structure. 

❖ It executes a set of instructions repeatedly for a certain number of times or until a certain condition is met. 

2. Write the syntax for an ‘for’ loop in PHP. 

for (initialization: condition; increment /decrement)  

{ 

     //code to be executed; 

}      

3. Write the syntax for an ‘while’ loop in PHP. (J-2023) 

while (condition is true)  

{ 

code to be executed; 

 }              

4. How is the ‘condition’ in a while loop is evaluated? 

❖ The condition is evaluated at the beginning of each iteration of the loop. 

❖ If it is true, the code block is executed. 

❖ If it is false, the loop is terminated 

5. What is the output of the following code snippet?       Output 

$i = 1;                                                                                      1 

While ($i < = 5)                                                                       2 

{                                                                                               3 

echo $i. “<br>”;                                                                       4 

$i++;                                                                                         5 

} 

1. Write the syntax for: For each loop in PHP. (M-2020) 

foreach ($array as $value)  

{  

  //code to be executed;  

} 

2. Write the Syntax of Switch... case statement in php. (M-2022) 

switch (expression) 

{  

  case value1: 

       //code to be executed if  expression = value1; 

   break; 

   case value2: 

      //code to be executed if  expression = value2; 

   break; 

default: 

      //code to be executed if expression is not equal to any of the values;   

} 

3. List out the looping structure in PHP. (M-2022)   (i) for Loop (ii) foreach Loop  (iii) While Loop  (iv) Do While Loop 

4. What is for each loop in PHP? (J-2022) 

❖ The foreach loop is used to iterate over elements of an array. 

❖ The foreach loop will iterate over each element of the array and assign the key of the element to the $key variable 

and the value of the element to the $value variable. 
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5. Differentiate – while loop and do.. while loop in PHP. (M-2024) 

while Do..while loop 

❖ While loop is called as the entry check loop ❖ Do..While loop is called as the exit- check loop 

❖ The while loop is used to execute a block of code while a 

certain condition is true. 

❖ The do...while loop is similar to the while loop, except 

that the code block is always executed at least once, even 

if the condition is false. 

❖ The condition is evaluated at the beginning of each 

iteration of the loop. If it is true, the code block is 

executed. If it is false, the loop is terminated. 

❖ The condition is evaluated at the end of each iteration of 

the loop. If it is true, the code block is executed again. 

If it is false, the loop is terminated. 
 

 CHAPTER -  8 (Forms and Files) 
1. What is the main objectives of PHP and HTML form controls? 

❖ Main objectives of PHP and HTML form controls are to collect data from users. 

❖ In the web development, user access websites or web pages from remote client machine and feed the data to server. 

❖ These data are collected via HTML form controls like text, drop drown and radio button. 

2. What the basic HTML form controls? 

❖ 1.Text inputs 2.Buttons 3.Checkbox 4.Radio box 5.File select 6.Form Tag 

3. How are the data collected via HTML form controls send to the server? 

❖ In the web development, user access websites or web pages from remote client machine and feed the data to server. 

❖ These data are collected via HTML form controls like text, drop drown and radio button etc. and send to server 

using server side programming like PHP.  

4. What is form Validation in PHP? (M-2020, M-2023) 

❖ Validation is a process of checking the input data submitted by the user from client machine. 

❖ There are two types of validation available in PHP.  

❖ They are , client-side , server side validation. 

5. What are the two types of validation available in PHP? 

❖ There are two types of validation available in PHP. 

❖ 1.Client-Side validation 2.Server Side Validation. 

1. Write short notes about fopen () function in PHP. (M-2020) 

❖ fopen() is a system function available in PHP.  

❖ This function helps to open a file in the server.  

❖ It contains two parameters one for the file and the other one specifies in which mode the file should be opened 

(Read/Write). 

2. Differentiate Check box and Radio button. (M-2022) 

(i) A checkbox allows the user to select more than one item, while a radio button only can indicate a single selection at a time. 

(ii) Also with a radio button, if the user selects a different choice their previous becomes deselected automatically. 

3.  Write the syntax to open file function in PHP with an example (M-2024) 

Syntax:  

❖ $file_Object= fopen(“FileName”, “Read/WriteMode”) or die(“Error Message!”); 

❖ $file_Object= fopen(“FileName”, “Read/WriteMode”) 

Example: 

 <?php  

$myfile = fopen(“Student.txt”, “r”) or die(“Unable to open file!”);  

?> 

 CHAPTER – 9 (Connecting PHP and MYSQL) 
1. What are the MySQLi function available PHP?                                      

1) mysqli_connect() Function  2) mysqli_close() Function  3) mysqli_query () Function. 

2. What is MySQLi function? (J-2024) 

❖ MySQLi is extension in PHP scripting language which gives access to the MYSQL database 

❖ Functions are available for MySQL Database connectivity and executing SQL queries. 

3. What are the types MySQLi function available PHP?  

1) Database Connections 2) Managing Database connections 3) Performing Queries  4) Closing connections 

4. Difference between Connection and Close function? 

Connection Close function 

❖ Connect to Database Server machine via PHP 

scripting language using Mysqli_connect() 

Function. 

❖ Mysqli_close() Function is used to close an existing 

opened database connection between PHP scripting 

and MySQL Database Server. 

❖ It requires Four parameters ❖ It requires one parameter. 
Syntax:  

❖ mysqli_connect(“Server Name “,”User 

Name”,”Password”,”DB Name”); 

Syntax:  

❖ mysqli_close(“Connection Object”); 
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5. Give few examples of MySQLi  Queries. 

$con=mysqli_connect(“localhost”,”my_user”,”my_password”,”Student_DB”); 

Eg:1 

$sql=”SELECT student_name,student_age FROMstudent”; 

mysqli_query($con,$sql); 

6. What is Connection string? 

❖ The mysqli_connect function uses these variables to connect Database server to PHP.  

❖ If connection gets fail, output will be printed with MySQL error code.  

❖ Otherwise connection is success. 

❖ The variables used to connect to the Database server are, 

$servername Database Server Server IP address  

$username Database Server User Name  

$password Database Server Password 

$DB_Name Database Name 
 

 CHAPTER – 10 (Introduction to Computer Networks) 
1. What is a Computer Network?                                                                        

❖ A set of computers connected together for the purpose of sharing resources is called as computer networks. 

❖ Internet is the most common resource shared on today. 

2. Write a short note on internet. 

❖ Internet stands for International Network. 

❖ Internet is simply defined as the World Wide Web connection of individual networks which operated by academic, 

industry, government, and private parties. 

3. What are the common uses of computer network? (S-2020, M-2024) 

❖ 1.Communication 2.Resource sharing 3.Information sharing 

4. What is node in Computer network? (J-2024) 

❖ A computer which is connected to a network is called as node. 

❖ The data originates and terminates at these particular nodes is called as a source and destination. 

1. What is flame wars? (M-2020) 

❖ Flame wars are nothing that lengthy exchange of angry or abusive messages between users of an online forum or 

other discussion area. 

2. Write the difference between wired and wireless networks. (M-2022) 

Wired networks Wireless networks 

A Wired network system connected with network cable . 

Ex: Speakers, CCTV, printers, outdoors, and scanners 

etc., with cables. 

A Wireless network is connecting devices 

like tablets(tab), indoor cameras and E-readers, 

etc., without cables (WiFi). 
 

3. What are the ways in which network are connected at home? (M-2023) 

❖ Network at home were connected in two ways  1.Wired Network  2.Wireless Network 

 CHAPTER – 11 (Network Examples and Protocols) 
1. Define Intranet. (J-2023)                                                                                                                                                                    

❖ It is a private network within an enterprise to share company data and computing resources between the employees. 

❖ It may consist of many interlinked local area networks. 

❖ It includes connections through one or more gateway computers to outside internet. 

2. What is the uses of mobile networks? 

❖ Mobile networking assign to the technology supports voice/data, network connectivity using via radio transmission solution.  

❖ Wireless use both data and voice are being transmitted over both circuit via switched networks and packet-switched networks. 

❖ Mobile network is used for wireless communication which is made up of voice, data, image and text message. 

3. List out the benefits of WIFI (M-2023) 

1) It provides mobility. 2) It provides connection to Internet.3) Flexibility of LAN.   

4) Ensures connectivity.5) Low cost, high benefits. 

4. Expand HTTP, HTTPS, FTP  

1.HTTP    :Hypertext Transfer Protocol     2.HTTPS  :Hyper Text Transfer Protocol Secure   

3.FTP       :File Transfer Protocol                

1. Write features of Mobile Networks. (S-2020)(J-2022)(J-2023) 

❖ Less consumption of power is used by mobile devices comparing with a single transmitter or satellite often cell 

towers were nearer. 

❖ Huge capacity than a large transmitter, at single frequency can be used for different or many links as long as they 

are in different in cells. 

2. What are the layers available in TCP/IP reference model? (M-2024) 

1. Network Access Layer - concerned with building packets.  2. Internet Layer - describes how packets are to be delivered.  

3. Transport Layer - ensure the proper transmission of data.   4. Application Layer - application network processes. 
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 CHAPTER – 12 (DNS - Domain Name System) 
1. List any four domain names.    

❖ TLD – Top Level Domains: These are at the highest level in the DNS structure of the Internet. 

❖ ccTLD: country code Top level domain 

❖ IDN ccTLD – Internationalised country code top-level domains. 

❖ gTLD- Generic Top Level Domain 

Domain Name Meaning 

com Commercial Organisation 

edu Educational Institutions 

gov Government (US) 

mil Military groups 
 

2. What is an IP address? 

❖ Internet Protocol (IP) address is simply the logical address in the network layer. 

❖ IP address is also used to uniquely identify a computer over the network. Two types – IPv4 and IPv6 

3. What is an URL? (M-2023) 

❖ URL (Uniform Resource Locator) is the address of a document on the Internet. 

❖ URL is made up of four parts- protocols, hostname, folder name and file name. 

❖ Each part has its own specific functions. 

4. List out four URLs you know. 

1. https://www.google.com/     2. https://www.facebook.com/ 

3. https://www.padasalai.net/    4. https://www.kalviseithi.com/ 

5. What is a zone? 

❖ A zone is a subset of the Domain namespace generally stored in a file. 

❖ Zone is defined as a group of contiguous domains and sub domains in the Domain Name Space. 

6. What is a resolver? (J-2023, J-2024) 

❖ The resolver is a program which is responsible for initiating the translation of a domain name into an IP address. 

❖ A resolver is stored in the host. 

❖ There is no need of any protocol to form a connection between the resolver and the user program. 

7. Write any four generic top level domain. 

Domain Name Meaning 

com Commercial Organisation 

edu Educational Institutions 

gov Government (US) 

mil Military groups 
 

8. Mention the components of DNS.  1.Name space 2.Name server 3.Zone 4.Resolver 

1. What are the types of URL? (M-2020)(J-2022)   (i) Absolute URL (ii) Relative URL                

 CHAPTER – 13 (Network Cabling) 
1. Write note on co-axial cable. 

❖ This cable is used to connect the television set to home antennas. 
❖ It has a copper wire inside and insulation is covered on the top of the copper wire to provide protection to the cable. 

❖ This cable used to transfer the information at 10 mbps speed. 

❖ The cable is classified into thin-net and thick-net cables.  

2. What are the uses of USB cables?  

❖ The Universal Serial Bus are used to connect keyboard, mouse and other peripheral devices. 

❖ Micro USB is a miniaturized version of the USB used for connecting mobile devices such as smart phones, GPS 

devices and digital cameras. 

❖ The latest version of USB is USB 3.0 which has the data transfer rate 4.85 Gbps. 

3. What is an Ethernet port? 

❖ The Ethernet port is the jack where the Ethernet cable is to be connected. 

❖ This port will be there in both the computers and the LAN port. 

4. What is the use of Crimping tool? 

❖ The crimping tool is a physical tool which is used to connect the patch wire and the Ethernet connector. 

❖ The crimping tool looks like a small cutting handle with two mould of Ethernet port. 

❖ The tool will puncture the connector and inserts the wire set in the connector. 

5. What are the types of twisted pair cables?  

❖ Two types of twisted pair cables are,1) Unshielded Twisted Pair (UTP)  2) Shielded Twisted Pair (STP) 

6. What is meant by champ connector? 

❖ The RJ-21 connector has 50 pins with 25 pins at one end and 25 pins at the other end. 

❖ RJ-21connector is also called as champ connector or Amphenol connector. 

❖ The RJ-21 interface is typically used for data communication trucking applications. 
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 CHAPTER – 14 (Open Source Concepts) 
1. What is Open Source Software? 

❖ Open Source simply refers to making the source code of the software freely available for users or other developers 

to use and make changes into the original repository or fork the project into and build a new one.  
❖ Open source software is usually created and updated by many programmers around the world and made freely accessible. 

2. What is meant by network simulator? 

❖ A network simulator is a software program that replicates the functioning of a computer network. 
❖ In simulators, the computer network is typically demonstrated with devices, traffic etc. and the performance are evaluated.  

3. What is trace file? (M-2020, M-2023) 

❖ A significant output of simulation is the trace files. 

❖ Trace files can document every incident that happened in the simulation and are used for examination.  

4. Write short notes on NS2. (M-2024) 

❖ NS2 is the abbreviation of NETWORK SIMULATOR version 2. 
❖ It was considered explicitly for exploration in network communication and event driven open-source simulator in computer. 

❖ OTCL and C++ are used to create and run NS2. 

5. Write short note on Open NMS? (J-2024) 

❖ Open NMS (Network Management System) is a free and open-source initiative grade network monitoring and 

network management platform. 

❖ It is established and maintained by a community of users, developers and by the Open NMS Group, it offering 

services, training and support. 

1. Differentiate free source software and open source software. (S-2020) 

Free source software Open source software 

Freeware usually refers to proprietary software that 

users can download at no cost. 

It refers to the software that is developed and tested 

through open collaboration 

But whose source code can not be changed Anyone with the academic knowledge can access, 

inspect, modify and redistribute the source code. 
 

2. Explain BOSS OS. (J-2023) 

❖ BOSS (Bharat Operating System Solutions) Operating System Developed in India by C-DAC (Centre for 

Development of Advanced Computing) helps to prompt the use of Open Source Software in India 

❖ It supports many Indian Languages 

 CHAPTER – 15  (E-Commerce) 
1. Define E-Commerce.                                                                                      

❖ E-Commerce can be described as the process of buying or selling products, services or information via internet. 

❖ E-Commerce is currently one of the most important aspects of Internet era. 

2. Distinguish between E-Business and E-Commerce. 

E-Business E-Commerce 

E-Business entirely depends on the internet for its every 

intra-company and inter-company activities 

E-commerce is commercial transaction through internet. 

E-Business is a superset of E-Commerce E-Commerce is a sub set of E-Business. 
 

3. Differentiate tangible goods and electronic goods with example of your own. 

Tangible goods Electronic goods 

Physical goods we receive via internet Non-Physical goods (Downloaded form) we receive via internet 

Ex: Bags, shoes, Dress materials etc. Ex: Downloading, Antivirus software, Host star app. 
 

4. What is dotcom bubble and dotcom burst? 

Dotcom Bubble  

❖ The Dotcom Bubble was a historic excessive 

growth (excessive assumption) of economy that 

occurred roughly between 1995 and 2000. 

❖ The nasdaq -Composite stock market index, fell 

from 5046.86 to 1114.11. 

❖ This is infamously, known as the Dotcom Crash or 

Dotcom Burst. 

❖ It was also a period of extreme growth in the usage 

and adaptation of the Internet as well. 

❖ This began on March 11, 2000 and lasted until 

October 9, 2002. 
 

5. Write a short note on out-sourcing. 

❖ Out-Sourcing is hiring third party service providers to handle business oh behalf. 

❖ If a company’s work is hired to another company, it would be termed as out-sourcing. 

 CHAPTER – 16 (Electronic Payment Systems) 
1. Define electronic payment system.                                                                

❖ The term electronic payment refers to a payment made from one bank account to another bank account using 

electronic methods forgoing the direct intervention of bank employees. 

❖ An Electronic payment system is a financial arrangement that consists an inter mediator to facilitate transfer of 

money-substitute between a payer and a receiver. 
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2. Distinguish micro electronic payment and macro electronic payment. 

Micro electronic payment Macro electronic payment 

Online payment system designed to allow efficient and 

frequent payment of small amounts. 

Macro electronic payment system support Payment of 

higher value. 

The communication and computational costs are 

minimized here to keep transaction costs very low. 

The security requirements are more rigorous because of 

huge money transactions. 
 

3. Explain the concept of e-wallet. (J-2024) 

❖ Electronic wallets (e-wallets) or electronic purses allow users to make electronic transactions quickly and securely 

over the Internet through smart phones or computers. 
❖ The electronic wallet functions almost the same as a physical wallet in term that it holds our money. 

4. Write a short note on credit card. 

❖ Credit card is an electronic payment system normally used for retail transactions. 

❖ A credit card enables the bearer to buy goods or services from a vendor, based on the cardholder’s promise to the 

card issuer to payback the value later with an agreed interest 

❖ The Company responsible for communicating the transaction between the acquirer and the credit card issuer.  

Example:       1.Visa, 2.Master Card, 3.Rupay 

5. What is smart card? 

❖ The modern version of card based payment is smart cards.  

❖ Smart cards along with the regular features of any card based payment system holds a EMV chip.  

❖ This chip is similar to well-known sim card in appearance but differ in its functionalities. 

 CHAPTER – 17 (E-Commerce Security Systems) 
1. Write about information leakage in E-Commerce.                                      

The leakage of trade secrets in E-Commerce mainly includes two aspects: 

1. The content of the transaction between the vendor and customer is stolen by the third party. 

2. The documents provided by the merchant to the customer or vice versa are illegally used by other. 

❖ This intercepting and stealing of online documents is called information leakage. 

2. Write a short note on typo piracy. 

❖ Typo piracy is a variant of Cyber Squatting. 

❖ Some fake websites try to take advantage of users‟ common typographical errors in typing a website address and 

direct users to a different website. 

❖ Such people try to take advantage of some popular websites to generate accidental traffic for their websites. 

❖ Example:        1. www.goggle.com,         2.www.faceblook.com 

3. Write about phishing  

❖ Phishing is acquiring critical data like login credential through telephone, sms, e-mail or any social media by the 

crackers disguising as authentic.  

4. List the different types of security technologies in E-Commerce. 

1) Encryption technology 2) Authentication technology 3) Authentication protocols 

5. Write about digital signature. 

❖ A digital signature is a mechanism that is used to verify that a particular digital document, message or transaction is authentic. 

 CHAPTER – 18 (Electronic Data Interchange- EDI) 
1. Define EDI. (J-2024)                                                                                           

❖ The Electronic Data Interchange (EDI) is the exchange of business documents between one trade partner and 

another electronically.  
❖ It is transferred through a dedicated channel or through the Internet in a predefined format without much human 

intervention. 

2. List few types of business documents that are transmitted through EDI. 

1) Delivery Notes   2) Invoices  3) Purchase Orders  4) Advance Ship Notice 5) Functional Acknowledgements 

3. Write any two EDI Standards 

1.Basic standards  2.Code standards  3.Message standards  4.Document standards  

5. Management standards  6.Application standards  7. Communication standards. 

1. What is 3D secure electronic transaction? (S-2020) 

❖ 3-D Secure is a secure payment protocol on the Internet.  

❖ It was developed by Visa to increase the level of transaction security, and it has been adapted by MasterCard.  

❖ It gives a better authentication of the holder of the payment card, during purchases made on websites. 

This authentication model comprise 3 domains (hence the name 3D) which are:  

1. The Acquirer Domain 2. The Issuer Domain 3. The interoperability Domain 
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CHAPTER 1 TO 18 TWO & THREE MARK BOOK inside QUESTION & ANSWERS 

 CHAPTER – 1 (Multimedia) 
1.  Multimedia production:  

❖ Adequate time and efficient planning is required for multimedia production.  

❖ This assures that the project will proceed smoothly and ensures that the information reaches the target audience. 

2.  Animation with types: 

❖ Animation is the process of displaying still images so quickly so that they give the impression of continuous 

movement. In animation the screen object is a vector image. 

Path Animation:  Path animation involves moving an object on a screen that has a constant background 

Frame Animation: 

❖ In frame animation, multiple objects are allowed to travel simultaneously and the background or the object also changes. 

3.  Raster Images: 

❖ The common and comprehensive form of storing images in a computer is raster image.  

❖ Raster image is made up of the tiny dots called pixel. Each pixel consists of two or more colors. 

❖ Eg. one bit is two colors, four bits means sixteen colors, eight bits indicates 256 colors, and so on. 

4.  Advantages of Vector images: 

❖ Relatively small amount of data is required to represent the image and thereby only less memory is needed to store.  

❖ Compression techniques are used to reduce the file size of images that is useful for storing large number of images 

and speeding transmission for networked application.  

5.  Animation dimensions: 

❖ Animation may be in two or three dimensional.  

❖ A two dimensional animation, brings an image alive, that occur on the flat X and Y axis of the screen. 

❖ A three dimensional animation it occurs along the three axis X, Y and Z. 

6.  Animation types:  

❖ The two basic types of animations are Path animation and Frame animation. 

7.  Path animation with example: 

❖ Path animation involves moving an object on a screen that has a constant background  

❖ E.g. A cartoon character may move across the screen regardless of any change in the background or the character. 

8.  Frame Animation: 

❖ In frame animation, multiple objects are allowed to travel simultaneously and the background or the object also changes. 

9.  Sound: 

❖ Sound is a meaningful speech in any language and is the most serious element in multimedia, providing the pleasure 

of music, special effects and so on.  

❖ Decibels is the measurement of volume, the pressure level of sound. 

10.  MIDI: 

❖ Musical Instrument Digital Identifier (MIDI) Musical Instrument Digital Identifier (MIDI) is a standard 

communication tool developed for computers and electronic instruments.  

❖ This tool is flexible and easy for composing the projects in multimedia.  

❖ Tools for synthesizing the sound and software for sequencing are necessary for MIDI. 

11.  Digital audio: 

❖ Digital Audio Sampled sound is a Digitized sound.  

❖ A sample of sound is taken and stored every nth fraction of a second as digital information in bits and bytes.  

❖ The quality of this recording depends on the sampling rate.  

❖ Sampling rate is defined as how often the samples are taken and how many numbers are used to represent the value 

of each sample (bit depth, resolution and sample size). 

12.  Video: 

❖ Video is defined as the display of recorded event, scene etc.  

❖ The powerful way to convey information in multimedia applications are embedding of video 

13.  Video types:  

❖ The video can be categorized in two types as analog video and digital video. 

14.  Analog Video: 

❖ In analog video, the video data are stored in any non-computer media like video tape, laser disc, film etc. 

15.  Analog video types:  

❖ Composite and Component Analog Video 

16.  Composite analog video: 

❖ Composite Analog Video has all the video components like brightness, color, and synchronization combined into one signal.  

❖ Thus the quality of the composite video resulted in color blending, low clarity and high generational loss. 

17.  Digital video: 

❖ Digital video is an electronic representation of moving visual images in the form of encoded digital data. 

❖ This is in contrast to analog video where images are displayed in rapid succession. 

18.  List out text editors: Notepad (Windows), Gedit or nano (Unix, Linux), TextEdit (Mac OS X) and so on. 
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19.  TIFF: 

❖ This format is common in desktop publishing world (high quality output), and is supported by almost all software packages.  

❖ Recent versions of TIFF allows image compression, and the format is comfortable for moving large files between computers. 

20.  GIF: 

❖ GIF is a compressed image format. Most of the computer color images and backgrounds are GIF files.  

❖ This file format is best suitable for graphics that uses only limited colors, and it is the most popular format used for 

online color photos.  

❖ 8-bit Color look up table is used by the GIF format to identify its color values.  

❖ This format is supported widely.  

21.  JPEG: 

❖ JPEG is a commonly used method of lossy compression for digital images.  

❖ The degree of compression can be adjusted and it works good with photographs, naturalistic artwork, and similar 

material but functions less on lettering, live drawings or simple cartoons. 

22.  MP3: 

❖ MPEG Layer-3 format is the most popular format for storing and downloading music.  

❖ The MP3 files are roughly compressed to one-tenth the size of an equivalent WAV file 

23.  Variety of audio file formats: 

❖ The most common formats are wave files (.WAV) and MPEG Layer-3 files (.MP3), WMA and RA. 

24.  MPEG (Moving Picture Experts Group):  

❖ MPEG is a standard for generating digital video and audio compression under the International Standards 

Organization (ISO) by the group of people.  

25.  MPEG types: 

❖ MPEG-1, the standard on which Video CD and MP3 are based, 

❖ MPEG-2, the standard that supports products as Digital Television set top boxes and DVD 

❖ MPEG-4, the standard for multimedia and mobile web. 

❖ MPEG-7, the standard for search of audio and visual content.  

❖ Research on MPEG-21 “Multimedia Framework” has started in 2000.  

❖ Simply MPEG is the standards for digital video and audio compression. 

26.  PNG: 

❖ PNG is an extensible file format for the less loss, portable and well compressed storage of raster images.  

❖ PNG acts as replacement for GIF and also replaces multiple common uses of TIFF.  

❖ PNG works good with online viewing applications like World Wide Web.  

❖ So it is fully stream able with a best display option. 

27.  List out multimedia production team: 

❖ Script writer, Production manager, Editor, Graphics Architect, Multimedia Architect and Web Master. 

28.  List out multimedia project testing browsers: 

❖ Internet Explorer, Chrome, Mozilla and Netscape Navigator. 

29.  Delivering the Multimedia Product: 

❖ A multimedia application is delivered in a more effective way by the integration of two mediums CD-ROM/DVD and Internet. 

30.  Multimedia Architect: 

❖ The multimedia architect integrates all the multimedia building blocks like graphics, text, audio, music, video, 

photos and animation by using an authoring software.  

31.  Computer Graphic Artist:  

❖ The role of Computer Graphic Artist is to deal with the graphic elements of the programs like backgrounds, bullets, 

buttons, pictures editing, 3-D objects, animation, and logos etc 

32.  List out social networking sites:  

❖ Social networking sites like Facebook, Whatsapp, Twitter etc. 

 CHAPTER – 2 (An Introduction to Adobe Page maker) 
1.  Threading text:  The process of connecting text among Text blocks is called threading text. 

2.  Delete text in PageMaker file:  

To delete a character, do the following : 

(i) Position the insertion point to the left of the character to be deleted. 

(ii) Press Delete key on the keyboard. (or) 

(iii) Position the insertion point to the right of the character to be deleted. 

(iv) Press Backspace key on the keyboard. 

3.  Shortcut key to cut and paste a block of a document in Abode PageMaker: 

❖ The selected text can be easily cut and pasted in the required location. 

To cut and paste text: 

1. Select the text to be moved.  2. Choose Edit > Cut in the menu bar.  

3. Insertion point is moved to the place where the text is to be pasted.  4. Choose Edit > Paste in the menu bar. 

The following keyboard shortcuts can be used to move text: 1.Ctrl + X → to Cut  2. Ctrl + V → to Paste 
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4.  Text blocks:  

❖ A Text block contains text you type, paste or import. 

❖ You can’t see the borders of a text block until you select it with the pointer tool. 

5.  Resize a Text Block in PageMaker:  

❖ When you select a text block with the Pointer tool, the block’s boundaries become visible.  

❖ Two handles are seen above and below the text block. These handles are called Windowshades. 

❖ There is a dark square on both ends of the handle. These are used to change the size of the text block. 

6.  Tool box Show & Hide: 

Show: 1. Click on Window. The Window menu will appear.  2. Click on Show tools. 

Hide:  1. Click on Window. The Window menu will appear.  2. Click on Hide tools to hide the toolbox. 

7.  Keyboard shortcuts: 

1) Pointer- F9,            2) Rotating- Shift + F2,  3) Line - Shift + F3, 4) Rectangle - Shift + F4  

5)Ellipse - Shift + F5 6)Polygon- Shift + F6     7) Hand- Shift + Alt + Drag Left mouse button   

8) Text- Shift + Alt + F1   9) Cropping-Shift + Alt + F2, 10) Constrained Line- Shift + Alt + F3, 

11) Rectangle Frame - Shift + Alt + F4 

8.  Scroll bars:  

❖ Scrolling is the process of moving up and down or left and right through the document window 

9.  Scroll bar types: 

❖ There are two scrollbars namely Vertical and Horizontal scroll bars for scrolling the document vertically or 

horizontally. 

10.  Ruler:  Show and hide. 

❖ Rulers There are two ruler bars. One is at the top and the other is at the left side.  

To show the ruler:  

1. Click on View. The View menu will appear.  

2. Click on Show Rulers. Rulers appear along the top and left sides of the document window.  

To hide the ruler:  

1. Click on View. The View menu will appear.  2. Click on Hide Rulers to hide the rulers. 

11.  Undo Command: 

❖ The Undo command is used to reverse the action of the last command.  

❖ To reverse the last command, click on Edit>Undo in the menu bar (or) press Ctrl + Z in the keyboard. 

12.  Copying and Moving Text:  

❖ The Copy and Paste commands of PageMaker can be used to copy text from one location in a document and paste it 

at another location.  

❖ The Cut and Paste commands can be used to move text from one position in a document to the other.  

❖ The Cut command deletes the selected text from its original position.  

13.  Resizing a Text Block  (or) Window shades: 

❖ When you select a text block with the Pointer tool, the block’s boundaries become visible.  

❖ Two handles are seen above and below the text block.  

❖ These handles are called Window shades.  

❖ There is a dark square on both ends of the handle.  

❖ These are used to change the size of the text block 

14.  Resize the text block: 

1. Click on the Pointer tool.  

2. Click either the left or right corner handle on the bottom of the text block and drag.  

     When you release the mouse button, the text in the text block will reflow to fit the new size of the text block. 

3. A red triangle in the bottom window shade means there is more text in the text block than is visible on the page.  

    Drag the window shade handle down to show more text. 

15.  Save a document with a new name or in a different location:  

1. Choose File > Save As in the menu bar. (or) Press Shift + Ctrl + S in the keyboard.  

    Now Save Publication dialog box will appear.   

2. Type a new name or specify a new location.  3. Click the Save button. 

16.  Closing a Document: 

❖ After a document is saved, it is not closed.  

❖ It remains open so that the user can continue working.  

❖ When the work is finished, the user should save and close the document.  
❖ After saving, the document can be closed using the File > Close command in the menu bar (or) Ctrl +W in the keyboard 

17.  Opening an existing Document: 
1. (a) Choose File > Open in the menu bar (or) Click on the Open icon ( ) in the Tool bar (or Press Ctrl + O in the Keyboard.  

     A Open Publication dialog box  appears on the screen. 

2. The file name is given in the File name list box. The name of the file to be opened can be chosen from the list, which is displayed.  

3. Then click on the Open button. Now the required file is opened. 
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18.  Scrolling the Document: 

1. To scroll left and right the left and right arrow respectively should be clicked. 

2. To scroll up and down the up and down arrow respectively should be clicked.  

3. To scroll a relative distance in the document the scroll box should be drawn up or down. 

19.  Separating Text from the Frame: 

1. Click the frame with the Pointer tool.  

2. Choose Element > Frame > Separate Content in the menu bar.  

    The text will not appear in the frame. It will be separated from the frame. 

   (b) Click on the Save icon( ) in the Tool bar. (or) Press Ctrl + S in the Keyboard. (c) A Save Publication dialog box. 

20.  Magnify part of a page by dragging:  

1. Select the zoom tool.  

2. Drag to draw a marquee around the area you want to magnify.  

To zoom in or out while using another tool:  

❖ Press Ctrl+Spacebar to zoom in.  

❖ Press Ctrl+Alt+Spacebar to zoom out. 

21.  Character Formatting using the Control Palette: 

1. Click on Window > Show Control Palette sequence in the menu bar. (or)  

2. Press Ctrl + ‘ in the keyboard. Now the Control Palette appears on the window. 

22.  Modify character attributes using the Character Control Palette:  

1. Select the text you want to modify.  

2. Make the appropriate changes in the Control palette. 

 
23.  Changing Text Colour:  

You can change the colour of the text. Your design may look beautiful if you choose a text colour other than black.  

To colour characters  

1. Select the text you want to colour.  2. Choose Window > Show Colors in Menu bar.   

    The Colors palette appears. Click the colour you want to apply to the selected text.  

❖ The characters change to the colour you selected in the palette. 

24.  List out four main drawing tools: 

❖ Line tool, Rectangle tool, Ellipse tool and Polygon tool are four main drawing tools. 

25.  Drawing Polygon:  

1. Click on the Polygon tool from the toolbox. The cursor changes to a crosshair.  

2. Click and drag anywhere on the screen. As you drag, a Polygon appears.  

3. Release the mouse button when the Polygon is of the desired size. 

26.  Filling Shapes with Colors and Patterns: 

1. Draw a rectangle using Rectangle tool. 2. Select the rectangle.  

3. Choose Window > Show colors in the menu bar. (or) Press Ctrl + J Now Colors palette appears.  

4. Click on the required colour from the Colors Palette. 5. The rectangle will be filled with the colour 

27.  Removing Pages: 

1. Choose Layout > Remove Pages in the menu bar. The Remove Pages dialog box appears 

2. Type the page range you want to remove. 3. Click on OK button. 

28.  Header and footer: 

Header: Text that is repeated at the top of each page.  

Footer: Text that is repeated at the bottom of each page 

29.  Symbol in page maker:  

❖ A sign or a special character that can be inserted in a PageMaker document 

 CHAPTER  -  3 (Introduction to Database Management System) 
1.  Primary key:  

❖ This key of relational table identifies each record in the table in a unique way 

2.  Attributes in PHP:  

❖ 1.Key Attribute: Generally a key attribute describes a unique characteristic of an entity. 

❖ 2.Simple Attribute:The simple attributes cannot be separated it will be having a single value for their entity.  

❖ 3.Composite Attributes: 

The composite attributes can be subdivided into simple attributes without change in the meaning of that attribute. 

❖ 4.Single Valued Attributes: 

A single valued attribute contains only one value for the attribute and they don’t have multiple numbers of values.  

❖ 5.Multi Valued Attributes: A multi valued attribute has more than one value for that particular attribute. 

3.  Popular database management system: MySQL, Oracle 

4.  Features of DBMS:Giving protection to data, user-friendly for users etc, 
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5.  Definition: DBMS 

❖ “A database management system (DBMS) is system software for creating and managing databases.  

❖ The DBMS provides users and programmers with a systematic way to create, retrieve, update and manage data.” 

6.  What type of data is stored in a database?  

❖ In a database, we would be grouping only related data together and storing them under one group name called table.  

❖ This helps in identifying which data is stored where and under what name. 

7.  Concurrent transaction: 

❖ Isolation property is needed during concurrent transaction.  

❖ When multiple users do the transactions by accessing same object at the same time, the transaction is known as 

concurrent transaction. 

8.  Degree of Consistency: 

❖ To prevent the conflict in database update, the transactions are isolated from other user and serialized.  

❖ This is also known as Degree of Consistency 

9.  Concurrency Control and Locking:  

❖ It is the DBMSs mechanism used for data sharing.  

❖ When the same data is shared among multiple users, proper access control is needed and privilege of changing the 

applications data item is controlled through Locking. 

10.  Advantages of hierarchical model: 

Advantages: 1.less redundant data, 2.efficient search, 3.data integrity and 4.security. 

Limitations: 1.Complex to implement and 2.difficulty in handling many to many relationships. 

11.  Advantage & limitations of network model: 

Advantages            : 1. Ability to handle more relationship types. 

                                 2.  Easy data access, 3.Data integrity and 4.Independence.  

Limitation             : 1. Difficulty in design and maintenance. 

12.  Components of network model: 

(i) Network schema: Schema defines all about the structure of the database. 

(ii) Sub schema: Controls on views of the database for the user 

(iii) Language : Basic procedural for accessing the database 

13.  Terminologies of relational model: 

Instance : A table consisting of rows and columns 

Schema  : Specifies the structure including name and type of each column. 

                 A relation (table) consists of unique attributes (columns) and tuples (rows). 

14.  Object-oriented database model: 

❖ Incorporates the combination of Object Oriented Programming (OOP’s) concepts and database technologies. 

❖ Practically, this model serves as the base of Relational model.  

❖ Object oriented model uses small, reusable software known as Objects. 

15.  List out RDBMS Jargons:  

❖ Database, Tables, Tuple, Attribute, Schema and Key 

16.  Relational database: 

❖ Any database whose logical organization is based on relational data model is known as Relational Database. 

17.  Examples of RDBMS: MySQL, oracle and Microsoft Access. 

18.  SQL supporting platform:  

❖ Windows, Linux and MAC Operating Systems. 

19.  List out other relational databases: Oracle, MS SQL Server and MS Access. 

20.  Table: 

❖ In relational database model, table is defined as the collection of data organized in terms of rows and columns.  

❖ Table is the simple representation of relations 

21.  Column or attribute: 

❖ The table consists of several rows and columns.  

❖ Table can be divided into smaller parts, in terms of columns.  

❖ Each column is known as attributes. 

❖ The vertical entity in a table is known as Attribute or Column. 

22.  Row or record or tuple: 

❖ A single entry in a table is called as Row or Record or Tuple.  

❖ Set of related data’s are represented in a row or tuple.  

❖ The horizontal entity in a table is known as Record or row. 

23.  Key or primary key: 

❖ The candidate key that is chosen to perform the identification task is called the primary key and any others are Alternate keys.  

❖ Every tuple must have, by definition, a unique value for its primary key. 

24.  Composite primary key: 

❖ A primary key which is a combination of more than one attribute is called a composite primary key. 
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25.  Foreign Key: 

❖ A foreign key is a “copy” of a primary key that has been exported from one relation into another to represent the 

existence of a relationship between them.  
❖ A foreign key is a copy of the whole of its parent primary key i.e if the primary key is composite, then so is the foreign key. 

26.  Super key: 

❖ An attribute or group of attributes, which is sufficient to distinguish every tuple in the relation from every other one 

is known as Super Key. 

27.  Candidate key or minimal super key: 

❖ Each super key is called a candidate key.  

❖ A candidate key is selected from the set of Super Key.  

❖ While selecting candidate key, redundant attributes should not be taken.  

❖ The candidate key is also known as minimal super keys. 

28.  Composite or compound key: 

❖ A key with more than one attribute to identify rows uniquely in a table is called Composite key.  

❖ This is also known as Compound Key. 

29.  Attributes: 

❖ An attribute is the information about that entity and it will describe, quantify, qualify, classify, and specify an entity.  

❖ An attribute will always have a single value, that value can be a number or character or string. 

30.  Attributes types: 

1. Key Attribute 2. Simple Attributes 3. Composite Attributes 4. Single Valued Attribute 5. Multi Valued. 

31.  Entity types: 

1. Strong Entity 2. Weak Entity 3. Entity Instance 

32.  List of commonly used databases: 

● DB2 ● MySQL ● Oracle ● PostgreSQL ● SQLite ● SQL Server ● Sybase 

33.  Web or light databases: 

❖ Light databases were able to handle all the issues raised by the network.  

❖ So all the light databases that supports the web applications are also known as Web Databases. 

34.  MySQL – Administration Responsibilities:  

❖ In general there exists a role known as Database Administrators (DBA’s) who takes care of configuration, 

installation, performance, security and data backup.  

❖ DBA’s posses the skills on database design, database queries, RDMS, SQL and networking.  

❖ The primary task is the creation of new user and providing them with access rights. 

35.  List out software tools: 

1,PHPMYADMIN 2.MYSQL Workbench 3.HeidiSQL 

36.  List out popular Desktop Application tools: 

❖ The popular Desktop Application tools are MySQL Workbench and HeidiSQL. 

37.  Features of PHPMYADMIN: 

❖ Web interface, importing data from CSV and exporting data to various formats.  

❖ It generates live charts for monitoring MySQL server activities like connections, processes and memory usage.  

❖ It also helps in making the complex queries easier. 

38.  Features of HeidiSQL: 

❖ Monitoring server host, server connection, Databases, Tables, Views, Triggers and Events. 

39.  Designing databases: 

❖ The process of creating, implementing and maintaining the enterprise data in a system is known as Designing of databases. 

40.  Major parts that forms a databases: 

❖ Tables - similar to an excel sheet, containing multiple rows and columns.  

❖ Where each row is a record and each column is an attribute.  

❖ Queries – It is a question with multiple conditions posted to the database.  

❖ The records in the database that satisfies the passed conditions are retrieved.  

❖ Views – A set of stored queries. 

41.  WHERE Clause: 

❖ In SQL command WHERE clause is used to specify the selection criteria Based on that data’s are retrieved or 

modified as per the query.  

❖ In the WHERE conditions, operations like =, !=, >, >=, < , <= are used to frame the query statement. 

❖ WHERE clause is used in SELECT and UPDATE query statement for the condition.  

❖ The number of records updated in a table depends on the WHERE condition. 

42.  Backup:  

❖ It is a program or process of copying table contents into a file for future reference.  

❖ It’s a challenging task for DBA’s   

43.  Primary Key:  This key of relational table identifies each record in the table in a unique way.  

44.  Record:  Record is referred in a table, which are composed of fields.  
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45.  Join:   

❖ Retrieves data from two or more tables, by referencing columns in the tables that hold identical values 

46.  Query:  

❖ In SQL, all commands are named as query. The query statement is executed against the databases.  

47.  SQL:  

❖ It (Structured query Language) is a programming language designed mainly for managing data in RDBMS 

48.  Open Source:  

❖ Open source refers to the design that is publicly accessible by people for modification and sharing  

 CHAPTER – 4 (PHP : Hypertext Pre-Processor ) 
1.  PHP:  

❖ PHP (Hypertext Pre-processor) is a one of the important server side Web and general purpose scripting language 

invented by Rasmus Lerdorf in 1994. 

❖ It is very simple and lightweight open source server side scripting language. 
❖ It can easily embed with HTML and other client side scripting languages like CSS (Cascading Style Sheets) and Java script. 

2.  Types of Syntax are available in PHP:  

1. Default Syntax. 2. Short Open Tags. 3. HTML Script embed Tags. 

3.  Is PHP a case sensitive language?  

❖ Yes, PHP is a case sensitive language both upper and lower case are treated differently. 

❖ Example: $x and $X are different variable names. 

4.  Declare variables in PHP:  

❖ Variable name must always begin with a $ symbol. 

❖ EX: $name = “Balu”; $age = 30; $is_admin = true; $prices = array(10, 20, 30); 

5.  Client server architecture  

❖ A server is a computer or a device that provides functionality for the other programs or devices called clients.  

❖ This architecture is called the client server model, and a single over all computation is distribution across multiple 

processes or devices. 

6.  Dynamic web page: 

❖ A dynamic web page is a page whose content can change each time it is viewed.  

❖ It is particularly well-suited for creating database-driven websites, because it can be used to interact with databases 

in a very efficient way. 

7.  Static web page: 

❖ A static web page is a page that has fixed content that does not change, unless it is manually updated by the web developer.  

❖ The content on a static web page is the same every time it is viewed. 

8.  List out features of PHP: 

1.Server-side scripting language 2.Open-source software 3.Platform independent 4.Database support. 

9.  Web development using html,java script & css: 

❖ HTML (HyperText Markup Language) is used to structure and format the content of a web page.  

❖ JavaScript is a client-side scripting language that is used to add interactivity to web pages.  

❖ CSS (Cascading Style Sheets) is a style sheet language that is used to control the appearance of a web page.  

❖ It can be used to define the layout, font, and color of a page 

10.  Variable declaration with example: 

❖ In PHP, variables are declared by assigning a value to them.  

❖ There is no need to specify the type of a variable when declaring it, as the type is determined by the value it holds.  

Example: 

$name = “Balu”;  $age = 30; $is_admin = true;  $prices = array(10, 20, 30);  

11.  HTML:   

❖ HTML stands for Hyper Text Markup Language.   

❖ This language is designed for creating websites.  

12.  WAMP:   WAMP is abbreviation for “Windows, Apache, MySQL, and PHP”. 

 CHAPTER – 5 (Functions and Arrays IN PHP ) 
1.  Parameterized functions in PHP.  

(i) PHP Parameterized functions are the functions with parameters or arguments. 

(ii) Required information can be shared between function declaration and function calling part inside the program. 

2.  Associative array  

❖ An associative array is a data structure that stores a collection of key-value pairs.  

❖ The keys are used to identify the values, and the values can be of any data type.  

❖ The keys in an associative array are often called “labels” because they label or identify the corresponding values. 

3.  How many types of Functions are there in PHP?   

❖ 1. User defined function, 2. Pre-defined or System or built-in functions, and 3. Parameterized function 

4.  What is parameter and arguments?  

❖ 1.Parameters: function definition  2.Arguments: function call 
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5.  What is function, function name and parameter list? 

❖ The ‘function’ keyword is used to define a function.  

❖ FunctionName is the name of the function. It can be any valid PHP identifier, as long as it is not a reserved word.  

❖ Parameter list is a comma-separated list of variables.  

❖ These parameters are optional and we can have as many or as few as we like.  

❖ Inside the curly braces, we can put any code we want the function to execute.  

6.  Create an indexed array in PHP:  

❖ By enclosing a comma-separated list of values in square brackets (or) By using the array() function. 

7.  Create an associative array in PHP: 

❖ By enclosing a comma-separated list of key-value pairs in square brackets (or)  by using the array() function. 

8.  Nested array: 

❖ In PHP, a multidimensional array is an array that contains one or more arrays as its elements.  
❖ The elements of a multidimensional array can themselves be arrays, creating an array of arrays, also known as a nested array. 

 CHAPTER – 6 (Conditional Statements IN PHP) 
1.  If-else Statement in PHP.  

❖ The if ... else statement is a conditional statement in PHP.  

❖ It executes one block of code if a condition is true and another block of code if the condition is false. 

2.  Control statements or control structures: 

❖ Statements in a script need not necessarily be executed in a sequential order.  

❖ Some segments in a script are executed based on a condition.  

❖ In such situations the flow of control jumps from one part of the script to another.  

❖ The statements that cause such jumps are called as control statements or control structures. 

3.  Categories of control structures: 

❖ The two major categories of control structures are Conditional statements and Looping statements. 

4.  Conditional statements with types: 

❖ Conditional statements in PHP execute code based on a specific condition.  

❖ There are several types of conditional statements in PHP.  

❖ They are 1. ‘if ’ statement 2. ‘if …else’ statement 3. ‘if … elseif … else’ statement 4. ‘switch’ statement 

5.  If statement: 

❖ The if statement is the simplest of all the conditional statements.  

❖ A block of code is executed if a certain condition is true. 

6.  Role of break statement: 

❖ The break statement is used to terminate each case.  

❖ If a break statement is not used, the code will continue to execute for all subsequent case statements until a break is 

encountered. 

❖ The role of the break statement in a switch statement is to terminate the case and exit the switch statement. 

 CHAPTER – 7 (Loops IN PHP) 
1.  Write a PHP code to print 10 to 20 number in ascending order using while loop and do-while loop. 

While loop:                            Output: 11 12 13 14 15 16 17 18 19 20 

$i = 10;  

while ($i<= 20)  

{  

    echo $i . “<br>”;  

    $i++;  

} 

While loop:                            Output: 11 12 13 14 15 16 17 18 19 20 

$i = 10;  

do  

{  

   echo $i . “<br>”;  

   $i++;  

}  

while ($i<= 20); 

2.  Write the syntax for: For each loop in PHP.  

foreach ($array as $value)  

{  

  //code to be executed;  

} 
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3.  Write the Syntax of Switch... case statement in php.  

switch (expression) 

{ 

  case value1: 

       //code to be executed if  expression = value1; 

   break; 

   case value2: 

      //code to be executed if  expression = value2; 

   break; 

default: 

      //code to be executed if expression is not equal to any of the values;   

}  

4.  List out the looping structure in PHP.  

(i) for Loop (ii) foreach Loop  (iii) While Loop  (iv) Do While Loop 

5.  For each loop in PHP:  

❖ The foreach loop is used to iterate over elements of an array. 

❖ The foreach loop will iterate over each element of the array and assign the key of the element to the $key variable 

and the value of the element to the $value variable. 

6.  Features of Looping structure  

❖ Looping structures are useful for writing iteration logics. 

❖ It is the most important feature of many programming languages, including PHP. 

7.  What is loop in PHP? 

❖ A loop is a control structure that repeatedly executes a block of code until a certain condition is met or a specific 

number of times. 

❖ A loop executes a set of instructions (a block of code) repeatedly for a certain number of times or until a certain 

condition is met. 

8.  for loop in PHP: 

❖ ‘For loop’ is called as the entry-check loop.  

❖ The for loop is used to execute a block of code a specific number of times. 

9.  While loop in PHP: 

❖ ‘While loop’ is called as the entry-check loop.  

❖ The while loop is used to execute a block of code while a certain condition is true. 

10.  Do-while loop in PHP: 

❖ ‘Do … while loop’ is called as the exit-check loop.  

❖ The do...while loop is similar to the while loop, except that the code block is always executed at least once, even if 

the condition is false. 

11.  Foreach loop in PHP: 

❖ The foreach loop is used to iterate over elements of an array. 

❖ The foreach loop is particularly useful when you want to perform a set of actions on each element of an array, such 

as printing the elements, summing them up, or modifying them in some way.  

❖ It is a simple and efficient way to iterate over arrays in PHP. 

12.  Block of code: 

❖ A block of code, also known as a code block, is a group of statements to be executed together as a single unit. 

 CHAPTER -  8 (Forms and Files) 
1.  Fopen () function in PHP. 

❖ Fopen() is a system function available in PHP.  

❖ This function helps to open a file in the server.  
❖ It contains two parameters one for the file and the other one specifies in which mode the file should be opened (Read/Write). 

2.  Differentiate Check box and Radio button.  

(i) A checkbox allows the user to select more than one item, while a radio button only can indicate a single selection at a time. 

(ii) Also with a radio button, if the user selects a different choice their previous becomes deselected automatically. 

3.  List out HTML form control:  

❖ HTML form controls like textbox, dropdown box and radio button etc., 

4.  File select:  

❖ File select is the best feature to select one file from the local machine to server machine at a time. 

5.  Form tag:  

❖ Form tag is used to mention a method (POST or GET) and control the entire form controls in the HTML document 

6.  Types of form handling variables : 

❖ Two PHP variables such as $_POST and $_GET 

7.  File handling:  

❖ File handling is an important activity of all web application development process. 
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8.  Different task of the file handling: 

1.PHP Open a File, 2.PHP Read a File, 3.PHP Close a File, 4.PHP Write a File,  

5.PHP Appending a File and 6.PHP uploading a File. 

9.  HTML:   

❖ Hypertext Markup Language is the standard markup language for creating web pages and web applications.  

10.  File upload:  

❖ A PHP script can be used with a HTML form to allow users to upload files to the server 

11.  FORM Validation:  

❖ Validation of HTML form data is important to protect your form from hackers and spammers. 

 CHAPTER – 9 (Connecting PHP and MYSQL) 
1.  Basic HTML Form Controls:  

❖ 1. Text inputs 2. Buttons 3. Checkbox 4. Radio box 5. File Select 6. Form Tag 

2.  Features of RDBMS:  

❖ MySQL, Oracle, IBM DB2, and Microsoft SQLSERVER etc 

3.  RAD: 

❖ PHP has also attracted the development of many software frameworks that provide building blocks and a design 

structure to promote rapid application development (RAD) 

4.  Types of RAD soft wares: 

❖ Some of these include PRADO, CakePHP, Symfony, CodeIgniter, Laravel, Yii Framework, Phalcon and Zend 

Framework, offering features similar to other web frameworks. 

5.  SQL:  

❖ SQL is a domain-specific language used in programming and designed for managing data held in a relational 

database management system  

6.  Queries:  

❖ A query is a request for data or information from a database table or combination of tables.  

7.  MySQL:   

❖ MySQL is an open-source relational database management system  

8.  SERVER or CLIENTS: 

❖ A server is a computer or a device that provides functionality for other programs or devices, called “clients”.  

❖ This architecture is called the client– server model, and a single overall computation is distributed across multiple 

processes or devices. 

9.  Database: 

❖ A database is an organized collection of data, generally stored and accessed electronically from a computer system. 

 CHAPTER – 10 (Introduction to Computer Networks) 
1.  Flame wars:  

❖ Flame wars are nothing that lengthy exchange of angry or abusive messages between users of an online forum or 

other discussion area. 

2.  Write the difference between wired and wireless networks.  

Wired networks Wireless networks 

A Wired network system connected with network cable . 

Ex: Speakers, CCTV, printers, outdoors, and scanners 

etc., with cables. 

A Wireless network is connecting devices like 

tablets(tab), indoor cameras and E-readers, etc., without 

cables (WiFi). 
 

3.  What are the ways in which network are connected at home?  

❖ Network at home were connected in two ways  1.Wired Network  2.Wireless Network 

4.  Artificial intelligence:  

❖ Artificial intelligence will help to maintain, manage, and protect the network problems. 

❖ Now the networks are monitored by algorithm that enables for anomalous build-ups of traffic and activity which 

may be the result of nasty activities such as (D Dos) Distributed Denial of- Service attacks and attempted hacks. 

❖ Artificial intelligence will be able to predict traffic as it collects and analyses data in real time. 

5.  Types of shared resources in internet: 

❖ Some of the shared resources are file server, web camera, speakers, printer, scanner, fax machine etc., 

6.  Accessing services in internet: 

❖ Accessing services such as WWW (World Wide Web), Digital audio, Digital video which are shared to use 

applications, software, and storage servers. 

7.  Network: 

❖ In networking, nodes are identified by its IP addresses i.e.,(network address) and can include hosts such as mobile 

phones , tabs , personal computers, huge servers and other networking device.  

❖ Connecting more than one device is called as network. 

8.  List out online services:  

❖ Online service providers are Flipkart, Amazon, snap deal etc. 

9.  Online payments:  Online payments help in sending and receiving money via payment methods using this Internet. 
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10.  List out search engine: 

❖ Internet Explorer, Yahoo, bing were powerful search engine.  

❖ Later, Google stepped in with user friendly gmail, youtube, googledrive, google maps, etc 

11.  Types of innovations:  

❖ Mobile technology and social web.  

12.  Types of resource sharing: 

❖ Simply resource sharing is a sharing of devices like printers, scanner, PDA, fax machine, and modems 

13.  Examples of network in business: 

❖ Cheap marketing price and easy selection of products through Internet with customers satisfaction can also be done.  

❖ Company license, renewals, other certificates, bill payments, receipts, invoice, stock maintenance. 

14.  Examples of network in home: 

❖ Network at home helps us to perform e-banking, e-learning, e-governance, e-health, telemedicine, call centers, video 

conferencing, digitalization of memories, etc 

15.  Examples of mobile networks: 

❖ For example mobiles, tablets, pagers, laptops, engaged with mobile broadband just like modems etc. 

16.  Examples of social applications:  

❖ Whatsapp, Facebook, Twitter, Blogs, Pinterest, Classmate and so on 

17.  Attributes of social networks:  

❖ 1.Membership 2.Content contribution Frequent visits. 3.Relationship building. 

18.  List out benefits of social networks: 

􀁺 Group information sharing over long distances.  􀁺 Broadcast announcements. 􀁺 Fostering diversity of thought 

19.  Disadvantages of social network: 

❖ Simply wasting the precious time on Internet by surfing, searching unwanted things.  

❖ Lot of unnecessary wrong information’s are sometimes posted by some people on their web pages, blog etc.  

❖ Different types of thefts related to money and other valuables can take place through Internet as hackers and viruses 

are always active around. 

20.  Hackers:  

❖ Hackers were skilled computer experts, some who with their technical knowledge access our accounts 

21.  E-Banking: 

❖ It was a safe, fast, easy and efficient electronic service that enables you access to bank account and to carry out 

online banking services, 24 hours a day, and 7 days a week. 

22.  E-Governance:  

❖ This is an application of ICT for access the government services, communication transactions, of various standards 

system between government to citizen, government to business. 

23.  Viruses:   

❖ Malware treats or computer warms that replicates it By its own is called as virus. 

24.  E-Readers:  

❖ E-Readers is similarly called as e-book reader these were designed for the purpose of reading via mobile electronics 

device to read digital e-books and periodically 

25.  Cloud Storage:  

❖ Just a storage of data on online, access in different area no geographical limits was in need 

26.  Cloud Computing:   

❖ It is based on Internet computing, to share resources, software and information. 

27.  Blogging:   

❖ Add new material to or regularly update a blog. 

 CHAPTER – 11 (Network Examples and Protocols) 
1.  Features of Mobile Networks.  

❖ Less consumption of power is used by mobile devices comparing with a single transmitter or satellite often cell 

towers were nearer. 

❖ Huge capacity than a large transmitter, at single frequency can be used for different or many links as long as they 

are in different in cells. 

2.  Intranet  

❖ It is a website used by organizations to provide a place where employees can access company related information.  

❖ It is a private network within an enterprise to share company data and computing resources between the employees. 

3.  Network protocol: 

❖ A network protocol is a set of rules that determine how data is transmitted between different devices in the same network.  

❖ It allows connected devices to communicate with each other, regardless of any differences in their internal 

processes, structure or design. 

4.  Types of network protocol: 

❖ Network communication protocols It is the basic data communication protocol it includes of HTTP and TCP/ IP.  

❖ Network security protocol It confirms security over network communication and includes HTTPS, SFTP and SSL.  
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❖ Network management protocol It Provides network governance and maintenance and include ICMP and SNMP. 

5.  ARPANET 

❖ ARPANET was developed by the Advanced Research Projects Agency (ARPA) of the U.S. government in 1969.  

❖ It was first recognized as the ARPANet.  

❖ The unique aim was to generate a network that would permit users of a research computer from one university to 

“talk to” research computers on other universities. 

6.  IOT: 

❖ Internet of Things refers to the digital interconnection of everyday objects (home applicances, wearable devices or 

automobiles) with the Internet.  

❖ The ‘thing’ in IoT refers to objects that have been assigned an IP address and have the ability to collect and transfer 

data over a network without manual assistance or intervention. 

7.  Cells: 

❖ A mobile network or cellular network as it is made up of a large number of signal areas called cells.  

❖ These cells join to form a large coverage area 

8.  List out generations of mobile networks: 

1.First Generation (1G) 1981- NMT launch  2.Second Generation (2G) 1991-GSM Launch  

3.Second to Third Generation Bridge (2.5)2000 – GPRS launch  4.Third Generation (3G) 2003  

5.Fourth Generation (4G) 2007  6.Fifth Generation (5G) 2019+ 

9.  NMT: 

❖ NMT stands for Nordic Mobile Telephone communication.  

❖ They had a very low traffic density of one call per radio channel, and a very poor voice quality, and they used 

unsure and unencrypted transmission, which leads to the spoofing of its identities. 

10.  GSM: 

❖ GSM stands for (Global System for Mobile communication) was most popular standard which is used in second 

generation, using 900MHz and 1800MHz for the frequency bands.  

❖ GSM mobile systems grown digital transmission using SIM. 

11.  SIM: 

❖ SIM stands for (Subscriber Identity Module) technology to authenticate a user for identification and billing 

purposes, and to encrypt the data to prevent listen without permission (eavesdropping).  

❖ The transmission used as TDMA. 

12.  GPRS: 

❖ GPRS was introduced here, this is the excess period of mobile networking development, between 2G and 3G.  

❖ GPRS stands for (General Packet Radio Service).  

❖ GPRS is a data service which enables mobile devices to send and receive messages, picture messages and e-mails.  

❖ It allows most popular operating speeds of up to 115kbit/s, latterly maximum of 384kbit/s by using EDGE. 

13.  Examples of IP networks:  

❖ 802.11 WLAN, GPRS and UMTS 

14.  Bases of 5G network: 

❖ The two phases of 5G, First one will be complete by March 2019,Second one is expected to complete at March2020, 

for submission to the ITU(International Telecommunication Union) as a candidate IMT-2020 technology. 

15.  List out benefits of 5G: 

❖ 5G is the stage succeeds the 4G (LTE/ WiMAx), 3G(umts) and 2G(GSM) syetems. 5G targets to perform the high 

data rate, reduced latency, energy saving, cost reduction, higher system, capacity, and massive device connectivity 

16.  Li-fi: 

❖ Li-Fi is a wireless technology which uses light-emitting diodes (LEDs) for data transmission whereas Wi-Fi uses 

radio frequencies for data transmission.  

❖ Li-Fi is the short form of Light Fidelity.  

❖ The term Li-Fi was first used by Harald Haas, Professor in Edinburgh University.  

❖ The computer scientists achieved speeds of 224 gbps in the lab and research is going on.  

❖ The biggest revolution in the Internet world is going to happen 

17.  Types of RIFD:  

❖ Two types of RFID tags were Active RFID and Passive RFID systems. 

18.  RIFD: 

❖ RFID - Radio Frequency Identification.  

❖ RFID is a technology designed to locate objects (Credit cards, Passports or even livestock) using radio signals.  

❖ RFID used radio waves to read and capture information stored on a tag attached to an object 

19.  OSI model: 

❖ Open System Interconnection (OSI) model was found in the year 1934, general framework that enables network 

protocols along with software and systems to be developed based on general set of guidelines.  

❖ It describes the standards for the inter-computer communication. 
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20.  Other network protocols: 

❖ Other networks similarly classified in network layer are IP, ARP, ICMP,IGMP, at transport layer are TCP,UDP at 

Application Layer are HTTP, FTP, Telenet, SMTP, and DNS. 

21.  Domain Names and TCP/IP Addresses: 

❖ The address for any website is not as easy as to remember, domain name are used instead.  

❖ For example, 216.58.216.164 is one of the IP address for Google and google.com is the domain name. 

 CHAPTER – 12 (DNS - Domain Name System) 
1.  Types of URL:   

❖ The URL is divided into 2 types (i) Absolute URL (ii) Relative URL 

2.  Expand ARPANET, STP and USB.  

❖ ARPANET - Advanced Research Projects Agency Network 

❖ STP - Shielded Twisted Pair     USB - Universal Serial Bus 

3.  URL  with types:   

❖ URL means Uniform Resource Locator. It is the address of a resource on the internet.  

❖ A URL indicates the location of a resource as well as the protocol used to access it. 

Eg: http://www.google.com  

❖ The URL is divided into 2 types : (i) Absolute URL (ii) Relative URL 

4.  List out DNS components: Namespace, Name server, Zone and Resolver. 

5.  DNS: 

❖ Domain Name System (DNS) maintains all the directory of domain names and help us to access the websites using 

the domain names.  

❖ It translates the domain name into IP address. 

6.  Types of IP addresses:  

❖ There are two types: IPv4 and IPv6 

7.  Types of URL parts: URL is made up of four parts- protocols, domain name, folder name and file name 

8.  What are the two ways to represent the IP addresses? 

❖ There are two ways to represent the IP addresses. 

1.Binary notation:  

❖ In binary notation the address is expressed as 32-bit binary values. For E.g. 00111001  10001001  00111000  

00000111 

2. Dotted-decimal notation:  

❖ In dotted-decimal notation the address is written in decimal format separated by dots(.). 

9.  List out name space organized : 1.Flat name space 2.Hierarchical name space 

10.  Flat name space: 

❖ The flat namespace is where the name is assigned to the IP address.  

❖ They do not have any specific structure.  

❖ In this flat name space, some meaningful names are given to IP address for accessing 

11.  Disadvantages of flat name space: 

❖ The major disadvantage of flat name space is that they cannot be used in large systems.  

❖ Because they need to be accessed and controlled centrally to avoid ambiguity and redundancy.  

❖ But it is difficult in a flat name system.  

❖ To avoid this major disadvantage, hierarchical name space is widely used. 

12.  Hierarchical name space: 

❖ Hierarchical name space is where the name is made up of several parts.  

❖ The first part may represent the nature of the organization, the second part may represent the name of the 

organization, and the third part may represent the department of the organization and so on. 

❖ In this way the power to control the name space can be decentralized. 

13.  Domain namespace: 

❖ Domain name space was designed to achieve hierarchical name space.  

❖ In this, The names are represented as a tree-like structure with a root element on the top.  

❖ This Tree can have a maximum of 128 levels starting from the root element, taking level 0 to level 127 

14.  Label: 

❖ Label Each node in the DNS tree-like structure has a name, called a label.  

❖ Label is a string having a maximum of 63 characters 

15.  gTLD: 

❖ Top level domain is the last part of a domain name. Generic top level domains are used for generic purpose.  

❖ For example .com is used for commercial purpose and .edn is for educational purpose.  

❖ It is maintained by IANA. 

16.  cTLD: 

❖ Country domain uses 2-character country abbreviation according to country.  

❖ For e.g., google.in for INDIA, google.us for US 
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17.  Types of Name Servers:  

1. Root Name Server - top level server which contains entire DNS tree, maintained by ICANN. There are 13 servers.  

2. Primary Name Server– contains a zone resource records. These records are updatable by domain name holders.  

3. Secondary Name Server – contains a copy of primary server files.  

    This server has no authority to update, but reduce the workload of primary server by sharing the queries. 

18.  List out zone copies files: 

❖ There are two copies of zone files available, Master file and slave file. 

19.  ICANN: 

❖ ICANN, Internet Corporation for Assigned Names and Numbers is the Non-profit Organization which assigns 

names and numbers for all Internet resources like domain names and IP addresses. 

20.  Webserver: 

❖ Web server is a program running on dedicated machine which handle the queries of www end user. Server is used to 

host the websites and to deliver the contents of websites using HTTP.  

❖ While typing the URL in browser, the browser send the URL to DNS.  

❖ After getting an IP address from DNS, It sends the request to the web server with IP address. 

21.  IANA: 

❖ IANA (Internet Assigned Number Authority) is an affiliated authority of ICANN.  
❖ IANA does the overall management of the DNS root server, IP addressing, and other Internet protocol resource handling. 

❖ IANA takes care of a number of key aspects of the DNS, including the root zone, and the domains .int and .arpa. 

https://www.iana.org/ 

22.  ICANN WHOIS: 

❖ The WHOIS is a service of ICANN.  

❖ It is a free, publicly available directory containing the details of registered domain names and their owners 

(registrants). https://whois.icann.org/en 

 CHAPTER – 13 (Network Cabling) 
1.  Computer media: 

❖ Computer Networking is a group of interconnected computers or other devices for sharing the data and resources among them 

2.  Examples of wired and wireless media: 

❖ Wired media (Unshielded Twisted pair, shielded Twisted pair, Co-axial cables and Optical fibre)  

❖ Wireless media (Infra Red, Bluetooth, WiFi) 

3.  Differentiate Wireless and wired media: 

❖ Wireless networks enable more devices including mobile sharing the resources and Internet connections remotely.  

❖ But Compared to wireless networks, wired networks maintain a faster Internet speed and more secure.  

❖ Wired networks for larger area are more expensive.  

❖ Wired networks are still widely used in the offices where increased speed and secure connections need. 

4.  List out coaxial cable: 

❖ The cable is classified into thinnet and thicknet cables. 

5.  Twisted pair cable: 

❖ It is a type of cable with two or more insulated wires twisted together.  

❖ This twisted cable has 8 wires which are twisted to ignore electromagnetic interference. 

6.  Fiber Optic cable:  

❖ This cable is made by using strands of glass.  

❖ It uses pulses of light to send the information.  

❖ They are mainly used in Wide Area Network (WAN).  

❖ These cables are placed in deep underground to avoid any damage to the cables. 

7.  USB dongles: 

❖ There are some special network devices used to connect the Internet through the USB called dongles.  

❖ The dongle is a small peripheral device which has a compatible of mobile broadband with a sim slot in it and 

connects the Internet and acts as a modem to the computer. 

8.  Serial and Parallel cables:  

❖ Before Ethernet cable was invented, the Serial and Parallel interface cables were used to connect the system to the Internet.  

❖ They were sometime used for PC to PC networking. E.g. RS232 cable 

9.  Ethernet Cables:  

❖ This is a type of twisted pair cable.  

❖ It is the most common type of network cable mainly used for connecting the computers or devices at home or office.  
❖ This cable connects wired devices within the local area network (LAN) for sharing the resources and accessing Internet. 

10.  Null modem cable: 

❖ Just like the crossover cable, RS-232 cable is also used for interconnecting two computers without modem.  

❖ So it is also a null modem cable. A cable interconnecting two devices directly is known as a null modem cable. 

11.  List out Ethernet cable manufactured: 
❖ Ethernet cables are normally manufactured in several industrial standards such as Cat 3, Cat 5, Cat 6, Cat 6e and cat 7. 

www.Padasalai.Net                                                                     www.Trb Tnpsc.Com

Kindly Send Me Your Key Answer to Our email id - Padasalai.net@gmail.com

www.P
ad

as
al

ai
.N

et

www.P
ad

as
al

ai
.N

et

https://www.padasalai.net/
https://www.padasalai.net/


 

71 
                                             PREPARED BY...,    B.MOHAMED YOUSUF   M.C.A., B.Ed..,    (PG   ASST IN COMPUTER SCIENCE) 

                                             [yousufaslan5855@gmail.com] 

 

12.  8P8C connector: 

❖ The RJ45 connector is a small plastic cube. It has eight pins.  

❖ It is connected to each end of the Ethernet cable.  

❖ It is also known as 8P8C connector.  

❖ These plugs (connector) are inserted into Ethernet port of the network card. 

13.  Ethernet card: 

❖ Ethernet card is a Network Interface Card (NIC) that allows computers to connect and transmit data to the devices on the network.  

❖ It may be an expansion card or built-in type 

14.  Devices/Technology Alternative Names 

Ethernet Technology RJ45, 802.3 (according to IEEE) 

RJ45 Connector (male) RJ45 plug, Ethernet connector, 8P8C connector 

RJ45 socket (female) Rj45 jack, Ethernet Port 

RJ45 Cable Ethernet cable 
 

15.  Ethernet Cable Color Coding Techniques with types: 

❖ There are three types of wiring techniques to construct the Ethernet cable.  

❖ It is also known as color coding techniques.  

❖ They are ● Straight-Through Wiring ● Cross-over Wiring ● Roll-over Wiring 

16.  Console cable: 

❖ Rollover cable is also known as Console cable.  

❖ It is typically flat (and light blue color) to distinguish it from other types of network cabling. 

17.  How to determine the type of Ethernet cables?  

❖ Straight-through: The coloured wires are in the same sequence at both ends of the cable.  

❖ Cross-over: The first coloured wire at one end of the cable is the third coloured wire at the other end of the cable.  

❖ Roll-over: The coloured wires are in the opposite sequence at either end of the cable. 

18.  LAN: Local Area Network in which the devices used in home or office interconnected for sharing the resources. 

19.  WAN: Wide Area Network, WAN is the network that spans large geographical area 

20.  WWW: 

❖ World Wide Web, Definition comes from the World Wide Web Consortium (W3C):  

❖ “The World Wide Web is the universe of network-accessible information, an embodiment of human knowledge.” 

 CHAPTER – 14 (Open Source Concepts) 
1.  Differentiate free source software and open source software.  

Free source software Open source software 

Freeware usually refers to proprietary software that 

users can download at no cost. 

It refers to the software that is developed and tested 

through open collaboration 

But whose source code can not be changed Anyone with the academic knowledge can access, 

inspect, modify and redistribute the source code. 
 

2.  BOSS OS: 

❖ BOSS (Bharat Operating System Solutions) Operating System Developed in India by C-DAC (Centre for 

Development of Advanced Computing) helps to prompt the use of Open Source Software in India 

❖ It supports many Indian Languages 

3.  Can anyone change the codes in Open Source Software?  

❖ Open Source Software has been developed by a variety of programmers. However, to add a new change to the 

software, the modified code will be submitted to a group of dedicated programmers.  
❖ These programmers then test the modified codes and if it satisfies the appropriate rules, it will then be distributed to all. 

4.  Advantage of the proprietary software: 

❖ The advantage of the proprietary software is that it gives more control, support, training, security and stability for 

user making the software reliable to the users 

5.  Why Need for Network Open Source Software? 

❖ In a network it is not easy to find problems.  
❖ Especially when there are more systems are connected, the complexity is more, so we need Network Software to Control, 

Analyse the Server, System, protocol, Network, Traffic flow and reports about ups and downs of network parts. 

6.  NRCFOSS:  

❖ National Resource Centre for Free and Open Source Software is an Institution of Government of India.  

❖ It helps in development of FOSS (Free Open Source Software) in India. 

7.  Types of open source license: 

❖ Apache License 2.0  ● BSD 3-Clause “New” or “Revised” license   

❖ BSD 2-Clause “Simplified” or “FreeBSD” license  ● GNU General Public License (GPL) 

8.  Network stimulation: 

❖ Network simulation is a method where a software program models the activities of a network by calculating the 

communication between the different network objects such as(routers, nodes, switches, access points, links etc.). 
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9.  Network stimulator: 

❖ A network simulator is a software program that replicates the functioning of a computer network.  

❖ In simulators, the computer network is typically demonstrated with devices, traffic etc. 

10.  Types of open NMS:  

❖ There are two types of Open NMS - Meridian and Horizon. 

11.  Goal open NMS: 

❖ The goal is for Open NMS to be actually distributed, scalable management application platform for all features of 

the FCAPS (Fault, configuration, accounting, performance, security) network management model.  

❖ Presently the emphasis is on Fault and Performance Management. 

12.  Difference between meridian and horizon: 

❖ When we need stability and long term support choose Meridian which is best for Enterprises as well as businesses. 

❖ Horizon used where innovation occurs frequently.  

❖ It is Best for IT-ecosystem, new technologies monitoring. 

13.  List out open source hardware: 

 ● Remix ● Remake ● Remanufacture ● Redistribute ● Resell ● Study and Learn  

 CHAPTER – 15  (E-Commerce) 
1.  Explain B2C module in E-Commerce. 

❖ In B2C E-Commerce, commercial transactions take place between business firms and their consumers.  

❖ It is the direct trade between companies and end-consumers via the Internet.  

❖ B2C companies sell goods, information or services to customers through online in a more personalized dynamic 

environment and is considered as real competitor for a traditional storekeeper. 

❖ Example:  A book company selling books to customers. 

2.  Classify the E-Commerce Business Models. 

(i) Business to Business (B2B) (ii) Business to Consumer (B2C)  (iii) Business to Government (B2G) 

(iv) Consumer to Business (C2B) (v) Consumer to Consumer (C2C)(vi) Consumer to Government (C2G) 

(vii) Government to Business (G2B)(viii) Government to Consumer (G2C)(ix) Government to Government (G2G) 

3.  What are the different types of infrastructures in E-Business? 

Network Infrastructures:  

❖ Internet, Intranet, Extranet 

Multimedia content & network publishing infrastructures: 

❖ HTML, Online Marketing 

Messaging & information distribution infrastructures: 

❖ EDI, e-mail, http, Computerized Inventory Management Systems 

Other Common business service infrastructures: 

❖ Electronic payments gateways, globalized Supply Chain Management (SCM), Online Transaction Processing). 

4.  A company can be called E-Business if and only if : 

❖ It has the ability to conduct business electronically over Internet.  

❖ It manages payment transaction through Internet.  

❖ It has a platform for selling products & services via Internet. 

5.  Which model is called reverse auction model? 

❖ C2B model, is also called as reverse auction model.  

❖ Here, customer bid his price for a service or a product.  

❖ Then E-Commerce business entity will match the requirement of the consumer to the best possible extent. 

6.  What is C2B2C? 

❖ The electronic tools and Internet infrastructure are employed to support transactions between individuals. 

❖ Typically, this type of E-Commerce works as Consumer to Business to Consumer (C2B2C).  

❖ It means that a consumer would contact a business in search of a suitable customer.  

❖ Most of the auction websites and matrimonial websites are working on this methodology. 

7.  G2G systems can be classified into two types: 

Internal facing or local level: 

❖ Joining up a single Government’s bureaucracy. e.g. https://www.nic.in/  

External facing or international level: 

❖ Joining up multiple Governments’ bureaucracy. 

8.  WEB 1.0, 2.0 & 3.0: 

Web 1.0  

❖ (Web of Content) is the early web that contained text, images and hyperlinks and allowed users only to search for 

information and read it.  

❖ There was a very little in the way of user interaction or content generation.  

Web 2.0  

❖ (Web of Communication) is a read-write web that allowed users to interact with each other.  
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Web 3.0  

❖ (Web of Context) is termed as the semantic web or executable web with dynamic applications, interactive services, 

and “machine-to-machine” interaction. 

9.  Off-shoring & Out-sourcing: 

❖ Off-shoring Company’s work is given to overseas (another country) company  

❖ Out-sourcing Hiring third party service providers to handle business on behalf.  

 CHAPTER – 16 (Electronic Payment Systems) 

1.  Classification of Electronic Payment systems:1) Micro electronic Payment Systems 2) Macro electronic Payment Systems 

2.  Payment system types: 

❖ Payment system can also be divided into two types, namely the cash payment system and the non-cash payment 

system based on the instruments used.  

❖ In the cash payment system, the instruments used are in the form of currency (paper money and coins) while in the 

non-cash payment system the instruments used are card-based payment, Cheques or electronic money. 

3.  Micro electronic payment transactions: 

Step 1 Customer proves his authentication and the payment processor issues micro payments.  

Step 2: Customer pays the micro payments to the online service provider and gets the requested goods or services from them.  

Step 3: Service provider deposit micro payments received from the customer to the payment processor and gets the money. 

4.  Popular macro on-line payment systems: 

1) Card based payment systems  2) Electronic account transfer  

3) Electronic cash payment systems  4) Mobile payment systems and internet payment systems 

5.  Card Based Payments Systems: 

1. Credit card based payment systems (pay later)  2. Debit card based payment systems (pay now)  

3. Stored value card based payment systems (pay before) 

6.  Advantages of credit card:  

❖ Most credit cards are accepted worldwide. It is not necessary to pay physical money at the time of purchase.  

❖ The customer gets an extra period to pay the purchase. Depending on the card, there is no need to pay annuity. 

❖ Allows purchases over the Internet in instalments.  

❖ Some issuers allows “round up” the purchase price and pay the difference in cash to make the transactions easy. 

7.  Key players in operations of credit card: 

❖ 1. Bearer 2. Merchant.  3. Acquirer 4. Credit Card Network  5. Issuer  

8.  Anatomy of a credit card  

1. Publisher.  2. Credit card number 3. Name of the cardholder 4. EMV chip  5. RFID symbol 

6. Expiration month and year 7. Card brand logo 8. Magnetic stripe 9. Hologram 10. Signature 11. CVC/CVV 

9.  Advantages of smart card: 

❖ The advantage of Smart cards is that it can provide identification, authentication, data storage and application processing. 

10.  Smart cards types:  

❖ Smart cards can be classified into Contact smart cards and Contactless smart cards. 

11.  Electronic Account Transfer: 

❖ These include ECS (Electronic Clearing Services), EFT (Electronic funds transfers), Real Time Gross Settlement 

system (RTGS) etc.  

❖ These Electronic Payment systems are used in lieu of tendering cash in domestic and international transactions. 

12.  Electronic Funds Transfer: 

❖ Electronic Funds Transfer (EFT) is the “electronic transfer” of money over an online network.  

❖ The amount sent from the sender’s bank branch is credited to the receiver’s bank branch on the same day in batches. 

13.  N-EFT: 

❖ EFT is known by a number of names across countries.  

❖ In India, it is called as N-EFT (National Electronic Fund Transfer), in the United States, they may be referred to as 

“electronic cheques” or “e-cheques”. National Electronic Funds Transfer 

14.  NEFT: 

❖ (NEFT) is an electronic funds transfer system initiated by the Reserve Bank of India (RBI) in November 2005.  

❖ It is established and maintained by Institute for Development and Research in Banking Technology (IDRBT).  
❖ NEFT enables a bank customer to transfer funds between any two NEFT-enabled bank accounts on a one-to-one basis. 

15.  RTGS: 

❖ Real Time Gross Settlement system (RTGS) is a payment system particularly used for the settlement of transactions 

between financial institutions, especially banks.  

❖ As name indicates, RTGS transactions are processed at the real- time.  

❖ RTGS payments are also called as push payments that are initiated (“triggered”) by the payer.  

❖ RTGS payments are generally large-value payments, i.e. high-volume transactions. 

16.  Function of crypto currency: 

❖ The function of crypto currency is based on technologies such as Mining, Block chain, Directed Acyclic Graph, 

Distributed register (ledger), etc. 

www.Padasalai.Net                                                                     www.Trb Tnpsc.Com

Kindly Send Me Your Key Answer to Our email id - Padasalai.net@gmail.com

www.P
ad

as
al

ai
.N

et

www.P
ad

as
al

ai
.N

et

https://www.padasalai.net/
https://www.padasalai.net/


 

74 
                                             PREPARED BY...,    B.MOHAMED YOUSUF   M.C.A., B.Ed..,    (PG   ASST IN COMPUTER SCIENCE) 

                                             [yousufaslan5855@gmail.com] 

 

17.  Portfolios: 

❖ The state of ownership of a crypto currency is related to individual system blocks called “portfolios”. 

❖ Only the holder of the corresponding private key would have control over a given portfolio 

18.  Crypto currency:  

❖ A crypto currency is a unique virtual (digital) asset designed to work as a medium of exchange using cryptographic algorithm.  

❖ This algorithm secures the transactions by recording it in block chain and controls the creation of additional units of the currency. 

19.  E-Cash: 

❖ Eletronic case is (E-Cash) is a currency that flows in the form of data.  

❖ It converts the case value into a series of encrypted sequence numbers, and uses the serial numbers to represent the 

market value of various currencies in reality. 

20.  Examples of electronic wallet: 

❖ There are several electronic wallet services that are now widely used. e.g. :PayPal, SBI Buddy. 

21.  Mobile Banking: 

❖ Mobile banking is another form of net banking.  

❖ The term mobile banking (also called m-banking) refers to the services provided by the bank to the customer to 

conduct banking transactions with the aid of mobile phones. 

22.  Mobile Banking operations: 

1.Contacting the call center. 2.Automatic IVR telephone service.  3.Using a mobile phone via SMS.  

4.WAP technology. 5.Using smartphone applications. 

23.  UPI applications types: 

❖ UPI applications use two types of address - global and local.  

❖ Global address includes bank account numbers and IFSC.  

❖ Local address is a virtual payment address 

24.  Virtual payment address: 

❖ Virtual payment address (VPA) also called as UPI-ID, is a unique ID similar to email id (e.g. name@bankname) 

enable us to send and receive money from banks 

25.  Point of Sale Terminal (POS): 

❖ It enables customers to make payment for purchase of goods and services by means of credit and debit cards.  

❖ To facilitate customer convenience some banks also cash withdrawal using debit cards at POS terminals. 

26.  PIN: (PIN Personal Identification Number) 

❖ A static number that is assigned to consumers to secure card based payments.  

 CHAPTER – 17 (E-Commerce Security Systems) 
1.  Write short note on mining in crypto currency?  

❖ The crypto currency units are created by the solution of cryptographic tasks called mining. 

❖ The miners not only generate new monetary units, but also initiate new transactions to the block chain.  

❖ As a reward, they will receive new Bit coins. 

2.  Types of E-Commerce Threats: 

1. Information leakage 2. Tampering 3. Payment frauds 4. Malicious code threats.  

5. Distributed Denial of Service (DDoS) Attacks 6. Cyber Squatting  7. Typopiracy  

3.  Phishing: 

❖ Phishing is also a E-Commerce threat in which a target is contacted by e-mail, telephone or text message by 

someone who pretend himself as a genuine authority.  
❖ They try to trap individuals to provide sensitive data such as, banking and credit card details, OTP, PIN or passwords.  

❖ Once they succeed, the results would lead to devastating acts such as identity theft and financial loss. 

4.  Hacking: 

❖ Hacking refers to unauthorized intrusion into a computer or a network.  

❖ That is to say breaking security to gain access to a website illegally and intercept confidential information.  
❖ They would then misuse such information to their advantage or modify and even destroy its contents to harm the competitors. 

5.  Ransomware:  

❖ Ransomware is a type of malware that usually encrypt all the files in a target’s computer and threatens to publish the 

critical data unless a ransom (money) is paid. 

6.  Dimensions of E-Commerce security: 

1.Authenticity. 2.Availability 3.Completeness 4.Confidentiality 5.Effectiveness 6.Integrity 7.Non-repudiation 

8.Privacy 9.Reliability 10.Review ability 

7.  Encryption technologies types: 1.Symmetric key encryption 2.System symmetric key encryption system. 

8.  Security token:A security token is a hardware component that are used to identify and authenticate users. 

9.  Digital certificate: 

❖ The digital certificate are being issued by a licensed Certifying Authority (CA).  

❖ NIC, Safescript, TCS, MTNL, e-Mudhra are some of the authorized Certifying Authorities under Government of 

India. 
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10.  3D Secure: 

❖ “3-D Secure is a secure payment protocol on the Internet.  

❖ It was developed by Visa to increase the level of transaction security, and it has been adapted by MasterCard.  

❖ It gives a better authentication of the holder of the payment card, during purchases made on websites.  

❖ The basic concept of this (XML-based) protocol is to link the financial authorization process with an online 

authentication system 

11.  3D secure authentication model: 

❖ 1. The Acquirer Domain 2. The Issuer Domain 3. The interoperability Domain 

12.  Cipher text and Plaintext: 

Cipher text: 

❖ It is the encrypted data usually the output of an encryption algorithm  

❖ Decipher A standard algorithm for decrypting data. 

Plaintext: 

❖ It is the unencrypted information also called as input chip  

❖ Traffic An indicator that marks the number of visitors for a particular site. 

13.  Cracker:  

❖ A person who breaks computer network’s security maliciously to gain access to critical data. 

❖ Cryptanalysis Analysing a suspecting document for hidden data or cipher text  

14.  Cyber Squatting: 

❖ Cyber Squatting Is the illegal practice of registering an Internet domain name that might be wanted by another 

person in an intention to sell it later for a profit  

15.  Encryption:  

❖ A method of scrambling data using an algorithm to protect / hide from unauthorized access.  

16.  One-Time Password (OTP):  

❖ A dynamic password that is valid for one login session or transaction provides a potential security for a e-payment transaction.  

17.  Friendly Fraud: 

❖ Friendly Fraud Is an intentional falsely claim of a costumer that they really didn’t buy(after receiving the goods)  

18.  Message digest (MD): 

❖ Message digest (MD) Is a representation of data in a form of single string of digits using one- way hashing formula.  

 CHAPTER – 18 (Electronic Data Interchange- EDI) 
1.  What is 3D secure electronic transaction?  

❖ 3-D Secure is a secure payment protocol on the Internet.  

❖ It was developed by Visa to increase the level of transaction security, and it has been adapted by MasterCard.  

❖ It gives a better authentication of the holder of the payment card, during purchases made on websites. 

This authentication model comprise 3 domains (hence the name 3D) which are:  

1. The Acquirer Domain 2. The Issuer Domain 3. The interoperability Domain 

2.  What are the four major components of EDI?  

❖ There are four major components of EDI. They are. (i) Standard document format (ii) Translator and Mapper 

(iii) Communication software (iv) Communication network 

3.  What is EDI? Write its types.  

❖ EDI is “Paperless Trade” and EFT (Electronic Transfer) is “Paperless Payment”. 

❖ EDI types: 1. Direct EDI  2.EDI via VAN  3.EDI via FTP/VPN, SFTP, FTPS  4.Web EDI  5.Mobile EDI 

4.  EDI standard example:  

❖ EDI standard e.g. EDIFACT, XML, ANSI ASC X12, etc. 

5.  Direct EDI/Point-to-Point: 

❖ It is also called as Point-to-Point EDI.  

❖ It establishes a direct connection between various business stakeholders and partners individually.  

❖ This type of EDI suits to larger businesses with a lot of day to day business transactions. 

6.  Value-added network: 

❖ A value-added network is a company, that is based on its own network, offering EDI services to other businesses.  

❖ A value-added network acts as an intermediary between trading partners.  

❖ The principle operations of value-added networks are the allocation of access rights and providing high data security. 

7.  EDI via FTP/VPN, SFTP, FTPS:  

❖ When protocols like FTP/VPN, SFTP and FTPS are used for exchange of EDI based documents through the Internet or Intranet it 

is called as EDI via FTP/VPN, SFTP, FTPS.  

8.  Web EDI:  

❖ Web based EDI conducts EDI using an web browser via the Internet.  

❖ Here the businesses are allowed to use any browser to transfer data to their business partners.  

❖ Web based EDI is easy and convenient for small and medium organizations.  

9.  Mobile EDI: When smartphones or other such handheld devices are used to transfer EDI documents it is called as mobile EDI.  

❖ Mobile EDI applications considerably increase the speed of EDI transactions. 
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      CHAPTER 1 TO 18 THREE MARK BOOK BACK & public QUESTION with ANSWERS 
 CHAPTER – 1 ( Multimedia ) 

1. List out image file formats : (J-2024) 

1) TIFF (Tagged Image File Format)  2) BMP (Bitmap) 3) DIB (Device Independent Bitmap)  

4) GIF (Graphics Interchange Format) 5) JPEG (Joint Photographic Experts Group) 6) TGA (Tagra) 

7) PNG (Portable Network Graphics) 

2. List out audio file formats:  

1) WAV (Waveform Audio File Format) 2) MP3 (MPEG Layer-3 Format) 3) OGG     

4) WMA (Windows Media Audio) 5) RA (Real Audio Format) 6) AIFF (Audio Interchange File Format) 

3. List out video file formats: (M-2022) 

1) AVI (Audio/Video Interleave)  2) MPEG (Moving Picture Experts Group) 

3) WMV(Windows Media Video) 4) MOV(Quick time format) 4) FLV (Adobe Flash Video Format 

1. What is animation? Write its types. (M-2020) 

❖ Animation is the process of displaying still images so quickly so that they give the impression of continuous 

movement. In animation the screen object is a vector image. 

Path Animation:   

❖ Path animation involves moving an object on a screen that has a constant background 

Frame Animation: 
❖ In frame animation, multiple objects are allowed to travel simultaneously and the background or the object also changes. 

2. Describe the various file format in multimedia (J-2022) 

List out Text file formats:  1.RTF 2 .Plain text 

List out image file formats :  

1) TIFF (Tagged Image File Format)  2) BMP (Bitmap) 3) DIB (Device Independent Bitmap)  

4) GIF (Graphics Interchange Format) 5) JPEG (Joint Photographic Experts Group) 

List out audio file formats:  

1) WAV (Waveform Audio File Format) 2) MP3 (MPEG Layer-3 Format) 3) OGG     

4) WMA (Windows Media Audio) 5) RA (Real Audio Format)  

List out video file formats:  

1) AVI (Audio/Video Interleave)  2) MPEG (Moving Picture Experts Group) 

3) WMV(Windows Media Video) 4) MOV(Quick time format) 4) FLV (Adobe Flash Video Format 
 CHAPTER – 2 ( An Introduction to Adobe Page maker ) 

1. What is PageMaker? Explain its uses.  (J-2022)                                             

❖ Adobe PageMaker is a page layout software. 

❖ It is used to design and produce documents that can be printed. 

❖ Page layout software includes tools that allow you to easily position text and graphics on document pages. 

Example: Creating a newsletter that includes articles and pictures on each page using PageMaker 

2. Mention three tools in PageMaker and write their keyboard shortcuts. 

1.Pointer Tool- F9     2.Rotating Tool- Shift + F2       3.Line Tool- Shift + F3      

3. Write the use of any three tools in PageMaker along with symbols.  

4. How do you re-join split blocks? (M-2024) 

To re-join the two text blocks:    

1. Place the cursor on the bottom handle of the second text block, click and drag the bottom handle up to the top. 
2. Then place the cursor on the bottom handle of the first text block, and click and drag the bottom handle down if necessary. 

5. How do you link frames containing text? 

To link frames containing text, 

1. Draw a second frame with the Frame tool of your choice. 

2. Click the first frame to select it. 

3. Click on the red triangle to load the text icon. 

4. Click the second frame. PageMaker 

5. Page Maker flows the text into the second frame. 

6. What is the use of Master Page? (M-2020, M-2023) 

❖ Any text or object that you place on the master page will appear on the entire document pages to which the master is 

applied.  

❖ It shortens the amount of time because you don’t have to create the same objects repeatedly on subsequent pages. 

❖ Master Pages commonly contain repeating logos, page numbers, headers and footers.  
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7. How to you insert page numbers in Master pages? (M-2022) 

1. Click on Master Pages icon. 

2. Then click on Text Tool. Now the cursor changes to I – beam. 

3. Then Click on the left Master page where you want to put the page number. 

4. Press Ctrl + Alt + P. 

5. The page number displays as ‘LM’ on the left master page. 

6. Similarly click on the right Master page where you want to put the page number. 

7. Press Ctrl + Alt + P. 

1. How to resize a Text Block in PageMaker? (S-2020) 

❖ When you select a text block with the Pointer tool, the block’s boundaries become visible.  

❖ Two handles are seen above and below the text block. These handles are called Window shades. 

❖ There is a dark square on both ends of the handle. These are used to change the size of the text block 

 CHAPTER  -  3 (Introduction to Database Management System) 

1. Explain on Evolution of DBMS.                                                               

❖ The concept of storing the data started before 40 years in various formats. 

❖  In earlier days they have used punched card technology to store the data.  

❖ Then files were used.  

❖ The file systems were known as predecessor of database system. 

❖ Various access methods in file system were indexed, random and sequential access.  

2. What is relationship in databases? List its types. (M-2022, M-2023) 

❖ In Entity Relationship Model, relationship exists between two entities. 

❖ Three types of relationships are, 1) One-to-One relationship         

2) One-to-Many relationship      3) Many-to-Many relationship 

One-to-One relationship:  

❖ Consider two entities A and B.  

❖ one-to-one (1:1) relationship is said to exist in a relational database design, if 0 or 1 instance of entity A is 
associated with 0 or 1 instance of entity B, and 0 or 1 instance of entity B is associated with 0 or 1 instance of entity A.  

One-to-Many relationship:  

❖ Consider two entities A and B.  

❖ one-to-many (1:N) relationship is said to exist in a relational database design, for 1 instance of entity A there 

exists 0 or 1 or many instances of entity B, but for 1 instance of entity B there exists 0 or 1 instance of entity A.  

Many-to-Many relationship: 

❖ Consider two entities A and B.  

❖ many-to-many (M:N) relationship is said to exist in a relational database design, for 1 instance of entity A 

there exists 0 or 1 or many instances of entity B, and for 1 instance of entity B there exists 0 or 1 or many 

instance of entity A. 

3. Discuss on Cardinality in DBMS.  (J-2023)  

❖ It is defined as the number of items that must be included in a relationship. 

❖ It is defined as the number of different values in any given table column. 

Example :   

❖ Number of entities in one set mapped with the number of entities of another set via the relationship.  

❖ Three classifications in Cardinality are one-to-one, one-to-many and Many-to-Many 

 
4. List any 5 privileges available in MySQL for the User. 

   Privileges   Action Performed (If Granted) 

1.Select_priv User can select rows from database tables. 

2.Insert_priv User can insert rows into database tables. 

3.Update_priv User can update rows of database tables. 

4.Delete_priv User can delete rows of database tables. 

5.Create_priv User can create new tables in database. 

6.Alter_priv User can make changes to the database structure. 
 

5. Write few commands used by DBA to control the entire database. 

1.USE Database :   

❖ This command is used to select the database in MySQL for working. 

         Mysql>use test; 

         Database changed 

2. SHOW Databases :   

❖ Lists all the databases available in the database server           Mysql>show databases; 
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3. SHOW Tables :    

❖ Lists all the tables available in the current database we are working in. 

          Mysql>show tables; 

1. What are the Types of SQL Commands? (S-2020)  

(i) Data Definition Language (DDL) (ii) Data Manipulation Language (DML 

(iii) Data Query Language (DQL) (iv) Transaction Control Language (TCL) (v) Data Control Language (DCL) 

2. Explain different types of attributes in PHP (J-2022) 

1. Key Attribute: Generally a key attribute describes a unique characteristic of an entity. 

2.Simple Attribute: 

❖ The simple attributes cannot be separated it will be having a single value for their entity.  

3.Composite Attributes: 
❖ The composite attributes can be subdivided into simple attributes without change in the meaning of that attribute. 

4.Single Valued Attributes: 
❖ A single valued attribute contains only one value for the attribute and they don’t have multiple numbers of values.  

5.Multi Valued Attributes:  

A multi valued attribute has more than one value for that particular attribute. 

 CHAPTER – 4 ( PHP : Hypertext Pre-Processor ) 

1. What are the features of PHP?                            

1.Server-side scripting language: 

❖ PHP is a server-side scripting language, which means that the scripts are executed on the server and the output 

is sent to the client. 

2.Open-source software: 

❖ PHP is an open source software, which means that the source code is available for anyone to view and modify. 

3.Platform independent: 

❖ PHP can be run on many different operating systems, including windows, Linux, and macOS. 

4.Database support: 

❖ This makes it easy to create database-driven websites. 

2. Explain the types of PHP Tags. 

❖ PHP supports three different set of tags:  1. Default Syntax 2. Short open Tags 3. HTML Script embed Tags. 

1. Default Syntax: 

❖ In the PHP Default tags, PHP code is enclosed in <?php and ?> tags. 

2. Short open Tags: 

❖ Short open tags are an alternative to the default syntax, and they allow you to use  <? and ?> instead of  <?php and ?>. 

3. HTML Script embed Tags: 

❖ You can also embed PHP code within HTML script tags, 

Example:   <script language=”Php”> 

                       // PHP code 

                    </script> 

3. Write about the rules for naming a variable in PHP. (J-2023) 

1. A Variable’s name must start with a dollar sign ($), for example: $name. 
2. The Variable’s name can contain a combination of strings, numbers, and the underscore, for example: $my_report1. 

3. The first character after the dollar sign must be either a latter or an underscore. 

4. Variable names in PHP are case-sensitive.  

❖ This is a very important rule. It means that $name and $Name are entirely different variables.  

4. List out the different types of data types in PHP. 

1.Integer 2.Float 3.String 4.Boolean 5.Array 6.Object 7.Resource 8.NULL 

5. Write about the syntax of PHP. 

❖ We should always keep in mind these two basic rules of PHP. 

1. PHP code is enclosed in <?php and ?>tages. 

❖ These tags are called opening and closing tags. 

Example:  <?php   // PHP code   ?> 

2. A PHP statement must end with a semicolon (;) 

Example: 

<php 

 echo “Hello, World!”;  // This is a valid PHP statement 

?>  

1. Write the output of the following PHP script. (J-2023)            Output  

<?php                                                                                     Welcome to PHP programming 

function welcome ()                                                               Dear student 

echo “Welcome to PHP programming!”. ”<br>”;                 Give your best in your exams 

echo “ Dear”. “Student”. “<br>”; 

echo “Give your best in your exams”.”<br>”;}Welcome (); ?> 
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2. Write the output of the following program (M-2023) 

<?php                                    Output: 

$a = 5; $b = 10;                       75 

$c = ($a+$b)* $a; 

echo $c;  ?> 

3. Write short notes on PHP operator. (M-2022) 

❖ Operator is a symbol which is used to perform mathematical and logical operations in the programing languages.  

❖ Different types of operator in PHP are: 

(i) Arithmetic operators, (ii) Assignment operators, (iii) Comparison operators,  

(iv) Increment/Decrement operators, (v) Logical operators, and (vi) String operators. 

4. What is the purpose of webserver and web browser? (M-2020) 

Web server : 

❖ A web server’s main purpose is to store web files and broadcast them over the internet for you site visitor’s to see. 

❖ In-essence, a web server is simply a powerful computer that stores and transmits data via the internet 

Web browser : 

❖ A Web browser (commonly referred to as a browser) is a software application for accessing information on the 

World Wide Web.  
❖ Each individual Web page, image, and video is identified by a distinct URL, enabling browsers to retrieve and 

display them on the user’s device. 

5. Write short notes on comparison operator in PHP (J-2022) 

Comparison Operators: 
❖ Comparison operators are used to compare two values and determine whether a certain condition is true or false.  

Operator Operator Name Meaning Example Output 
> Greater than  It return True if left is greater than right  5>2 True 

< Less than It return True if left is less than right 5<2 False 
>= Greater than or equal to It return True if left is greater than or equal to right 5>=2 True 
<= less than or equal to It return True if left is less than or equal to right 5<=2 False 
= = Equal to It return True if left is equivalent to right 5= = 5 True 
!= Not equal to It return True if left is not equivalent to right 5!=5  5!=6 True  False 

 

 CHAPTER – 5 ( Functions and Arrays IN PHP ) 

1. What are the advantages of using functions in PHP? (J-2024) 

1.Code reuse: 

❖ Functions allow us to reuse code, which can save us time and effort when writing and maintaining our code. 

2.Testing and debugging: 

❖ Functions allow us to test and debug our code more easily, as we can test individual functions separately from 

the rest of the code. 

3. Modularity: 

❖ Functions allow us to break down our code into smaller, modular pieces, which can make it easier to maintain 

and modify. 

2. What is the syntax for defining a function in PHP? 
function functionName( [parameter list] ) 

{ 

    // code to be executed  

} 

3. How do you call a function in PHP? 

❖ Calling a function is another name for executing the function. 

❖ A function is called simply by using the function name, along with an argument list, as a statement. 

Syntax:   functionName();  {or} 

                functionName(argument list); 

4. Write Short notes on an Associative array.  

❖ An associative array is a data structure that stores a collection of key-value pairs. 

❖ The keys are used to identify the values, and the values can be of any data type. 

❖ The keys in an associative array are often called “labels” because they label or identify the corresponding values. 

1. What is user defined function? Write its syntax. (M-2020) 

❖ We can define a user defined function by using the ‘function’ keyword, followed by the name of the function 

and a set of parentheses.  

❖ Here is the general syntax for creating a function in PHP:  

❖ Function definition (or declaration) 

Syntax:   
function functionName([parameter list])  

{  

// code to be executed } 
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2. Write the output of the following PHP code. (M-2022) 

<?php>                                                   Output 

$S=array(11, 333, 7777);                       Syntax error 

foreach($S as $V) 

print $V “<br>”; 

<?> 

3. Write the output of the following PHP script (J-2022) 

<?php                                                  Output: 

$x = array (10, 20, 30);                        Sum = 90 Rupees.  [or] Syntax error 

$y = array (50, 60, 80);  

$z = $y [1] + $x[2]; 

Print (“Sum = “ .z.”Rupees” 

4. How many types of Functions are there in PHP? Mention its types. (S-2020) 

❖ In PHP, there are several types of functions that we can use. 1. User defined function, 2. Built-in functions 

 CHAPTER – 6 ( Conditional Statements IN PHP ) 

1. Write the syntax for an if..elseif..else statement in PHP. 

if (condition 1) 

{  

    // code to be executed if condition 1 is true; 

} 

elseif (condition 2) 

{  

    // code to be executed if condition1 is false and condition 2 is true; 

} 

elseif (condition 3) 

{  

    // code to be executed if condition1 and condition 2  is false and condition 3 is true; 

} 

else 

{ 

   // code to be executed if  all conditions are false; 

} 

2. Write the Syntax for a Switch statement in PHP. 

switch (expression) 

{ 

  case value1: 

       //code to be executed if  expression = value1; 

   break; 

   case value2: 

      //code to be executed if  expression = value2; 

   break; 

default: 

      //code to be executed if expression is not equal to any of the values;   

} 

3. In an if..elseif..else statement, where is the code executed if all conditions are false? 

❖ The if..elseif..else statement is a conditional statement in PHP. 

❖ This statement allows you to check multiple conditions and run different code based on which condition is 

true. 

❖ This type of statement begins with the keyword ”if”. 

❖ It can be followed by one or more “elseif”. 

❖ Finally ends with an “else” part. 

4. Differentiate if statement and if elseif else statement.  (M-2022) 

If statement If else statement 

If-elseif-else statement is a combination of if else 

statement 

If statement executes a single statement 

More than one statement can execute the condition 

based on user needs 

Only one statement can execute 

If the condition if false more alternatives are there. If the condition is false, there is no alternative 
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 CHAPTER – 7 ( Loops in PHP ) 

1. Describe the three parts of a for-loop in PHP (initialization, condition and increment) and explain their 

purpose. 

❖ The initialization part is executed only once at the beginning of the loop. 

❖ It is used to initialize variables. 

❖ The condition is evaluated before each iteration of the loop. 

❖ If it is true, the code block is executed. 

❖ If it is false, the loop is terminated. 

❖ The increment/decrement part is executed after each iteration for the loop. 

❖ It is used to update variables. 

2. Write a PHP code to print 1 to 10 numbers ascending order using for loop.           Output             (J-2024) 

❖ To print the numbers from 1 to 10 in ascending order.                                               1 to 10 

       for ($i = 1; $i<= 10; $i++) 

      { 

      echo $i. “<br>”; 

       } 

3. Explain the difference between while loop and do…while loop in PHP. 

While loop Do while loop 

1.Execution order 1.Execution order 

The while loop first evaluates the condition before 

executing the code block. 

On the other hand, the do..while loop first executes the 

code block and then evaluates the condition. 

If the condition is true, the code block is executed. If the condition is true, the code block is executed again. 

If the condition is false, the loop is terminated If the condition is false, the loop is terminated 

2.Minimum number of iteration 2.Minimum number of iteration 

The while loop may not execute the code block at all if 

the condition is false from the beginning. 

The do..while loop, on the other hand, guarantees that 

the code block will be executed at least once, even if 

the condition is false. 
 

1. Write the features of Looping structure (M-2020) 

❖ Looping structures are useful for writing iteration logics. 

❖ It is the most important feature of many programming languages, including PHP. 
2. Write the output of the following PHP code. (M-2024) 

<?php>                                                                           Output 

$S=array(“a”=>10,”b”=>20,”c”=>30);,                         a=>10                                          

foreach($array as $key=>  $value)                                 b=>20 

{                                                                                      c=>30 

echo $key.”=>”.$value. “<br>”; 

} 

<?> 

 CHAPTER -  8 ( Forms and Files) 

1. Explain the difference between checkbox and radio button in HTML forms. (J-2024) 

❖ Checkbox is a important feature which selects more than one value from the HTML form.  

❖ Radio box is similar to checkbox but one value can be chosen at a time. 
2. Explain the difference between the POST method and GET method of sending data to the server in PHP.  

❖ All the input values are synchronized and sent to the server via POST method or GET method.        (J-2023) 

GET Method: 

❖ The input data sent to the server with POST method via URL address is known as query string. 

❖ All input data are visible by user after they clicks the submit button. 

POST Method: 

❖ The input data sent to the server with POST method is stored in the request body of the client’s HTTP request. 

3. What are the different file handling tasks that can be performed using PHP? 

1. PHP Open a File,      2. PHP Read a File, 3. PHP Close a File,         

fopen( ) ❖ The fopen() is a system function available in PHP.  

❖ This function helps to open a file in the server. 

fread( ) ❖ The fread() function reads from an open file.  

❖ The file object comes from fopen function. 

fclose ( ) ❖ The fclose() function is used to close an opened file.  

❖ The file object comes from fopen function. 
 

1. Write the Basic HTML Form Controls (S-2020) 

1. Text inputs 2. Buttons 3. Checkbox 4. Radio box 5. File Select 6. Form Tag 
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 CHAPTER – 9 ( Connecting PHP and MYSQL ) 

1. Write the Syntax for MySQLi Queries.                                                       

❖ “mysqli_query” is a function, helps to execute the SQL query statements in PHP scripting language.  

Syntax:         mysqli_query(“Connection Object”,”SQL Query”) 

2. Write is the purpose of MySQLi function available.  

❖ In PHP Scripting language many functions are available for MySQL Database connectivity and executing SQL queries.  

❖ MySQLi is extension in PHP scripting language which gives access to the MYSQL database. MySQLi 

extension was introduced version 5.0.0, 

❖ The MySQLi extension contains the following important functions which are related to MySQL database 

connectivity and management. 1.Mysqli_connect( )  2.Mysqli_close( )   3.Mysqli_query( ) 

3. Write MySQL Connection Syntax with example. (M-2020, S-2020, J-2022, M-2024) 

Syntax:  mysqli_connect(“Server Name “,”User Name”,”Password”,”DB Name”); 

Example:    $conn = mysqli_connect($servername, $username, $password,$DB_name); 

 CHAPTER – 10 ( Introduction to Computer Networks ) 

1. Write a note on Resource sharing. 

❖ It allows all kind of programs, equipment’s and data to be accessed by anyone via network irrespective of the 

physical location of the resource. 

❖ Simply resource sharing is a sharing of devices like printers, scanner, PDA, fax machine, and modems. 

2. List out some benefits of social networks. (J-2024) 

1.Group information sharing over long distances:  

❖ Although friends and family members can keep in contact via mobile phone calls or by text messages, social 

nets provide a much richer environment for staying connected. 

2.Broadcast announcements:  

❖ Quick, easy way to spread information’s of emergencies and natural calamities. Venues and local shops can 

advertise upcoming events on social networks.  

3.Fostering diversity of thought:  

❖ Some critics of social networks point out that online communities attract people by similar interests and backgrounds. 

3. Write a note on Mobile networks. 

❖ Mobile network is the network connecting devices without cable (wireless).  

❖ Mobile computers, such as laptop, tablet, and hand held computers, were fastest growing segments.  

❖ At land areas network was distributed as cells, each will be served by single – location transceiver, but 

generally three cell sites or a base transceiver station.  

❖ This base station provides the cell with network coverage and other features that can be utilized for 

transmission of voice, data and other content as well.  

❖ Joining together all radio coverage is called as wide geographical area.  

❖ This portable transceivers used to communicate with one another with fixed transceivers and moving via more 

than one cell during transmission.  

❖ For example mobiles, tablets, pagers, laptops, engaged with mobile broadband just like modems etc. 

1. What do you mean by artificial intelligence? (J-2023) 

❖ Artificial intelligence will help to maintain, manage, and protect the network problems. 

❖ Now the networks are monitored by algorithm that enables for anomalous build-ups of traffic and activity 

which may be the result of nasty activities such as (D Dos) Distributed Denial of- Service attacks and 

attempted hacks. 

❖ Artificial intelligence will be able to predict traffic as it collects and analyses data in real time. 

 CHAPTER – 11 ( Network Examples and Protocols) 

1. Compare Internet, Intranet and Extranet. (M-2022) 

1.Internet: 

❖ The Internet is a network of global connections – comprising private, public, business, academic and 

government networks – linked by guided, wireless and fiber-optic technologies. 

Ex: Sending email to a friend. 

2.Intranet: 

❖ It is a private network within an enterprise to share company data and computing resources between the 

employees. It may consist of many interlinked local area networks. 

Ex: Accessing your record in the employee personnel file. 

3.Extranet: 

❖ It is a private network that uses Internet technology and the public telecommunication system to securely share 

business’s information with suppliers, vendors, partners, customers, or other businesses. 

Ex: Checking availability of inventory from an outside supplier.           

2. Write short notes on HTTP, HTTPS, FTP (M-2023) 

HTTP : 

❖ It is used between a web client and a web server and it guarantees non secure data transmissions. 
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HTTPS: 

❖ It is used between a web client and a web server ensures secure data transmissions. 

FTP : 

❖ It is used between computers for sending and receiving file. 

3. What are the layers available in TCP/IP Reference Model? (J-2023) 

❖ Network Access Layer        -   Concerned with building packets. 

❖ Internet Layer            - Describes how packets are to be delivered. 

❖ Transport Layer           - Ensure the proper transmission of data. 

❖ Application Layer              -   Application network processes. 

1. What is Intranet (M-2020) 

❖ It is a website used by organizations to provide a place where employees can access company related information.  

❖ It is a private network within an enterprise to share company data and computing resources between the employees. 

2. Differentiate HTTP and HTTPS  (S-2020) 

HTTP: A protocol used between a web client and a web server protects non-secure data transmissions. 

      The core protocol of the World Wide Web. 

HTTPS:A protocol used between a web client and a web server permits secure data transmissions. 

 CHAPTER – 12 ( DNS – Domain Name System ) 

1. Write a note on URL and its types. 

❖ URL (Uniform Resource Locator) is the address of a document on the Internet.  

❖ URL is made up four parts–protocols, hostname, folder name and file name. 

URL Type:   1.Absolute URL  2.Relative URL  

2. Differentiate Ipv4 and Ipv6. 

Ipv4 Ipv6 

❖ Ipv4 address is a 32-bit unique address given to 

a computer system. 

❖ Ipv6 address is a 128-bit unique address given to a 

computer system. 

❖ The number of addresses that can be formed in 

Ipv4 is 232. 

❖ The number of addresses that can be formed in Ipv6 is 

2128. 

❖ IP address represented by, Binary notation 

Dotted-decimal notation 

❖ IP address represented by, 4-digit Hexadecimal numbers 

separated by colon symbols. 
 

3. What are the differences between Absolute URL and Relative URL? (M-2023, J-2024) 

                Absolute URL               Relative URL 

❖ Absolute URL is the complete address of a 

document on the Internet. 

❖ Relative URL is the partial address of a document on 

the Internet. 

❖ Absolute URL contains all the information that 

are required to find the files on the Internet. 

❖ Relative URL contains only file name or file name 

with folder name. 

❖ All the four parts is very important in absolute 

URL. 

❖ Relative URL is used when the file is on the same 

server related to original document. 
 

4. Write a note on domain name.  

❖ Domain name is the sequence of labels, which are separated by dot (.). 

❖ The domain name is always read from the lower level to higher level i.e., from the leaf node to root node. 

❖ Since the root node always represent NULL string, all the domain name ending with dot. 

1. Expand ARPANET, STP and USB. (M-2022) 

❖ ARPANET - Advanced Research Projects Agency Network 

❖ STP - Shielded Twisted Pair     USB - Universal Serial Bus 
2. What is URL? Write its types. (S-2020)  

❖ URL means Uniform Resource Locator. It is the address of a resource on the internet.  

❖ A URL indicates the location of a resource as well as the protocol used to access it. 

Eg. : http://www.google.com The URL is divided into 2 types : (i) Absolute URL (ii) Relative URL 

 CHAPTER – 13 ( Network Cabling) 

1. Write a note on crossover cables.                                                               

❖ Cross over cable is used to join two network devices of the same type like example two PC’s or two network devices. 

❖ The Null modem Cables are the example of the crossover cables. 

❖ Crossover cable is used to connect two computers or Ethernet devices directly together without a hub. 

❖ The pairs (Tx and Rx lines) will be crossed which means pin 1 & 2 of the plug on one end are connected with 

pin 3 & 6 of the plug on other end, and vice versa (3 & 6 to pin 1 & 2). 

2. Write a short note on RJ45 connector. 

❖ The RJ45 connector looks similar like a telephone jack but it looks a slightly wider. 

❖ In RJ45 the “RJ” stands for registered jack and the “45” simply refers to the interface standard. 

❖ The RJ45 connector is a small plastic cube. It has 8 pins. 

❖ It is connected to each end of the Ethernet cable.It is also known as 8P8C connector. 

❖ These plugs are inserted into Ethernet port of the network card. 
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3. What is meant by null modem cable? (M-2024) 

❖ A cable interconnecting two devices directly (or without modem) is known as a null modem cable. 

Example: Crossover cable, RS-232, Rollover cable. 

4. What are the components involved in Ethernet cabling? 

❖ 1) Patch Cable (Twisted pair) 2) RJ45 Connector 3) Ethernet Ports 4) Crimping Tool 

5. What are the types of Fibre optic cables? (J-2023, J-2024) 

❖ There are two types of fibre optic cables are available are, 

❖ Single-mode (100BaseBx) 2) Multimode (100BaseSX). 

Single-mode cables: Used for long distance transmission and at a high cost. 

Multimode cables: Used for short distance transmission at a very low cost. 

 CHAPTER – 14 ( Open Source Concepts ) 

1. What are the uses of Open source Network Software?   (M-2022) 

❖ We can select and use any software that suits our needs.  

❖ The complete option of the software can be used without any cost and restrictions.  

❖ We can share our ideas with the team, write the required code share it with many. 

❖ We can learn many ideas and make our program writing skills more efficient.  

❖ We can add the most required features in the software by making changes. 

❖ Many open source software are very user friendly. 

2. Explain Free software. 

❖ The free software ability to download and modify software without restriction or charge.  

❖ However, free software is a concept developed in the 1980s by an MIT computer science researcher, Richard 

Stallman who defined four conditions – as outlined by the non-profit Free Software Foundation.  

❖ These “four freedoms” emphasize the ability of users to use and enjoy software as they see fit. 
❖ Freeware usually refers to proprietary software that users can download at no cost, but whose source code cannot be 

changed. 

3. List out the Popular open source software. (J-2022) 

❖ NS2, OPEN NMS, My SQL, PDF Creator, Open Office, 7zip, GNUCASH, GIMP, BLENDER, 

❖ AUDACITY, VLC, MOZILA, FIREFOX, MAGENTO, ANDROID, PHP. 

4. Write note on open source hardware. 

❖ In this period of increased competition and cyber-crimes, the computers used by individuals or business 

organisations may have spy hardware’s of rivals. 

❖ Open source hardware technology helps in such threats. 

❖ In this technique we get the components of the hardware and its circuit diagram, so we can remove suspicious 

spyware if found.  

Open Source Hardware: 

1.Remix   2.Redistribute 3.Remake 4.Resell 5.Remanufacture  6. Study and Learn 

5. Explain Types of Organisations related to Open Source. 

1) Apache Software Foundation  2) Free Software Foundation 

3) Linux Foundation                    4) Open Source Initiative 

 CHAPTER – 15  ( E-Commerce) 

1. Describe how E-Commerce is related to socio-technological changes.   

❖ Growth of E-Commerce is also related to the socio-technological changes. 

❖ The more, the medium becomes deep rooted, the more, are the users drawn towards it. 

❖ Increase of users, increases the markets.As the markets expand, more business organizations are attracted. 

❖ The more businesses accumulate it create competition. 
❖ The competition leads to innovation; innovation in turn drives the development of technology; technology 

facilitates E-Commerce’s growth. 
2. Write a short note on the third wave of E-Commerce. (J-2024) 

❖ The third wave is brought on by the mobile technologies. 

❖ It connects users for real-time and on-demand transactions via mobile technologies. 

❖ The term Web 3.0, summarizes the various characteristics which include Artificial Intelligence, Semantic Web, 

and Generic Database etc. 

3. Explain B2B module in E-Commerce. (J-2023, M-2024) 

❖ In B2B E-Commerce, commercial transactions take place between different business organizations, through the Internet. 

Example: 

❖ A cycle company may buy tyres from another company for their cycles. 
❖ When compared to other models, the value per transaction in B2B transaction is high, because of bulk purchases. 

❖ The company also might get the advantage of discounts on bulk purchases. 

Out-sourcing and Off-shoring are generally associated with B2B E-Commerce.  

❖ If a company’s work is hired to another company, it would be termed as out-sourcing.  

❖ If the work is outsourced to a company, which is outside its own country, it is called as off-shoring.  
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4. Write a note on name-your-price websites. 

❖ Name-your-price sites are just like normal retail sites. 

❖ In contrast, the buyer negotiates with the retailer for a particular product or service. 

Example: https://in.hotels.com/  
5. Write a note on physical product dispute of E-Commerce. 

❖ Physical product disputes are a major disadvantage in E-Commerce. 

❖ E-Commerce purchases are often made on trust because, we do not have physical access to the product. 

❖ Though Internet is an effective channel for visual and auditory information but not senses. 

❖ We can see pictures of the perfumes, but could not smell their fragrance. 

❖ If we want to inspect something, we choose what we look at and how we look at it. 

❖ But in online shopping, we would see only the pictures the seller had chosen for us. 
❖ People are often much more comfortable in buying the generic goods rather than unique or complex things via the Internet. 

1. Explain B2C module in E-Commerce. (M-2023) 

❖ In B2C E-Commerce, commercial transactions take place between business firms and their consumers.  

❖ It is the direct trade between companies and end-consumers via the Internet.  

❖ B2C companies sell goods, information or services to customers through online in a more personalized 

dynamic environment and is considered as real competitor for a traditional storekeeper. 

Example:  A book company selling books to customers. 

2. Classify the E-Commerce Business Models (S-2020) 
(i) Business to Business (B2B) (ii) Business to Consumer (B2C)  (iii) Business to Government (B2G) 

(iv) Consumer to Business (C2B) (v) Consumer to Consumer (C2C)(vi) Consumer to Government (C2G) 

(vii) Government to Business (G2B)(viii) Government to Consumer (G2C)(ix) Government to Government (G2G) 

 CHAPTER – 16 ( Electronic Payment Systems) 

1. Define micro electronic payment and its role in E-Commerce. (J-2022)   

❖ Micro Electronic Payment is an on-line payment system designed to allow efficient and frequent payments of small amounts. 

Role in E-Commerce: 

❖ An e-commerce payment system facilitates the acceptance of electronic payment for online transaction. 

❖ E-commerce payment systems have become increasingly popular due to the widespread use of internet- based 

shopping and banking. 

2. Compare and contrast the credit card and debit card.  

           CREDIT CARD                    DEBIT CARD 

You can buy items on EMI You can’t by items on EMI 

Repayment of used with in stipulated period. No repayment required. 

Pay Later System Pay Now System 

The credit card issuer lends money to customer with an 

agreed interest. 

The debit card deducts the amount directly from 

customer’s bank account. 
The bank account is not prerequisite for issuing a credit card. The bank account is must for issuing a debit card. 

 

3. Explain briefly Anatomy of a credit card. 

1. Publisher:  

❖ Emblem of the issuing bank  

2. Credit card number:  

❖ The modern credit card number has 16-digit unique identification number. 

3. Name of the cardholder:  

❖ It is visibly embossed on the front side of the card. 

4. EMV chip:  

❖ It is integrated chip in addition to magnetic stripe to store cardholder’s information.  

5. RFID symbol:  

❖ It indicates that it is a contactless smartcard.  

6. Expiration month and year:  

❖ The card is valid until the last day of the month printed on it.  

7. Card brand logo:  

❖ It is the name of the credit card network company.  

Ex: Visa and MasterCard Rupay  

8. Magnetic stripe:  

❖ It is an iron based magnetic material containing encrypted data about the card holder and account number.  

9. Hologram:  

❖ Hologram is a security feature that prevents duplication 

10. Signature:  

❖ It is cardholder’s signature at the back of the card 

11. CVC/CVV:  

❖ Card Verification code/ value is a 3 digit code usually printed to the left of signature pane validates the card.  
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4. Briefly explain the stored value card and its types. (M-2024) 

❖ Stored value card is a type of debit card that is pre-loaded with certain amount (value), with which a payment is made. 

❖ It is a card that has default monetary value onto it.  

❖ The card may be disposed when the value is used, or recharged to use it again. 

TYPES OF STORED VALUE CARD: 

1.Closed loop (single purpose): 

❖ Money is metaphorically stored on the card in the form of binary-coded data. 

2.Open loop (multipurpose): 

❖ Open loop cards can be used to make debit transaction at variety of retailers. 

5. What is electronic fund transfer? (M-2022) 

❖ Electronic Funds Transfer (EFT) is the “electronic transfer” of money over an online network.  
❖ The amount sent from the sender’s bank branch is credited to the receiver’s bank branch on the same day in batches.  

❖ Unlike traditional processes, EFT saves the effort of sending a demand draft through post and the inherent 

delay in reaching the money to the receiver. 

❖ Banks may charge commission for using this service.  

❖ EFT is a widely used method for moving funds from one account to another in B2B business models. 

 CHAPTER – 17 (E-Commerce Security Systems) 

1. What is E-Commerce Security system? (J-2024) 

❖ E-commerce security is a set of protocols that safety guide E-commerce transactions through the internet. 

❖ Security has become a critical factor and core issue in the emerging E-business. Solving the security problems 

in transactions is the basis for ensuring the smooth development of E-business. 

2. List any two E-Commerce Security Threats? (M-2024) 

1. Information leakage      2.Tampering 3.Payment frauds   4. Malicious code threats   

5. Distributed Denial of Service (DDOS) Attacks   6. Cyber Squatting   7.Typo piracy 8.Phishing 

1. Information Leakage : (Two aspects) 

a) The content of the transaction between the vendor and customer is stolen by the third party. 

b) The documents provided by the merchant to the customer or vice versa are illegally used by the other.  
❖ This intercepting and stealing of online documents is called information leakage. 

2.Tampering : 

❖ E-commerce has the problem of the authenticity and integrity of business information. 

❖ When hackers grasp the data transmitted on the network, it can be falsified in the middle through various 

technical means, and then sent to the destination, thereby destroying the authenticity and integrity of the data. 
3. Write a note on asymmetric key encryption.  (M-2023) 

❖ Asymmetric key encryption is also known as public key encryption. 

❖ It uses public key authentication and digital signatures. 

❖ Different keys are used for encryption and decryption. 

❖ Speed of encryption or decryption is comparatively slow. 

❖ The size of cipher text is always greater than plain text. 

4. Write a note on digital certificate. 

❖ A digital certificate is an electronic document used to prove the ownership of a public key. 

❖ This certificate includes the information about the sender’s identity, digital signature and a public key.  

❖ A digital certificate function is similar to the function of identification cards such as passports and driving 

licenses. Digital certificates are issued by recognized Certification Authorities (CA). 

5. Write about plain text cipher text: 

Plain text:    

❖ It is the unencrypted information also called as input chip 

Cipher text:   

❖ It is the encrypted data usually the output of an encryption algorithm. 

1. Write short note on mining in crypto currency? (M-2020) 

❖ The crypto currency units are created by the solution of cryptographic tasks called mining. 

❖ The miners not only generate new monetary units, but also initiate new transactions to the block chain. 

❖ As a reward, they will receive new Bit coins. 
 CHAPTER – 18 ( Electronic Data Interchange- EDI) 

1. Write a short note on EDI via VAN                                                                       

❖ EDI via VAN (Value Added Network) is where EDI documents are transferred with the support of third party network 

service providers.  

❖ Many businesses prefer this network model to protect them from the updating ongoing complexities of network 

technologies. 

2. List the various layers of EDI.  (J-2023, M-2024) 

1. Semantic layer 2.Standards translation layer 3. Transport layer  4.Physical layer 

3. Write a note on UN/EDIFACT. 

❖ United Nations / Electronic Data Interchange for Administration, Commerce and Transport (UN / EDIFACT) is an 
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international EDI - standard developed under the supervision of the United Nations. 

❖ In 1987, the UN / EDIFACT syntax rules were approved as ISO: ISO9735 standard by the International Organization for 

Standardization. 

❖ EDIFACT includes a set of internationally agreed standards, catalogues and guidelines for electronic exchange of 

structured data between independent computer systems. 

1. What are the four major components of EDI? (M-2020) 

(i) Standard document format (ii) Translator and Mapper 

(iii) Communication software (iv) Communication network 

2. What is EDI? Write its types. (S-2020) 

❖ EDI is “Paperless Trade” and EFT (Electronic Transfer) is “Paperless Payment”. 

❖ EDI types: 1. Direct EDI  2.EDI via VAN  3.EDI via FTP/VPN, SFTP, FTPS  4.Web EDI  5.Mobile EDI 

3. Explain 3D secure payment protocol (J-2022) 

❖ 3-D Secure is a secure payment protocol on the Internet.  

❖ It was developed by Visa to increase the level of transaction security, and it has been adapted by MasterCard.  

❖ It gives a better authentication of the holder of the payment card, during purchases made on websites. 

This authentication model comprise 3 domains (hence the name 3D) which are:  

1. The Acquirer Domain 2. The Issuer Domain 3. The interoperability Domain 

4. List few types of business documents that are transmitted through EDI (M-2024) 

1. Delivery notes 2.Invoices 3.Purchase orders 4.Advance ship notice 5. Functional acknowledgements. 
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      CHAPTER 1 TO 18 FIVE MARK BOOK BACK & PUBLIC QUESTION WITH ANSWERS 
 CHAPTER – 1 ( Multimedia ) 

1. Explain in detail about production team Roles and Responsibilities. (J-2022, M-2023, M-2024) 

1.Production Manager:                                  

❖ In a multimedia production, the role of production manager is to define, and coordinate, the production of the 

multimedia project in time and with full quality. 

❖ The production manager should be an expertise in the technology expert, good at proposal writing, good 

communication skills and budget management skills. 

2. Content Specialist: 

❖ Content specialist is responsible for performing all research activities concerned with the proposed application’s content.  

❖ Program content refers to projects information, graphics, data or facts presented through the multimedia production. 

3. Script Writer : 

❖ The script writer visualizes the concepts in three dimensional environments and if needed uses the virtual reality 

integration into the program. 

4. Text Editor: 

❖ The content of a multimedia production always must flow logically and the text should always be structured and 

correct grammatically.  

5. Multimedia Architect: 

❖ The multimedia architect integrates all the multimedia building blocks like graphics, text, audio, music, video, 

photos and animation by using an authoring software. 

6. Computer Graphic Artist: 

❖ The role of Computer Graphic Artist is to deal with the graphic elements of the programs like backgrounds, bullets, 

buttons, pictures editing, 3-D objects, animation, and logos etc. 

7. Audio and Video Specialist: 

❖ The roles of these specialists are needed for dealing with narration and digitized videos to be added in a multimedia presentation 

❖ They are responsible for recording, editing sound effects and digitizing. 

8. Computer Programmer: 

❖ The computer programmer writes the lines of code or scripts in the appropriate language.  

❖ These scripts usually develops special functions like developing the software to give the size and shape of video 

windows, controlling peripherals and so on. 

9. Web Master: 

❖ The responsibility of the web master is to create and maintain an Internet web page.  

❖ They converts a multimedia presentation into a web page.  

❖ Final multimedia product is a joint effort of the entire team. 

2. Explain about different file formats in multimedia files.  (M-2020, J-2024) 

I. Text Formats : 

1.RTF 

❖ Rich Text Format is the primary file format introduced in 1987 by Microsoft with the specification of their 

published products and for cross-platform documents interchange. 

2.Plain text 

❖ Plain text files can be opened, read, and edited with most text editors.  

II. Image Formats : 

1.TIFF (Tagged Image File Format) 

❖ This format is common in desktop publishing world (high quality output), and is supported by almost all software packages.  

❖ Recent versions of TIFF allows image compression, and the format is comfortable for moving large files between computers. 

2.DIB (Device Independent Bitmap) 

❖ This format which is similar to BMP, allows the files to be displayed on a variety of devices. 

3.GIF (Graphics Interchange Format) 

❖ GIF is a compressed image format.  

❖ Most of the computer colour images and backgrounds are GIF files. 

4.JPEG (Joint Photographic Experts Group) 

❖ JPEG was designed to attain maximum image compression.  

❖ It uses compression technique, where a compression method is referred that loses some of the data required for the 

image reconstruction.  

5.PNG (Portable Network Graphics) 

❖ An extensible file format for the less loss, portable and well compressed storage of raster images. 

❖ PNG acts as replacement for GIF and also replaces multiple common uses of TIFF.  

III. Digital Audio File Formats:  

1.WAV (Waveform Audio File Format) 

❖ It is the most popular audio file format in windows for storing uncompressed sound files. 

❖ In order to attain the reduced file size it can also be converted to other file formats like MP3. 
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2.MP3 (MPEG Layer-3 Format) 

❖ MPEG Layer-3 format is the most popular format for storing and downloading music. 

3.AIFF (Audio Interchange File Format) 

❖ A standard audio file format used by Apple which is like a WAV file for the Mac. 

4.WMA (Windows Media Audio) 

❖ It is a popular windows media audio format owned by Microsoft. 

❖ WMA is a file extension used with windows media player. 

IV. Digital Video File Formats :  

1.AVI (Audio/Video Interleave) 

❖ AVI is the video file format for Windows. Here sound and picture elements are stored in alternate interleaved 

chunks in the file. 

2.MPEG (Moving Picture Experts Group) 

❖ MPEG is a standard for generating digital video and audio compression under the International Standards 

Organization (ISO) by the group of people.  

❖ Simply MPEG is the standards for digital video and audio compression. 

1. Explain in detail Process of   Multimedia  [OR] Explain Multimedia production (S-2020)(J-2023)                          

1. Conceptual Analysis and Planning: 

❖ Conceptual analysis identifies an appropriate theme, budget and content availability on that selected theme. 

❖ Copy right issues also are considered in this phase. 

2. Project design: 

❖ Once the theme is finalized objectives, goals, and activities are drawn for the multimedia project. 

❖ General statements are termed as goals.  

❖ The specific statements in the project is known as the objectives.  

❖ Activities are series of actions performed to implement an objective.  

❖ These activities contribute to the Project design phase. 

3. Pre-production: 

❖ Based on the planning and design, it is necessary to develop the project. 

 STEPS IN PRE-PRODUCTION 

4. Budgeting: 

❖ Budgeting for each phases like consultants, hardware, software, travel, communication and publishing is estimated 

for all the multimedia projects. 

5. Multimedia Production Team: 

❖ The team comprises of members playing various roles and responsibilities like Script writer, Production manager, 

Editor, Graphics Architect, Multimedia Architect and Web Master. 

6. Hardware/Software Selection: 

❖ All multimedia Application requires appropriate tools to develop and playback the application.  

❖ Hardware includes the selection of fastest CPU, RAM and huge monitors, sufficient disc for storing the records.  

7. Defining the Content: 

❖ Content is the “stuff” provided by content specialist to the multimedia architect with which the application is 

developed, who prepares the narration, bullets, charts and tables etc. 

8. Preparing the structure : 

❖ A detailed structure must have information about all the steps along with the timeline of the future action.  

9. Production: 

❖ In the multimedia application, after the pre-production activities, the production phase starts.  

❖ This phase includes the activities like background music selection, sound recording and so on.  

10. Testing: 

❖ If it’s a web based product, its functioning is tested with different browsers like Internet Explorer, Chrome, Mozilla 

and Netscape Navigator.  

11. Documentation & 12. Delivering the Multimedia Production 
 CHAPTER – 2 ( An Introduction to Adobe Page maker ) 

1. Explain the tools in PageMaker toolbox.   (M-2020, M-2023) 

Tool Toolbox Cursor Use 

Pointer tool   
Used to select, move, and resize text objects and graphics. 

Text tool 
  

Used to type, select, and edit text. 

Rotating tool 

   
Used to select and rotate objects. 

Cropping tool 

   
Used to trim imported graphics. 

Line tool 

  
+ Used to draw straight lines in any direction. 
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Constrained  

Line tool  

+ Used to draw vertical or horizontal lines. 

Rectangle tool 

 
 

+ Used to draw squares and rectangles. 

Rectangle  

Frame tool  

+ Used to create rectangular placeholders for text and graphics. 

Ellipse tool 

  

+ Used to draw circles and ellipses. 

Ellipse  

Frame tool  

+ Used to create elliptical placeholders for text and graphics. 

Polygon tool 

  
+ Used to draw polygons. 

Polygon 

Frame tool 
 

+ Used to create polygonal placeholders for text and graphics. 

Hand 

   
Used to scroll the page (an alternative to the scroll bar) 

Zoom 

   

Used to magnify or reduce an area of the page. 

 

2. Write the steps to place the text in a frame.  

To place text in a Frame: 

1. Click on one of a Frame tool from the Toolbox. 

2. Draw a frame with one of PageMaker’s Frame tools  

(Rectangle frame   tool or Ellipse Frame Tool or Polygon frame Tool).Make sure the object remains selected. 

3. Click on File. The File menu will appear. 

4. Click on Place. The Place dialog box will appear. 

5. Locate the document that contains the text you want to place, select it. 

6. Click on Open. 

7. Click in a frame to place the text in it.  The text will be placed in the frame 

3. Write the steps to draw a star using polygon tool? (S-2020, J-2023, M-2024) 

To draw a Star: 

1. Click on the Polygon tool from the toolbox. 

       The cursor changes to a crosshair. 

2. Click and drag anywhere on the screen. As you drag, a Polygon appears. 

3. Release the mouse button when the Polygon is of the desired size. 

4. Choose Element > Polygon Settings in the menu bar. 

        Now Polygon Settings dialogue box appears. 

5. Type 5 in the Number of sides text box. 

6. Type 50% in Star inset textbox. 

7. Click OK. Now the required star appears on the screen. 

1. Define a text block. How will you create and move a text block? (M-2022) 

Text block: 

❖ A text block contains the text you type, paste, or import. 

❖ All text in page maker resides inside containers called text blocks. 

To create a text block with the text tool:  

1. Select the text tool (T) from the toolbox. The pointer turns into an I-beam. 

2. On an empty area of the page or pasteboard, do one of the following 

Click the I-beam where you want to insert text. 

This creates a text block to the width of the column or page.  

By default, the insertion point jumps to the left side of the text block. 

3. Type the text you want.  

Unlike with a text frame, you do not see the borders of a text block until you click the text with the pointer tool. 

Moving a text Block:  

❖ To move a block without changing its shape, place the cursor anywhere inside the block, and click and drag it to 

the required position. 

2. How can you convert text in a text block to a frame? (M-2023) 

❖ Draw the frame of your choice using the Page Maker’s Frame Tools. 

❖ Select the text block you want to insert in the frame. 

❖ Click the frame while pressing the shift key.  

Now both elements will be selected. 

❖ Choose Element --> Frame --> Attach Content on the menu bar. 

       Now the text appears in the frame. 
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 CHAPTER  -  3 (Introduction to Database Management System) 

1. Discuss on various database models available in DBMS.            

❖ The database technology came into existence in terms of models with relational and object-relational behaviour. 

Types of Data Model: 

1. Hierarchical 2.  Network model 3. Relational model 4. Object-oriented database model 

1. Hierarchical Database Model: 

❖ The famous Hierarchical database model was IMS (Information Management System), IBM’s first DBMS.  

❖ In this model each record has information in parent/ child relationship like a tree structure.  

❖ The collection of records is called as record types / Tables. 

❖ The individual records are equal to rows. 

❖ Advantages: 1.less redundant data, 2.efficient search, 3.data integrity and 4.security. 

Limitations: 1.Complex to implement and 2.difficulty in handling many to many relationships. 

2. Network model: 

❖ The first developed network data model was IDS (Integrated Data Store) at Honeywell.   
❖ Network model is similar to Hierarchical model except that in this model each member can have more than one owner.  

❖ The many to many relationships are handled in a better way.  
❖ This model identified the three database components Network schema, Sub schema and Language for data management.  

(i) Network schema: Schema defines all about the structure of the database. 

(ii) Sub schema: Controls on views of the database for the user 

(iii) Language : Basic procedural for accessing the database. 

❖ Advantage            : 1. Ability to handle more relationship types. 

❖                                  2.  Easy data access, 3.Data integrity and 4.Independence.  

❖ Limitation             : 1. Difficulty in design and maintenance. 

❖ 3. Relational model: 

❖ Oracle and DB2 are few commercial relational models in use. 

❖ Relational model is defined with two terminologies Instance and Schema.  

Instance: A table consisting of rows and columns 

Schema: Specifies the structure including name and type of each column. 

❖ A relation (table) consists of unique attributes (columns) and tuples (rows). 

❖ 4.Object-oriented database model: 
❖ This model incorporates the combination of Object Oriented Programming (OOP’s) concepts and database technologies. 

❖ Practically, this model serves as the base of Relational model.  

❖ Object oriented model uses small, reusable software known as Objects.  

❖ These are stored in object oriented database.  

❖ This model efficiently manages large number of different data types.  

2. List the basic concepts of ER Model with suitable example.  (J-2023, M-2024) 

ER Model  basic concepts:    

❖ The basic concepts of ER model consists of..., 

❖ Entity or Entity type 2. Attributes 3. Relationship 

❖ These are the general concepts which help to create an ER diagram and produce an ER model.  

❖ With the help of these any database design can be created and viewed to know the concept in that database design. 

1.Entity or Entity type:  

❖ An Entity can be anything a real-world object or animation which is easily identifiable by anyone even by a 

common man. 

Example:  

❖ In a company’s database Employee, HR, Manager are considered as entities, where each of these entity will be 

having their own attributes.  

❖ An entity is represented by a rectangular box. 

Types of Entity:   1. Strong Entity   2. Weak Entity   3. Entity Instance  

❖ 2.Attributes:  

❖ An attribute is the information about that entity and it will describe, quantify, qualify, classify, and specify an entity.  

❖ An attribute will always have a single value, that value can be a number or character or string. 

Types of attributes: 1. Key 2. Simple 3. Composite 4. Single Valued 5. Multi Valued Attribute 

3.Relationship Type:   

❖ In ER Model, relationship exists between two entities.  
❖ Three types of relationships are available and the Entity- Relationship(ER) diagram is based on the three types listed below. 

❖ 1. One-to-One relationship 2.One-to-Many relationship3.Many-to-Many relationship. 

One-to-One relationship:  

❖ Consider two entities A and B. one-to-one (1:1) relationship is said to exist in a relational database design, if 0 or 1 

instance of entity A is associated with 0 or 1 instance of entity B, and 0 or 1 instance of entity B is associated with 

0 or 1 instance of entity A.  
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One-to-Many relationship:  

❖ Consider two entities A and B. one-to-many (1:N) relationship is said to exist in a relational database design, for 1 

instance of entity A there exists 0 or 1 or many instances of entity B, but for 1 instance of entity B there exists 0 or 

1 instance of entity A.  

Many-to-Many relationship: 

❖ Consider two entities A and B. many-to-many (M:N) relationship is said to exist in a relational database design, 

for 1 instance of entity A there exists 0 or 1 or many instances of entity B, and for 1 instance of entity B there 

exists 0 or 1 or many instance of entity A. 

3. Discuss in detail on various types of attributes in DBMS. (J-2024) 

Types of attributes:      

1. Key Attribute   2. Simple Attributes   3. Composite Attributes 

4. Single Valued Attribute 5. Multi Valued Attribute 

1.Key Attribute: 

❖ Generally a key attribute describes a unique characteristic of an entity. 

2.Simple Attribute: 

❖ The simple attributes cannot be separated it will be having a single value for their entity.  

Example: 

❖ The name as the attribute for the entity employee and here the value for that attribute is a single value. 

3.Composite Attributes: 

❖ The composite attributes can be subdivided into simple attributes without change in the meaning of that attribute. 

Example:  

❖ In the above diagram the employee is the entity with the composite attribute Name which are sub-divided into two 

simple attributes first and last name. 

4.Single Valued Attributes: 

❖ A single valued attribute contains only one value for the attribute and they don’t have multiple numbers of values.  

Example:  Age.   

❖ It is a single value for a person as we cannot give n number of ages for a single person, therefore it is a single 

valued attribute.  

Single Valued Attributes 

Attribute Values 

Age 3 

Roll no 85 

5.Multi Valued Attributes: 

❖ A multi valued attribute has more than one value for that particular attribute. 

Example: Degree.   

❖ A person can hold n number of degrees so it is a multi-valued attribute. 

Attributes and values 

Attribute Values 

Degree B.Tech, MBA 

       Bank_Account SBI, HDFC      
 

4. Write a note on open source software tools available in MySQL Administration. 

Types of software tools:  

❖ Many open source tools are available in the market to design the database in a better and efficient manner.  

❖ PhpMyAdmin is most popular for Web Administration. 

❖ The popular Desktop Application tools are MySQL Workbench and HeidiSQL. 

1.PHPMYADMIN (Web Admin) : 

❖ This administrative tool of MySQL is a web application written in PHP.  

❖ They are used predominantly in web hosting.  

❖ The main feature is providing web interface, importing data from CSV and exporting data to various formats.  

❖ It generates live charts for monitoring MySQL server activities like connections, processes and memory usage.  

❖ It also helps in making the complex queries easier. 

2.MySQL Workbench (Desktop Application): 

❖ It is a database tool used by developers and DBA’s mainly for visualization. 
❖ This tool helps in data modelling, development of SQL, server configuration and backup for MySQL in a better way.  

❖ Its basic release version is 5.0 and is now in 8.0 supporting all Operating Systems.  

❖ The SQL editor of this tool is very flexible and comfortable in dealing multiple results set 

3.HeidiSQL (Desktop Application):  

❖ This open source tool helps in the administration of better database systems.  

❖ It supports GUI (Graphical User Interface) features for monitoring server host, server connection, Databases, 

Tables, Views, Triggers and Events. 

 

www.Padasalai.Net                                                                     www.Trb Tnpsc.Com

Kindly Send Me Your Key Answer to Our email id - Padasalai.net@gmail.com

www.P
ad

as
al

ai
.N

et

www.P
ad

as
al

ai
.N

et

https://www.padasalai.net/
https://www.padasalai.net/


 

93 
                                   PREPARED BY...,    B.MOHAMED YOUSUF M.C.A., B.Ed..,    (PG   ASST IN COMPUTER SCIENCE) 

                                   [yousufaslan5855@gmail.com] 

 

5. Explain the DDL command of their function in SQL. 

❖ The DDL commands are used to define database schema (Structure). 

❖ Also to create and modify the structure of the database object in the database. 

❖ CREATE, ALTER, DROP, RENAME and TRUNCATE commands belongs to this category. 

Commands Description 

CREATE Used to create database or tables 

ALTER Modifies the existing structure of database or table 

DROP        Deletes a database or table. 

RENAME Used to rename an existing object in the database 

TRUNCATE   Used to delete all table records 

Create/Drop /Selecting Database : 

1. Create Database – used to create new SQL Database 

❖ Syntax: CREATE database databasename;  

❖ Example: mysql>create database studentDB;  

❖ The database created now can be viewed using the following Syntax:  mysql> Show databases;  

❖ As a result, the newly created studentDB will be listed.  

2. Drop Database – used to remove any of the existing SQL Database.  

❖ Syntax: DROP database databasename;  

❖ Example: mysql>DROP database studentDB;  

❖ The deleted database will not be viewed,when we list all databases using the Syntax, Show databases;  

3. Select Database – Many databases are available in the repository, from which the suitable database is selected 

using the below command.  

❖ Syntax: USE databasename;  

❖ Example: mysql>USE studentDB;  

❖ Once the database is selected, multiple operations are performed as per the needs of the application. 

1. Define a key and primary key. Explain the types of key. (M-2022) 

Key: 
❖ The candidate key that is chosen to perform the identification task is called the primary key and any others are 

Alternate keys.  

❖ Every tuple must have, by definition, a unique value for its primary key.  

❖ A primary key which is a combination of more than one attribute is called a composite primary key. 

1.Foreign Key  

❖ A foreign key is a “copy” of a primary key that has been exported from one relation into another to represent the 

existence of a relationship between them.  
❖ A foreign key is a copy of the whole of its parent primary key i.e if the primary key is composite, then so is the foreign key.  

❖ Foreign key values do not have some attribute(s) null and others non-null. 

2.Super Key:  

❖ An attribute or group of attributes, which is sufficient to distinguish every tuple in the relation from every other 

one is known as Super Key. Each super key is called a candidate key.  

❖ A candidate key is selected from the usually) have to be unique.  

❖ Foreign keys can also be null.  

❖ A composite foreign key cannot set of Super Key.  

❖ While selecting candidate key, redundant attributes should not be taken.  

❖ The candidate key is also known as minimal super keys. 

3.Composite Key  

❖ A key with more than one attribute to identify rows uniquely in a table is called Composite key.  

❖ This is also known as Compound Key. 

 CHAPTER – 4 ( PHP : Hypertext Pre-Processor ) 

1. What are the data types in PHP? Explain (J-2022, M-2022, J-2024) 

Data type: 

❖ Value assigned to variables in PHP will be of a set data type. 

Types: 1.Interger 2.Float 3.String 4.Boolean 5.Array 6.Object 7.Resource 8.NULL 

1.Intger:  

❖ Integer is a data type which contains whole numbers. It can be Positive, Negative or zero. 

Ex:   $age = 30;   $count = -10;  

2.Float:  

❖ Float is a data type which contains decimal numbers. 

Ex:    $price = 19.99;  $weight = 65.5; 

3.String:  

❖ String is a data type which contains a sequence of characters enclosed in single (‘‘) or double quotes (“ “) 

Ex:    $name = “Bharath”;   $message = ‘Hello, World!’; 
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4.Boolean:  

❖ Boolean is a data type which contains the value True or False. 

Ex:    $is_admin = true; $is_logged_in = false; 

5.Array:  

❖ An array is a data type which has multiple values in a single variable. 

Ex:    $prices = array(10, 20, 30); $items = array(“item1”,”item2”, “item3”); $prices = array(19.99, 24.99,29.99) 

6.Object:  

❖ An object is a data type that represents an instance of a class.Ex:     $user = new User(); $product = new Product(); 

7.Resource:  

❖ A resource is a special data type of data that represents a connection to an external resource, such as a file or a data base. 

Ex:      $fp = fopen(“file.txt”, “r”);  // $fp is a resource. 

            $conn = mysqli_connect(“localhost”, “username”, “Password”, “database”); //$conn is a resource 

8. NULL :  

❖ NULL is a special data type which contains NULL value.  

❖ A null value simply means no value.  The keyword NULL is not case sensitive 

Ex:      $x = null;   $y= “ “; 

2. Explain operators in PHP with example. (J-2023) 

❖ An operator is a symbol that performs a given action on a value or group of values. 

❖ The values the operations is performed upon are known as operands. 

❖ The types of operators in PHP are:    

       1. Arithmetic operators, 2. Assignment operators, 3. Comparison operators, 

       4. Logical operators, 5. Increment/Decrement operators, 6.String operators.    

1. Arithmetic operators: 

❖ Arithmetic operators are used to perform math operations for example, addition, subtraction, multiplication and division. 

Operator Operator Name Example Output 

+ Addition 5+2 7 

- Subtraction 5-2 3 

* Multiplication 5*2 10 

/ Division 5/2 2.5 

% Modulus 5%2 1 

2.Assignment Operators: 

❖ Assignment operator = is used to assign value to a variable. 

❖ The assignment operator takes the value of its right-hand operand and assigns it to its left hand operand. 

Operator Operator Name Example Output 

= Assignment  $a = 5; 5 

Combined Assignment Operators: 

Operator Operator Name Example Equivalent to Output 

+= Addition  

assignment  

$a = 5; 

$b = 2; 

$a+=$b; 

 

$a = $a + $b; 

 

7 

-= Subtraction  

assignment 

$a = 5; 

$b = 2; 

$a-=$b; 

 

$a = $a - $b; 

 

3 

*= Multiplication 

assignment 

$a = 5; 

$b = 2; 

$a*=$b; 

 

$a = $a * $b; 

 

10 

/= Division 

assignment 

$a = 5; 

$b = 2; 

$a/=$b; 

 

$a = $a / $b; 

 

2.5 

%= Modulo 

assignment 

$a = 5; 

$b = 2; 

$a%=$b; 

 

$a = $a % $b; 

 

1 

3.Comparison Operators: 

❖ Comparison operators are used to compare two values and determine whether a certain condition is true or false.  

Operator Operator Name Meaning Example Output 

> Greater than  It return True if left is greater than right  5>2 True 

< Less than It return True if left is less than right 5<2 False 

>= Greater than or equal to It return True if left is greater than or equal to right 5>=2 True 

<= less than or equal to It return True if left is less than or equal to right 5<=2 False 

= = Equal to It return True if left is equivalent to right 5= = 5 True 

!= Not equal to It return True if left is not equivalent to right 5!=5 5!=6 True  False 
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4.Logical Operators: 

❖ Logical Operators are used to perform logical operations on variables and values. 

Operator Operator 

Name 

Meaning Example Output 

&& Logical AND It returns true if  both operands are true, and 

false other wise 

(5>3)&&(5>7) False 

|| Logical OR It returns true if  at least one of the operands is 

true, and false other wise 

(5>3) || (5>7) True 

! Logical NOT It returns the opposite of the operand  !(5>3) False 

xor XOR It returns true if  exactly one of the operands is 

true, and false other wise 

(5>3)xor(5>7) True 

5.Increment and Decrement Operators: 

❖ In PHP, the increment operator ++ is used to increase the value of a variable by 1, and the decrement operator – is 

used to decrease the value of variable by 1. 

Operator Operator Name Example Meaning 

++ 

(increment 

Operator) 

++$a (Pre-Incre $x=++$a First, $a is incremented by 1 and then the value is returned. 

$a++(Post-Incre $x=$a++ First, the value of $a is returned and then it is incremented by 1 

- - 

(decrement 

Operator) 

--$a (Pre-decre $x=--$a First, $a is decremented by 1 and then the value is returned 

$a--(Post-Incre $x=$a-- First, the value of $a is returned and then it is decremented by 1 

6.String Operators: 

❖ String operators have concatenation operator (.) and concatenation assignment operator (.=). 

❖ Concatenation means adding one or more variables to an existing variable. 

Operator Operator Name Meaning Example Output 

. (Dot) Concatenation It concatenates (joins) two strings together $a=’Hello’; 

$b=’World’; 

$c=$a.$b; 

HelloWorld 

. (Dot 

Equal to) 

Concatenation 

assignment 

It appends one string to another and assigns 

the result to a variable in a single statement. 

$a=’Hello’; 

$b=’World’; 

$a.=$b; 

 

HelloWorld 

 

1. Write a PHP code to do the following: (M-2022) 

(i) If the given number ‘n’ is divisible by 3, then print “DIVISIBLE BY 3”. 

<?php 

$n = readline (“Enter the number”); 

if ($n% 3 = = 0) 

{ 

echo “Divisible by 3”; 

} 

?> 

(ii) Otherwise, check whether the number ‘n’ is odd or even. - if even print “EVEN NUMBER” 

- if odd print “ODD NUMBER” 

<?php 

$n = readline (“Enter the number”); 

if ($n% 2 = = 0) 

{ 

echo “EVEN NUMBER”; 

} 

else 

{ 

echo “ODD NUMBER”; 

} 

?> 

 CHAPTER – 5 ( Functions and Arrays IN PHP ) 

1. Explain the user-defined function with suitable example   (M-2024)                                          

User defined Function: 

❖ We can define a user defined function by using the ‘function’ keyword, followed by the name of the function and 

a set of parentheses. 

General syntax for creating function: 

Function definition (or declaration) 
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Syntax: 

 function functionName([parameter list])  

{  

   //code to be executed;  

} 

Let’s break this down: 

1. The ‘function’ keyword is used to define a function. 

2. FunctionName is the name of the function. It can be any valid PHP identifier, as long as it is not a reserved word. 

3. Parameter list is a comma-separated list of variables. These parameters are optional and we can have as many or 

as few as we like. 

4. Inside the curly braces, we can put any code we want the function to execute. This can include PHP statements, 

loops, conditions, and so on. 

Function Calling:  

❖ Calling a function is another name for executing the function. 

❖ A function is called simply by using the function name, along with an argument list, as a statement.  

Syntax:  

functionName();  [or] functionName(argument list);   

❖ We can also pass argument to a function by including them within the parentheses, separated by commas. 

❖ functionName($arg1, $arg2,$arg3); 

Example 1: Function with no parameters                                      Output 

<?php                                                                                             “Hello, world!” 

      function printGreeting () 

      { 

         echo “Hello, world!”; 

       } 

      printGreeting (); 

?>  

2. Explain indexed array and associative array. (S-2020, J-2024) 

1.Indexed array: 

❖ An indexed array is an array that uses a numeric index to access its elements. 

❖ The index is a number that starts at 0 for the first element and increases by 1 for each subsequent element.  

We can create an indexed array in PHP: 

1. by enclosing a comma-separated list of values in square brackets (or) 

2. by using the array () function. 

Syntax: 

             $arrayVariable = [element1, element2, element3,….elementN];            (or) 

             $arrayVariable = array(element1, element2, element3,….elementN);  

Example: 

a) $fruits = [‘apple’, ‘banana’, ‘orange’]; 

b) $fruits =  array (‘apple’, ‘banana’, ‘orange’); 

c) $numbers =  array (1,2,3,4,5); 

d) $colours = array(‘red’, ‘green’, ‘blue’); 

e) $num = array(10, 10.5, 20,20.5); 

2.Associative Array: 

❖ An associative array is a data structure that stores a collection of key-value pairs. 

❖ The keys are used to identify the values, and the values can be of any data type. 

❖ The keys in an associative array are often called “labels” because they label or identify the corresponding values. 

We can create an associative array in PHP: 

3. by enclosing a comma-separated list of key-value pairs in square brackets (or) 

4. by using the array () function. 

Syntax 

$arrayVariable = [“key1” => “value1”, “key2” => “value2”, “key3” => “value3”, …“keyN” => “valueN”]; 

$arrayVariable = array (“key1” => “value1”, “key2” => “value2”, “key3” => “value3”, …“keyN” => “valueN”); 

Example: 

$student = [“Name” => “Ram”, “Age” => “25”, “Place” => “Trichy”]; 

$student = array (“Name” => “Ram”, “Age” => “25”, “Place” => “Trichy”); 
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1. What is array? Explain the Multidimensional Array.  (M-2020)(M-2022)(J-2023) 

Array : 

❖ Array is a concept that stores more than one value of same data type in single array variable. 

Multidimensional array:  

❖ In PHP, a multidimensional array is an array that contains one or more arrays as its elements.  

❖ The elements of a multidimensional array can themselves be arrays, creating an array of arrays, also known as a 

nested array.  

Example 1 : A multidimensional array that contains one array as its element.: 

$arr = array( array(1, 2, 3), );  

echo $arr[0][1];     // Output will be 2.  

❖ This array contains one element, which is an array containing three integers.  

❖ You can access the elements of this array using two sets of square brackets, with the first set specifying the row 

and the second set specifying the column.  

Example 2 : A multidimensional array that contains three arrays as its elements: 

$arr = array( array(1, 2, 3), array(4, 5, 6), array(7, 8, 9) );  

echo $arr[1][2];      // Output will be 6.  

❖ We can access the elements of the array using two sets of square brackets, with the first set specifying the row and 

the second set specifying the column. 

 CHAPTER – 6 ( Conditional Statements IN PHP ) 

1. Explain if..elseif..else statement with an example. (J-2024) 

❖ The if..elseif ..else statement is a conditional statement in PHP. 

❖ This statement allows you to check multiple conditions and run different code based on which condition is true. 

❖ This type of statement begins with the keyword “if”. 

❖ It can be followed by one or more “elseif”. 

❖ Finally ends with an “else” part. 

Syntax: 

if (condition 1) 

{  

    // code to be executed if condition 1 is true; 

} 

elseif (condition 2) 

{  

    // code to be executed if condition1 is false and condition 2 is true; 

} 

elseif (condition 3) 

{  

    // code to be executed if condition1 and condition 2  is false and condition 3 is true; 

} 

else 

{ 

   // code to be executed if  all conditions are false; 

} 

Example:                                                                   Output 

<?php                                                x is greater than 10 but not greater than 15 

 $x=12; 

 if ($x>20) 

 { 

 echo “x is greater than 20”; 

 } 

 elseif ($x>15) 

 { 

 echo"x is greater than 15 but not greater than 20”; 

 } 

 elseif ($x>10) 

 { 

 echo “x is greater than 10 but not greater than 15”; 

 } 

 else  

 { 

 echo"x is not greater than 10” 

  } 

?> 
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2. Discuss in detail about Switch statement with an example. (M-2020, S-2020, J-2022, M-2023, J-2023) 

Switch statement:  

❖ This is a multiple branching statement where, based on a condition, the control is transferred to one of the many 

possible points. 

❖ The switch statement is used to specify multiple conditions. 

❖ It runs a different code block for different conditions. 

Syntax:     

switch (expression) 

{ 

  case value1: 

       //code to be executed if  expression = value1; 

   break; 

   case value2: 

      //code to be executed if  expression = value2; 

   break; 

default: 

      //code to be executed if expression is not equal to any of the values;   

} 

Example:                                                                               Output 

<?php                                                                                 x is equal to 10 

  $x= 10; 

switch ($x)  

{ 

case 5: 

echo “x is equal to 5”; 

break; 

case 10: 

echo “x is equal to 10”; 

break; 

case 15: 

echo “x is equal to 15”; 

break; 

default:                      

echo “x is not equal to 5,10, or 15”; 

        }              

?>                

1. Explain the functions of conditional statement in PHP (M-2022) 

‘if’statement:  
❖ The if statement is the simplest of all the conditional statements. A block of code is executed if a certain condition is true. 

Syntax: 

if (condition)  

{  

// code to be executed if condition is true;  

}  

Example :  

<?php  

$x = 10;  

if ($x > 5)  

{  

echo “x is greater than 5”;  

}  

?> 

if ... else statement:  

❖ The if ... else statement is a conditional statement in PHP. It executes one block of code if a condition is true and 

another block of code if the condition is false.  

Syntax  
if (condition)  

{  
// True-block;  

}  

else  
{  

// False-block;  

} 
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‘if... elseif ...else’ Statement:  

• The if ... elseif ... else statement is a conditional statement in PHP.  

• This statement allows you to check multiple conditions and run different code based on which condition is true.  

• This type of statement begins with the keyword ‘if’. It can be followed by one or more ‘elseif’.  

• Finally ends with an ‘else’ part.  

Syntax  

if (condition1)  

{  

// code to be executed if condition1 is true;  

} elseif (condition2)  

{  

// code to be executed if condition1 is false and condition2 is true;  

}  

elseif (condition3)  

{  

// code to be executed if condition1 and condition2 are false and condition3 is true;  

}  

else  

{ // code to be executed if all conditions are false;  

}   
 CHAPTER – 7 ( Loops IN PHP ) 

1. Explain “for” loop with example. (S-2020, M-2024) 

❖ ‘for loop’ is called as the entry-check loop. 

❖ The for loop is used to execute a block of code a specific number of times. 

Syntax: 

for (initialization: condition; increment /decrement)  

{ 

     //code to be executed; 

}      

❖ The initialization part is executed only once at the beginning of the loop. 

❖ It is used to initialize variables. 

❖ The condition is evaluated before each iteration of the loop. 

❖ If it is true, the code block is executed. 

❖ If it is false, the loop is terminated. 

❖ The increment/decrement part is executed after each iteration for the loop. 

❖ It is used to update variables. 

Example 1:                                                                                                                     Output 

❖ To print the numbers from 1 to 5 in ascending order.                                               1 to 5  

for ($i = 1; $i<= 5; $i++) 

{ 

  echo $i. “<br>”; 

} 

Example 2:                                                                                                                      Output 

❖ To print the numbers from 5 to 1 in descending order.                                               5 to 1  

for ($i = 5; $i>= 5; $i--) 

{ 

  echo $i. “<br>”; 

} 

2. Write a PHP code to print 10 to 20 numbers in ascending order using while loop and do.. while loop. 

Example:   (while loop)                                                                                                Output 

❖ To print the numbers from 10 to 20 in ascending order.                                           10 to 20  

$i =10 

while ($i<=20) 

{ 

  echo $i. “<br>”; 

  $i++ 

} 

 

Example:  (do..while loop)                                                                                             Output 

❖ To print the numbers from 10 to 20 in ascending order.                                            10 to 20 

$i=10; 

do 

{ 
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echo $i.”<br>” 

$i++ 

} 

while ($i<=20); 

3. Explain ‘foreach’ loop with examples. [or] Explain working of loops in array (J-2022, M-2023)  

❖ The foreach loop is used to iterate over elements of an array. 

Syntax: 

foreach ($array as $value) 

{ 

   // code to be executed; 

} 

Example: 

❖ To print the elements of an array 

$array =array(1,2,3,4,5); 

foreach ($array as $value) 

{ 

  echo $value.”<br>”; 

 } 

 
❖ You can also use the foreach to iterate over the keys and values of an associative array by using the following syntax: 

 foreach ($array as $key => $value) 

{ 

   // code to be executed; 

} 

❖ The foreach loop will iterate over each element of the array and assign the key of the element to the $key variable 

and the value of the element to the $value variable. 

Example:                                                                                                            Output 

$array =(“a”=>1, “b”=>2, “c”=>3);                                                             a=>1     a=>2   a=>3 

foreach($array as $key=>$value) 

{ 

 echo $key.”=>”.$value.”<br>”; 

} 

❖ The foreach loop is particularly useful when you want to perform a set of actions on each element of an array, 

such as printing the elements, summing them up, or modifying them in some way. 

❖ It is a simple and efficient way to iterate over arrays in PHP. 

1. Write a PHP code to print all the odd numbers from 3 to 15 using foreach loop. (M-2022) 

<?php 

$a = range (3, 15); 

foreach ($a as $v)  

{ 

if (($v%2) !=0)  

{ 

echo "$v”; 

} 

} 

?> 

2. Write the output of the following program (M-2023) 

<?php                                                                                         Output 

$pass_mark = 35;                                                 The student is eligible for promotion 

$student_mark = 70; 

if($student_mark > = $passmark) 

{  

echo “The student is eligible for promotion”; 

} 

else 

{ 

echo “The student is  not eligible for promotion”; 

} 
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 CHAPTER -  8 ( Forms and Files) 

 1. Discuss in detail about HTML form controls. 

❖ Main objective of PHP and HTML form controls are to collect data from users. 

The following control are available in HTML form: 

1.Text inputs  2.Buttons  3.Checkbox  4.Radio box  5.File Select  6.Form Tag   

1. Text inputs contain textbox and text area controls.   

2. Buttons may contain Submit button, Reset button and Cancel Button. 

3. Checkbox is the important feature which selects more than one value from the HTML form.  

4. Radio box is similar to checkbox but one value can be chosen at a time. 

5. File select is the best feature to select one file from the local machine to server machine at a time. 
6. Form tag  is used to mention a method (POST or GET) and control  the  entire form controls in the HTML document. 

Example: 

 
2. Explain in detail of File handling functions in PHP. (M-2020, S-2020) 

1.PHP Open a File: 

❖ fopen() is a system function available in PHP. 

❖ fopen ( ) function helps to open a file in the server. 

❖ It contains two parameters one for the file and the other one specifies in which mode the file should be opened 

(Read/Write) 

Syntax: $file_Object=fopen(“FileName”,“Read/WriteMode”) or die(“Error Message!”); 

Example: 

<?php 

$myfile = fopen(“Student.txt”, “r”) or die(“Unable to open file!”); 

?> 

2.PHP Read a File: 

❖ The fread() function reads from an open file.  

❖ The file object comes from fopen function. 

Syntax:fread($file_Object,filesize(“FileName”)); 

Example: 

<?php 

fread($myfile,filesize(“Student.txt”)); 

?> 

3.PHP Close a File: 

❖ The fclose() function is used to close an opened file.  

❖ The file object comes from fopen function. 

Syntax:fclose($file_Object); 

Example: 

<?php 

$myfile = fopen(“student.txt”, “r”); 

fclose($myfile); 

?> 

4.PHP write a File: 

❖ The fwrite() function is used to write to a file.  

Syntax: 

fwrite($myfile, $txt); 

?> 
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1. Explain Form handling method in PHP (M-2022) 

PHP Basic Form Handling: 

❖ When the user keys in the input data in HTML controls and clicks the submit button the request will be generated 

and reaches a PHP file which is mentioned in the FORM tag under the Action attribute.  

❖ All the input values are synchronized and sent to the server via POST method or GET method.  

❖ Method is an attribute of form tag in HTML.  

❖ Once the data reaches the server, two PHP variables such as $_POST and $_GET collects the data and prepares 

the response accordingly.  

Post Method:  

❖ The input data sent to the server with POST method is stored in the request body of the client’s HTTP request.  

Get Method:  

❖ The input data sent to the server with POST method via URL address is known as query string.  

❖ All input data are visible by user after they click the submit button.  

Example:  

Test.html:  

<html>  

<body>  

<form action=”welcome.php” method=”post”>  

Name: <input type=”text” name=”name”><br>  

E-mail: <input type=”text” name=”email”> <br>  

<input type=”submit”>  

</form>  

</body>  

</html>  

 

Welcome.php:  

<html>  

<body> Welcome  

<?php  

echo $_POST[“name”];  

?> 

<br> Your email address is:  

<?php  

echo $_POST[“email”];  

?>  

</body>  

</html> 

 CHAPTER – 9 ( Connecting PHP and MYSQL ) 

1. Discuss in detail about My SQL functions with example. (S-2020, J-2024) 

❖ In PHP Scripting language many functions are available for MYSQL Database connectivity and executing SQL queries. 

❖ 1.Mysqli_connect( ) 2.Mysqli_close( )  3.mysqli_query( )   

1.Mysqli_connect( )  

❖ Before accessing MySQL Database, connect to Database Server machine via PHP scripting language using 

Mysqli_connect () Function.  

Syntax:  mysqli_connect(“Server Name “,”User Name”,”Password”,”DB Name”);  

❖ This function requires four parameters to connect to database server.  

❖ Database Server name, Database username, password and Database Name. 

❖ Opens a connection to MYSQL server and returns an object represents the connection to the server. 

2.Mysqli_close( )  

❖ mysqli_close() Function is used to close an existing opened database connection between PHP scripting and 

MySQL Database Server.  

Syntax: mysqli_close(“Connection Object”);  

Example:  

<?php 

$con=mysqli_connect(“localhost”,”$user”,”$password”,”SCHOOL_DB”);  

mysqli_close($con);  

?> 

3.mysqli_query( ) 

❖ The main goal of MySQL and PHP connectivity is to retrieve and manipulate the data from MySQL database server.  

❖ The SQL query statements help in PHP MySQL extension to achieve the objective of MySQL and PHP connection.  

❖ “mysqli_query” is a function that helps to execute the SQL query statements in PHP scripting language. 

Syntax: mysqli_query(“Connection Object”,”SQL Query”)  
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Example:  

$con=mysqli_connect(“localhost”,”my_user”,”my_password”,”Student_DB “);  

$sql=”SELECT student_name,student_age FROMstudent”; 

mysqli_query($con,$sql);  

2. Explain in details types of My SQL connection method in PHP. 

❖ Accessing MySQL Database, connect to Database Server machine via PHP scripting language using My 

sqli_connect() Function.  

Syntax:   mysqli_connect(“Server Name “,”User Name”,”Password”,”DB Name”); 

❖ This function requires four parameters to connect to database server.  

❖ Database Server name, Database username, password and Database Name. 

Example : 

<?php 

$servername = “localhost”; 

$username = “username”; 

$password = “password”; 

$DB_name = “School_DB”; 

// Create connection 

($conn=mysqli_connect($servername, $username, $password,$DB_name); 

// Check connection 

if (!$conn)  

{ 

die (“Connection failed: “. mysqli_connect_error()); 

} 

echo “Connected successfully”;  

            ?>        

❖ In the above code snippet, three variables are used to connect to the Database server.  

❖ They are 

✓ $servername          -> Database Server Server IP address 

✓ $username   -> Database Server User Name 

✓ $password   -> Database Server Password 

✓ $DB_Name   -> Database Name 

❖ The mysqli_connect function uses these variables and connect Database server from PHP scripting. 

❖ If connection gets fail, output will be printed with MySQL error code. Otherwise connection is success.     

3. Explain MySQLi Queries with examples.  (M-2020) 

❖ The main goal of MySQL and PHP connectivity is to retrieve and manipulate the data from MySQL database server.  

❖ The SQL query statements help in PHP MySQL extension to achieve the objective of MySQL and PHP 

connection.  

❖ “mysqli_query” is a function that helps to execute the SQL query statements in PHP scripting language. 

Syntax:  mysqli_query(“Connection Object”,”SQL Query”)  

Example 1:  

$con=mysqli_connect(“localhost”,”my_user”,”my_password”,”Student_DB “); $sql=”SELECT 

student_name,student_age FROMstudent”; 

mysqli_query($con,$sql);  

Example 2 : 

<?php 

$conn=mysqli_connect(“localhost”,”username”,”password”,”mydb”); 

$sql_stmt=”select*from Students”; 

$result=mysqli_query($conn,$sql_stmt); 

$rows=mysqli_fetch_array($result); 

foreach($rows as $t) 

{ 

echo $t.”<br>”; 

} 

Mysqli_conn($conn); 

?> 
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 CHAPTER – 10 ( Introduction to Computer Networks ) 

1. Explain uses of Computer network 

The common uses of computer network are  

1.Communication  2.Resource sharing  3.Data (or) software sharing   

1.Communication : 

❖ Using computer networks, we can interact with the different people with each other all over the world.  

❖ It provides a powerful communication among widely separated employees, team section.  

❖ They can easily communicate at very low cost via mobile, social media, telephone, e-mail, chatting, video 

telephone, video conferencing, SMS, MMS, groupware etc…  

2.Resource sharing : 

❖ Resource sharing means when one device is accessed by many systems.  

❖ It allows all kind of programs, equipment’s and available data to be accessed by anyone via network irrespective 

of the physical location of the resource.  

❖ Simply resource sharing is sharing such as printers, scanner, PDA, fax machine, and modems.  

❖ For example, many computers can access one printer if it is in network.  

3.Software (or) Data sharing:  

❖ Using computer network, any application or other software can be stored at a central computer or server.  

❖ The software can be shared among other computers of the network.  

❖ It provides high reliability and backup can also be stored at one location for easy availability in case of crash. 

2. Explain about social applications in computer network. 

❖ To get connected to with people around the world through social network media, applications like Whatsapp, 

Facebook, Twitter, Blogs, Pinterest, Classmate and so on are in full fledge use. 

❖ Through the social media we share our thoughts, ideas, files and also chats. 

These social networks share several attributes in common: 

1. Membership: 

❖ Social nets generally requires user to register names and accounts to avoid duplicate and maintain secrecy.  

❖ So many public networks offer free registration and some meagre charges for their services. 

❖ Private networks (such as BANK ACCOUNT HOLDERS groups) restrict registration to people who meet certain 

eligibility criteria. 

2.Content contribution: 

❖ These networks allow members to easily share comments, movies, music, short films and/or photos with others. 

3.Frequent return visits: 
❖ Healthy social net have a group of members who check in regularly to contribute their share and also for new updates 

4.Relationship building: 

❖ The common goal of most social networks is to allow interaction among people, which create stronger connection 

with people of different communities. 

1. Mention some uses of network at business, home and mobile. (J-2022)  

Networks in Business:  

❖ In twenty first century, communication is very important factor for successful business operations. 

❖ There by with the growth of computer network and speedy Internet services, business also developed drastically.  

❖ With the development of cloud computing, global access and security issues were restricted.  

❖ Internet conversation made conversation faster, quick decision making and money saving e-banking paying 

methods for easy transactions.  

❖ Business large or small scale B2C, B2B, B2G,C2B, C2C, C2G, G2B,G2C, G2G or commercial that transfer 

information across the Internet can be done.  

❖ Cheap marketing price and easy selection of products through Internet with customers satisfaction can also be 

done. Company license, renewals, other certificates, bill payments, receipts, invoice, stock maintenance, can be 

done without any geographical boundaries via Internet and computer networks. 

❖ Government subsidies are available for their business to promote their business by digitization. 

Networks at Homes: 
❖ Now a day, network has become common as it facilitates communication among devices with in the close vicinity of a home.  

❖ Devices in this network can be smart devices, mobile computers, network printers which are capable of interacting 

and thereby increase the quality of life inside home in a variety of ways like automation of repetitive tasks, 

increased personal productivity, enhanced home security and easier access to entertainment.  

❖ Network at home helps us to perform e-banking, e-learning, e-governance, e-health, telemedicine, call centers, 

video conferencing, digitalization of memories, etc.  

Mobile Networks:  

❖ Mobile network is the network connecting devices without cable (wireless).  

❖ Mobile computers, such as laptop, tablet, and hand held computers, were fastest growing segments.  

❖ At land areas network was distributed as cells, each will be served by single – location transceiver, but generally 

three cell sites or a base transceiver station.  

❖ This base station provides the cell with network coverage and other features that can be utilized for transmission 
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of voice, data and other content as well.  

❖ Joining together all radio coverage is called as wide geographical area.  

❖ This portable transceivers used to communicate with one another with fixed transceivers and moving via more 

than one cell during transmission.  

❖ For example mobiles, tablets, pagers, laptops, engaged with mobile broadband just like modems etc. 
 CHAPTER – 11 ( Network Examples and Protocols) 

1. Explain about Internet, Intranet and Extranet.   (J-2022, M-2023)                  

1.INTERNET: 

❖ The Internet, “the Net,” is a worldwide system of computer networks. 

❖ A global network, public TCP/IP network used by over a billion people all over the world. 

❖ A network of networks where the users at any one computer can, if they have permission, get information from 

any other computer. 

❖ The Internet is a network of global connections – comprising private, public, business, academic and government 

networks – linked by guided, wireless and fiber-optic technologies. 

❖ It was perceived by the Advanced Research Projects Agency (ARPA) of the U.S. government in 1969 and was 

first recognized as the ARPANet. 

Example:  

❖ Sending email to a friend ,Download programs and files, Social media, E-Mail 

2.INTRANET: 

❖ It is a private network within an enterprise to share company data and computing resources between the employees. 

❖ It may consist of many interlinked local area networks. 

❖ It includes connections through one or more gateway (connects two networks using different protocols together 

known as protocol convertor) computers to outside Internet. 

Example:  
❖ Sharing of company policies/rules and regulations, Access employee database, Distribution of circulars/Office Orders 

3.EXTRANET: 

❖ It is a private network that uses Internet technology and the public telecommunication system to securely share 

business’s information with suppliers, vendors, partners, customers, or other business. 

Example:  

❖ Customer communications, online education/ training, Account status enquiry. 

2. Discuss about OSI model with its layers. (M-2020) 

OSI Model : 

❖ Open System Interconnection (OSI) model was found in the year 1934, general framework that enables network 

protocols along with software and systems to be developed based on general set of guidelines.  

❖ It describes the standards for the inter-computer communication 

OSI Layers: 

1. Physical Layer:  

❖ This is the 1st layer, it defines the electrical and physical specifications for devices.  

2. Data Link Layer:  

❖ It is the 2nd layer and it guarantees that the data transmitted are free of errors. 

❖ This layer has simple protocols like “802.3 for Ethernet” and “802.11 for Wi-Fi”.  

3. Network Layer:  

❖ It is the 3rd layer determining the path of the data packets.  

❖ This layer is responsible for routing of data packets using IP Addressing.  

4. Transport Layer:  

❖ It is the 4th layer that guarantees the transportation/sending of data successfully.  

❖ It includes the error checking operation.  

5. Session Layer:  

❖ It is the 5th layer, identifies the established system session between different network entities.  

❖ It controls dialogues between computers  

6. Presentation Layer:  

❖ It is the 6th layer that does the translation of data to the next layer (Prepare the data to the Application Layer).  

❖ Encryption and decryption protocols occur in this layer such as, Secure Socket Layer (SSL).  

7. Application Layer:  

❖ It is the 7th layer, which acts as the user interface platform comprising of software within the system. 
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3. Difference between TCP/IP and OSI Reference Model... 
 

                      TCP/IP Model             OSI Reference Model 

❖ It is client server model. I.e. when the client requests for 

service it is provided by the server 

❖ It is conceptual model 

❖ It is standard protocol used for every network including the 

internet. 

❖ It is not a protocol but a reference model used for 

understanding and designing the system architecture. 

❖ TCP/IP has Four layers ❖ OSI has Seven layers 

❖ Vertical approach. ❖ Horizontal approach 

❖ It is Tangible ❖ It is not Tangible 

❖ TCP/IP is protocol dependent ❖ OSI is protocol independent 

❖ TCP/IP is a set of protocols which governs communications 

among all computers on the Internet. 

❖ Open System Interconnection (OSI) 

1. Explain about the development, merits and demerits in Mobile networks. (J-2023) 

Development of Mobile Networks:                                                                 
1.First Generation(1G) 1981- NMT launch                                     2.Second Generation(2G) 1991-GSM Launch 

3.Second to Third Generation Bridge (2.5)2000 – GPRS launch    4.Third Generation( 3G) 2003- UK 3G launch 

5.Fourth Generation (4 G) 2007                                                       6.Fifth Generation (5G) 2019+ 

Merits of Mobile Networks: 

❖ It provides both voice/data services. It connects both fixed and wireless telephone users. 

❖ It is used in areas where cables cannot be laid out due to its wireless nature. It is easy to maintain. 

❖ It is easy to upgrade the equipment’s. 

❖ The mobile and fixed subscribers are connected immediately with cellular network as soon as mobile phones are 

switched on. 

❖ All the handshake signals between mobile and base station are automatically exchanged. 

Demerits of Mobile Networks:  
1. Cost 2.Vulnerable to Security risks 3.Additional training is needed to use new technology. 4.Cyber Crime. 

2. Explain about TCP/IP layers (S-2020) 

❖ There are four total layers of TCP/IP protocol, each of which is listed below with a brief description. 

1. Network Access Layer - concerned with building packets.  

2. Internet Layer - describes how packets are to be delivered.  

3. Transport Layer - ensure the proper transmission of data.  

4. Application Layer - application network processes.  

These processes include File Transfer Protocol (FTP), Hypertext Transfer Protocol (HTTP), and Simple Mail 

Transfer Protocol (SMTP). 

 CHAPTER – 12 ( DNS - Domain Name System ) 

1. Classify and Explain the IP address and its types. (J-2024) 

❖ Internet Protocol (IP) address is simply the logical address in the network layer. 

❖ IP address is also used to uniquely identify a computer over the network. 

❖ Due to increase in the number of system in a network there is a need of more addresses which lead to two 

addressing methods i.e.,.IPv4 and IPv6. 

1.IPv4 Address: 

❖ IPv4 address is a 32-bit unique address given to a computer system. 

❖ No two systems can have same IP address. 

❖ If the network has p connections then „ p‟ addresses should be there. 

❖ An address space is the total number of addresses that can be made by that protocol. 

❖ It is determined by the number of bits that the protocol use. 

There are two ways to represent the IP address, 

Binary notation:  

❖ In binary notation the address is expressed as 32-bit binary values. 

Dotted-decimal notation:  

❖ In dotted-decimal notation the address is written in decimal format separated by dots(.). 

2.IPv6 Address: 

❖ IPv6 address is a 128-bit unique address given to a computer system. 

❖ The number of addresses that can be formed in IPv6 is 2128. 

❖ In IPv6 address, the 128 bits are divided into eight 16-bits blocks. 
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❖ Each block is then changed into 4-digit Hexadecimal numbers separated by colon symbols. 

❖ E.g. 2001:0000:32313:DFE1:0063:0000:0000: FEFB 

2. Explain the name server and its types. (J-2022) 

❖ Name Server is a main part in the Domain Name System (DNS). 

❖ It is a software program that run on a physical system. 

❖ It has the DNS database consisting of domain names and their corresponding IP addresses. 

❖ Name Server translates the domain name to IP address. 

❖ There is a need to store a large number of domain names for worldwide usage, so plenty of servers are used in the 

hierarchical manner. 

❖ Name servers do the important task of searching the domain names. 
❖ While you searching for a websites, local name server ask the different name servers until one of them finds out the answer. 

❖ At least it returns IP address for that domain name. 

❖ Your computer is now connected to the requested webpage.   

TYPES OF NAME SERVERS: 

❖ There are three types of Name Servers which control the entire Domain Name System: 

1.Root Name Server: 

❖ Top level server which contains entire DNS tree, maintained by ICANN. There are 13 servers. 

2.Primary/Master Name Server: 

❖ Contains a zone resource records. 

❖ These records are updatable by domain name holders such as organizations. 

3.Secondary/Slave Name Server: 

❖ Contains a copy of primary server files. 

❖ This server has no authority to update, but reduce the workload of master server by sharing the queries. 

3. Explain how the DNS is working. (M-2024) 

❖ When the user enters the URL (consists of protocol, domain name, folder name, file name) in the browser, the 

system first checks its DNS cache for the corresponding IP address.  
❖ If the IP address is found in the cache then the information is retrieved from cache.  
❖ If not, then the system needs to perform DNS query i.e., the system needs to query the resolver about the IP 

address from Internet Service Provider (ISP).  
❖ Each resolver has its own cache and if it is found in that then that information is retrieved.  
❖ If not, then the query is passed to next domain server i.e., TLD (Top Level Domain) which reviews the request and 

direct the query to name servers associated with that specific domain. 
❖ Until the query is solved it is passed to next level domains.  
❖ Finally, the IP address is detected and corresponding record is sent to the resolver.  
❖ Then the resolver returns the record back to the computer browser. 
❖ Now the user can view the webpages for the detected IP address 

1. What is domain name space? Explain. (M-2022) 

Domain Name Space:  

❖ Domain name space was designed to achieve hierarchical name space.  

❖ In this, The names are represented as a tree-like structure with a root element on the top.  

❖ This Tree can have a maximum of 128 levels starting from the root element, taking level 0 to level 127. 
❖ The above figure represent the domain name space where the root element is present at the top most level i.e., level 0. 

❖ The root element always represents the NULL string (empty string).  

❖ The next level to the root element is node (children of root element).  

❖ Each node in the tree has a label and a domain name. 

Label : 

1. It is a string which can have maximum of 63 characters.  

Each node in that level should have different labels thereby assuring the individuality of the domain name. 
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2. In other words, Labels are the names given to domains.  

Domain is a sub tree in domain name space tree structure.  

The domain can be further divided into sub domains. 

3. The domain name which is obtained by reading the labels from bottom to top, separating each label by dot (.). 

Domain name : 

1. It is the sequence of labels. In domain name the sequence of labels are separated by dot (.). 

2. The domain name is always read from the lower level to higher level i.e., from the leaf node to root node.  

3. Since the root node always represent NULL string, all the domain name ending with dot. 

 CHAPTER – 13 ( Network Cabling) 

1. What is meant by Registered Jack? Explain briefly the types of Jacks. 

 Registered Jacks: 
❖ A Registered Jack commonly known as RJ is a network interface used for network cabling, wiring and jack construction. 

❖ The primary function of the registered jack is to connect different data equipment and telecommunication devices. 

❖ The commonly known registered jacks are RJ-11, RJ-45, RJ-21, and RJ-28. 
❖ The registered jack refers to the male physical connector (Plug), a female physical connector (Jack) and its wiring. 

Types of Registered Jacks: 

1. RJ-11: 

❖ It is the most popular modern form of registered jack  

❖ It is found in home and office used for landline phones. 

❖ There are 6 pin where, the two pins give the transmission configuration, 

❖ The two pins give the receiver configuration and the other two pins will be kept for reserved. 

2.RJ-14 and RJ-61: 

❖ The RJ-14 is also used in telephone lines like RJ-11. 

❖ It has 6 pins whereas the RJ-61 has 8 pins. 

❖ RJ-61 uses the twisted pair cable to connect the network devices. 

3. RJ-21: 

❖ The RJ-21 connector has 50 pins with 25 pins at one end and 25 pins at the other end. 

❖ It is also called as champ connector or Amphenol connector. 

❖ The Amphenol is a connector manufacturer. 

❖ The RJ-21 interface is typically used for data communication trucking applications. 

2. Explain the components used in Ethernet cabling.  (M-2024) 

❖ Ethernet cabling is the process of connecting the computers with other devices using Ethernet cables.  

The four main components used in the Ethernet cabling components are  

        1. Patch Cable (Twisted pair)  2. RJ45 Connector  3. Ethernet Ports  4. Crimping Tool 

1.Patch cable (Twisted pair): 

❖ These Cables are generally made up of 8 wires in different colors. 

❖ Four of them are solid colours, and the others are striped. 
❖ Ethernet cables are normally manufactured in several industrial standards such as Cat 3, Cat 5, Cat 6, Cat 6e and cat 7.  

❖ “Cat” simply stands for “Category,” and the following number indicates the version.  

❖ Latest version denotes faster and higher frequencies, measured in Mhz.  

❖ Increasing the size of the cable also lead to slower transmission speed. 

2.RJ45 Connector: 

❖ The RJ45 connector looks similar like a telephone jack but it looks a slightly wider. 

❖ In RJ45 the “RJ” stands for registered jack and the “45” simply refers to the interface standard. 

❖ The RJ45 connector is a small plastic cube. 

❖ It has 8 pins. 

❖ It is connected to each end of the Ethernet cable. 

❖ It is also known as 8P8C connector. 

❖ These plugs are inserted into Ethernet port of the network card. 

3.Ethernet port: 

❖ Ethernet port is an opening which is a part of an Ethernet card. 

❖ It accepts RJ45 connector with Ethernet cable. 

❖ It is found on personal computers, laptops, routers, switches, hubs and modems. 
❖ Once you inject the plug into the port the two led lights will glow in the computer, one is green and another one is orange.  

❖ The orange light will start blinking which indicates that the Internet is connected. 

4.Crimping tool: 

❖ Crimping is the process of joining two or more pieces of metal or wire by deforming one or both of them to hold each other. 

❖ Joining RJ45 connector together with twisted pair cable at each end is an essential process in Ethernet cabling 

which lead the cable to function properly. 

❖ The crimping tool is a physical tool which is used to connect the patch wire and the Ethernet connector. 

❖ The crimping tool looks like a small cutting handle with two mould of Ethernet port. 
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3. Explain the types of network cables. (M-2020, S-2020, J-2023) 

1.Coaxial Cables : 

❖ This cable is used to connect the television sets to home antennas.  
❖ It has a copper wire inside and insulation is covered on the top of the copper wire to provide protection to the cable.  

❖ It is very difficult to install and maintain, because they are too big to carry and replace.  

❖ This cable is used to transfer the information at 10mbps speed. 

❖ The cable is classified into thin net and thick net cables.  

2.Twisted Pair Cables: 

❖ It is type of cable with two or more insulated wires twisted together.  

❖ This twisted cable has 8 wires which are twisted to ignore electromagnetic interference.  

❖ There are two types of twisted pair cables, Unshielded Twisted Pair (UTP) and Shielded Twisted pair (STP).  

❖ The UTP is used nowadays as modern cables for Internet and they are lower in cost and installation and 

maintenance is easy compared to the coaxial cables.  

❖ STP is similar to UTP, but it is covered by an additional jacket to protect the wires from External interference 

3.Fiber Optics: 

❖ This cable is made by using strands of glass. 

❖ It uses pulses of light to send the information. 

❖ They are mainly used in Wide Area Network (WAN). 

❖ These cables are placed in deep underground to avoid any damage to the cables.  

❖ There are two types of fiber-optic cables available, One is single-mode another one is multimode.  

❖ Single-mode cables are used for long distance transmission and at a high cost whereas the multimode cables are 

used for short distance transmission at a very low cost.  

❖ The optic cables are easy to maintain and install. 

4.USB Cables: 

❖ The Universal Serial Bus are used to connect keyboard, mouse and other peripheral devices.  

❖ Micro USB is a miniaturized version of the USB used for connecting mobile devices such as smart phones, GPS 

devices and digital cameras. 

❖ The latest version of USB is USB 3.0 which has the data transfer rate 4.85 Gbps.  

5.Serial and Parallel cables: 

❖ Before Ethernet cable was invented, the serial and parallel interface cables were used to connect the system to the internet. 

❖ They were sometime used for PC to PC networking. 

❖ Ex: RS232 cable 

❖  The serial cable send 1 bit at a time whereas the parallel port send 8 bit at a time.   

6.Ethernet Cables: 

❖ This is a type of twisted pair cable. 
❖ It is the most common type of network cable mainly used for connecting the computers or devices at home or office. 

❖ This cable connects wired devices within the local area network (LAN) for sharing the resources and accessing Internet. 

 CHAPTER – 14 ( Open Source Concepts ) 

1. Differentiate Proprietary and open source software.   (M-2024)      
 

Proprietary software Open Source Software 

❖ It refers to the software that is solely owned by the 

individual or the organization that developed it. 

❖ It refers to the software that is developed and tested 

through open collaboration. 

❖ The project is managed by a closed group of 

individuals or team that developed it. 

❖ The project is managed by an open source community of 

developers and programmers. 

❖ It gives more control, support, training, security and 

stability for users. 

❖ Difficult to work for beginners, exchange of files to 

other software. 

❖ Reliable to the users. ❖ Lack of responsibility, service and problems with 

hardware compatible. 

❖ Eg: Windows,Mac os,  Adobe Flash Player. ❖ Eg: Android, fire fox, Libre office ,Ubuntu 

2. List out the Benefits of Open Source Software. 

❖ OSS projects are collaboration opportunities that improve skills and build connections in the field.  

Domains that developers can contribute to the open source community include:  

❖ 1. Communication tools.             2. Distributed revision control systems.  

3. Bug trackers and task lists.      4. Testing and debugging tools. 

Benefits of Open Source software: 

❖ There are many open source software.so 

❖ We can select and use any software that suits our needs. 

❖ The software can be used without any cost and restrictions. 

❖ We can share our ideas with the team, write the required code and share it with many. 

❖ We can learn many ideas and make our program writing skills more efficient. 
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❖ The coding in open source software are being groomed by many enthusiastically members of the group. 

❖ Problems in the programs are quickly mended by the group’s effort. 

❖ We can add the most required features in the software by making changes to the open source software. 

❖ Many open source software are very user friendly. 

 CHAPTER – 15  ( E-Commerce) 

1. List all the E-Commerce business models and explain any four briefly.  

E-COMMERCE BUSINESS MODELS: 

1.Business to Business (B2B)         2.Business to Consumer (B2C) 

3.Business to Government (B2G)   4.Consumer to Business (C2B) 

5.Consumer to Consumer (C2C)    6.Consumer to Government (C2G) 

7.Government to Business (G2B)   8.Government to Consumer (G2C) 

9.Government to Government (G2G) 

1.Business to Business (B2B) 

❖ In B2B E-Commerce, commercial transactions take place between different business organizations, through the Internet. 

❖ For example, a cycle company may buy tyres from another company for their cycles. 

❖ When compared to other models, the value per transaction in B2B transaction is high, because of bulk purchases. 

2.Business to Consumer (B2C) 

❖ In B2C E-Commerce, commercial transactions take place between business firms and their consumers. 

❖ It is the direct trade between companies and end-consumers via the Internet. 

❖ An example of B2C transaction is a book company selling books to customers. 

❖ This mode is intended to benefit the consumer and can say B2C. 

❖ E-Commerce works as ‟retail store‟ over Internet. 

3.Business to Government (B2G)  

❖ B2G is a business model that refers to business organizations sells products, services or information to 

Governments or to its administrations.  
❖ In other words, when a company get paid for its goods, services by the Government through Internet it is called as B2G model.  

❖ E.g. The Government or its administration buys laptops for students. 

4.Consumer to Business (C2B)  

❖ C2B can be described as a form of E-Commerce where, the transaction is originated by the consumers.  

❖ The consumers will fix a requirement or specific price for a service or a commodity.  

❖ C2B model, is also called as reverse auction model.  

❖ Here, customer bid his price for a service or a product.  

❖ Then E-Commerce business entity will match the requirement of the consumer to the best possible extent. 

5.Consumer to Consumer (C2C)  

❖ C2C in E-Commerce provides opportunity for trading of products or services among consumers who are 

connected through the Internet.  

❖ In brief when something is bought and sold between two consumers using Internet it is called C2C E-Commerce. 

❖ For example, a consumer who wants to sell his property can post an advertisement on the website 

(eg:timesclassifieds.com). 

6.Consumer to Government (C2G) 

❖ Citizens as Consumers and Government engage in C2G E-Commerce. 

❖ Here an individual consumer interacts with the Government. 
❖ C2G models usually include income tax or house tax payments, fees for issuance of certificates or other documents. 

❖ People paying for renewal of license online may also fall under this category. 

7.Government to Business (G2B) 

❖ G2B is closely related to B2G. 
❖ G2B in E-Commerce refers to a business model where Government providing services or information to business organization. 

❖ It may be a formal offer such as a takeover bid for a road project. 

8.Government to Consumer (G2C)  

❖ G2C in E-Commerce is very similar to C2G.  

❖ Here the Government provides platform for its citizens to avail its services and information through the Internet.  

❖ The services may be issue of certificates through online. 

❖ E.g. https://csc.gov.in/governmenttocitizen 

9.Government to Government (G2G)  

❖ G2G is the online (usually non-commercial) interaction between Government organizations or departments.  

❖ G2G’s principle objective is to implement e-governance rather than commerce. 

❖ G2G model in e-governance involves distributing data or information between its agencies/departments.   

2. Explain any five E-Commerce revenue models. (J-2022, J-2024) 

1.AUCTION SITE: 

❖ It is a kind of website that auctions items on the Internet and levies some commission from the sales. 

❖ Example: https://www.ebay.com/ 
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2.BANNER ADVERTISEMENT SITE : 

❖ It displays advertisements of other companies in its websites and thereby earns revenue. 

3.BULK-BUYING SITES : 

❖ It collects a number of users together all of who want to buy similar items; the site negotiates a discount with the 

supplier and takes a commission. 

❖ Example: https://www.alibaba.com/ 

4.DIGITAL PUBLISHING SITES : 

❖ It effectively host the e-books or magazines on the web. 

❖ They make profits in a number of ways such as advertising, selling etc., https://wordpress.org/ 

5. LICENSING SITES:It allows other websites to make use of their software. 

6. NAME-YOUR-PRICE SITES: 

❖ In contrast, the buyer negotiates with the retailer for a particular product or service.    

❖ Example: https://in.hotels.com/ 

3. How would you differentiate a traditional commerce and E-Commerce?  

      Traditional Commerce            E-Commerce 

❖ Traditional commerce is buying or selling of products 

and services physically. 

❖ E-Commerce carries out commercial transactions 

electronically on the Internet. 

❖ Customer can easily identify, authenticate and talk to 

the merchant. 

❖ Neither customer nor merchant see the other. 

❖ Physical stores are not feasible to be open all the times. ❖ It is always available on all time and all days of the year. 

❖ Products can be inspected physically before purchase. ❖ Products can’t be inspected physically before purchase. 

❖ Scope of business is limited to particular area. ❖ Scope of business is global. Vendors can expand their 

business Worldwide. 

❖ Resource focus Supply side. ❖ Resource focus Demand side. 

❖ Business Relationship is Linear. ❖ Business Relationship is End-to-end. 

❖ Marketing is one way marketing. ❖ One-to-one marketing. 

❖ Payment is made by cash, cheque, cards etc. ❖ Payment system is mostly credit card and through 

fund transfer. 

❖ Most goods are delivered instantly ❖ It takes time to transport goods. 
 

1. What are the advantages and disadvantages of E-commerce to consumer? (M-2020) 

Advantages : 

1. E-Commerce system is operated on all days and all the day.  

It is able to conduct business 24 x 7.  

Neither consumer nor suppliers need physical store to be opened to do business electronically.  

People can interact with businesses at the time of their convenience. 

2. Speed is a major advantage in E-Commerce.  

Advanced Electronic communications systems allow messages to reach across the world instantaneously. 

Communication delay is not a part of the Internet or E-Commerce world. 

3. The Internet is too easy to ‘shop around’ for products and services that may be cheaper and effective than left to 

buy only in a Brick and Mortar shop.  

It provides an opportunity to buy at reduced costs. 

4. The whole world becomes a shop for today’s customers.  

They can have wide choice by comparing and evaluating the same product at different websites before making a 

purchase decision. 

5. Customers can shop from home or anywhere at their convenience.  

They don’t need a long wait to talk to a salesman.  

They can read the details regarding model numbers, prices, features etc. of the product from the website and buy at 

their own convenience. Payments can also be made through online. 

Disadvantages: 

1. E-Commerce is often used to buy goods that are not available locally but from businesses all over the world.  

Physical goods need to be transported, which takes time and costs money. 

2. Unlike returning goods to a traditional shop returning goods through online is believed to be an area of difficulty.  

The doubts about the period of returning, will the returned goods reach source in time, refunds, exchange and 

postage make one tiresome. 

3. Privacy issues are serious in E-Commerce. 

In E-Commerce generating consumer information is inevitable.  

Not all the companies use the personal information they obtained to improve services to consumers. 

4. Physical product disputes are a major disadvantage in E-Commerce.  

5. E-Commerce purchases are often made on trust. This is because, we do not have physical access to the product.  

Internet is an effective channel for visual and auditory information it does not allow full scope for our senses.  
We can see pictures of the perfumes, but could not smell their fragrance; we can see pictures of a cloth, but not its quality. 
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2. Write about development and growth of E-Commerce (M-2023) 

The First Wave of Electronic Commerce: 1995 -2003  

❖ The Dotcom companies of first wave are mostly American companies.  

❖ Thereby their websites were only in English.  

❖ The Dotcom bubble had attracted huge investments to first wave companies.  

❖ As the Internet was mere read-only web (web 1.0) and network technology was in its beginning stage, the 

bandwidth and network security was very low.  

❖ Only EDI and unstructured E-mail remained as a mode of information exchange between businesses. 

❖ But the first wave companies enjoyed the first-move advantage and customers were left with no option. 

The Second Wave of Electronic Commerce: 2004 – 2009  

❖ The second wave is the rebirth of E-Commerce after the dotcom burst.  
❖ The second wave is considered as the global wave, with sellers doing business in many countries and in many languages.  

❖ Language translation and currency conversion were focused in the second wave websites.  
❖ The second wave companies used their own internal funds and gradually expanded their E-Commerce opportunities.  

❖ As a result E-Commerce growth was slow and steady.  

❖ The rapid development of network technologies and interactive web (web 2.0, a period of social media) offered 

the consumers more choices of buying.  

❖ The increased web users nourished E-Commerce companies (mostly B2C companies) during the second wave.  

The Third Wave of Electronic Commerce: 2010 – Present  

❖ The third wave is brought on by the mobile technologies.  

❖ It connects users for real-time and on-demand transactions via mobile technologies.  

❖ The term Web 3.0, summarize the various characteristics of the future Internet which include Artificial 

Intelligence, Semantic Web, Generic Database etc. 

 CHAPTER – 16 ( Electronic Payment Systems) 

1. Explain the key players of a credit card payment system. [OR] What is pay later method card? (M-2023) 

Explain the key players of Pay later method payment system and bring out its merits.               

Credit card: 

❖ Credit Card Credit card is an electronic payment system normally used for retail transactions.                       

Key Players In Operations Of Credit Card 

1.Bearer: 

❖ The holder of the credit card account who is responsible for payment of invoices in full or a portion of the balance 

(revolver) the rest accrues interest and carried forward. 

2.Merchant: 

❖ Storekeeper or vendor who sell or providing service, receiving payment made by its customers through the credit card. 

3.Acquirer: 

❖ Merchant’s bank that is responsible for receiving payment on behalf of merchant send authorization requests to the 

issuing bank through the appropriate channels. 

4.Credit Card Network: 

❖ It acts as the intermediate between the banks. 

❖ The Company responsible for communicating the transaction between the acquirer and the credit card issuer. 

❖ These entities operate the networks that process credit card payments worldwide and levy interchange fees. 

❖ E.g. Visa, MasterCard, Rupay 

5.Issuer: 

❖ Bearer’s bank, that issue the credit card, set limit of purchases, decides the approval of transactions, issue invoices 

for payment, charges the holders in case of default and offer card-linked products such as insurance, additional 

cards and rewards plan. 

Merits:  

❖ Most credit cards are accepted worldwide. 

❖ It is not necessary to pay physical money at the time of purchase.  

❖ The customer gets an extra period to pay the purchase.  

❖ Depending on the card, there is no need to pay annuity. 

2. Write a note on   a. Internet banking b. Mobile banking. (J-2024) 

a) Internet banking: 

❖ Internet banking is a collective term for E-banking, online banking, virtual banking, direct banks, web banking and 

remote banking. 

❖ Internet banking allows customers of a financial institution to conduct various financial transactions on a secure 

website operated by the banking institutions. 

❖ This is a very fast and convenient way of performing any banking transactions. 

❖ It enables customers of a bank to conduct a wide range of financial transactions through its website. 

❖ In fact, it is like a branch exclusively operating of an individual customer. 

❖ The online banking system will typically connect to the core banking system operated by customers themselves 

(Self-service banking). 
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Advantages: 

❖ Account holder are secured by user name and password while doing payments. 

❖ Accounts can be accessed with Internet anywhere at any time. 

❖ Any standard browser (e.g. Google Chrome) is adequate. 

❖ Internet banking does not need installing any additional software. 

b) Mobile banking : 

❖ Mobile banking is another form of net banking. 

❖ The term mobile banking (also called m-banking) refers to the services provided by the bank to the customer to 

conduct banking transactions with the aid of mobile phones. 

❖ These transactions include balance checking, account transfers, payments, purchases, etc. 

❖ Transactions can be done at anytime and anywhere. 

❖ The WAP protocol installed on a mobile phone helps the user have a permanent control over the account and 

remote management of his own finances. 

Mobile Banking operations can be implemented in the following ways: 

❖ Contacting the call centre. 

❖ Automatic IVR telephone service. 

❖ Using a mobile phone via SMS. 

❖ WAP technology. 

❖ Using smart phone applications. 

3. Explain in detail: Unified payments interface. 

❖ Unified Payments Interface (UPI) is a real-time payment system developed by National Payments Corporation 

of India (NCPI) to facilitate inter-bank transactions. 

❖ It is simple, secure and instant payment facility. 

❖ This interface is regulated by the Reserve Bank of India and used for transferring funds instantly between two 

bank accounts through mobile (platform) devices. http://www.npci.org.in/ 

❖ UPI withdraws and deposits funds directly from the bank account whenever a transaction is requested. 
❖ It also provides the “peer to peer” collect request which can be scheduled and paid as per requirement and convenience. 

❖ UPI is developed on the basis of Immediate Payment Service (IMPS). 

To initiate a transaction, UPI applications use two types of address - global and local. 

❖ Global address includes bank account numbers and IFSC. 

❖ Local address is a virtual payment address. 

❖ Virtual payment address (VPA) also called as UPI-ID, is a unique ID enable us to send and receive money from 

multiple banks and prepaid payment issuers. 

Advantages 

❖ Immediate money transfers through mobile device round the clock 24 x 7. 

❖ Can use single mobile application for accessing multiple bank accounts. 

❖ Single Click Authentication for transferring of fund. 

❖ It is not required to enter the details such as Card no, Account number, IFSC etc. for every transaction. 

❖ Electronic payments will become much easier without requiring a digital wallet or credit or debit card. 

1. Briefly explain Electronic Account transfer and its types. (S-2020)(J-2023) 

❖ With the advent of computers, network technologies and electronic communications a large number of alternative 

electronic payment systems have emerged.  

Types: 

1.ECS (Electronic Clearing Services),  2.EFT (Electronic funds transfers),  

3.Real Time Gross Settlement system (RTGS) etc. 

1.ECS (Electronic Clearing Services) 

❖ Electronic Clearing Service can be defined as repeated transfer of funds from one bank account to multiple bank 

accounts or vice versa using computer and Internet technology. 

❖ Advantages of this system are bulk payments, guaranteed payments and no need to remember payment dates. 

❖ ECS credit is used for making bulk payment of amounts. 

❖ ECS debit is used for bulk collection of amounts. 

2.EFT (Electronic funds transfers) 

❖ Electronic Funds Transfer (EFT) is the “electronic transfer” of money over an online network. 
❖ The amount sent from the sender’s bank branch is credited to the receiver’s bank branch on the same day in batches. 

❖ EFT is a widely used method for moving funds from one account to another in B2B business models. 

3.Real Time Gross Settlement system (RTGS) 

❖ Real Time Gross Settlement system (RTGS) is a payment system particularly used for the settlement of 

transactions between financial institutions, especially banks. 

❖ As name indicates, RTGS transactions are processed at the real time. 

❖ RTGS payments are also called as push payments that are initiated (“triggered”) by the payer. 

❖ RTGS payments are generally large-value payments, i.e. high-volume transactions. 

❖ Real-time gross settlement transactions are Unconditional and Irrevocable. 
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2. Compare and contrast Credit Card, Debit Card and Stored Value Card. (M-2022) 

(i) Credit Card:  

❖ Credit card is an electronic payment system normally used for retail transactions.  

❖ A credit card enables the bearer to buy goods or services from a vendor, based on the cardholder’s promise to the 

card issuer to payback the value later with an agreed interest.  

❖ Every credit card account has a purchase limit set by the issuing bank or the firm.  

❖ A credit card is different from a debit card where the credit card issuer lends money to customer instead of 

deducting it from customer’s bank account instantly. 

(ii) Debit Card:  

❖ Debit Card is an electronic payment card where the transaction amount is deducted directly from the card holder’s 

bank account upon authorization. 

❖ Generally, debit cards function as ATM cards and act as a substitute for cash 

❖ The way of using debit cards and credit cards is generally the same but unlike credit cards, payments using a debit 

card are immediately transferred from the cardholder’s designated bank account, instead of them paying the 

money back at a later with added interest.  

❖ In modern era the use of debit cards has become so widespread. 

(iii) Stored Value Card:  

❖ Stored value card is a type of debit card that is pre-loaded with certain amount(value), with which a payment is 

made. It is a card that has default monetary value onto it.  

❖ The card may be disposed when the value is used, or recharged to use it again.  

❖ The major advantage of stored value card is that customers don’t need to have a bank account to get prepaid cards. 

3. Explain Smart card and its types. (J-2022) 

❖ The modern version of card based payment is smart cards.  

❖ Smart cards along with the regular features of any card based payment system holds a EMV chip.  

❖ This chip is similar to well-known sim card in appearance but differ in its functionalities.  
❖ The advantage of Smart cards is that it can provide identification, authentication, data storage and application processing.  

Types:  

❖ Contact smart cards and Contactless smart cards. 

 CHAPTER – 17 (E-Commerce Security Systems) 

1. Write about dimensions of E-Commerce Security. (J-2024) 

❖ As the security issue is the most worrying issue for E-Business, ensuring the security of E-Commerce activities 

has become the core research field of E-Commerce.  

The following are some of the security elements involved in E-Commerce: 

Authenticity Conforming genuineness of data shared 

Availability Prevention against data delay or removal 

Completeness Unification of all business information 

Confidentiality Protecting data against unauthorized disclosure 

Effectiveness Effective handling of hardware, software and data. 

Integrity Prevention of the data being unaltered or modified. 

Non-repudiation Prevention against violation agreement after the deal. 

Privacy Prevention of customers‟ personal data being used by others. 

Reliability Providing a reliable identification of the individuals or businesses. 

Review Ability Capability of monitoring activities to audit and track the operations. 
 

2. Differentiate symmetric key and asymmetric key encryption. 

Symmetric key encryption Asymmetric key encryption 

Same key is used for both encryption and decryption  Different keys are used for encryption and decryption 

Speed of encryption or decryption is very Fast Speed of encryption or decryption is comparatively slow 

Plain text and cipher text are of same size The size of cipher text is always greater than plain text. 

Algorithms like DES, AES, RC4 uses symmetric key 

encryption 

Algorithms like RSA, ECC, DSA use asymmetric key 

encryption 

Provides confidentiality Provides confidentiality, authenticity and non-

repudiation 

The number of key used grows exponentially with the 

number of users 

The number of key used grows linearly with the number 

of users 
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3. Explain authentication protocols. (M-2024) 

❖ At present, there are two kinds of security authentication protocols widely used in E-Commerce, namely Secure 

Electronic Transaction (SET) and Secure Sockets Layer (SSL). 

1.Secure Electronic Transaction (SET): 

❖ Secure Electronic Transaction (SET) is a security protocol for electronic payments with credit cards, in particular 

via the Internet.  
❖ SET was developed in 1996 by VISA and MasterCard, with the participation of GTE, IBM, Microsoft and Netscape.  

❖ The implementation of SET is based on the use of digital signatures and the encryption of transmitted data with 

asymmetric and symmetric encryption algorithms.  

❖ SET also use dual signatures to ensure the privacy.  

SET system incorporates the following key features:  

❖ Using public key encryption and private key encryption ensure data confidentiality.  

❖ Use information digest technology to ensure the integrity of information.  

❖ Dual signature technology to ensure the identity of both parties in the transaction.  

2.Secure Sockets Layers (SSL): 

❖ The most common Cryptographic protocol is Secure Sockets Layers (SSL).  

❖ SSL is a hybrid encryption protocol for securing transactions over the Internet.  

❖ The SSL standard was developed by Netscape in collaboration with MasterCard, Bank of America, MCI and 

Silicon Graphics.  

❖ It is based on a public key cryptography process to ensure the security of data transmission over the internet.  

❖ Its principle is to establish a secure communication channel (encrypted) between a client and a server after an 

authentication step. 

1. Differentiate digital signatures and digital certificates. (M-2020)(J-2023) 

                Digital Signature            Digital Certificate 

• A digital signature is a mechanism that is used to verify that a 

particular digital document, message or transaction is 

authentic. 

• A digital certificate is a computer file which officially 

approves the relation between the holder of the certificate 

and a particular public key. 

• Used to verify the trustworthiness of the 

data being sent. 
• Used to verify the trustworthiness of the sender. 

• Digital signature is to ensure that a data remain secure from the 

point it was issued and it was not modified by a third party 
• Digital certificate binds a digital signature to an entity 

 

• It provides authentication, non-repudiation and integrity • It provides authentication and security. 

• A digital signature is created using a DSS, SHA-1 or SHA-2 . • A digital certificate works on the principles of PKCS, 

X.509 , PGP formats 

• The document is encrypted at the sending end and decrypted at 

the receiving end using asymmetric keys 

 

• A digital certificate consist of certificate's owner name 

and public key, expiration date, a Certificate Authority 's 

name , a Certificate Authority's digital signature 
 

2. Explain SSL: (J-2022) 

Secure Sockets Layers: 

❖ The most common Cryptographic protocol is Secure Sockets Layers (SSL).  

❖ SSL is a hybrid encryption protocol for securing transactions over the Internet.  
❖ The SSL standard was developed by Netscape in collaboration with MasterCard, Bank of America, MCI and Silicon Graphics.  

❖ It is based on a public key cryptography process to ensure the security of data transmission over the internet.  

❖ Its principle is to establish a secure communication channel (encrypted) between a client and a server after an 

authentication step. 
❖ Today, all browsers in the market support SSL, and most of the secure communications are proceeded through this protocol.  

❖ SSL works completely hidden for the user, who does not have to intervene in the protocol.  

❖ The only thing the user has to do is make sure the URL starts with https:// instead of http:// where the “s” 

obviously means secured.  

❖ It is also preceded by a green padlock. 
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 CHAPTER – 18 ( Electronic Data Interchange- EDI) 

1. Briefly explain various types of EDI. (M-2024) 

❖ The types of EDI were constructed based on how EDI communication connections and the conversion were organized.  

❖ Thus based on the medium used for transmitting EDI documents the following are the major EDI types.                                    

EDI Types: 

     1.Direct EDI  2.EDI via VAN   3.EDI via FTP/VPN, SFTP, FTPS 4.Mobile EDI  5.Web EDI      

1.Direct EDI/Point-to-Point: 

❖ It is also called as Point-to-Point EDI. 

❖ It establishes a direct connection between various business stakeholders and partners individually. 

❖ This type of EDI suits to larger businesses with a lot of day to day business transactions. 

2.EDI via VAN: 

❖ EDI via VAN (Value Added Network) is where EDI documents are transferred with the support of third party 

network service providers. 
❖ Many businesses prefer this network model to protect them from the updating ongoing complexities of network technologies. 

3.EDI via FTP/VPN, SFTP, FTPS: 

❖ When protocols like FTP/VPN, SFTP and FTPS are used for exchange of EDI based documents through the 

Internet or Intranet it is called as EDI via FTP/VPN, SFTP, FTPS. 

❖ Web EDI Web based EDI conducts EDI using a web browser via the Internet. 

4.Mobile EDI: 

❖ When smart phones or other such handheld devices are used to transfer EDI documents it is called as mobile EDI. 

❖ Mobile EDI applications considerably increase the speed of EDI transactions. 

5.Web EDI  

❖ Web based EDI conducts EDI using a web browser via the Internet.  

❖ Here the businesses are allowed to use any browser to transfer data to their business partners.  

❖ Web based EDI is easy and convenient for small and medium organizations. 

2. What are the advantages of EDI? (M-2023) 

❖ EDI was developed to solve the problems inherent in paper-based transaction processing and in other forms of 

electronic communication. 
❖ Implementing EDI system offers a company greater control over its supply chain and allow it to trade more effectively. 

❖ It also increases productivity and promotes operational efficiency. 

The following are the other advantages of EDI: 

1.Improving service to end users 2.Increasing productivity  3.Minimizing errors 

4.Slashing response times  5.Automation of operations  6.Cutting costs 

7. Integrating all business and trading partners. 8. Optimizing financial ratios. 
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CHAPTER 1 TO 18 FIVE MARK BOOK inside QUESTION & ANSWERS 

 CHAPTER – 1 ( Multimedia ) 
1. 2. Applications of Multimedia: 

1. Education: 

❖ Multimedia plays an vital role in offering an excellent alternative method to traditional teaching by allowing the 

students to explore and learn various concepts through animation.  

❖ Students, teachers and the parents enjoy this multimedia mode of learning and multimedia learning materials.  

❖ Multimedia based teaching and learning system named as MODULO at GMU in Germany developed is a web- 

based environment that aims to provide students with flexible and decentralized learning environment based on 

their educational background.  

❖ In India, multimedia is used in different ways for teaching and learning like e-learning, distance learning, virtual 

learning and so on. EDUSAT (Education Satellite) is launched in India for serving the educational sector of the 

country for emulating virtual classroom in an effective manner. 

2. Entertainment: 

❖ The remarkable advancement in the entertainment industry is due to the Multimedia Technology mainly.  

❖ This technology is needed in all mode of entertainment like radio, TV, online gaming, video on demand etc.  
❖ Video on demand or movies on demand is a service that provides movies to television sets on an individual basis at homes.  

❖ Movies are stored in a central server and transmitted through a communication network.  

❖ A set-top box connected to the communication network converts the digital information to analog signals and 

inputs it to the television set.  

3. Business Systems:  

❖ Business applications for multimedia include presentations, training, internet protocols and so on.  

❖ The marketing and advertising agencies are using animation techniques for sales promotion.  

❖ High resolution projectors are common for multimedia presentations on the road.  

❖ Cell phones and personal digital assistants with Bluetooth and Wi-Fi communication technology makes 

multimedia communication for business more efficiently.  

4. Medical Services: 

❖ Medical services are grown drastically with the development of multimedia.  

❖ Medical Students practices surgery methods via simulation prior to actual surgery.  

❖ Tiny digital cameras are inserted in human body and it displays the inner site of the body through which the 

medical practitioners can see the internal parts without actually dissecting it.  

5. Public Places: 

❖ Multimedia is available in many public places like trade shows, libraries, railway stations, museums, malls, 

airports, banks, hotels and exhibitions in the form of kiosks.  

❖ It helps the customers by providing information to them.  
❖ The information presented in kiosk are enriched with animation, video, still pictures, graphics, diagrams, maps, audio and text.  

❖ Banks uses kiosks in the form of ATM machines.  

6. Multimedia Conferencing:  

❖ Multimedia conferencing or video- conferencing is a system that performs face-to-face interactions among 

participating users, located far from each other, as if they were sitting and discussing in a single room. 

 CHAPTER – 2 ( An Introduction to Adobe Page maker ) 
1.  Explain methods of selecting a text  

Selecting Text using the mouse: 

 1. Place the Insertion point to the left of the first character to be selected.  

2. Press the left mouse button and drag the mouse to a position where you want to stop selecting.  

3. Release the mouse button.  

4. The selected text gets highlighted. 

Selecting Text using the Keyboard: 

1. Place the Insertion point to the left of the first character you wish to select.  

2. The Shift key is pressed down and the movement keys are used to highlight the required text.  

3. When the Shift key is released, the text is selected. 

2.  Explain the methods of deleting a text in page maker. 

To delete a character, do the following :  

1. Position the insertion point to the left of the character to be deleted.  

2. Press Delete key on the keyboard. (or)  

3. Position the insertion point to the right of the character to be deleted.  

4. Press Backspace key on the keyboard.  

To delete a block of text, do the following :  

1. Select the text to be deleted.  

2. Press Delete or Backspace in the keyboard (or) Edit > Clear command. 
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3.  Explain about Moving the Text in page maker. 

Moving the Text: 

To cut and paste text: 

1. Select the text to be moved.  

2. Choose Edit > Cut in the menu bar. (or) Press Ctrl + X in the keyboard (or)  

• Click the right mouse button and choose cut from the pop-up menu.  

3. Insertion point is moved to the place where the text is to be pasted.  

4. Choose Edit > Paste in the menu bar. (or) Press Ctrl + V in the keyboard. (or)  

• Click the right mouse button and choose Paste from the pop-up menu.  

• The text can also be moved in this way to another location. 

Copying the Text: 

To copy and paste text  

1. Select the text to be coped.  

2. Choose Edit > Copy in the menu bar (or) Press Ctrl + C in the keyboard (or)  

• Click the right mouse button and choose Copy from the pop-up menu.  

3. Insertion point is moved to the place where the text is to be pasted.  

4. Choose Edit > Paste in the menu bar (or) Press Ctrl + V in the keyboard (or)  

• Click the right mouse button and choose Paste from the pop-up menu.  

• The text can also be copied in this way to another location. 

4.  How to create a text block in page maker? 

To create a text block with the text tool:  

1. Select the text tool (T) from the toolbox. The pointer turns into an I-beam. 

2. On an empty area of the page or pasteboard, do one of the following:  

❖ Click the I-beam where you want to insert text. 

3. Type the text you want. Unlike with a text frame, you do not see the borders of a text block until you click the text 

with the pointer tool. 

Resizing a Text Block : 

❖ When you select a text block with the Pointer tool, the block’s boundaries become visible.  

❖ Two handles are seen above and below the text block. These handles are called Window shades.  

❖ There is a dark square on both ends of the handle. These are used to change the size of the text block. 

5.  Converting text in a Text block to a Frame: 

1. Draw the frame of your choice using one of the PageMaker’s Frame tool.  

2. Select the text block you want to insert in the frame. 

3. Click the frame while pressing the Shift key. Now both elements will be selected.  

4. Choose Element > Frame > Attach Content on the Menu bar.  

5. Now the text appears in the frame. 

6.  Saving a Document: 

To save a document for a first time following steps are used:  

1. (a) Choose File > Save in the menu bar. (or)  

2. The file name is given in the File name list box.  

3. Then click on the Save button to save the document.  

    The document is now saved and a file name appears in the title bar. 

    Once a file is saved under a name, to save it again the name need not be entered again.  

    The file can be saved simply by selecting the File > Save command or by clicking the Save button 

     (or) Clicking Ctrl + S in the keyboard. 

7.  Magnifying and reducing with the zoom tool: 

To magnify or reduce with the zoom tool:  

❖ Select the zoom tool. The pointer becomes a magnifying glass with a plus sign in its center, indicating that the 

zoom tool will magnify your view of the image.  

❖ (The magnifying glass shows a minus sign in its center when in reduction mode.)  

❖ To toggle between magnification and reduction, press the Ctrl key.  
❖ Position the magnifying glass at the center of the area you want to magnify or reduce, and then click to zoom in or out.  

❖ Continue clicking until the publication is at the magnification level you want.  

❖ When the publication has reached its maximum magnification or reduction level, the center of the magnifying 

glass appears blank. 

8.  Character Formatting using Character Specifications Dialog Box:  

❖ Character formatting means displaying text in a certain way.  

❖ Character formatting consists of text properties - bold, italic, underline, font type, font size, font color, etc. 

The steps to apply character formatting to text are as follows :  

1. Select the text to be formatted.  

2. Choose Type > Character in menu bar (or) Press Ctrl + T on the keyboard.  

www.Padasalai.Net                                                                     www.Trb Tnpsc.Com

Kindly Send Me Your Key Answer to Our email id - Padasalai.net@gmail.com

www.P
ad

as
al

ai
.N

et

www.P
ad

as
al

ai
.N

et

https://www.padasalai.net/
https://www.padasalai.net/


 

119 
                                   PREPARED BY...,    B.MOHAMED YOUSUF M.C.A., B.Ed..,    (PG   ASST IN COMPUTER SCIENCE) 

                                   [yousufaslan5855@gmail.com] 

 

    The Character Specifications dialog box appears. 

3. Make the appropriate changes in the dialog box.  

    ● Click the drop-down menu arrow of the Font box and select the desired font.  

    ● Click the drop-down menu arrow of the Font Size box and select the font size.  

    ● Click the drop-down menu arrow of the Font Color box and select the desired color.  

    ● Click the Bold, Italic, or Underline buttons to make the text bold, italic, or underlined respectively.  

4. Click on OK 

9. 1

0 

Explain drawing line tool in page maker. 

Drawing Lines:  

❖ PageMaker has two Line tools. The first one creates a straight line at any orientation.  

❖ The second is a constrained. Line tool that draws only at increments of 45 degrees.  

❖ You can change the property of tools by double-clicking on them. 

To draw a line:  

1. Select the Line tool from the toolbox. The cursor changes to a crosshair.  

2. Click and drag on the screen to draw your line. As you drag, a line appears. 

3. Release the mouse button and the line will be drawn and selected, with sizing handles on either end.  

    Resize the line by clicking and dragging the handles, if necessary. 

To draw a Dotted line:  

1. Double click the Line tool from the toolbox. A Custom Stroke dialogue box appears. 

2. Select the required Stroke style in the drop-down list box. 

3. Then click OK button. Now the cursor changes to a crosshair.  

4. Click and drag on the screen to draw your dotted line. As you drag, the line appears.  

5. Release the mouse button and the line will be drawn and selected, with sizing handles on either end. 

    Resize the line by clicking and dragging the handles, if necessary. 

10. 1

1 

Explain about drawing Rectangles or Ellipses: 

1. To draw a rectangle or ellipse: Click on the Rectangle or Ellipse tool from the toolbox.  

    The cursor changes to a crosshair.  

2. Click and drag anywhere on the screen. As you drag, a rectangle or ellipse appears.  

3. Release the mouse button when the rectangle or ellipse is of the desired size.  

    Press the Shift key while you’re drawing to constrain the shape to a square or circle. 

Drawing a Rounded Corner Rectangle: 

1. Double-click the Rectangle tool in the toolbox. The Rounded Corners dialog box appears.  

2. Choose a corner setting from the preset shapes.  

3. Click on OK. The cursor changes to a crosshair.  

4. Click and drag anywhere on the screen.  

5. Release the mouse button when the rectangle is the desired size.  

    Press the Shift key as you draw to constrain the shape to a rounded- corner square. 

11.  Explain about working with pages in page maker software. 

Going to a specific Page  

❖ PageMaker provides several methods for navigating through the pages in your publication. 

Method 1:  

❖ You can move from one page to another by using the Page up and Page down keys on your keyboard. 

❖ This is probably the navigation methods you will use most often.  

Method 2:  

❖ You can move from one page to another by using the page icons at the left bottom of the screen.  

❖ Click on the page icon that corresponds to the page that you want to view. The page is displayed.  

Method 3: Using the Go to Page dialog box: 

To go to a specific page in a document  

1. Choose Layout > Go to Page in the menu bar (or) Press Alt + Ctrl + G in the keyboard.  

     Now the Go to Page dialog box appears. 

2. In the dialogue box, type the page number that you want to view. 

3. Then click on OK. The required page is displayed on the screen. 

12.  How to create new master pages page in page maker? 

To create a new Master Page : 

1. Click the New Master Page icon in the Master Pages palette. The New Master Page dialog box appears.  

2. Enter the name of the new master page in the Name field.  

3. Make the appropriate changes in the Margins and Column Guides fields.  

4. Click on OK. A new Master Page appears in the Master Pages palette. 

13. 1

4 

Explain print a document in page maker. 

1. Choose File > Print in the menu bar (or) Press Ctrl + P in the keyboard. The Print Document dialog box appears.  

2. Choose the settings in the Print Document dialog box as  

❖ Select the printer from the Printer drop-down list box.  
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Choose the pages to be printed in the Pages group box by selecting one of the following available options :  

All: This option prints the whole document.  

Ranges:  

❖ This option prints individual pages by the page number or a range of pages. 

❖ You can use commas to separate the page numbers (e.g., 5,7,19)  

❖ Use a hyphen to print page ranges(e.g., 10-17; this will print all pages from page numbers 10 to 17).  
❖ To print from a particular page to the end of the document, enter the starting page number followed by a hyphen (e.g., 5 - ).  

❖ You may also combine individual page numbers and a range of pages (e.g., 5, 9, 15-26).  

Print :  

❖ You can also print only odd- numbered or even-numbered pages.  

❖ Select the Odd pages or Even pages option from the Print drop-down list box. 

❖ Type the number of copies you want in the Copies text box.  

❖ You can choose whether to collate the pages or not. Suppose you want to print 4 copies of a 5 pages document.  
❖ If the Collate option is not selected. PageMaker will first print 4 copies of page 1, then 4 copies of page 2, and so on. 

❖ If the Collate option is selected, PageMaker will print a complete set of pages 1 to 5, then a second set, and so on.  

4. After choosing from the options in the Print Document dialog box, click Print button to print the document.  

❖ Make sure the printer is switched on. 

 CHAPTER  -  3 (Introduction to Database Management System) 
1.  Explain about MYSQL. 

❖ MySQL is an open source relational database management system.  

❖ Its name is a combination of “My” the name of the founder Monty Widenius’s daughter and “SQL”.  

❖ A clear definition of database and SQL is mandatory to understand MySQL.  

❖ In simple, a database is defined as the structured collection of data.  

❖ Ex. Photo gallery is a database which has collection of photos (data).  

❖ SQL - structured query language is not a database.  
❖ It is a standardized language used to access the database and the data’s are processed to turn into efficient information.  

❖ The SQL standard always refers to the current version and the current version is 2003.  

❖ MySQL is open source software that allows managing relational databases.  

❖ It also provides the flexibility of changing the source code as per the needs.  

❖ It runs on multiple platforms like Windows, Linux and is scalable, reliable and fast 

2.  ER-Diagram notation 
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3.  Explain about MYSQL administration. 

Creating New User Account to MySQL:  

❖ In MySQL database, there exists a table named user.  

❖ The newly created account must have an entry in this user table.  

❖ Consider the admin creates an account with username and password.  

❖ The user account is activated with various access rights like INSERT, SELECT and UPDATE.  

❖ Consider the user table has the following fields host, name, password, select_priv, insert_priv and update_priv. 

❖ A new user account is added with values to the user table using the following INSERT query in MySQL database.  

The Syntax for inserting record:  

❖ INSERT INTO table name (Parameter1,Parameter2, Parameter3..) VALUES (Value1, Value2, Value3..);  

❖ All the query is in SQL will terminate with semicolon(;).  

❖ mysql> INSERT INTO user (host, name, password, select_priv, insert_ priv, update_priv)  

              VALUES (‘localhost’, ‘guest’, PASSWORD(‘guest123’), ‘Y’, ‘Y’, ‘Y’);  

❖ Query OK, 1 row affected (0.20 sec)  

4.  Explain about MYSQL Installation procedure. 

❖ Download and install XAMPP Server Software from Internet. 

❖ Click the Welcome Page Next Button 

❖ Select the Required component along with MYSQL component and click next button. 

❖ Choose The Installation Folder and click Next 

❖ Click Next Button in Setup ready page. 

❖ Installation get started. 

❖ After installing Click finish button and open the XAMMP Control panel. 

❖ In the Control Panel start the Apache and MySQL Services one by one. 

❖ The two services get started one by one 

❖ Open the URL http://localhost/phpmyadmin URL in a browser to access MySQL database. 

5.  Explain about SQL  

❖ SQL- Structured Query Language is a standard language used for accessing and manipulating databases.  

❖ It is declared as standard by American National Standards Institute (ANSI) and International Organization for 

Standardization (ISO) in 1986 and 1987 respectively. 

❖ Though SQL is standard language, different versions are maintained to meet out the requirements.  

Few major functions performed using SQL are listed below:  

● Executes queries against a database.  ● Retrieves data from database.  

● Inserts and updates records in a database ● Delete records from database.  

● Creates new databases and new tables in a database. 

6.  What are the types of Sql with example? 

1.Data Definition Language (DDL)  

❖ The DDL commands are used to define database schema (Structure).  

❖ Also to create and modify the structure of the database object in the database.  

❖ CREATE, ALTER, DROP,RENAME and TRUNCATE commands belongs to this category. 

Commands Description 

CREATE Used to create database or tables 

ALTER Modifies the existing structure of database or table 

DROP        Deletes a database or table. 

RENAME Used to rename an existing object in the database 

TRUNCATE   Used to delete all table records 

2.Data Manipulation Language (DML)  

❖ These SQL commands deals with the manipulation of data present in the database.  

❖ Most of SQL commands come under DML. INSERT, UPDATE, and DELETE commands belong to this category. 

Commands Description 

INSERT Adds new rows into database table. 

UPDATE Modifies existing data with new data in a table 

DELETE Deletes the records from the table. 

3.Data Query Language (DQL)  

❖ SELECT is the only SQL command used to fetch or retrieve the data from database tables that come under DQL. 

Commands Description 

SELECT Retrieve data from the table 

4.Transaction Control Language (TCL)  

❖ These SQL commands manage the transactions in SQL databases.  

❖ It also helps to save the change into database permanently.  

❖ COMMIT, ROLLBACK, SET TRANSACTION and SAVEPOINT commands belongs to this category. 
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Commands Description 

COMMIT Permanently saves into database 

ROLLBACK Restore database to original form since the last COMMIT.  

SET TRANSACTION Sets the transaction properties such as read- write or read only access. 

SAVE POINT Used to temporarily save a transaction so that we can rollback to that point whenever required 

5.Data Control Language (DCL)  

❖ The SQL commands that implement security on database objects like table, view, stored procedure etc.  

❖ GRANT and REVOKE commands belongs to this category. 

Commands Description 

Grant Used to give permission to specific users on specific database objects like table, view etc. 

Revoke Used to take out permission from specific users on specific database objects like table,view etc. 
 

7.  Explain about delete & modify the record. 

Deleting Record: 

❖ The existing record in a table is removed from the table using DELETE command.  

❖ Entire record or specified columns in the table can be deleted.  

❖ If we want to perform delete operation on specific columns, then the condition is given using WHERE clause.  

❖ If the condition is not specified, then the entire data will be deleted.   

Syntax1: DELETE from tablename WHERE columnname=”value”;  

Example: mysql>DELETE from Biodata WHERE firstname=”Mani”; 

Syntax2: DELETE from tablename; Example: mysql>DELETE from Biodata ; 

Modifying Record: 

❖ SQL provides us with modifying and updating the existing records in a table using UPDATE command.  

❖ The age of Krishna in Biodata table is changed using the below Syntax.  

Syntax1: UPDATE tablename SET column1=”new value” Where column2=”value2”;  

Example: mysql>UPDATE Biodata SET age=13 WHERE firstname=”Krishna”; 

8.  Explain about sorting record 

❖ The Query results are listed in Ascending or Descending order using the command ORDER BY clause.  

❖ In some databases the results are sorted by default in Ascending order and is given in Syntax1.  

❖ The results are displayed in descending order as per Syntax2. 

Syntax1: select * from tablename ORDER BY columnname;  

Example: select * from Biodata ORDER BY firstname; 

Syntax2: select * from tablename ORDER BY columnname DESC;  

Example: select * from Biodata ORDER BY firstname DESC; 

 CHAPTER – 4 ( PHP : Hypertext Pre-Processor ) 
1.  Explain about “Echo” statement with examples. 

❖ In PHP, the echo statement is used to output a string or other data to the screen.  

❖ It is a simple and efficient way to display information to the user.  

The echo statement can be used in several different ways:  

• To output a single string: (String values must be enclosed in single or double quotes.)  

Examples: echo ‘Hello, world!’; 

• To output multiple strings, separated by commas: Examples: echo “Hello, world!”;  

• To output the value of a variable: Examples: $name = “Kumar”; echo “My name is $name”;  

• To output the result of an expression. Examples: $x = 10; $y = 20; echo $x + $y; // Outputs ‘30’  

• To output multiple variables in the same echo statement, you can separate them with a comma.  

Examples: echo $x, $y, $z;  

• To concatenate (join) multiple strings together, you can use the concatenation operator (.). 

Examples: $name = “Mani”; echo “My name is” . $name;  

• To print multiple lines of text, you can use multiple echo statements.  

Examples : echo ‘This string has multiple’; echo ‘lines.’;  

• To output a string of text that contains a single quote, you can use double quotes to enclose the string.  

Examples: echo “It’s a nice day today.”; 

 CHAPTER – 10 ( Introduction to Computer Networks ) 
1. Explain about network applications: 

Application of Internet:                

● Download programs and files       ● Social media   ● E-Mail            ● E-Banking  

● Audio and Video Conferencing    ●E-Commerce  ● File Sharing      ● E- Governance  

● Information browsing                   ● Search the web addresses for access through search engine ● Chatting and etc  

Application of Intranet: 

● Sharing of company policies/rules and regulations  ● Access employee database  

● Distribution of circulars/ Office Orders                    ● Access product and customer data  

● Sharing of information of common interest              ● Launching of personal/ departmental home pages  
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● Submission of reports                                                ● Corporate telephone directories.  

Application of Extranet: 

● Customer communications  ● Online education/ training  ● Account status enquiry  

● Inventory enquiry                ● Online discussion               ● Supply – chain managements  

● Order status enquiry            ● Warranty registration         ● Claims       ● Distributor promotions 

 CHAPTER – 12 ( DNS - Domain Name System ) 
1. 2. Explain about components of DNS.  

❖ There are three important components in the Domain Name System.  

❖ They are, 􀁺 Namespace 􀁺 Name server 􀁺 Zone 􀁺 Resolver 

1.Name Space  

❖ The domain names must be very unique and appropriate.  

❖ The names should be selected from a namespace.  

❖ The name space can be organised in two ways 􀁺 Flat name space 􀁺 Hierarchical name space 

2.Name Server  

❖ Name Server is a main part of the Domain Name System (DNS).  

❖ It is a software program that run on a physical system. It has the DNS database consisting of domain names and 

their corresponding IP addresses.  

❖ Name Server translates the domain name to IP address. 

3.Zone  

❖ The entire name space is divided into many different zones.  

❖ Zone is a group of contiguous domains and sub domains.  

❖ If the zone has a single domain, then zone and domain are the same. 

4.Resolver  

❖ The resolver is a program which is responsible for initiating the translation of a domain name into an IP address.  

❖ Since a resolver is stored in the host, there is no need of any protocol to form a connection between the resolver 

and the user program. 

2. 3. What are the basic rules of domain name? 

❖ Domain name can consist of alphabets (a-z, A-Z) and the digits (0-9).  

❖ Hyphens are allowed, but hyphens can not be used as the first character of a domain name.  

❖ Spaces are not allowed  

❖ Special symbols (such as !, $, &, _ and so on) are not permitted.  

❖ The entire domain name may be at most 253 characters long.  

❖ Domain names are not case-sensitive. 

3.  Write short note on: 

Domain: A domain is a sub tree in the DNS tree-like structure. 

Zone: A zone is a group of contiguous domains and sub domains.  

Domain name space: Domain Name space is an entire collection Domains, Sub domains and Zones  

Name server: Name server manages the database of domain names and corresponding IP addresses.  

Server: A server can contain more than one zone files (Zones). A zone can contain more than one sub domains 

 CHAPTER – 13 ( Network Cabling) 
1.  Explain about pin details of Ethernet connector: 

❖ It has two main signals. One is TX (to transmit data) and Rx (to receive data).  

1. The first pin is the positive terminal used to transmit data (TX+). 

2. The second pin is the negative terminal used to transmit data (Tx-).  

3. The third pin is the positive terminal (Rx+) used to receive data. 

4. The fourth and fifth pins are left for later use.  

5. The sixth pin is the negative terminal used to receive data (Rx-).  

6. The seventh and eighth pins are left for later use.  

7. All these pins are bidirectional. 

2.  Crimping process for making Ethernet cables  

1. Cut the cable with desired length. 

2. Strip the insulation sheath about 1 inch from both end of the cable and expose the Twisted pair wires  

3. After stripping the wire, untwist the smaller wires and arrange them into the proper wiring scheme, 

   T568B preferred generally.  

4. Bring the wires tighter together and cut them down so that they all have the same length ( ½ inch).  

5. Insert all the 8 coloured wires into the eight grooves in the connector.  

    The wires should be inserted until the plastic sheath is also inside the connector.  

6. Use the crimping tool to lock the RJ45 connector on the cable.  

     It should be strong enough to handle manual traction. Now it is ready for data transmission.  

7. Use a cable tester to verify the proper connectivity of the cable. 
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3.  Ethernet Cable Color Coding Techniques. 

❖ There are three types of wiring techniques to construct the Ethernet cable.  

❖ It is also known as color coding techniques.  

❖ They are ● Straight-Through Wiring ● Cross-over Wiring ● Roll-over Wiring 

1.Straight-Through Wiring:  

❖ In general, the cables used for Ethernet connections are “straight-through cables”.  

❖ These cable wires are in the same sequence at both ends of the cable.  
❖ It means that pin 1 of the plug on one end is connected to pin 1 of the plug on the other end (for both standard – T568A & T568B).  

❖ The straight through wiring cables are mostly used for connecting PC / NIC card to a hub.  

❖ This is a simple physical connection used in printers, computers and other network interfaces 

2.Cross-over Wiring  

❖ If you require a cable to connect two computers or Ethernet devices directly together without a hub, then you will 

need to use a Crossover cable instead. Here, the pairs of Tx and Rx lines are crossed.  

❖ It means pin 1 & 2 of the plug on one end are connected with pin 3 & 6 of the plug on other end,  

and vice versa (3 & 6 to pin 1 & 2). 

3.Roll-over Wiring:  

❖ Rollover cable is a type of null-modem cable that is often used to connect a device console port to make 

programming changes to the device.  

❖ The roll over wiring have opposite pin arrangements, all the cables are rolled over to different arrangements.  

❖ In the rollover cable, the coloured wires are reversed on other end i.e.  

❖ The pins on one end are connected with other end in reverse order (i.e. pin 1 to 8, 2 to 7, 3 to 6, 4 to 5, 5 to 4, 6 to 

3, 7 to 2, 8 to 1). 

 CHAPTER – 15  ( E-Commerce) 
1.  Evolution of Electronic Commerce: 

❖ E-Commerce is not a completely new type of commerce.  

❖ The dawn of E-Commerce started few decades ago and continues to grow exponentially.  

❖ It first emerged on private networks in 1970s.  

❖ Electronic Data Interchanges and teleshopping together paved the way for the E-Commerce.  

❖ The history of modern E-Commerce is closely twisted together with the history of the Internet.  

❖ E-Commerce became really possible when the Internet was opened to commercial use.  

❖ Online shopping started to grow when National Science Foundation opened the Internet to the public in 1991. 

Since then businesses have reached websites.  

❖ With the progress of the Internet technology and vastly developed global Internet community, large number of 
Dotcoms, FinTech and Internet Startups have appeared and a strong foundation of electronic commerce continues to build. 

❖ The Internet has provided new commercial potential not only for large organizations, but also provided a 

sustainable entry point for Small and Medium-sized Enterprises (SMEs) of E-Commerce. 

❖ Today, E-Commerce is no longer an exclusive domain of large organizations or private networks. 

❖ Even though E-Commerce has been existing since few decades, it has recently sustained significant growth.  

❖ It is because the Internet has transformed from an auxiliary communication medium of academics and large 

organizations to an entrenched communication medium that extends nearly to all parts of mainstream society.  

❖ Integrated with commercialization of the Internet, personal computers and electronic payment systems together 

made E-Commerce flourish.  

❖ The growth of E-Commerce is also related to the socio-technological changes.  

❖ The more, the medium becomes deep-rooted, the more, are the users drawn towards it.  

❖ Increase of users, increases the markets.  

❖ As the markets expand, more business organizations are attracted.  

❖ The more businesses accumulate it create competition.  

❖ The competition leads to innovation; innovation in turn drives the development of technology; technology 

facilitates E-Commerce’s growth. 
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2.  Explain about describing various events in E-commerce. 

 
3.  Comparison between Traditional Commerce and E-Commerce: 

Traditional Commerce              E-Commerce 

Traditional commerce is buying or selling of products 

and services physically. 

E-Commerce carries out commercial transactions 

electronically on the Internet 

Customer can face to face identify, authenticate and talk 

to the merchant 

Neither customer nor merchant see the other 

Physical stores are not feasible to be open at all times It is always available on all time and all days of the year 

Products can be inspected physically before purchase Products can’t be inspected physically before purchase 

Scope of business is limited to particular area Scope of business is global Vendors can expand their 

business Worldwide. 

Resource focus Supply side Resource focus Demand side 

Business Relationship is Linear Business Relationship is End-to-end 

Marketing is one way marketing One-to-one marketing 

Payment is made by cash, cheque, cards etc Payment system is mostly through credit card, debit card 

or fund transfer 

Most goods are delivered instantly. It takes time to transport goods 
 

 CHAPTER – 16 ( Electronic Payment Systems) 
1.  Electronic Case Payment System: 

❖ Electronic case is (E-Cash) is a currency that flows in the form of data.  

❖ It converts the case value into a series of encrypted sequence numbers, and uses the serial numbers to represent the 

market value of various currencies in reality.  

Cryptocurrency  

❖ A crypto currency is a unique virtual (digital) asset designed to work as a medium of exchange using 

cryptographic algorithm.  

❖ This algorithm secures the transactions by recording it in block chain and controls the creation of additional units 
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of the currency.  

❖ The state of ownership of a crypto currency is related to individual system blocks called “portfolios”.  

❖ Only the holder of the corresponding private key would have control over a given portfolio the function of crypto 

currency is based on technologies such as Mining, Block chain, Directed Acyclic Graph, Distributed register 

(ledger), etc.  

Electronic wallets  

❖ Electronic wallets (e-wallets) or electronic purses allow users to make electronic transactions quickly and securely 

over the Internet through smartphones or computers.  

❖ The electronic wallet functions almost the same as a physical wallet in term that it holds our money. 

❖ Electronic wallets were first recognized as a method for storing money in electronic form, and became popular 

because it provides a convenient way for online shopping.  

❖ With the development of advanced Internet, the use of electronic wallets turned out as an efficient transaction tool.  

❖ This is evidenced by the many E-Commerce websites that use electronic wallets as a transaction tool.  

2.  Advantages of internet banking: 

❖ The advantages of Internet banking are that the payments are made at the convenience of the account holder and 

are secured by user name and password. i.e. with Internet access it can be used from anywhere in the world and at 

any time.  

❖ Any standard browser (e.g. Google Chrome) is adequate.  

❖ Internet banking does not need installing any additional software.  

❖ Apart from regular transactions, Internet banking portal provides complete control over all banking demands such 

as available balance, transaction statements, recent transactions, bill payment, blocking a card in case of theft or 

loss, information about other bank products like payment cards, deposits, loans etc. 

3.  Write a steps to transfer fund using net banking: 

Step 1: Login to net banking account using unique user name and password provided by the bank earlier.  

Step 2: Add the beneficiary as a payee to enable transfer of fund. The following details like Account 

             Number, Name, IFSC about the beneficiary are to be filled in the ‘Add New Payee’ section.  

Step 3: Once the beneficiary is added, choose RTGS / NEFT / IMPS as mode of Fund Transfer.  

Step 4: Select the account to transfer money from, select the payee, enter the amount to be transferred and add remarks  

Step 5: Click on submit.  

Step 6: Enter the OTP received to mobile number linked to the corresponding account to complete the transaction. 

4.  Unified Payments Interface:  

❖ Unified Payments Interface (UPI) is a real-time payment system developed by National Payments Corporation of 

India (NCPI) to facilitate inter-bank transactions.  

❖ It is simple, secure and instant payment facility.  

❖ This interface is regulated by the Reserve Bank of India and used for transferring funds instantly between two 

bank accounts through mobile (platform) devices. http://www.npci.org.in/ Unlike traditional e-wallets, which take 

a specified amount of money from user and store it in its own account, UPI withdraws and deposits funds directly 

from the bank account whenever a transaction is requested.  

❖ It also provides the “peer to peer” collect request which can be scheduled and paid as per requirement and 

convenience.  

❖ UPI is developed on the basis of Immediate Payment Service (IMPS).  

❖ To initiate a transaction,  UPI applications use two types of address - global and local.  

❖ Global address includes bank account numbers and IFSC.  

❖ Local address is a virtual payment address.  

❖ Virtual payment address (VPA) also called as UPI-ID, is a unique ID similar to email id (e.g. name @ bank name) 

enable us to send and receive money from banks.  

❖ The bank or the financial institution allows the customer to generate VPA using phone number associated with 

Aadhaar number and bank account number.  

❖ VPA replaces bank account details thereby completely hides critical information. 

 CHAPTER – 17 (E-Commerce Security Systems) 
1.  Types of E-Commerce Threats: 

1. Information leakage:  

❖ The leakage of trade secrets in E-Commerce mainly includes two aspects:  

(a) the content of the transaction between the vendor and customer is stolen by the third party;  

(b) the documents provided by the merchant to the customer or vice versa are illegally used by the other. 

❖ This intercepting and stealing of online documents is called information leakage.  

2. Tampering:  

❖ E-Commerce has the problem of the authenticity and integrity of business information.  

❖ When hackers grasp the data transmitted on the network, it can be falsified in the middle through various technical 

means, and then sent to the destination, thereby destroying the authenticity and integrity of the data.  
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3. Payment frauds:  

❖ Payment frauds have subsets like Friendly fraud (when customer demands false reclaim or refund), Clean fraud 

(when a stolen credit card is used to make a purchase) Triangulation fraud (fake online shops offering cheapest 

price and collect credit card data) etc. 

4. Malicious code threats:  

❖ Within an E-Commerce site, there are multiple vulnerable areas that can serve as an intrusion point for a hacker to 

gain payment and user information.  

❖ Using malware, Cross Site Scripting or SQL Injection, an attacker will extract the credit card information and sell 

the acquired data on black markets.  
❖ Fraud is then committed to extract the greatest value possible through E-Commerce transactions or ATM withdrawals, etc.  

5. Distributed Denial of Service (DDoS) Attacks:  

❖ It is a process of taking down an E-Commerce site by sending continious overwhelming request to its server.  

❖ This attack will be conducted from numerous unidentified computers using botnet.  

❖ This attack will slow down and make the server inoperative.  

❖ DDoS attacks is also called as network flooding. 

6.Cyber Squatting:  

❖ Cybersquatting is the illegal practice of registering an Internet domain name that might be wanted by another 

person in an intention to sell it later for a profit.  
❖ It involves the registering of popular trademarks and trade names as domain names before the particular company do.  

❖ Cyber squatters also involve in trading on the reputation and goodwill of such third parties by inducing a customer 

to believe that it is an official web page. 

7. Typopiracy:  

❖ Typopiracy is a variant of Cyber Squatting. Some fake websites try to take advantage of users’ common 

typographical errors in typing a website address and direct users to a different website. 

❖ Such people try to take advantage of some popular websites to generate accidental traffic for their websites.  

❖ E.g. www.goggle.com, www.faceblook.com. 

2.  Security technologies in E-Commerce transaction:  

❖ The security technologies in E-Commerce transactions are roughly classified into,  

● Encryption technology ● Authentication technology ● Authentication protocols 

1.Encryption technology:  

❖ Encryption technology is an effective information security protection.  

❖ It is defined as converting a Plaintext into meaningless Cipher text using encryption algorithm thus ensuring the 

confidentiality of the data.  

❖ The encryption or decryption process uses a key to encrypt or decrypt the data.  

❖ At present, two encryption technologies are widely used.  

❖ They are ● Symmetric key encryption system ● Asymmetric key encryption system. 

2.Authentication Technology:  

❖ The main role of security certification is to ensure Authentication, Integrity and Non-repudiation. 

❖ This can be achieved through digital signatures and digital certificates.  

Digital certificates  

❖ A digital certificate is an electronic document used to prove the ownership of a public key.  

❖ This certificate includes the information about the sender’s identity, digital signature and a public key.  
❖ A digital certificate function is similar to the function of identification cards such as passports and driving licenses.  

❖ Digital certificates are issued by recognized Certification Authorities (CA). 

Digital signature:  

❖ A digital signature is a mechanism that is used to verify that a particular digital document, message or transaction is authentic.  

❖ It provides the receiver the guarantee that the message was actually generated by the sender.  

❖ It also confirms that the information originated from the signer and has not been altered by a cracker in the middle.  

❖ Digital signatures can provide the added assurances of evidence to the origin, identity and status, as well as 

acknowledging the consent of the sender. 

3.Authentication protocols:  

❖ At present, there are two kinds of security authentication protocols widely used in E-Commerce, namely Secure 

Electronic Transaction (SET) and Secure Sockets Layer (SSL).  

❖ Secure Electronic Transaction Secure Electronic Transaction (SET) is a security protocol for electronic 

payments with credit cards, in particular via the Internet.  
❖ SET was developed in 1996 by VISA and MasterCard, with the participation of GTE, IBM, Microsoft and Netscape.  

❖ The implementation of SET is based on the use of digital signatures and the encryption of transmitted data with 

asymmetric and symmetric encryption. algorithms.  

❖ SET also use dual signatures to ensure the privacy.  

Secure Sockets Layers:  

❖ The most common Cryptographic protocol is Secure Sockets Layers (SSL).  

❖ SSL is a hybrid encryption protocol for securing transactions over the Internet.  
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❖ The SSL standard was developed by Netscape in collaboration with MasterCard, Bank of America, MCI and Silicon Graphics.  

❖ It is based on a public key cryptography process to ensure the security of data transmission over the internet.  

❖ Its principle is to establish a secure communication channel (encrypted) between a client and a server after an 

authentication step. 

 CHAPTER – 18 ( Electronic Data Interchange- EDI) 
1.  History of EDI:  

❖ In late 1960s, shipping line, railroads, airlines, and truck companies of USA were exchanging electronic messages 

for their businesses.  

❖ These messages were in different formats, and it resulted in problems in transfer of goods.  

❖ In 1968, these companies grouped together among themselves and formed the Transportation Data Coordinating 

Committee (TDCC) to develop EDI standard formats.  

❖ In 1975, first EDI standards were released by TDCC, of which Ed Guilbert was a major contributor. 

❖ In 1977, a group of supermarket companies and their business partners begin drafting and using an EDI project.  

❖ The TDCC is renamed as Electronic Data Interchange Association (EDIA) in 1978.  

❖ Later in that year, the EDIA was undertaken by the American National Standards Institute and becomes the 

ANSIX12 committee.  

❖ Since then this committee is responsible for the publication of EDI standards.  

❖ Later in 1985, UN created the EDIFACT to assist with the global reach of technology in E-Commerce.  

❖ EDIFACT is the most widely used EDI. 

❖ The first EDI messages was sent in 1965 from the Holland-American steamship line to Trans-Atlantic shipping 

company using telex messages.  

❖ The computer had sent a full page of information in roughly 2 minutes.  

❖ These messages were then written on the magnetic tapes that could be loaded onto another computer 

2.  EDI Standards:  

❖ The standard is the most critical part of the entire EDI.  

❖ Since EDI is the data transmission and information exchange in the form of an agreed message format, it is 

important to develop a unified EDI standard.  

❖ The EDI standard is mainly divided into the following aspects:  

basic standards, code standards, message standards, document standards, management standards, application 

standards, communication standards and security standards.  

❖ The first industry-specific EDI standard was the TDCC published by the Transportation Data coordinating 

Committee in 1975.  

❖ Then other industries started developing unique standards based on their individual needs.  

❖ E.g. WINS in the warehousing industry.  

❖ The most widely used EDI message standards are the United Nations EDIFACT and the ANSI X12. 

3.  UN/EDIFACT:  

❖ United Nations / Electronic Data Interchange for Administration, Commerce and Transport (UN / EDIFACT) is an 

international EDI - standard developed under the supervision of the United Nations. 

❖ In 1987, the UN / EDIFACT syntax rules were approved as ISO: ISO9735 standard by the International 

Organization for Standardization.  

❖ EDIFACT includes a set of internationally agreed standards, catalogues and guidelines for electronic exchange of 

structured data between independent computer systems. 

❖ It is a cross-industry, standard data format of electronic data for commercial transactions. Maintenance and further 

development of this standard goes through the United Nations Center for Trade Facilitation and Electronic 

Business (UN/CEFACT), which is affiliated to the UN Economic Commission for Europe (UNECE). 
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4.  UN/EDIFACT Message structure: 
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CHAPTER 1 TO 9 IMPORTANT procedures, formats and methods 
 CHAPTER-2 ( An Introduction to Adobe Page maker ) 
1. 1

. 

Opening page maker: 

❖ Start→All Programs → Adobe → Pagemaker 7.0 → Adobe PageMaker 7.0. 

2. 2

. 

Creating a New Document: 

1. Choose File > New in the menu bar. (or) Press Ctrl + N in the keyboard.  

    Now Document Setup dialog box appears. 

2. Enter the appropriate settings for your new document in the Document Setup dialog box.  

3. Click on OK. 

3. 3

. 

Page maker Shortcuts: 

1 Pointer Tool F9 7 Hand Tool Shift + Alt + Drag Left mouse button 

2 Rotating Tool Shift + F2 8 Text Tool Shift + Alt + F1 

3 Line Tool Shift + F3 9 Cropping Tool Shift + Alt + F2 

4 Rectangle Tool Shift + F4 10 Constrained Line Tool Shift + Alt + F3 

5 Ellipse Tool Shift + F5 11 Rectangle Frame Tool  Shift + Alt + F4 

6 Polygon Tool Shift + F6 
 

4. 4

. 

Keyboard shortcuts: 

1 Cut Ctrl + X   9 Undo Ctrl+Z 

2 Copy Ctrl + C 10 Redo Ctrl+Y 

3 Paste Ctrl + V 11 Zoom out Ctrl+Alt+ Space bar 

4 Save Ctrl + S 12 Go to page Alt+Ctrl+G 

5 Close Ctrl +W 13 Master page Ctrl+Alt+P 

6 Zoom in Ctrl+Space bar 14 Control Palette Ctrl+” 

7 Open Ctrl + O  

8 Print Ctrl+P 
 

 CHAPTER  -  3 (Introduction to Database Management System) 
1.  Creating New User Account to MySQL: 

Syntax  

INSERT INTO table name (Parameter1,Parameter2, Parameter3..) VALUES (Value1, Value2, Value3..);  

• All the query is in SQL will terminate with semicolon(;) 

mysql> INSERT INTO user (host, name, password, select_priv, insert_ priv, update_priv)  

             VALUES (‘localhost’, ‘guest’, PASSWORD(‘guest123’), ‘Y’, ‘Y’, ‘Y’); 

2.  Administrative MySQL Command: 

1. USE Database: 

Syntax: mysql > use test;  

                            Database changed  

              mysql> 

2. SHOW Databases 

Syntax: mysql > show databases; 

3. SHOW Tables 

Syntax: mysql > show tables; 

4. SHOW COLUMNS FROM tablename 

Syntax: mysql > show columns from sports; 

5. SHOW INDEX FROM tablename  

Syntax: mysql > show indexes from sports; 

3.  Example of create & use: 

• Create a database to store the personaldetails.  

mysql> create database personaldetails;    Query Ok, 1 row affected  

mysql> USE personaldetails;  Database changed. 

4.  The created database is listed using SHOW command:  

 mysql> show databases; 

5.  Insert Rows: 

INSERT INTO TABLE_NAME (column1, column2, column3, ... columnN) VALUES (value1, value2, value3, ...valueN); 

6.  Create Database:  

Syntax: CREATE database databasename;  

Example: mysql>create database studentDB;  

Syntax: mysql>Show databases; 

7.  Drop Database: 

Syntax: DROP database databasename; Example: mysql>DROP database studentDB; 
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8.  Select Database: 

Syntax: USE databasename;  

Example: mysql>USE studentDB; 

9.  Insert Record: 

Syntax 1: INSERT INTO tablename (column1, column2, column3) VALUES (value1, value2, value3);  

mysql>INSERT INTO Biodata (firstname, lastname, age) VALUES (Krishna, Sam, 10); 

Syntax 2: INSERT INTO tablename VALUES (value1, value2, value3); 

mysql>INSERT INTO Biodata VALUES (Krishna, Sam, 10); 

10.  Select Record: 

Syntax1: SELECT * from tablename;  

Example: mysql>SELECT * from Biodata; 

Syntax2: SELECT column1, column2 from tablename;  

Example: mysql>SELECT firstname, age from Biodata; 

11.  Deleting Record: 

Syntax1: DELETE from tablename WHERE columnname=”value”;  

Example: mysql>DELETE from Biodata WHERE firstname=”Mani”; 

Syntax2: DELETE from tablename;  

Example: mysql>DELETE from Biodata ; 

12.  Modifying Record: 

Syntax1: UPDATE tablename SET column1=”new value” Where column2=”value2”;  

Example: mysql>UPDATE Biodata SET age=13 WHERE firstname=”Krishna”; 

13.  Sorting Records: 

Syntax1: select * from tablename ORDER BY columnname;  

Example: select * from Biodata ORDER BY firstname; 

Syntax2: select * from tablename ORDER BY columnname DESC;  

Example: select * from Biodata ORDER BY firstname DESC; 

 CHAPTER – 4 ( Introduction to Hypertext Pre-Processor ) 
1. 1

. 

How many types of PHP syntax: 

Types of PHP tags Opening tag Closing tag 

1. PHP Default tags <?php  ?> 

2. Short open tags <?  ?> 

3. HTML script embed tags <scriptlanguage=”php”> </script> 
 

2. 2

. 

PHP operator: 

Operators  type Operators 

1.Arithmetic operators +, -, *, /, %  

2.Assignment operators  =, +=, -=, *=, /=, %=  

3.Comparison operators ==, ===, !=, <>, !==, >, <, >=, <=  

4.Increment/Decrement operators ++$x, $x++, --$x, $x--  

5.Logical operators  &&, ||, !,xor  

6.String operators  . , .=  
 

3. 3

. 

What will be the output of the following php code?  OUTPUT: 

<?php                                                                               int(15) 

$x=15;   var_dump($x);  ?> 

4. 5

. 

Basic Rules for Variable Declaration  

1.Variable name must always begin with a $ symbol.  

2.Variable name can never start with a number.  3.Variable names are case-sensitive.  

5. 6

. 

Write the output of the following program.                                                       output  

<?php       $a=5; $b=10;          $c=($a+$b)*$a;     echo $c;    ?>                            75 

6.  PHP Syntax: 

1. PHP code is enclosed in <?php and ?> tags. These tags are called opening and closing tags.  

Example :  

<?php 

 // PHP code  

?> 

2. A PHP statement must end with a semicolon (;).  

Example : 

 <?php  

    echo “Hello, World!”;         // This is a valid PHP statement  

  ?> 
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7.  Variable declaration: 

$name = “Balu”;  

$age = 30;  

$is_admin = true;  

$prices = array(10, 20, 30); 

8.  Operators in PHP with example.  

1. Arithmetic operators: 

Operator Operator Name Example Output 

+ Addition 5+2 7 

- Subtraction 5-2 3 

* Multiplication 5*2 10 

/ Division 5/2 2.5 

% Modulus 5%2 1 

2.Assignment Operators: 

Operator Operator Name Example Output 

= Assignment  $a = 5; 5 

Combined Assignment Operators: 

Operator Operator Name Example Equivalent to Output 

+= Addition  assignment  $a = 5; $b = 2; $a+=$b; $a = $a + $b; 7 

-= Subtraction  assignment $a = 5; $b = 2; $a-=$b; $a = $a - $b; 3 

*= Multiplication assignment $a = 5; $b = 2; $a*=$b; $a = $a * $b; 10 

/= Division assignment $a = 5; $b = 2; $a/=$b; $a = $a / $b; 2.5 

%= Modulo assignment $a = 5; $b = 2; $a%=$b; $a = $a % $b; 1 

3.Comparison Operators: 

Operator Operator Name Meaning Example Output 

> Greater than  It return True if left is greater than right  5>2 True 

< Less than It return True if left is less than right 5<2 False 

>= Greater than or equal to It return True if left is greater than or equal to right 5>=2 True 

<= less than or equal to It return True if left is less than or equal to right 5<=2 False 

= = Equal to It return True if left is equivalent to right 5= = 5 True 

!= Not equal to It return True if left is not equivalent to right 5!=5 5!=6 True False 

4.Logical Operators: 

Operator Operator Name Meaning Example Output 

&& Logical AND It returns true if  both operands are true, and 

false other wise 

(5>3)&&(5>7) False 

|| Logical OR It returns true if  at least one of the operands 

is true, and false other wise 

(5>3) || (5>7) True 

! Logical NOT It returns the opposite of the operand  !(5>3) False 

xor XOR It returns true if  exactly one of the operands 

is true, and false other wise 

(5>3)xor(5>7) True 

5.Increment and Decrement Operators: 

Operator Operator Name Example Meaning 

++ 

(increment 

Operator) 

++$a (Pre-Incre $x=++$a First, $a is incremented by 1 and then the value is returned. 

$a++(Post-Incre $x=$a++ First, the value of $a is returned and then it is incremented by 1 

- - 

(decrement 

Operator) 

--$a (Pre-decre $x=--$a First, $a is decremented by 1 and then the value is returned 

$a--(Post-Incre $x=$a-- First, the value of $a is returned and then it is decremented by 1 

6.String Operators: 

❖ String operators have concatenation operator (.) and concatenation assignment operator (.=). 

❖ Concatenation means adding one or more variables to an existing variable. 

Operator Operator Name Meaning Example Output 

. (Dot) Concatenation It concatenates (joins) two strings together $a=’Hello’; 

$b=’World’; 

$c=$a.$b; 

HelloWorld 

. (Dot 

Equal to) 

Concatenation 

assignment 

It appends one string to another and assigns 

the result to a variable in a single statement. 

$a=’Hello’; 

$b=’World’; 

$a.=$b; 

 

HelloWorld 
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9.  Embedding PHP code in HTML: 

<html>  

<head>  

<title>My PHP Page</title>  

</head>  

<body>  

<?php  

echo “Hello, World!”;  

?>  

</body>  </html> 

 CHAPTER-5 ( PHP Function and Array ) 
1. 1

. 

Write a php code to display your name and your school address    

<?php                                                                      Output 

echo”SabariIrul”,”<br>”;                                     SabariIrul 

echo”DRSMHSS”,”<br>”;                                  DRSMHSS 

echo”Singrathoppu”,”<br>”;                               Singrathoppu 

echo”RAMNAD-6200018”,”<br>”;                    RAMNAD-6200018 

?> 

2. 3

. 

Function Declaration:  

syntax:  

function functionName([parameter list] )  

{  

    //code to be executed;  

} 

3. 4

. 

Function Calling:  

syntax : 

functionName();  (or) 

functionName(argument list); 

Example 1: Function with no parematers                                      Output 

<?php                                                                                             “Hello, world!” 

      function printGreeting () 

      { 

         echo “Hello, world!”; 

       } 

      printGreeting (); 

?> 

 

(b) Function with 1 parameter:                                                           Output 

<?php                                                                                              “Hello, Barathi!” 

function greet($name)  

{  

echo “Hello, $name!”;  

}greet(“Barath”); 

?>  

(c ) Function with 2 parameters:                                                          Output 

<?php                                                                                                         “50” 

function addNumbers($x, $y)  

{  

echo $x + $y;  

} addNumbers(10,40); 

4. 5

. 

Indexed array: 

Syntax  

$arrayVariable = [ element1, element2, element3, … elementN]; (or)  

$arrayVariable = array( element1, element2, element3, … elementN); 

Examples  

(a) $fruits = [‘apple’, ‘banana’, ‘orange’];  

(b) $fruits = array(‘apple’, ‘banana’, ‘orange’);  

• In the example above, the elements in the array are “apple”, “banana”, and “orange”.  

• The first element has an index of 0, the second element has an index of 1, and so on.  

(c) $numbers = array(1, 2, 3, 4, 5);  

(d) $colours = array(“red”, “green”, “blue”);   (e) $num = array(10, 10.5, 20, 20.5); 
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5.  Associative array: 

Syntax  

$arrayVariable = [ "key1" => "value1", "key2" => "value2", "key3" => "value3" "keyN⇒ "valueN" ];       (or) 

$arrayVariable = array( "key1" => "value1", "key2" => "value2", "key3" => "value3" "keyN⇒ "valueN" ); 

Example 1  

$student = [ “Name” => “Ram”, “Age” => 25, “Place” => “Trichy” ];    (OR)  

$student = array( “Name” => “Ram”, “Age” => 25, “Place” => “Trichy” );  

Example 2  

$marks = [ “studentName” => “Ravi”, “ExamNo” => 12425, “Tamil” => 95, “English” => 80, “Computer Applications” => 97 ]; (OR)  

$marks = array( “studentName” => “Ravi”, “ExamNo” => 12425, “Tamil” => 95, “English” => 80, “Computer Applications” => 97 ); 

6.  Some examples of associative arrays in PHP:  

Example1  

<?php $ages = array( “Arun” => 25, “Balu” => 30, “Naveen” => 28 ); echo $ages[“Arun”];  

// Output will be 25. echo $ages[“Balu”];    // Output will be 30. echo $ages[“Naveen”];    // Output will be 28. ?>  

Example 2:  

<?php $student = array( “name” => “Barath”, “age” => 23, “place”=> “Sirugambur”, “city” => “Trichy”, );  

echo $student[“name”];       // Output will be “Barath”.  

echo $student[“age”];         // Output will be 23 

?> 

7.  Multidimensional array  

Example 1 : A multidimensional array that contains one array as its element.  

$arr = array( array(1, 2, 3), );  

echo $arr[0][1];           // Output will be 2.  

Example 2 : A multidimensional array that contains three arrays as its elements.  

$arr = array( array(1, 2, 3), array(4, 5, 6), array(7, 8, 9) );  

echo $arr[1][2];          // Output will be 6. 

 CHAPTER-6 ( PHP Conditional Statements ) 
1.  If’statement: 

Syntax :  

if (condition)  

{  

// code to be executed if condition is true;  

}  

Example :                                Output 

<?php                                        x is greater than 5 

$x = 10;  

if ($x > 5)  

{  

echo “x is greater than 5”;  

}  

?> 

2.  If ... else statement:  

Syntax  
if (condition)  

{  

// True-block;  

}  

else  

{  

// False-block;  

} 

Example :                                   Output  
<?php                                          x is greater than 5 

$x = 10;  

if ($x > 5)  

{  

echo “x is greater than 5”;  

}  

else  

{ 

echo “x is not greater than 5”;  

} ?>  
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3.  If... elseif ...else’ Statement: 

Syntax  

if (condition1)  

{ 

 // code to be executed if condition1 is true;  

}  

elseif (condition2)  

{  

// code to be executed if condition1 is false and condition2 is true;  

}  

elseif (condition3)  

{  

// code to be executed if condition1 and condition2 are false and condition3 is true;  

} else  

{  

// code to be executed if all conditions are false;  

} 

Example :                                                                        Output  

<?php                                                         x is greater than 10 but not greater than 15 

$x = 12; if ($x > 20)                                                     

{  

echo “x is greater than 20”;  

}  

elseif ($x > 15)  

{  

echo “x is greater than 15 but not greater than 20”;  

}  

elseif ($x > 10)  

{  

echo “x is greater than 10 but not greater than 15”;  

}  

else  

{  

echo “x is not greater than 10”;  

} ?> 

4.  Switch’ statement: 

Syntax: 

switch (expression)  

{  

case value1:  

         //code to be executed if expression = value1;  

          break;  

case value2:  

          //code to be executed if expression = value2;  

          break; 

          ...  

default:  

       //code to be executed if expression is not equal to any of the values;  

}  

Example :                                                            Output  

<?php                                                                x is equal to 10 

$x = 10;  

switch ($x)  

{  

case 5:  

echo “x is equal to 5”;  

break;  

case 10:  

echo “x is equal to 10”;  

break; case 15: echo “x is equal to 15”; break; default: echo “x is not equal to 5, 10, or 15”;  

}?>  
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 CHAPTER-7 ( Looping Structure ) 
1.  for loop   

Syntax  

for (initialization; condition; increment/decrement)  

{  

    //code to be executed;  

} 

Example 1  To print the numbers from 1 to 5 in ascending order  

for ($i = 1; $i<= 5; $i++)  

{  

echo $i . “<br>”;  

} 

Example 2  To print the numbers from 5 to 1 in descending order  

for ($i = 5; $i>= 1; $i _ _)  

{  

echo $i . “<br>”;  

} 

2.  While loop. 

 Syntax  

while (condition)  

{  

//code to be executed;  

} 

Example To print the numbers from 1 to 5                       Output 

$i = 1;                                                                                        1 

while ($i<= 5)                                                                           2 

{                                                                                                3 

echo $i . “<br>”;                                                                       4 

$i++;                                                                                          5 

} 

3.  do...while loop  

Syntax  

do  

{ 

 //code to be executed;  

}  

while (condition); 

Example To print the numbers from 1 to 5                         Output 

$i = 1;                                                                                           1 

do                                                                                                  2 

{                                                                                                    3                                                                               

echo $i . “<br>”;                                                                           4 

$i++;                                                                                              5 

}  

while  

($i<= 5); 

4.  Foreach loop  

Syntax  

foreach ($array as $value)  

{  

//code to be executed;  

} 

Example To print the the elements of an array:           Output:  

$array = array(1, 2, 3, 4, 5);                                                 1 to 5 

foreach ($array as $value)  

{  

echo $value . “<br>”;  

} 

Example:                                                                              Output 

$array = array(“a” => 1, “b” => 2, “c” => 3);                        a => 1                

foreach ($array as $key => $value)                                        b => 2                
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{                                                                                               c => 3                

echo $key . “ => “ . $value . “<br>”;  

} 

5. 3

. 

What will be the output of the PHP code?                           Output 

<?php                                                                                        1 2 3 4 5 

for($x=1;$x<=5;$x++)                                                                (or) 

{                                                                                                  5 5 5 5 5 

echo $x; 

} ?> 

6. 4

. 

Write a PHP code to print all the odd numbers from 3 to 15 using for each loop.  

<?php 

    $odd_Numbers=array(3,5,7,9,11,13,15); 

    foreach($odd_Numbers as $Value) 

    { 

    print “$Value<br>”; 

    } 

?>      

                               (OR) 

<?php 

    $odd_Numbers=array(3,4,5,6,7,8,9,10,11,12,13,14,15); 

    foreach($odd_Numbers as $Value) 

    { 

    If($Value%2==1) 

    print “$Value<br>”; 

    } 

?> 

 CHAPTER-8 ( Forms and Files) 
1. 1

. 

PHP Basic Form Handling: 

Example: Test.html:  
<html>  

<body>  

<form action=”welcome.php” method=”post”>  

Name: <input type=”text” name=”name”><br>  

E-mail: <input type=”text” name=”email”><br>  

              <input type=”submit”>  

</form>  

</body>  

</html>  

Welcome.php:  

<html>  

<body> Welcome  

<?php  

echo $_POST[“name”];  

?><br>  

Your email address is: <?php echo $_POST[“email”]; ?>  

</body>  

</html> 

2.  Client Side Validation:  

Example:  

<input> required Attribute in HTML  

<form action=”welcome.php”>  

Username: <input type=”text”  

name=”name” required>  

                    <input type=”submit”>  

</form> 

3. 2

. 

Validation rules for HTML input field: 

❖ Name (Text Input) : Must contain letters and white-spaces  

❖ Email (Text Input) : Must contain @ and .strings  

❖ Website (Text Input) : Must contain a valid URL  

❖ Radio : Must be selectable minimum one value  

❖ Check Box : Must be checkable minimum one value  

❖ Drop Down menu : Must be selectable minimum one value 

www.Padasalai.Net                                                                     www.Trb Tnpsc.Com

Kindly Send Me Your Key Answer to Our email id - Padasalai.net@gmail.com

www.P
ad

as
al

ai
.N

et

www.P
ad

as
al

ai
.N

et

https://www.padasalai.net/
https://www.padasalai.net/


 

138 
           PREPARED BY...,    B.MOHAMED YOUSUF   M.C.A..,  B.Ed..,    (PG   ASST  IN COMPUTER  SCIENCE) 

           [yousufaslan5855@gmail.com] 

 

 

4. 4

. 

File handling functions in PHP. 

1.PHP Open a File: 

Syntax:$file_Object=fopen(“FileName”,“Read/WriteMode”) or die(“Error Message!”); 

Example: 

<?php 

$myfile = fopen(“Student.txt”, “r”) or die(“Unable to open file!”); 

?> 

2.PHP Read a File: 

Syntax:fread($file_Object,filesize(“FileName”)); 

 

Example: 

<?php 

fread($myfile,filesize(“Student.txt”)); 

?> 

3.PHP Close a File: 

Syntax:fclose($file_Object); 

Example: 

<?php 

$myfile = fopen(“student.txt”, “r”); 

fclose($myfile); 

               ?> 

4.PHP write a File: 

Syntax: 

<?php 

fwrite($myfile, $txt); 

                ?> 

 CHAPTER-9 ( Connecting PHP and MYSQL ) 
1. 2

. 

Database connections: 

Example:   mysqli_connect("server name","user name","password","DB name"); 

2. 5

. 

My SQL connection method: 

Syntax:    

         mysqli_connect(“Server Name “,”User Name”,”Password”,”DB Name”); 

Example : 

<?php 

$servername = “localhost”; 

$username = “username”; 

$password = “password”; 

$DB_name = “School_DB”; 

// Create connection 

($conn=mysqli_connect($servername, $username, $password,$DB_name); 

// Check connection 

if (!$conn)  

{ 

die (“Connection failed: “. mysqli_connect_error()); 

} 

echo “Connected successfully”;  

          ?>      

3. 6 Performing Queries: 

Syntax: mysqli_query(“Connection Object”,”SQL Query”)  

Example:  

$con=mysqli_connect(“localhost”,”my_user”,”my_password”,”Student_DB “); $sql=”SELECT 

student_name,student_age FROM student”;mysqli_query($con,$sql); 

4.  Closing Connection:  

Syntax: mysqli_close(“Connection Object”);  

Example:  

<?php 

   $con=mysqli_connect(“localhost”,”$user”,”$password”,”SCHOOL_DB”); mysqli_close($con); 

 ?>  

Example of PHP and MySQL Program:  

<?php $servername = “localhost”;  

$username = “username”;  
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$password = “password”;  

$dbname = “school_DB”;  

$connection = mysqli_connect(‘$servername ‘, ‘$username’, ‘$password’,’$dbname’);  

if (mysqli_connect_errno())  

{  

echo “Failed to connect to MySQL: “ . mysqli_connect_error();  

}  

sql_stmt = “SELECT * FROM my_contacts”;          //SQL select query  

$result = mysqli_query($connection,$sql_stmt);       //execute  

SQL statement$rows = mysqli_num_rows($result);  // get number of rows returned  

if ($rows)  

{  

while ($row = mysqli_fetch_array($result))  

{  

echo ‘ID: ‘ . $row[‘id’] . ‘<br>’;  

echo ‘Full Names: ‘ . $row[‘full_names’] . ‘<br>’;  

echo ‘Gender: ‘ . $row[‘gender’] . ‘<br>’;  

echo ‘Contact No: ‘ . $row[‘contact_no’] . ‘<br>’;  

echo ‘Email: ‘ . $row[‘email’] . ‘<br>’;  

echo ‘City: ‘ . $row[‘city’] . ‘<br>’;  

echo ‘Country: ‘ . $row[‘country’] . ‘<br><br>’;  

}  

}  

mysqli_close($connection);  

//close the database connection  

?> 
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 Public examination 2 & 3 mark COMPULSORY QUESTIONS WITH answers 

 TWO MARKS: (Q.NO 24) 
1.  Write the syntax to open file function in PHP with an example (M-2024) 

Syntax: $file_Object= fopen(“FileName”, “Read/WriteMode”) or die(“Error Message!”); 
2.  Explain BOSS OS. (J-2023) 

❖ BOSS (Bharat Operating System Solutions) Operating System Developed in India by C-DAC (Centre for 

Development of Advanced Computing) helps to prompt the use of Open Source Software in India. 

❖ It supports many Indian Languages 

3.  What are the ways in which network are connected at home? (M-2023) 

❖ Network at home were connected in two ways  1.Wired Network  2.Wireless Network 

4.  Write the syntax for an if … else statement in PHP. (J-2022)(J-2024) 

if (condition) 

{ 

     // True-block; 

} 

else 

{ 

      // False-block;    

} 

5.  Write the command and shortcut key to cut and paste a block of a document in Abode PageMaker. (M-2022) 

❖ The selected text can be easily cut and pasted in the required location. 

To cut and paste text: 

1. Select the text to be moved.  2. Choose Edit > Cut in the menu bar.  

3. Insertion point is moved to the place where the text is to be pasted.  4. Choose Edit > Paste in the menu bar. 

The following keyboard shortcuts can be used to move text: 1.Ctrl + X → to Cut  2. Ctrl + V → to Paste 

6.  What is 3D secure electronic transaction? (S-2020) 

❖ 3-D Secure is a secure payment protocol on the Internet.  

❖ It was developed by Visa to increase the level of transaction security, and it has been adapted by MasterCard.  

❖ It gives a better authentication of the holder of the payment card, during purchases made on websites. 

This authentication model comprise 3 domains (hence the name 3D) which are:  

1. The Acquirer Domain 2. The Issuer Domain 3. The interoperability Domain 

7.  Write the syntax for: For each loop in PHP. (MAR-2020) 

foreach ($array as $value)  

{  

  //code to be executed;  

} 

 Three MARKS: (Q.NO 33) 
1.  List out some benefits of social networks. (J-2024) 

1.Group information sharing over long distances:  

❖ Although friends and family members can keep in contact via mobile phone calls or by text messages, social 

nets provide a much richer environment for staying connected. 

2.Broadcast announcements:  

❖ Quick, easy way to spread information’s of emergencies and natural calamities. Venues and local shops can 

advertise upcoming events on social networks.  

3.Fostering diversity of thought:  
❖ Some critics of social networks point out that online communities attract people by similar interests and backgrounds. 

2.  Write the output of the following PHP code. (M-2024) 

<?php>                                                                           Output 

$S=array(“a”=>10,”b”=>20,”c”=>30);,                         a=>10                                          

foreach($array as $key=>  $value)                                 b=>20 

{                                                                                      c=>30 

echo $key.”=>”.$value. “<br>”; 

} 

<?> 

3.  Write the output of the following PHP script. (J-2023)                Output  

<?php                                                                                     Welcome to PHP programming 

function welcome ()                                                               Dear student 

echo “Welcome to PHP programming!”. ”<br>”;                 Give your best in your exams 

echo “ Dear”. “Student”. “<br>”; 

echo “Give your best in your exams”.”<br>”; 

} 
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Welcome (); 

?> 

4.  Write the output of the following program (M-2023) 

<?php                                    Output: 

$a = 5; $b = 10;                       75 

$c = ($a+$b)* $a; 

echo $c; 

?> 

 

5.  Write the output of the following PHP script (J-2022) 

<?php                                                  Output: 

$x = array (10, 20, 30);                        Sum = 90 Rupees.  [or] Syntax error 

$y = array (50, 60, 80); 

$z = $y [1] + $x[2]; 

Print (“Sum = “ .z.”Rupees” 

?> 

6.  Write the output of the following PHP code. (M-2022) 

<?php>                                                   Output 

$S=array(11, 333, 7777);                       Syntax error 

foreach($S as $V) 

print $V “<br>”; 

<?> 

7.  What is EDI? Write its types. (S-2020) 

❖ EDI is “Paperless Trade” and EFT (Electronic Transfer) is “Paperless Payment”. 

EDI types: 1. Direct EDI  2.EDI via VAN  3.EDI via FTP/VPN, SFTP, FTPS  4.Web EDI  5.Mobile EDI 

8.  What is user defined function? Write its syntax. (M-2020) 

❖ We can define a user defined function by using the ‘function’ keyword, followed by the name of the function 

and a set of parentheses.  

❖ Here is the general syntax for creating a function in PHP:  

❖ Function definition (or declaration) 

Syntax:  

function functionName([parameter list])  

{  

// code to be executed  

} 
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